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Foreword

Welcome to WordPerfect! and the first thing I want to say about all of this
is how much fun it’s going to be to teach you this great program, and how
much fun you’ll have learning it.

It’s great to be able to make documents in an hour that look like three
professionals at a publishing company spent a day on. It’s fun to explore
ways of putting information on a page that simply express your ideas better
than you ever thought you could. And above all else, it’s fun to see how you
can achieve professional results with a sureness and ease that will astound
you.

WordPerfect is what it is today because of the efforts of a team of gifted
programmers in the first place, and many valuable contributions by private
individuals since program development stopped. Edward Mendelson has
contributed WPMacApp, the more advanced of the two SheepShaver
packages free at WPMac, the mission-critical WPLO Converter, which
translates between WordPerfect and Microsoft Word documents, and the
other file conversion utilities WP Converter, WP Viewer, and RTF Con-
verter. Gero Herrmann has contributed plug-ins for Spotlight and Quick
Look, allowing search and display of WordPerfect documents in OSX, and
opening WP documents directly from Spotlight. Gero also wrote
DocCompare, which uses PERL and AppleScript for highly sophisticated
comparison of documents and revision tracking.

The moderating team at the WPMac support group (see page 29 for its
description and link), including Rick Albright, Smokey Ardisson, Geoff
Gilbert, Kevin McCoy (one of the original WordPerfect developers), John
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Kaufmann, John McVeigh, Edward Mendelson and Tom Rostafinski,
maintain the high level of quality of discussion and support that’s crucial to
maintaining the viability of WP for the Mac.

Since learning to use a Macintosh and WordPerfect is so much easier than
writing a book about it, I owe a lot of thanks: for the first edition, to the
great folks at the MIS:Press imprint of Henry Holt and Company, a first-
class team all the way.

The sailing ship in the Ex Libris design on the copyright page of this second
edition is a detail of Charles Vickery’s Joseph Conrad. Illustrations in
Chapter 15’s Black Magic Review are by Max Ernst. Other works are cited
where quoted.

I owe a special note of thanks to my good friend Dan Smellow. With his
exceptional technical as well as teaching capabilities, he tested this manu-
script line by line for clarity and quality of explanation. He even laughed at
some of my jokes. So the book in your hands has to be a good one, no
matter what I tried to do with it.

And thank you, for letting me help you with a great learning experience.



Introduction

The quality that the WordPerfect development team could offer became
apparent early in the history of the personal computer, and WP became the
default standard for word processing in the DOS world. When the Macin-
tosh came along, a WordPerfect executive was heard to say that his compa-
ny’s program would never run on a computer with a “rodent” attached to it.
Nonetheless, the Mac market grew and attracted a creative clientele, in
writing, graphics and music, and WordPerfect for the Mac, version 1, was
released in 1988.

I remember the program, the reviews, and the astonishment. I had just
finished writing a thesis using Microsoft Word version 3, often called the
buggiest program ever released, and was looking for something I could feel
more comfortable with. I toured FullWrite, an impressive effort, and
others, but quickly settled on WordPerfect’s fine feature set and intuitive
and elegant operation. But the magazine reviewers seemed to have a
different agenda.

Too many hierarchical menus, they said (most programs in current release
have more). Too many keystroke equivalents for menu commands, they
claimed. How can you have too many, and why is it that many of the most
sophisticated and powerful applications available today let you assign any
keystroke to any command, as do later releases of WordPerfect Mac?
Interesting criticism, and I saw a subtext – Apple was at that time, as it still
claims to be, a meaningful alternative for those who in the words of a Mac
ad, “think different”. Apple’s iconic Super Bowl ad in 1984 said it well. I
loved attending meetings of the Berkeley Macintosh Users Group in the
80’s not only for the information but for the camaraderie, the infectious
feeling that the auditorium was a rampart in the revolution to guarantee
that an individual with limited technical background, armed only with a
graphic screen and a mouse, could express his or her creativity in a mean-
ingful and fulfilling way. IBM, “Big Blue”, the land of suits and expense



22 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

accounts, was the enemy, and Big Blue’s kids, Lotus and WordPerfect, were
worth watching out for as well. Never mind that Lotus, after declaring
support for the Mac at its introduction, released Jazz, an all-in-one works-
type suite of applications that despite being a very interesting proof of
concept was largely unusable, and that WordPerfect had sniffed at the Mac
from day one.

But the Mac engaged the public’s imagination and its popularity grew,
especially among creative individuals and industries, and PC software
companies took more notice. When WordPerfect was released for the Mac,
the negative reviews seemed to suggest a “we don’t like your kind” attitude
on the part of the spokespeople of the Mac faithful. The leaders in DOS
software would, people were sure, release programs for the Mac that were
essentially identical and thereby turn the Mac into an IBM clone. The
revolution would be over. What a horrible way to die.

WordPerfect had committed itself, though, and its 1990 release of version
2 reflected a lot of attention to Mac users’ tastes. It did not have real tables,
however, and was ever so slightly slow. The Mac community liked the
interface better, but Microsoft Word, having supplanted MacWrite some
time before as the market leader, retained its position easily.

As WP’s response, version 3’s massive engineering addressed issues of
speed and functionality. Speed-critical parts of the program were rewritten
in assembly language, difficult to do but which ran faster. Tables were
extensively supported. An elaborate feature set was given an elegant and
intuitive interface. It was a thing of beauty. And then two things happened
that no one could have predicted.

The first was that Corel Corporation, which had bought WP from the
lackluster Novell, decided to ship Mac version 3 three months early. As a
programmer told me, “We had this guy writing display code. In meetings he
would say [in response to concern about the program’s atrocious screen
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display] ‘Mark that a 3’ [it would be fixed]”. Maybe it would have been, but
not with three months less time.

The second was that Microsoft released Word version 6. Instead of an
incremental upgrade from the popular version 5, this was a complete
redesign. Somewhat like the earlier Mac word processor FullWrite, it was a
case of the software being too much for the hardware. On the fastest
machine Apple sold at the time, it took a full 45 seconds between double-
clicking the program icon and being able to type. It drove people crazy
right away.

Thus WP Mac version 3 became the most popular word processing pro-
gram on the Mac. But the display problems drove people crazy, if not right
away. Microsoft streamlined Word a little, and it regained market leader-
ship.

When WP released version 3.5, with a host of wonderful features, they
improved somewhat but did not fix display issues, which I found confusing.
Although a very short macro was all that was needed to redraw the screen,
most people didn’t know that and didn’t follow early internet support
groups such as WP’s AOL bulletin board, that had such solutions. Why
didn’t WP really fix display?

They may have had other things on their mind. WP’s competitive market-
ing strategy of supporting every Apple technology was interesting, and also
frightening. It might be a good marketing position to have: “If Apple offers
it, we support it” – but it could also be expensive. Every technology?

Some, like AppleScript, would become wildly popular. Others, like
PowerTalk, would have worked for the new protocol of electronic mail on a
desktop computer, as opposed to a mainframe terminal, except that
dedicated email programs like Eudora got there first. PowerTalk only
lasted an OS version or two.
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But Apple had a very big idea: how about, instead of working with word
processing documents, spreadsheet documents, and graphics documents,
you just worked with documents? When you wanted to edit the word
processing components of your document you would open it in a word
processor, and when you wanted to edit spreadsheet elements you would
open it in a spreadsheet program? OpenDoc was its name, and this new OS
would give Apple a decisive advantage in the personal computer market.

WordPerfect saw an opportunity here to become the best-selling Mac word
processor again by committing enough resources to OpenDoc to become its
first full-fledged container, which would support the OS in its totality. The
magnitude of their investment in OpenDoc would reflect the depth of their
disappointment when Apple subsequently canceled its development. The
engineering required was enormous, the scope of the project became too
large, and it imploded and sank under its own weight.

About this time Steve Jobs rejoined Apple, bringing with him his NeXT
Computer and Unix-based OS. Another insanely great idea, truly, and
Apple decided that its next OS would be Unix-based. Thus OSX.

The extent of the loss occasioned by OpenDoc added to Corel’s other
financial difficulties. WP engineering had had a hard time writing WordPer-
fect for Windows. It kept crashing and no one could figure out why.
Microsoft, who wrote the competing word processing program as well as
the Windows OS, was certainly telling its competitors everything about the
OS and its application programming interface (API) that they needed to
know in order to write a Windows program. Weren’t they? Never mind the
increasingly fast and furious rumors that Microsoft wasn’t publishing
critical parts of the API, and that you were hearing cute little things on the
street like “Windows ain’t done ’till Lotus won’t run” – WP development
would just have to work harder. They finally got WPWin out the door, but
market share had sustained huge damage. This was in 1991. Novell bought
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WP in 1994,and sold it to Corel in 1996, but no one was able to regain the
former competitive advantage.

Microsoft at one point made an emergency $150 million investment in
Corel, purchasing non-voting stock and enabling the company to meet
payroll. Industry observers thought that Microsoft felt it was cheaper to
bail out at least one competitor in the word processing market than fight
the U.S. Department of Justice’s increasing interest in breaking up what
many people thought to be Microsoft’s effective monopoly.

Faced with major financial loss and looking at a major rewrite of Mac WP,
Corel decided to drop out of the Mac market. What was to be version 4 was
renamed 3.5e and would be the last version. Nonetheless, a patch was
issued by Corel in 1998, and an unofficial updater for OS 8/9/Classic (and
SheepShaver) appeared in 2000. If you use WP on the Mac, you should use
version 3.5e with both the patch and updater applied. The 1997 CD release
needs both of these; the download links at WPMac (see page 29) are to the
program with the patch pre-applied and to the separate updater; if you
download either of the SheepShaver packages at WPMac (WPMacApp and
SheepShaver-WP), everything has been applied and you’re ready to run.

In February 1998 I wrote Heather Boyer, Product Manager for WordPer-
fect Mac, to recommend that this last version of WP be made available as a
free download. She replied, “Thanks for the great suggestion! There was a
buzz around here today, and everyone likes the idea quite a bit. I ran it up
the flagpole to the Senior VP of Engineering and Mike Cowpland, our CEO”.
I did not hear further, but the program was released free not long thereaf-
ter.

Since then, many talented and generous people have contributed substan-
tial efforts both to running legacy Mac programs on Intel machines and to
keeping WP Mac eminently compatible with current Macintosh technolo-
gy. The SheepShaver, Basilisk and vMac emulators are examples of the
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first; a WP updater for OS 8 and later that restored functionality to the
Window, Styles and Movie menus, fixed scrolling speed and improved
display; WP Mac document conversion to and from MS Word; Spotlight
and Quick Look plug-ins; precise document comparison, advanced regular
expression search and what has been called the best writer’s outliner on the
personal computer are examples of the second.

These, and a fiercely loyal group of probably exceptional writers enable
WPMac and other user groups to continue to support this best of all word
processing programs. The display problems are there (largely extraneous
artifacts and what appears selected), but are easily rectified with the
“Redraw” macro at WPMac or by toggling visible paragraph markers or
fractional character widths, any of these requiring  only one keystroke. In
exchange users benefit from superior flexibility, customizability, excep-
tional speed and stability, especially with long and complex documents, an
especially intuitive and elegant design, and 15 years of ongoing support
since the program was last published, all free.



Note on the Text

The first edition of this book was titled “Teach Yourself WordPerfect 3.0
for the Mac”. This second edition adds material to cover everything in
version 3.5e, the last release, and also discusses installation and use on
Intel Macintosh computers with the SheepShaver emulator.

The text consists of explanation, numbered steps, and particular para-
graphs identified by these icons:

Note – this information is helpful but not necessary to
learning the step you are on.

Shortcut – here’s a faster way to perform an action.

Important tip, or a place where learners have tended to
make mistakes.

The first edition received these unsolicited comments:

Top Seller – Amazon.com . . . IMHO one of the better books on WordPerfect is
“Teach Yourself WordPerfect 3 for the Mac” written by John Rethorst . . . John
really knows this product inside and out. I doubt you’ll find a better book on this
subject . . . I second the motion for Rethorst’s book. I keep it by my desk all the
time . . . If any of you are looking for a good book on using WP3, John Rethorst’s
book from MIS press is excellent. I just finished reading it and I am very im-
pressed with the quality, accuracy and easy to read style. Congratulations John
on an excellent book and something we at WP are glad to see on the market
[WordPerfect Product Manager] . . . The book is wonderful – lucid, thorough and
well-organized. Easily the best writing on WP that I’ve seen! . . . I have gone
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through the section in your book on macros and find it excellent. . . In the
meantime, don’t wait for any further reviews. BUY THIS BOOK. It is absolutely
magnificent . . . I think I know the program pretty well, but John has certainly
covered all of the basics and intermediate topics, and is pretty thorough in
explaining the nooks and crannys of the program that interest advanced users. I
had only toyed with WP’s graphics capabilities; after working through his
discussion with keyboard and mouse in hand, I now feel like a graphics pro, and
am impressed with the program’s capabilities . . . I like your approaches to page
layout . . . you're a great educator . . . I've played around with drawing programs
for a long time but without much luck in Bézier curves. Your brief discussion of
these is the best I have found anywhere . . . Just as important as the depth is the
manner in which the material is presented. The tone is conversational, and
working with the book is like having a personal Mac guru to guide you through
each aspect of WP. I would say that John’s students are most fortunate to have
him, and readers of the book benefit from his experience at explaining complex
computer concepts to the uninitiated . . . the tedium of this type of material is
leavened with a subtle (and sometimes not so subtle) wry humor . . . I don’t like
to sound like a cheerleader, but I have read a plethora of manuals and third
party guides over the years [and] this book is to my mind the very model of what
a program guide should be. This is what WP’s manual should have been. In fact,
WP should buy the rights, and replace its sorry 3.0 manual with this book in the
box. They would have many more happy and proficient users in the WP fold . . . I
am writing to let you know how happy I am with your new book on WordPerfect
3.0. It is clear, concise and easy to understand . . . I caught the computer bug
seriously last year when I purchased a Performa 450 (I had a DOS machine for
four years which I hardly used). I have probably read over 50 computer books
since that time. Your book is the best one that I have read. I have Word at work.
However, Wordperfect is really a superior word processing program. When I
purchased it, I was having trouble understanding the program because the
manual that came with it was confusing and disjointed. WordPerfect should use
your book as their technical manual . . . Keep up the goods, it’s far and away the
most useful reference I’ve found. The chapters on Advanced Formatting and
Macros bring out Word Perfect’s strengths when compared to Word . . . I just
wanted to congratulate you on a project well done. I have been using WP since
version 1.0.2 on the Mac and I have seen this program grow-up into a really fine
word processor. It’s too bad the programmers of WP didn’t have you to write the
owner’s manual. You really cut through the BS and cleared up many items that
weren’t as clear as they should have been originally. NICE JOB!!! . . . [From
WordPerfect] I second John Rethorst’s book as an excellent reference . . . Best Book
. . . Highly readable, pleasant layout, minimum techogeek lingo . . . I’m now
writing a book on FileMaker Pro, and I think the idea of writing a computer book
started around the time I read and very much enjoyed your WordPerfect book
. . . You really are a good writer and reading it is a pleasure . . . Terrific!



WPMac Support Group

Since Corel Corporation discontinued development of WordPerfect for the
Macintosh, the primary source of support for the program has been a
Yahoo users’ group on the web.

With over 7,700 members, WPMac hosts informed discussion and
support, and over 100 files and links with free third-party solutions that
substantially enhance the program’s power and value.

These include emulation packages that run WordPerfect Mac on any
Macintosh including Intel machines, on any OS version including
Mavericks, current at this writing.

Membership is free at:

https://groups.yahoo.com/neo/groups/wordperfectmac/info

Another site, http://wpdos.org, although primarily about WordPerfect for
DOS, has several valuable pages of information on and support for WP
Mac.

https://groups.yahoo.com/neo/groups/wordperfectmac/info
http://wpdos.org




Chapter 1

Starting Out

In this chapter, you’ll learn how to:

• Choose the best WordPerfect package for your Macintosh
• Install WP on your computer
• Open WP, and enter text
• Save files to disk
• Open two files at once

Since its release by Corel Corporation as a free download, WordPerfect for
the Mac has been available in different packages, for different computers
and operating systems. Current packages support Intel Macintosh comput-
ers with Intel CPU chips, i.e. all Macs made since 2005, and other packages
work with Macs made with earlier chips: the Power PC (PPC) and the
68020 and 68030 (68K) chips from Motorola and IBM.

This chapter will begin by helping you identify which kind of Mac you
have, then choosing the best WP package and installing it.

What kind of Mac do I have?

Move your mouse cursor to the top left of your screen and click, to show
the Apple menu. Choose the first command, “About this Mac”. You’ll see a
box that looks more or less like figure 1.1.
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Figure 1.1: About this Mac

If you see the word “Intel” anywhere in this box, you have an Intel Mac. If
you see the word “PowerPC”, you have a PPC Mac. Otherwise, you have a
68K Mac.

Finding and installing WordPerfect

Whatever type you have, you’ll want to go to the WPMac web site (the link
is on page 29). Join Yahoo groups if necessary, then join WPMac, and go to
the Links section there.
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If you have a 68K or PPC Mac, look for Links titled Download site for v.
3.5e, and download a package. They are free, and will consist of an installer
and an updater for OS 8/9/Classic. Run them in that order.

If you have an Intel Mac, go to the SheepShaver and Basilisk folder in the
Links section, and look for links to WPMacApp or SheepShaver-WP. These
are both free complete installs of the SheepShaver emulator and WP.
Download one, double-click the .dmg file to open it and install from there.

This book assumes no prior knowledge on your part about WordPerfect or
word processing, but does assume that you know the general aspects of
operating a Macintosh.

If virus protection software is running on your Mac, you may
want to turn it off before installing WordPerfect. If you like, you
can scan the WordPerfect install file first, then turn the virus
programs off. See Chapter 17 for a discussion of what com-
puter viruses are, and what to do about them.

Starting to use WordPerfect

1. If you’ve installed the PPC or 68K version, find the WordPerfect folder
and double-click to open it. Then double-click the WP program icon. If
you’ve installed WPMacApp or SheepShaver-WP, double-click its icon
in your Applications folder.

The first time you start WordPerfect the program may ask you
for your name, organization, and license number. Type
anything alphabetical for name and organization, and any
number for a license, and click OK.
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2. After the program loads, you’ll see a window that’s largely blank. This is
where your writing or drawing will go. Depending on package, there may
be icons along the left and top of the screen, and the Menu Bar and
Ruler at the top are all tools that help make your file (or document –
the words are interchangeable) look the way you want it to. There’s a lot
here, so let’s ignore all of it, and pay attention to the blank area. This is
very much like a sheet of paper you’ve put into a typewriter, and you’re
all ready to type (or, excuse us, word process. You’re a computer user
now).

3. Go ahead and type a few words. Each letter appears on the screen as you
type. Note that the insertion point – a blinking vertical line – stays
just ahead of where you’re typing.

If you make a typing error, just use the delete key (or the backspace key
on some keyboards), and you’ll see for the first time that there’s something
special going on here: your Macintosh just erases what you backspace over,
and you can type the correction. No more white-out ever.

Don’t worry if you can type faster than the Macintosh can listen to you.
The Mac buffers all of your keystrokes, and puts them on the screen as fast
as it can. Just type away.

Here comes the next fancy part to computer word processing. Don’t press
the return key when you get near the right side of the screen. Just keep
typing whatever you want, and try to watch the screen as you do this. When
you get to the right side of the screen, and a word is too long to fit on the
line, it automatically jumps to the start of the next line.

This is called “word wrap” in computer lingo, and it’s a good example of
what WordPerfect can do for you. Why should you have to worry about
where a line ends, and whether a word will fit on the line, or whether you
should start a new line first? That’s the Macintosh’s job.
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Already, you’ve been freed to think as you write, and let this bunch of wires
and disks in front of you do the low-level work.

You’ll use the Return key on your keyboard only to start a new paragraph.

4. Press Return, and see that the blinking Insertion Point has gone down to
the line below where you were. Type a few more words. This is a new
paragraph, although it isn’t indented or separated by any space from
what you typed before.

Of the various ways to separate paragraphs (if you want to), the standard
use of the tab key, to indent the first line of a new paragraph, is fine. Or you
can take the more popular option that computer word processing people
do, which is to press return twice, so that there’s a space between para-
graphs, but no indenting.

5. Type some more, with new paragraphs as you wish and, when you get to
the bottom of the screen, you’ll see that the page scrolls so that you can
see each new line. Isn’t this something? WordPerfect is taking care of
you.

Let’s take a break from all this fun to do an essential chore. It’s got to be
done but, thankfully, it’s almost automatic once you learn how. This is
saving.

What this means is, all you’ve typed so far is in the Macintosh’s memory or,
exactly, the kind of memory called RAM, or random access memory. 

You can forget those big words right away; it’s just that this stuff called
RAM is your words on electronic chips, the kind you see when you take the
cover off your stereo. It’s all very nice while you’re typing, but when you
turn the Macintosh off, the electricity powering the chips turns off, and
your typing disappears.
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This is no good, so we want to transfer your typing to your hard disk, where
it will stay until tomorrow or next year. After doing this, you can then type
some more, or print your file, or stop working with the computer. So let’s
copy your typing from RAM to your hard disk or, as we say, save it to disk.

How to Save

1. Grab your mouse, and bring its arrow cursor up to top left of your
screen, to the File menu. Click and hold on this. You’ll see a menu drop
as shown in figure 1.2:

Figure 1.2: the File menu

Still holding your mouse button down:
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2. Bring your mouse down to the Save command, so that it’s highlighted,
and release the mouse button at this point. WordPerfect responds with
figure 1.3:

Figure 1.3: the Save As window. Note that keyboard command key
equivalents are shown in this illustration.

and this is initially a little confusing. Don’t worry; this is about as hard as
the Macintosh gets. It’s just that the Mac needs to know a couple of things
all at once: where you want to put your typing, and what you want to name
it. Forget everything else.

You’ll notice that the dialog you see on your screen doesn’t look exactly
like figure 1.3. The illustration has, for example, Command-D: the com-
mand key symbol, which looks like a cloverleaf or a propeller, and the
capital letter D next to the Desktop button. This means that pressing the
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Command key on your keyboard, which is just to the left or just to the left
and right of the Space bar, and at the same time pressing D, will do the same
thing as clicking the Desktop button with your mouse.

As you look at various command-equivalents, you’ll see that
many of them use the first letter of the action it will perform,
e. g. command–S. Also, command–period cancels most
dialogs: when you cancel a dialog, you simply go back to
where you were before you invoked it, leaving your work
unchanged.

Command–period is either a stretch or a two-handed venture,
but is a Macintosh standard. WordPerfect lets you cancel
anything by using the Escape key, for that more elegant
touch. And, as you know, pressing the Return or Enter key is
the same as clicking a button with a heavy border, as are the
OK buttons in these, and most, dialogs.

In Chapter 12 we’ll learn how to change keyboard equivalents
in WordPerfect, so you can press any keystroke you choose to
execute any command in the program.

Back to the Save As dialog – as with any filing system, the point of locating
it somewhere and naming it something just lets you find it later.

Since we’re just starting out, let’s save your file on the Desktop, which is
the name for the overall screen on your computer’s display. Later on, you
can decide where you want to keep documents of different types. So click
the Desktop button on the right.

3. For a name, just type “My First File” in the Save Document As box.

4. Click the Save button.
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Presto. This window (or, since it asks for a conversation between you and
your Mac, this dialog box) goes away, and you’re returned to your typing.
Note that the title of your file, at the top of the screen just below the menu
bar, and that used to read “Untitled”, now reads “My First File”.

Note that in figure 1.3, and all the illustrations of dialogs in this
book, Command Key equivalents are shown: instead of
clicking a button with your mouse, you can press the Com-
mand Key, which is next to the space bar or your keyboard
and which looks like a cloverleaf or propeller, and the letter or
number shown. This can be a convenience in word process-
ing, largely a keyboard-based operation anyway.

An exact copy of what’s on the screen is now on your hard disk, and you
can change some of what you typed, or add to it, without worrying about
losing part of it. You can always get it back, now that you’ve saved it. Go
ahead and type some more.

Let’s see how much easier it is to save any changes you make to “My First
File”, now that you’ve saved it a first time. From the File menu:

5. Choose the Save command again. This time, there’s no Save As window
(or dialog box) – just a pause for a couple of seconds, and you’re back to
your screen of typing.

Why didn’t the dialog box show up again? Because you’ve already saved it
the first time, so the Macintosh knows its name and where it is. All you’ve
done is added your more recent typing to the file.

This will be the same way as long as you work on this document – you just
add to it, then save, and your further work is then appended to what’s
already on your hard disk, safe and sound.
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The importance of saving

It’s a really great idea to nurture the habit of saving like this, every five
minutes or so. Don’t type for half an hour and then save. But why not?

It’s just that since what you write is in RAM – on those wires and chips – if
there’s a power outage, the electricity needed to keep your writing in RAM
can go away, and your work with it. But if you save your writing to disk
every five minutes, it’s safe even if the electricity goes out.

This is a big – no, the big – answer to lots of computer worries. You may
have friends who have lost hours of work; we sure have. Why did that
happen? Most often, they just didn’t save their writing often enough.

It’s so simple, that the only excuse is that they forgot. And since a habit is
the best insurance against a faulty memory, now’s the time to start a good
habit of saving often. Go to the kitchen and get your egg timer, set it for
five minutes, and type away. When the timer goes off, save and then write
some more.

You’ve just conquered the major source of computer problems.

Making changes to your file

As you’ve typed, you’ve probably made some typing errors, or changed
your mind about a word or two. You simply backspaced, and typed the
correction.

Now let’s say that you’re at the end of your fifth paragraph and, reading
what you’ve written, you see that you want to change something in the
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second paragraph. Do you have to backspace through three paragraphs
and, in doing so, delete all that’s in between? No way.

Here’s another use of your mouse:

1. Move it around a little on the screen. You’ll see another kind of cursor
appear, one that we call an I-Beam, when you’re over the typing area.
The cursor changes back to an arrow when it’s over the menus or a bar.
You’ve already seen the blinking insertion point, appearing where
you type, and you saw the arrow cursor when you brought your mouse
up to the File menu, as well as before you opened WP.

If you click your mouse (seen as the I-Beam) anywhere where you’ve
already typed, you’ll move the blinking insertion point to that place in your
typing.

2. Click your mouse just to the right of any word you’d like to change. See
that the insertion point is now blinking just after that word.

3. Backspace (using the Delete or Backspace key, depending on your
keyboard), until you’ve deleted the whole word you want to change.

4. Type your change.

This the next big plus to computer word processing. You can make any
change to any part of your file, any time you want to.

We say that a computer frees us, and empowers us, and this
is the first part of that. When you start to write, you can just sit
down at the Macintosh, open WordPerfect, and type whatever
comes into your mind. Any changes that you subsequently
want to make are easy, just a mouse click away.
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5. Save your changes, just for safety’s sake. That egg timer really is a good
idea, to develop this great habit right away.

For a faster way to change a word, double-click your I-beam
on it. The entire word will become selected. You can then just
type a replacement – the original word is deleted automati-
cally.

Closing your file

At this point, you’ve done all the writing you want to do in this file, and
perhaps want to write something else with WordPerfect. So let’s close the
file you’ve been working on.

1. Bring your mouse up to the File menu, and choose Close.

If you’ve done any more writing, or made other changes, your Mac will ask
you, by means of another dialog box, if you want to save those, not save
those, or cancel your decision to close your file. If you haven’t made
changes since you last saved, your file will simply close.

2. If you have made changes, the dialog box will look like figure 1.4:

Figure 1.4: Save changes?
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and you can click your mouse on what you want. Unless you’re sure you
don’t want to keep the changes to your file, you should click Save.

Your document is now closed, and you’ll see the Macintosh desktop. Let’s
begin a new file, to see how we can write something else.

Starting a new file

1. Come up to the File menu, and choose the first command: New.

You now have a new, untitled screen. Type a few words. This is an example
of a second piece of writing.

2. Choose Save from the File menu, and save this to disk as you did last
time. Use the name, “My Second File”.

3. Close this document, again from the File menu.

Now let’s say we want to go back to your first file, to make some further
changes, or maybe just look at it.

Opening a file

1. Choose Open from the File menu.

You’ll see a dialog box, shown in figure 1.5, which looks a little like what
you saw when you saved each of your two files for the first time. There’s a
list of folders or files, and buttons to the right.
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Figure 1.5: Open Dialog

2. Click on the words “My First File”. It becomes selected: the space
surrounding and within the letters becomes shaded.

3. Click the Open button at the right.

Or, double-click (click twice, quickly) on the name of the file.

Presto again! Your original writing is back on the screen.

This is an important step. You might want to close the file now, and go
through the steps again to open it. In this way, you can come back to any
file you have on your computer.
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4. Make some changes to “My First File” and save them.

5. Close “My First File”, and then open “My Second File”. Add a few words
to this one too, and then save this file.

It’s just as easy to have two or more files open at once, with their windows
next to each other, or one behind the other. You can compare two docu-
ments, or copy paragraphs out of one and paste them into the other.

6. Open “My First File” again. Its window sits nearly on top of “My Second
File”, but a little offset, so you can see the edges of both.

This kind of setup can give you a real boost in productivity and accuracy,
and you now know how to do it.

Quitting WordPerfect

At this point, let’s say that we’re through with the computer for the time
being. Rather than just turn the Mac off, we should quit WordPerfect first.
It’s important to do it this way, since both WordPerfect and the Macintosh
need to clean things up a little, so to speak, before the power’s shut off.

1. Bring your mouse up to the File menu, click, and choose the Quit
command, the last one on the menu.

If you have any unsaved changes to any open file, WordPerfect will ask
you if you want to save them. Do so. If you haven’t made changes since last
saving, the open files will simply close. WordPerfect (and SheepShaver, if
you’re using it) then quits, and you’re returned to your original desktop.
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Summary

If you don’t feel sure about all of this, why not repeat the steps from
“Starting to Use WordPerfect” up to now. For a certainty, repeating a few
steps now is a good idea, since the largest hurdle you’re facing is not an
objective complexity to the tasks, but a lack of ease and familiarity with
this kind of tool. Keep in mind that a little practice with these steps, now
and as we go, really pays off.

Otherwise, you can sure pat yourself on the back for learning how to:

• Install WordPerfect on your Macintosh
• Open WordPerfect, and write a letter, or a novel
• Save your work to disk frequently, so you won’t lose it
• Start a second file, and save that to disk
• Close files, and quit WordPerfect

which is quite a bit for your first session. Note that while not everything
seemed easy at the time, it certainly posed no problems if you did things
step by step, and repeated a step here and there as necessary.

Importantly, you’ve just learned how to do about ninety percent of what
word processing users do every day on their Mac. A little practice will
make it as effortless for you as it is for them. You see? We promised it
would be easy. 



Chapter 2

Basic Word Processing

In this chapter, you’ll learn how to:

• work with different fonts, sizes and styles of text
• apply font attributes to existing text, as well as new text
• change margins and tabs, using the ruler
• work with text alignment and justification
• change line and paragraph spacing
• use indenting
• work with WordPerfect’s Status Bar
• navigate around your document
• preview a printed file
• change print settings
• print a document

In chapter one, you learned the bread and butter of word processing –
entering text, and making and saving changes. Although you now have
most of the tools you need for most of the work you want to do, it’s just at
this point that powerful word processing programs like WordPerfect take
off, and give you a flexibility with and control over your text that’s most
impressive. You can make your documents – letters, brochures, longer
publications – look as good as professional printing.

In fact, most publishers now make use of the Macintosh for much of their
final output. This book was produced from start to finish on a Mac.

You can do this at a fraction of the cost and time it used to take. More
importantly, because you have extensive control over your document’s
formatting, you can fit the look of your work to its content.
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In case this sounds apocryphal, consider just about all of the advertising
you see. The words in the text have to do more than sound sophisticated or
forthright – they benefit by looking so. Presentation is a large and growing
industry, and formatting of text is integral to it.

Fonts and sizes

Let’s look first at fonts, or type styles, that the Mac offers you. The word
‘font’, etymologically from the same root as ‘fountain’, derives from the
days when type for printing was poured from hot lead into molds made
from, sometimes, wonderfully sophisticated renditions of letters of the
Roman (and other) alphabets. The Macintosh offers thousands of fonts and
WordPerfect can make use of nearly all of them, including, with the help of
the free Adobe Type Manager, the OTF format used in OSX. Figure 2.1
shows you a small sample.

As you can see, type makes a difference. Here’s how to use it.

Changing fonts

1. Open WordPerfect. Type a few lines of something. This text will be in
WordPerfect’s default font, called “Geneva” (If you got WP in one of the
SheepShaver packages at WPMac, the font will be “Lucida Grande”).
These or similar fonts are standard defaults in many Mac programs just
because they’re legible on screen.
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This is Palatino,  a font with a chisled look. It’s eminently legible in text, and is
also nice at larger size – for titles or display. The italic is also very clear. This is
the bold, and here’s the bold italic. Either italic,  or bold,  or the combination, is
more legible and aesthetic than underlining,  or all capital letters. 

Helvetica is clean and modern.  It’s not as good a choice,  though, for large blocks
of text. This is the italic, the bold, and here’s the bold italic. This is a nice
typeface for titles,  subheadings or picture captions. 

This is Courier, which looks just like a typewriter. The Mac
includes this in case you want it,  but there is advice against
it.  For one thing,  Courier is monospaced – an i is the same
width as an m.  It’s simply not as legible.  Part of the benefit
of learning the Mac and WordPerfect is getting away from the
look of a typewriter,  in favor of what professional publishing
looks like. 

Figure 2.1: Font selection

The default size you see is 12 points (14 points if Lucida Grande). A point
is a printer’s measure, and is 1/72 of an inch. 12 point type thus measures
1/6 of an inch from bottom to top of any capital letter. You can change the
font or size, either for your current document or for all new documents.
Figure 2.2 gives you some examples of sizes. WordPerfect offers you any
size from 1 point to 32,767 points.

You’ll change fonts and sizes by commands on the menu bar, and exactly
what you see on the menu bar depends on the size of your screen. If you
have a nine-inch screen, as on the Mac Plus, SE, or Classic, you’ll see a
Font Menu. If you have a larger screen, WordPerfect makes two menus,
Font and Size.
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This is 9 point, excellent for contracts and details of political promises. 

This is 10 point, a little better. Some books are printed in this size. 

This is 12 point, the WordPerfect and Macintosh default. 

This is 18 point, useful for titles and subheadings. 

This is 24 point, clearly in the title range.
Figure 2.2: Font sizes

2. Bring your mouse up to the Font menu, and choose something interest-
ing. “Palatino” might be nice. Go back to your keyboard, and type a few
words. Then change to “Helvetica”, and type some more.

3. Bring your mouse up to the Font menu (on smaller screens) or to the
separate Size menu (on larger ones), and choose 24 point. Type a little
more, and change the Font again if you want. This is fun to explore.

This is how you change font and size for text you’re about to type. But what
about changing these attributes for text you’ve already entered? No
problem. It’s so easy that many users, ourselves included, do all our text
entry in Geneva 12 point, and then change fonts and sizes.

There’s just one simple step first. We have to tell WordPerfect which text
we want to make a different font. We do this by selecting that text.

How to select text

Grab your mouse, and bring the Insertion Point over just to the left of
the word that will start the selection. Click and hold, and drag (move your
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mouse while holding down on its button) through the next three or four
words. You’ll see this text change from dark on light to the opposite, and
this just means it’s selected, as in figure 2.3.

Figure 2.3: Selected text

Once some text – a word, a line, or a paragraph, or part of any of these – is
selected, any command you choose from the Font/Size menu will apply to
it.
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Changing font and size of selected text

1. From the Font menu, choose a font other than the current one, which
has a checkmark beside it. See how the selected words change immedi-
ately to the font you chose.

As noted above, some fonts are especially legible on screen. To appreciate
the qualities of the font you just chose, perhaps Palatino or Helvetica, or to
make some text into a title, select what you want and:

2. Go to the Size menu (or the bottom of the Font menu on smaller moni-
tors) and choose 24 point.

This is just a first small inkling of what you can do with the Macintosh and
WordPerfect. Stick around, and see how to do anything at all with the
written word.

Styles

You might also want to change a word or a few to italics. Although it’s best
not to put too much text in italics – never a whole document, for example –
italics is the best way to emphasize a single word or phrase.

Although typewriters taught us to emphasize a point by putting it in all
capital letters or by underlining, neither of these is optimum. All caps looks
too loud, and underlining simply looks unprofessional. And both are harder
to read.

1. Select some other text (your earlier selection becomes unselected when
you select anything else) and then come up to the Style menu, near the
right of the menu bar.



Chapter 2: Basic Word Processing 53
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

2. You’ll see that the Plain Text command is currently chosen – it has a
check mark to the left of it. Choose the Italics command, the third one
down, and presto!, your selected text is now changed to italic.

Or, choose the Italics command without any text selected, so that whatever
you type immediately thereafter will be italicized.

When you want to go back to Plain Text, choose that command from the
Style menu.

If you want to change any text for a second time, just select it and make the
change. You can toggle back and forth as much as you’d like. Anything can
be changed, and changed back, as often as you want.

This hints at another valuable feature of computer word
processing – nothing is cast in concrete (or even ink), so you
can format text until it’s just right. And if ‘just right’ seems a
quandary right now, never fear – a little practice will give you
the experience you need to tell what’s going to look good on
the page.

Here’s an important reminder, though – save your work often
as you go. Saving doesn’t mean casting your text in concrete,
since you can always change it and save again. If the power
goes out, though, you’ll be glad you saved every five minutes,
just like that egg timer tells you to.

Scroll bars

As you’ve entered text, you may have typed more lines than will fit on your
screen. You can move around your document using the Scroll Bars,
which you see on the right side and on the bottom of your screen (just
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above the Status Bar). Figure 2.4 illustrates the vertical and horizontal
Scroll Bars.

            

Vertical Scroll Bar
            

Horizontal Scroll Bar

Figure 2.4: Scroll Bars

Let’s stay with the vertical Scroll Bar for now:

1. Click in either Arrow. Your document scrolls in the opposite direction,
since what you’re moving isn’t your writing, actually, but the window
through which you see it. This becomes intuitive in a few minutes since,
as you see, using the Arrow pointing down takes you down in your file.

2. Click in the gray area just below the top Arrow, and you move one
screen up. Ditto for the gray area near the bottom Arrow.

The Scroll Box (sometimes called the “thumb”) shows you where you are
in your file. You can see it move as you click on the Arrows or next to
them.

3. Click and hold on the Scroll Box, and drag it in either direction. When
you release the mouse button, your text will scroll as you specified.
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One important point specific to text documents, though, is that scrolling up
and down moves your writing but not your insertion point – it stays where
it was before you started to scroll.

To move the Insertion Point, just scroll to wherever you want to enter text,
and then click your mouse at the place you want to type. Your mouse click
places the Insertion Point at that spot.

How to Undo anything

Say you didn’t want to make the last style change. WordPerfect (and most
Macintosh programs) offers you an easy way to undo the last action you
performed.

1. From the Edit menu, choose the first command: Undo.

You’ll see that the last action you made has been reversed.

You have to choose Undo, though, as the next step you take.

If this doesn’t work for you, it’s because you inadvertently did something
else between making a font change, and then choosing Undo. Try another
change, and then Undo it.

The Undo command works for almost any action you perform in WordPer-
fect.

2. Make another format change, and then Undo it. A little practice will
familiarize you with this handy tool.
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Formatting with the Ruler and the Layout
Bar

WordPerfect first opens with one inch margins on the left and right sides of
the page. You might want other settings, either for an entire letter or
report, or you might want to indent just the first lines of each paragraph.
You can easily make these changes using the Ruler. If it’s not showing
now, click the Ruler button near the top left of the window to show it. You’ll
see figure 2.5.

Figure 2.5: WordPerfect’s ruler

The icons similar to scroll boxes show the margins, here at the default of 1
and 7.5 inches. The small down Arrow at the right side of the left margin
indicator is the first line indent: you would indent paragraphs here.

Below the numbers are the tab stops – like a typewriter, these are where
your Insertion Point stops each time you press the Tab key.

Setting margins

1. Open or type a document with several paragraphs in it. “My First File”
would be fine but, if you’ve changed fonts or sizes, first take your mouse
and drag through all the text to select it, and change it back to 12 point
Geneva or Lucida Grande, for this example.

Or, choose Select All from the Edit Menu, to select the entire
text.
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2. Click in front of a paragraph about halfway down the screen.

3. Click and hold on the left margin’s box, and drag it an inch to the right –
just above the number 2. As you drag, you’ll see a dotted line follow
your mouse movement. This dotted line, extending all the way down the
screen, can help with alignment. Release the mouse button.

All the text following your starting point has moved to your new left
margin, as in figure 2.6. Quick and easy.

If you only want a paragraph or two to follow this new margin, click your
mouse in front of the first paragraph you want to return to the one inch
(default) margin, and:

4. Drag the left margin box back to the one inch mark, and release. Your
text will change as shown in figure 2.7.
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Figure 2.6: Changing the left margin
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Figure 2.7: Changing margins at a later point

What you’ve just done is change margins for unselected text. Another way
to do it, if you want to indent just one paragraph:

5. Triple-click in the paragraph you want to indent, to select it all, and drag
the margin box over to the 2-inch mark.

Only the paragraph you selected changes, as in figure 2.8.
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Figure 2.8: Selecting a paragraph and changing margins

All of this works the same way with the right margin.

Here’s a good place to save again. You really can’t do it too
often, and it’s free. Not much in life is like that. Then return the
margins to the 1 inch and 7.5 inch marks.
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Tabs

The tabs WordPerfect provides you, by default, at every half inch along
the ruler are adequate for much of everyday word processing, but there’s a
great deal more flexibility available.

We’re going to replace some of these default tabs with other kinds – so that
several lines will align at their right edge, for example, or so that a column
of numbers all line up at the decimal point. First, let’s delete some default
tabs. Start a new document by choosing New from the File menu, show the
Ruler if necessary, and:

1. Click and hold on the tab icon at the 1.5 inch mark.

2. Drag it down into the text area, and let go. This deletes it.

3. Repeat this for the tabs from the 2 to the 7 inch marks.

Next to the Ruler button at the top left of the window, there’s another
button titled Layout. Click that if it’s not already active, to show the
Layout Bar. You’ll see figure 2.9.

Figure 2.9: The Layout Bar

What we’re interested in now is the leftmost icon on this bar, with the two
triangles on it. Note that the box the triangles are in is shadowed at the right
and bottom. This is the Macintosh designation for a Pop-Up menu.

4. Click on this icon, and you’ll see a menu drop, as in figure 2.10, showing
the different kinds of tabs WordPerfect offers you.
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Figure 2.10: The Tab Pop-Up menu

5. Move your mouse down to the Right Tab, and let go. It seems that
nothing has changed.

6. Now move your mouse to the 7 inch mark on the ruler, below the main
ruler line, where the other tabs are. Click once. You’ll see that you’ve
added a tab mark but, unlike the others, this triangle faces right instead
of left. Your ruler should look like figure 2.11.

Figure 2.11: New right tab set at the 7-inch mark

7. Type this, pressing the Tab and Return keys where shown in brackets:

Cast for “The Glass Menagerie” [Return]

Amanda Wingfield [Tab] Kay Martin [Return]
Laura Wingfield [Tab] Jessica Willis [Return]
Tom Wingfield [Tab] Katherine Thorncastle [Return]
Jim O’Connor [Tab] Fred Jones [Return]
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8. Bring your mouse up to the Tab Menu again, and choose Decimal.

9. Click at the 5 inch mark, press Return a couple of times, and type:

New Measurements [Return]

Length [Tab] 811.7522 [Return]
Width [Tab] 145.20 [Return]
Height [Tab] 300.08 [Return]

Every figure lines up at the decimal point.

Let’s try more advanced formatting.

1. Drag both the Decimal Tab at the 5 inch mark and the Right Tab at the 7
inch mark down into the text area, to delete them.

2. Pull down the Tab Menu again, and note that the four tabs after Decimal
all have three periods in front of their names. These indicate dot
leaders. 

3. Choose the Decimal Dot Leader Tab, and click to place one at the 6 inch
mark on your ruler. Press Return a couple of times, and type:

Fromage á la Maison [Tab] . . . . . . . . . . . . . . . . . . . . . . . . $4.95 [Return]
Confusion á la Rethorst [Tab]  . . . . . . . . . . . . . . . . . . . . $19.95

Here’s a great place to save again.

The Bar Tab (no, not the one you really have to pay pretty soon; the next
choice on the Tab Menu) is used to put a vertical line between two lists. Try
this, setting a Bar Tab at the 3.5 inch mark, and a left tab at 4 inches.
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4. Type a word, then press Tab twice, and type a couple more words. Press
Return, then repeat this. The bars join at the ends, to make one continu-
ous vertical line.

This feature is helpful for short and simple columns and tables, although
WordPerfect offers much more extensive implementations of both. We’ll
look at them later on.

5. Save again and then, from the File menu, choose Close. Let’s work with
other kinds of formatting.

Justifying text

As you’ve seen, WordPerfect wraps each line of text for you, so you don’t
have to use the Return key. In fact, you should never use the Return key
just to start a new line within a paragraph. It might look fine with the font
and size you’re using to write, but if you want to change font or size before
printing, and you choose a font that takes less space, you’ll end up with a
goofy looking page. WordPerfect re-wraps text when you change fonts, but
only if you didn’t end each line by pressing Return.

When you reach the end of a line and WordPerfect automatically starts a
new line, it leaves the spacing between each word in the line the same. So
the right ends of your lines of text are uneven or, as we say, ragged.

This might look unprofessional to you but, in fact, recent research in
reading has shown that legibility benefits most from equal spacing between
words and letters, and who cares whether the right margin is aligned or not.
The additional inter-word and even inter-letter spacing required to align
the right margin interferes with easy reading, even if the page as a whole
looks neater.
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WordPerfect gives you your choice, though, so let’s look at how to make
the right margin come out even or, as we say, justified.

1. Start a new document.

2. Type three paragraphs of your new novel or (greatly failing that), your
new computer book.

3. Click your mouse at the beginning of the first paragraph.

The Layout Bar above the Ruler has another pop-up menu just to the right
of the Tab Menu, as seen in figure 2.12. This governs alignment, or
justification.

Figure 2.12: The Alignment menu

The default shows lines even at the left margin, ragged at the right. Choose
the fourth command, Justify, which shows lines even at both left and
right.

See how all of your text is now even on both sides. WordPerfect has
inserted extra spacing within each line as necessary. You may prefer this
look, although more book and magazine designers all the time are opting
for a ragged right margin.

4. Choose Undo from the Edit menu, to reverse this formatting change.
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5. Now click your mouse just in front of the second paragraph, and choose
Justify again. As with other formatting, only the text after your insertion
point changes – in this case, the second and the last paragraphs. Undo
this too.

Say that you want only the middle paragraph justified. You could do this in
two ways. You could justify the second and third paragraphs and then
change the third back. Or, more efficiently:

6. Drag your mouse through only the second paragraph, to select it. Then
choose the Justify command. Only the second paragraph becomes
justified. Click anywhere in document to de-select this text. Then undo
this change.

As with fonts, you can of course choose formatting first, and
then enter text.

Here’s a good point to save again. You may become tired of our frequent
exhortations to save, but it’s most important to develop this excellent habit
early in your computer career.

Spacing

WordPerfect defaults to single spacing, where there’s just enough distance
between lines for the text to be legible. You may want the lines spaced
farther apart than that, though, say if you’re a college student with a 15
page paper due tomorrow. Or, drafts of most writing benefits from being
double-spaced to facilitate hand-written comments.
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You have very precise control over spacing in WordPerfect, but for now
let’s look at the basic kinds, shown in figure 2.13, available on the Layout
Bar.

Figure 2.13: The Line Spacing menu

1. Click your mouse just in front of the second paragraph. Again, this
formatting command will affect text following it.

2. From the Line Spacing menu, choose 2. All subsequent text is double-
spaced.

This command works as do the others, as far as selecting text and then
applying formatting. Undo the double-spacing (choose the Undo command
from the Edit Menu), and we’ll look at how WordPerfect can space para-
graphs apart, while leaving together the lines within each paragraph.

3. Click your mouse at the top of your text, and bring your mouse up to the
Layout Bar, where the fifth pop-up menu, seen in figure 2.14, governs
paragraph spacing.

Figure 2.14: The Paragraph Spacing menu
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4. Choose the third command, to give your text one space between para-
graphs. This formatting is common in a business letter, less so in reports
or academic writing.

What’s the point of spacing paragraphs this way, rather than just pressing
Return twice between each paragraph? One reason is that you may want the
paragraph spacing for your final, printed document, but it’s just too much
blank space on-screen.

Another reason, which applies generally, is that it’s more efficient to
separate writing and formatting as much as possible. This is so you can
write undisturbed, paying attention to your ideas, and then later format for
the clear and impressive appearance you want your document to have.

By entering text with as little formatting as possible, it’s easier to apply
formatting with the Layout Bar afterwards, rather than deleting a whole
bunch of double Returns when you belatedly decide that wider paragraph
spacing wasn’t what you wanted after all.

One application of this idea is the common format of single-spacing, but
indenting the first line of each paragraph. With typewriters, you pressed
Tab at the start of each new paragraph. WordPerfect can do this for you
just as well, but here’s a better way.

First Line Indent

You’ve seen that WordPerfect’s ruler has boxes for margins. There’s also a
small down arrow, normally at the right edge of the left margin box, as in
figure 2.15.
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Figure 2.15: The First Line Indent arrow, set for .5 inch

This determines where only the first line of each paragraph will start.

1. Click your mouse to place the Insertion Point in front of all text.

2. Click on the First Line indent icon, and drag it to the 1.5 inch mark. Each
paragraph now has that indentation.

Again, one advantage of using this tool rather than pressing
tab to start each paragraph is that you can change it at a later
time: remove it, in favor of paragraph spacing, or enlarge or
lessen the amount of indent, all in one action. In general,
formatting this way vastly increases flexibility.

The Status Bar

As we’ve worked with icons on the Ruler and the Layout Bar, we’ve seen
lots we can do, and the question arises, how to remember easily what each
icon does? Their pictures are helpful, but WordPerfect gives us more help,
contained in the Status Bar appearing at the bottom of the screen. Figure
2.16 shows this real-time help feature.

Figure 2.16: WordPerfect’s Status Bar
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1. Click on the box at the far left, which has an arrow pointing down. A
menu will pop up when you do.

2. The top command on this menu may say Show Help. Choose it if it
does. If it says Hide Help, release the mouse button at this point, so as
not to change anything.

3. Move your mouse over the First Line Indent arrow on the Ruler (no
need to click). Note that the right side of the Status Bar says in blue text,
quite simply, “First Line Indent”. Move your mouse over the Alignment
menu on the Layout Bar, and the Status Bar tells you that it “Changes
alignment”.

The Status Bar also shows you what page and line you’re on,
and the date and time. It can show you a great amount of
other information – status of your battery, for example, if
you’re using a laptop, or whether you’ve protected your
document so that you can’t make inadvertent changes to it.

You’ll learn how to add and delete whatever information you want from the
Status Bar later in this book, when we show you the considerable power
WordPerfect gives you to customize your working environment for your
needs.

Navigating around your document

You’ve seen how to go from one part of your document to another, using
the Scroll Bars and then clicking where you want to type or format next. As
you work with larger files, though, you’ll want to take advantage of the
many ways WordPerfect gives you to move around, which don’t require
you to leave your keyboard for the mouse.
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The advantage here is that when typing, we develop a feel for where things
are on the keyboard, and moving our thoughts as well as our hand to the
mouse presents an interruption. So WordPerfect lets us navigate within a
document entirely by the keyboard.

1. The Arrow Keys, at the bottom right of the main area (alpha, not
numeric) of your keyboard, move your cursor one letter to the right or
left, or one line up or down, within text.

2. Pressing the Option Key, and then a left or right Arrow key, moves
your cursor a word at a time. The Option Key plus an up or down Arrow
Key moves you up or down a page at a time.

3. Pressing the Command Key and a left or right Arrow moves you to the
left or right end of the line you’re on. Pressing Command and an up or
down Arrow moves you up or down one screen at a time, as opposed to
the page at a time the Option Key gives you. Unless your screen displays
exactly one page (and you can change page sizes for a document), the
distinction is useful.

These keyboard commands move your Insertion Point as well
as your view of your file. Using the Scroll Bars, by contrast,
moves your view of your document but not the Insertion Point.

The numeric part of some keyboards, off to the right, called the Keypad,
will enter numbers if you tell WordPerfect to do so. Otherwise, you can use
the Keypad to move your Insertion Point around your document as well.

Pressing the Shift and Clear keys together toggles between these two
functions of the Keypad.
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1. Pressing the 8 key moves your cursor up one line; pressing 2 moves it
down one. Pressing the 4 moves you one letter to the left; the 6 one
letter to the right.

2. The 9 key moves you up one page; the 3 key moves you down one.

3. The 5 key is called the Gold Key in WordPerfect; it is as good as gold,
as you’ll see. Here, its use is:

4. Pressing the Gold Key and then the 4 or the 6 moves you to either end of
the line you’re on.

5. Pressing the Gold Key and the 8 or the 2 moves you to the top or the
bottom of the screen you’re on.

6. Pressing the Gold Key twice, and then the 8 or the 2, moves your
Insertion Point to the beginning or the end of your document.

7. Pressing the minus key on the keypad moves you up one screen; the plus
key down one.

Should you want to enter numbers with the keypad instead, just press the
Shift and Clear keys. Pressing those keys again toggles you back to navigat-
ing mode. All navigating key assignments are shown in figure 2.17.

A little practice will make you as familiar with any of these
keystrokes as you are with how to type words. It’s just faster
and easier, part of why you’re learning WordPerfect.
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Figure 2.17: Navigating with the Keypad

If any of these keyboard commands seem uncomfortable to
you, you can change them. We’ll learn, in Chapter 12 of this
book, how to customize WordPerfect. You can literally make
WordPerfect perform any command it has with any keystroke
you want.

More advanced navigation around a document (and other
documents), using Bookmarks and Hyperlinks, is discussed in
Chapter 16.
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Printing

For this next exercise, you need to have a printer connected to your
Macintosh, and this printer needs to be selected using the Apple Menu
Item called the Chooser. Except – if you’re using either of the
SheepShaver packages free at WPMac, your printer is already selected,
and the Chooser is not installed.

All of this is a set-once-and-forget kind of thing, unless you use different
printers. Your Macintosh instruction manual explains how to use the
Chooser. We assume here that your printer is connected and chosen, and
turned on.

To obviate wasting paper and printer supplies, WordPerfect has a helpful
feature called Print Preview, which you might want to use often if not
every time you print. The advantage of previewing is that you see an exact
representation on screen of your whole page, right out to the edges. Also,
when you learn advanced formatting features such as headers, footers and
footnotes, you’ll appreciate seeing them previewed as they’ll appear on the
printed page.

Print Preview

1. Open a file and format it the way you’d like it to print.

2. Choose Print Preview... from the File menu. You’ll see something like
figure 2.18.
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Figure 2.18: Print Preview
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At the left of your screen is a series of boxes. The second box down has a
percentage figure. This is the size of the page on screen relative to actual
page size, and differs according to the size of your monitor. Note also that
your cursor has changed into a magnifying glass.

3. Move the magnifying glass to a part of the page you’d like a closer look
at, and click.

Your cursor changes again, this time into a hand. The percentage figure at
the left changes too, to read 100%.

4. Click and hold, and move the hand around. The page moves with it.

5. From the percentage box, choose 200%, then 400%. You can really get
down to it this way. Choose Full Page to go back to the magnifying
glass.

Above the percentage box, the left and right arrows move you from one
page to another (the arrow keys on your keyboard, and the 9 and 3 keys do
too). Or, you can type in a figure in the box at the lower left of the preview
page, and press Return on your keyboard.

The icon below the percentage box, with a representation of a single page,
allows you to change the preview to show facing pages.

6. Click this icon. Your preview now shows two pages at a time, and you
can move around pages and magnify as before. Click the icon, which
now looks like two pages, again. You’re back to a single page.

The next icon shows two dog-eared pages, each with a person on it. This is
the Page Setup command. You also access this from the document
window as well as the Print Preview window, so let’s do that.
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7. Close Print Preview by clicking its close box.

Page Setup

1. From the File Menu, click Page Setup. Figure 2.19 appears.

Figure 2.19: Page Setup dialog, for a Laserwriter

The features shown in this dialog for most printers include:

• Format for. This is the name of the chosen printer. Again, if you’re
using a SheepShaver package, this choice has been set elsewhere.

• Paper. The options on this pop-up menu include U. S. Letter and Legal,
and A4 and B5, common paper sizes in countries other than the U.S.
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• Orientation. These icons represent portrait (vertical) or landscape
(horizontal). Landscape is useful for some graphics but is infrequently
used for regular text.

• Scale. LaserWriters let you reduce to 25% or enlarge to 400% in one
percent increments; other printers may have more or less of a range.

When the page setup is what you want:

2. Click OK.

The last icon on the left may look different from this illustration, depend-
ing on what kind of printer is connected to your Mac and chosen for use. In
any case, this takes you to the Print dialog box.

The Print command

1. Choose Print from the File Menu, and you’ll see figure 2.20.

and the features offered will again differ according to printer. All we need
to look at now, though, are these options:

• Destination. If you’re using a SheepShaver package, this will be set to
File, and the other option, Printer, will be grayed out. Otherwise, the
default destination is Printer, but you can change it to File to make a
Postscript file of your document. That file can then be opened in other
programs, such as Apple’s OSX utility Preview, to make a PDF docu-
ment.
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Figure 2.20: Print dialog

• Copies. The default is one copy, reflecting normal use. If you need
multiple copies, here’s where you do it.

• Pages. The default is all, but you can easily print just pages 5 and 6 (or
just page 5, by typing 5 in both the From and To boxes). Press Tab to
move from box to box, or just click in each box in turn.

• Paper Source. Depending on the chosen printer, you can select paper
cassette or manual feed here.

With your printer ready to go:

2. Click OK. WordPerfect tells you it’s printing and, after a moment, you
have hard copy in your hands.
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This is a good place to stop and enjoy how much you’ve
learned. In this age, it’s no longer true that hard copy is the
only end result – you could be sending text across the country
electronically just as well. But there’s something to having
produced words on paper, with the fonts and formatting you
chose, this soon after starting to learn WordPerfect. Congratu-
lations.

Both the Page Setup and Print dialogs have popup menus that
offer more settings. We’ll look at these later on.

Printing with fewer steps

We’ve just looked at the complete steps to previewing a document, going to
Page Setup, and then printing. There’s no need to do all three, especially if
you print a copy of your file, and then make a few changes. You might now
(after saving your file) just choose the Print command, or Print One
Copy from the File menu.

For much of your work, you won’t need to visit the Page Setup
dialog at all – the settings remain undisturbed until you change
them, and go back to the default settings (e. g. portrait orien-
tation) for all new documents. Or, you could change things in
Page Setup early on in writing your document, then preview
and print when finished.

Button Bar commands to print

The Print and Print Preview commands are also available on the Button
Bar, as are most of WordPerfect’s basic commands. We’ll look at the
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Button Bar closely later; for now, note the buttons shown in figure 2.21
towards the top of the Bar (show it if necessary with the second command
on the Layout Menu).

            

Print Preview
            

Print

Figure 2.21: Print commands on the Button Bar

Summary

This chapter has taught you a lot about formatting and working with a
document. Creative use of fonts and formatting makes a large part of the
difference between what you can do with computer word processing and
what was available before. As we go, you’ll learn more about how format-
ting affects the content it presents. By now, though, you can

• choose from a range of fonts, sizes and styles, and apply them to existing
text, or what you’re about to type

• change margins, tabs, alignment and indenting to fit your needs
• learn the meaning of WordPerfect’s icons using the Status Bar
• navigate around your document using the keyboard
• set up printing, and print a document

all of which puts you, only two chapters into this book, in a position to do
efficient and productive word processing. Please take the time to go over
any sections which aren’t yet clear, and don’t forget to use the Save com-
mand often. You’re well on your way.





Chapter 3

Intermediate Word Processing

In this chapter, you’ll learn how to:

• save a file with another name
• find and replace words and phrases, in the current and in other docu-

ments
• copy text and paste it within a document
• copy text from one document and paste it into another
• drag text from one part of a single document to another
• use the Scrapbook for text or graphics
• configure graphics so text wraps around them
• check spelling, and edit WP’s dictionaries
• configure auto-correcting features
• find synonyms and antonyms with the thesaurus
• set any action to repeat any number of times
• check grammar
• count words, lines, paragraphs and pages in a document and get average

word and sentence length

Making and saving changes to files

Back to your document: let’s say you’ve typed, formatted, and printed it,
and it looks pretty good. You know you’re going to want to revise it,
though, and you could certainly do that to the original file.

There are real advantages, though, to working with successive versions.
You may change your mind, for example, about some revisions you’ve
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made that included erasing some text. How do you get that text back? It’s
easiest if you leave version one as it was, and make revisions to a new
version.

Saving a file with a new name

1. With your file open, choose Save As from the File Menu, as in figure
3.1.

Figure 3.1: the Save As dialog

WordPerfect gives you a Save As dialog, just as it did the first time you
saved this document. The present title of your file is shown, selected,
where the first time there was blank space.
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If you simply clicked the Save button at this point, the new version of your
file would replace the older one (it would ask first). So we need to change
the name.

2. Type a new name for your file. This could, for example, be the same
name plus the number 1 after it. The new name automatically replaces
the old one in the text entry box, since the old one was selected.

3. Click Save.

You now have two versions of your document safe on disk. Should the first
version have some thoughts you took out of the second version, you can
retrieve those, since the Save As command doesn’t replace the original
version the same way the Save command does.

Find and Change

Another means towards productivity and efficiency is finding a word or
phrase you know is in your document somewhere. WordPerfect makes it
easy to search a file for a string – any sequence of characters, such as a
word, words or part of a word – and replace it with something else.

Click at the top of your document, to put the cursor there, and:

1. Choose Find/Change from the Edit menu. You’ll get figure 3.2,
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Figure 3.2: the Find/Change dialog

with the cursor in the Find box.

2. Type the word, words or part of a word that you’re looking for, and click
Find. WordPerfect goes to the first occurrence of the string and selects
it for you. If you want to work with this selection, close the Find/Re-
place dialog. If you’re looking for a subsequent occurrence, click Find
again, and WordPerfect finds the second location of the string.

If you’re not finding what you know is there somewhere, it’s because you
haven’t exactly matched it or part of it in your search request. You may
have two spaces between words, for instance, in either the request or the
text you’re looking for.

Change To is also most useful. If, for example, you had just written a
political tract full of invective and then switched affiliations, and so wanted
to replace all instances of the word “Democrats” with “Republicans”, you
would type the find string in the first box, and the replacement string in the
second. Click in the Change To box to put your cursor there, or the Tab
key moves you back and forth.

You could then click the Find button to view the first occurrence, and then
decide whether to change it, or the Change button, below the boxes, to
find and replace that first instance but go no further. Change, then Find
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changes the present occurrence and then selects the next. Or click Change
All, to do just that without stopping at each location of the target word.

An efficient use of this feature is to put some of the harder-to-
type terms or phrases in your writing in a shorthand. The
backslash key is rarely used on the Mac, so you could type
“a\” to stand for “antidisestablishmentarianism”, use that
ridiculous word 25 times in your document by typing its
shorthand, and use the Change command once when done.

As with many WordPerfect features, this dialog has its own menu, just
below the dialog’s title bar. We’ll get to the advanced features later, but
note for now the first menu, Direction. This offers you the options of
Forward, Backward or Within Selection. Should you want to search
backward, you can. If you shift-click to make a large selection, within
which is the string you know you’re looking for, you can do this too.
Otherwise, searching forward is the normal approach. Wrap Around, if
deselected, tells WordPerfect to search only from the present position of
the insertion point to the end of the file.

Find Bar

Many of the most-used find and change commands are available a little
faster, on one of the Control Bars. Click Find there to open the Find Bar.
To the right of the text entry area you see buttons for forward and back-
ward, a menu for search just to beginning or end of the document, or wrap
around, or search within selection. The next menu offers options of
Document Only (not footnotes, endnotes, full forms, headers, footers or
text boxes), and search for Whole Word.
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If you click the last button, Change, you’ll see another text entry box and to
its right buttons for change the current found text, change and then find
next or previous, and change all, next or previous.

The Find Bar was introduced in WP 3.5 or 3.5e, and has a few bugs.

More extensive search

Find/Change searches only the front document. To search for text within
all files in a folder:

1. Go to the File Menu and choose Open…. Navigate to the folder you want
to search in (your startup disk would work but the search would take
longer, and you’d probably end up with results you weren’t looking for)

2. Click the Search Menu in the Menu Bar in that dialog and choose All
Documents. You’ll see figure 3.3.

WordPerfect asks you for a word or search pattern and, after a moment,
gives you a list of documents in the current folder containing the text you
want.
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Figure 3.3: Text (contents) search in the Open dialog

Copy and Paste

You could find any text from the first version of your file, copy it, and
then paste it into the second version. It’s just as easy to copy any text from
any document and paste it into any other document.

Let’s say, for instance, that you have a file entitled “5 Steps to Successful
Computing”, and you’re working on a new document entitled “6 Steps to
Staying Sane”. One of the five steps to successful computing reads:

“Don’t worry too much if the computer doesn’t do everything right.
Remember Murphy’s Law and chaos theory, and consider that with
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something as complex as a computer, there are incredible numbers of
things that can go wrong. Look at all the cartoons you see, and save your
work often”.

You may decide that this step would profitably be included in the six steps
to retaining sanity. With both files open:

1. Look at the next-to-last menu on the left half of the menu bar, the
Window Menu. It has three commands, a divider, and a list, as in
figure 3.4.

Figure 3.4: the Window Menu

• Next Window cycles through open documents, bringing each one
to the front, and making it the active window in turn.

• Tile Windows resizes and places all open windows on your screen
so that you can see all documents at once.

• Cascade Windows makes all open windows full size, with a slight
overlap in placement.

• following the dotted line is a list of all open files. Choose any one to
bring it to the front and make it active.
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3. Choose Cascade Windows, and then choose “5 Steps to Successful
Computing”, or your equivalent document – the one with the text you
want to copy from.

4. With your mouse, drag through the text you want to copy, to select it.

5. From the Edit menu, just to the right of the File menu, choose the third
command, Copy.

WordPerfect makes a copy of this text, and puts it in a special part of the
Mac’s memory called the Clipboard.

6. From the Window menu, choose “6 Steps to Staying Sane”, or your
equivalent – the file you want to paste text into.

7. Click at the point in your document where you want this text to appear.

8. From the Edit menu, choose the fourth command, Paste.

Figure 3.5: Copy and Paste
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Bingo, and there it is. Save “6 Steps”, or your equivalent, at this point.

This is a wonderful feature, that makes your working environment much
easier and more flexible than you might have imagined.

For example, you can make up boilerplate forms and contracts for your
business, and then write clauses specific to one agreement. Copy from one
document to the other. The Mac also lets you copy graphics – any kind of
drawing or chart from another program – and paste it into a WordPerfect
file.

If you want, you can cut text from one document and paste it into another.
Simply use the Cut command on the Edit menu instead of the Copy com-
mand. Careful, though – you no longer have that text in your first file.

We more often use Cut and Paste when working within one
document – the third paragraph more logically follows the
seventh, for example. Just drag through the text you want to
move, choose the Cut command, click where you want the text
to go, and Paste.

Copying or cutting, and then pasting, works fine for any amount of text. If
there’s more than you can see on your screen at one time, click your mouse
at the beginning or end of the text you want to copy or cut, then scroll to
the other end of it, hold down the Shift key on your keyboard, and click
again. The Mac selects all the text inbetween. We call this technique Shift-
Clicking. 

Drag and Drop

While you’ve just learned the Macintosh’s standard way of moving text,
WordPerfect offers you an elegant shortcut.
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1. Drag through text to select it, or triple-click to select the entire para-
graph.

2. Click in the selected area again. Move this cursor towards the target
point in your file, and note that an insertion point is following your
movement. This is the place where WordPerfect will ‘drop’ the text you
selected. If you move above or below the text area on your screen,
WordPerfect scrolls more of your file into view.

3. Let go the mouse button when this insertion point is where you want it.
Presto. The text is moved to its new location. Here’s a good time to save
again. Or, if you didn’t drop the text in quite the right place, the Undo
command is handy. Don’t forget that Undo has to be the next action you
take – or, if you saved your file just before dropping text in the wrong
place, then just close the file without saving, and reopen it. Another
reason to save frequently.

Copy and Paste using the Scrapbook

When you copied or cut text, it went into the clipboard, a special part of the
Mac’s memory. That’s just fine for immediate pasting – before you turn
your Mac off and the contents of the clipboard and all RAM are lost. You
might, though, want to copy some text from your active file and save it
elsewhere where it will be available another day.

1. Drag through a paragraph of your active file, and choose Copy.

2. From the Apple Menu (at the far left of your menu bar), choose Scrap-
book. You’ll see figure 3.6.
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3. Choose Paste from the Edit menu, and your text is pasted into the
Scrapbook. You might not be able to see all of it, owing to the Scrap-
book’s small window, but it’s all there.

Figure 3.6: the Scrapbook

After you close the Scrapbook, this text is saved to disk, and will be avail-
able for future use. For now, though, note the horizontal scroll bar
beneath the content area. Click on the right arrow, and note that there
are various graphics in the scrapbook.

You can copy any of these, and paste them into your WordPerfect docu-
ment, just as you moved text the other way.

1. Find a graphic you like (ignore the sound for now) and choose Copy
from the Edit menu. There’s no need to select before copying when
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using the scrapbook: the entire contents of the window you see are
automatically selected.

2. Click the scrapbook’s Close Box, at the top left of its window, to close
that program and return to your WordPerfect file.

3. Click to place the insertion point where you’d like this graphic to appear,
perhaps at the left side of the text, and choose Paste from the Edit menu.
You’ll see figure 3.7.

Figure 3.7: a graphic pasted into a document
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The graphic is pasted into your active file at the insertion point. It appears
as though it were a single letter, with the original text above and below it.
This will change as soon as we work with the graphic.

4. Click once on the graphic. (Don’t double-click. If you do, you’ll see the
graphic in its own window. Close this window, using its Close Box, to get
back to where you were.) A box appears around the graphic, as in figure
3.8.

Figure 3.8: the graphic after you click on it

5. Drag the graphic anywhere on the page, and note how the text in your
document wraps around it, as in figure 3.9.
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Figure 3.9: the graphic with text wrapped around it

6. Click anywhere else in your document, and the box around the graphic
disappears, as in figure 3.10.
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Figure 3.10: the graphic as it will print

Here’s a good point to save again, and then experiment with the graphic on
different parts of the page. Note that the text will stay on the side of the
graphic where there’s more room.

You now know how to paste a graphic into your text file. As we go, you’ll
see how to change size, shape or other attributes of pasted graphics, and
even to create them within WordPerfect.

This is quite a start, though – seamless integration of text and
graphics was a large part of what put the Macintosh on the
map.
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7. Click and drag your graphic anywhere in your document. The box
around it appears when you move it, and disappears again when you
click elsewhere on screen.

8. Preview your document now: it’s especially useful to get a sense of the
whole page when you’re placing graphics.

Correcting and improving your writing

Now that your document is nicely formatted and includes a graphic, let’s
make sure its good effect isn’t spoiled by misspelled words. WordPerfect
has an extensive dictionary (for American, Australian, British or Canadian
English, or 17 other languages) to catch spelling errors.

You can also add words to your own User Dictionary, to
include names or technical terms you use often.

Using WordPerfect’s Speller

1. Click at the beginning of your file.

2. From the Tools menu, choose Speller…. You’ll see figure 3.11.

Note that it has its own menu, just below the title bar. You’ll see this a lot in
WordPerfect: menus within dialogs, specific to the occasion.
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Figure 3.11: WP’s Speller dialog

3. Click the first menu, Check, and make sure that the Document
command has a check mark next to it. Alternatively, you could spell-
check your file only from the insertion point to the end, or check only
text you’ve selected, just to save time with larger files. Here, though, we
want to check the entire document.

4. Click the Start button. WordPerfect compares each word in your file
with its dictionary, and flags, or stops at, any word it can’t find.

In our sample, “Eerie.txt”, the first word the Speller found was the last part
of the title, illustrating the disadvantage of using naming conventions that
aren’t plain English. Your author is too set in his ways, having learned them
when computers had hand cranks and required titles like this – although
name extensions are becoming common again.
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A classic Mac file name (including extension if any) can’t be
longer than 31 characters, nor can it contain a colon. Should
you type a colon in a title, the Mac replaces it with a hyphen.

5. Click Ignore. This means that the word will not be flagged again in a
spell check of this document. It’s added to the Document Dictionary
(specific to this document and saved within it). To skip a word but not
add it to the Document Dictionary, click Ignore Once.

The next error found in this file is the name of your humble author. So be
it. He is not well enough known to be part of WordPerfect’s dictionary, and
so must add his name to the User Dictionary, done by clicking the Add
button. The word will then not be flagged on future spelling checks of this
or other documents.

For most words it stops at, WordPerfect gives you a list of suggestions.
Should you see that the questioned word is in fact wrong, and the correct
spelling is suggested in the main box:

6. Click on it to select it, and then click the Replace button. The word is
corrected. You can also just double-click on the suggestion.

The Ignore Once button is provided in case you feel the word, perhaps a
specialized term, is correct in this context, but might be wrong elsewhere.
It’s then not added to the Document Dictionary.

The Look Up button lets you type in your guess for the correct spelling of
a word that WordPerfect flags as incorrect but has no suggestions for, and
then look up your guess. If you know the right spelling, type it in and click
Replace.

If you want to check the spelling of a single word, sentence or paragraph,
select it and call the speller. Note from the dialog’s Check menu that
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there’s a check mark to the left of the Selection option – WordPerfect
knows you just want to check this selection. Click Start, and only that
excerpt will be spell-checked. No suggestions means the selection is spelled
correctly.

For our work, we’ve expanded the Speller window to cover a quarter of our
screen, and put it at the bottom right, just to the right of the document
window. Whatever you like here is fine – WordPerfect remembers your
preference, and opens the Speller window that way next time.

This tool, although of great value for effective communication
of the written word, isn’t perfect. If you had typed “an”, mean-
ing “and”, the speller wouldn’t flag it. Nor would it know to
correct “their” when you meant “there” and many people these
days seem to type “you” when they meant “your”. So it’s not a
substitute for careful proofreading, but it’s certainly a start.

Editing dictionaries

When you spell-check a document, WordPerfect makes use of three
dictionaries: Main (ships with the program), User (originally empty, but
words are added every time you click the Add button in the Speller dialog),
and Document (originally empty, but words are added when you click
Ignore in the Speller dialog)  All are editable.

To edit the Document Dictionary, choose Speller… from the Tools menu
and, in the Speller dialog, click the first menu, Check. The last item on that
menu is Edit Document Dictionary, where you can add and delete
words.

To edit the User Dictionary, locate its file in WordPerfect’s Language
folder. This folder will be named Language and be in the same folder as the
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WordPerfect application unless you’ve changed that folder. If you can’t
otherwise find the folder, go to Edit > Preferences… > Folders and choose
Language Tools from the Type Menu. This will display the path to the
Language folder.

Don’t double-click the User Dictionary to open it – go through the Open
command on the File Menu. Each word will be on its own line, separated by
hard returns. Edit as you like, then Save As with the same name, e.g. User
Dictionary (USA), in User Dictionary format.

If you save your User Dictionary in the standard, document
format, it won’t work.

You’ll have to do this if your User Dictionary exceeds 32,767 characters,
about 6,000 words.

You can edit the main dictionary and thesaurus using the ST Utility
program that comes with WordPerfect and is found in the Language folder.
Open it, open your dictionary and type a word that’s in the dictionary to see
that word and its hyphenation points, as in figure 3.12.

Editing the main dictionary isn’t something people do very often. One
reason is to add entries from a full User Dictionary. In any case, it’s certain-
ly advisable to archive your original main dictionary before doing this.
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Figure 3.12: ST Utility’s window

QuickCorrect

There are any number of words we tend to mistype frequently. “Teh” for
“the” is one example. QuickCorrect lets you enter any word you tend to
misspell, and enter its correct replacement. Choose Tools > QuickCorrect…
to get figure 3.13.
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Figure 3.13: QuickCorrect’s list

Several pairs are already provided. Add as many as you like, up to the
32,767 character limit for this kind of file.

Click Options… to get QuickCorrect’s other features, as shown in figure
3.14.

Figure 3.14: QuickCorrect options



106 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

Many of these fix small errors and some also make text entry easier. Why
bother to capitalize the first letter of a sentence when WP will do it for you?
Auto Indent changes a Tab to an Indent at appropriate places, such as the
start of a paragraph. Numbered or bulleted lists are much easier to read if
text is indented rather than tabbed.

Smart Quotes (also called Curly Quotes, Printer’s Quotes, or
Typographical Quotes) add a professional appearance:

These are “Smart Quotes”

These are "Plain Quotes"

This is a valuable part of the distinction between typed and typeset. Smart
quotes look much more professional. Another step in the same direction is
using proportional fonts, where an m is wider than an i, and putting only
one space between sentences. We’ll discuss these more in the chapter on
page design.

Turning Smart Quotes on works for single quotation marks and apostro-
phes too. The only reason we can think of not to use this feature is if you
indicate a lot of measurement in feet and inches with single and double
quotes, and don’t feel comfortable with curly marks for them. However,
you can assign other keystrokes to those characters, in Edit > Preferences
> Keyboard > Characters.

WordPerfect does very well at getting the direction right for
smart quotes but infrequently puts one facing the wrong way.
No problem – just delete the quote and the character to its left,
and retype.

Press command-shift-apostrophe to toggle smart quotes on and off.
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QuickCorrect also offers the aesthetic advantage of a single space between
sentences, instead of the old typing rule of two spaces, necessary with the
monospaced font of a typewriter, but unnecessary with modern fonts and
distracting as well.

Thesaurus

Beyond spell-checking and formatting, effective written communication
depends in no small part on vocabulary. WordPerfect’s Thesaurus is a
valuable tool, all the more so because, in electronic form, it’s far easier to
use.

Your cloth- or paper-bound thesaurus may sit neglected for much of your
writing, just because it’s really a fair amount of trouble to look up syn-
onyms. An electronic thesaurus, though, is very fast, and its use can
certainly make a difference in the quality of written expression.

To find a synonym for a word, put your insertion point in that word – no
need to select it – and:

1. Choose Thesaurus from the Tools menu. You’ll see figure 3.15 where,
in our example, we’ve asked for synonyms for the word “say”. A list of
them is provided in the leftmost of the three columns in this window.

You see that some synonyms have bullets to their left. If you double-click
on any of these, another list appears in the center column, with these
synonyms of synonyms. If you double-click on your choice here, yet
another list appears in the column on the right. Further double-clicking on
any bulleted word in any column replaces the column on the right with a
new list.
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Figure 3.15: WP’s Thesaurus

As with the Speller, you can type in any word and click Look Up. The
History menu lets you recall any word you’ve looked up. The Thesaurus
window also stays in the position and size you put it, from one session of
WordPerfect to the next.

2. Click on a word and then on the Replace button to change what was in
your text.

WordPerfect’s Speller is a useful and easy tool, and we
recommend it before printing anything. It’s so fast and valu-
able; why not nourish the habit? But the Thesaurus is, in the
end, even more valuable: Shakespeare may not have used a
dictionary, but he knew how important a thesaurus, or at least
the idea of one, was. Vocabulary is intrinsic to quality in writing
– why not make use of this excellent feature?
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Repeating actions

Listing multiple occurrences of text or formatting becomes easier with
WordPerfect’s ability to repeat a any action as many times as you’d like.

1. Press Command-Escape or Command-Clear (on the keypad). The small
Repeat Count window appears, as in figure 3.16.

Figure 3.16: Repeat Count

Repeat Count defaults to eight. WordPerfect will repeat eight times what-
ever you tell it to do next: keystrokes or macros, for example.

2. To cancel a repeat before starting it, just close this window. To stop a
repeat after you’ve started it, press Command-Period or Escape.

3. To change the repeat count, press Command-Shift-Escape or Command-
Shift-Clear. You’ll see figure 3.17.

Figure 3.17: Set Repeat Count

where you can type in any number (OK, only up to 32,767), and WordPer-
fect will use that. OK the Set Repeat Count dialog, then press Command-
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Clear or Command-Escape to call up the Repeat Count window. It has to be
on screen when you choose the menu command or press the keystroke you
want WordPerfect to repeat.

Grammatik

Not only can WordPerfect check your spelling and offer synonyms, but has
an extensive grammar checker as well. Like the Speller, Grammatik will
check an entire document unless you select some text first. So, for this
exercise, open any document and don’t select text.

1. Choose Grammatik… from the Tools menu, or press Command-Y.
You’ll see figure 3.18.

Figure 3.18: the Grammatik dialog
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2. Press Start. WordPerfect looks through your text according to sets of
rules, or rule classes, it contains, and that you can change. Figure 3.19
shows an example of what it might find.

Figure 3.19: a question of grammar

and at this point, you can type in a replacement and click Replace, or
judge that your writing is all right as it stands, and click Next. 

3. Proceed through your document, and see what Grammatik thinks of
your prose.

If it finds a lot, don’t be offended. It doesn’t like ours much either – with
the default rules. You can click Skip Always to skip any one word or
phrase, or Ignore Class to bypass a particular category of objection.
Grammar checkers especially don’t like use of the passive voice, and will
flag each occurrence. It is in general better style to use the active voice, but
occasional use of the passive is fine.
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A grammar checker is thus not the same as a spell checker.
Consider what Grammatik tells you to be suggestions for you
to judge.

You can click Add to add a word flagged as misspelled to Grammatik’s user
dictionary – but be cautioned that this user dictionary is not the same as
the user dictionary accessed by the regular Speller.

Since the Grammatik dialog is non-modal – you can click in another
window to bring it to the front, unlike the modal Print dialog, for example –
you can go back to your document at any point to make changes. Then
bring Grammatik to the front again, either by choosing it from the Window
menu, or choosing the command from the Tools menu. Another option is
to size your document and place it and the Grammatik window so that both
are visible at once.

Grammatik beeps when you’ve reached the end of your document. If
you’ve turned a rule class off by clicking Ignore Class, a dialog asks you
if you want to save this custom writing style, as in figure 3.20.

Figure 3.20: Save a custom writing style?

Click no for now. What’s a custom writing style?

Grammatik understands that different writing styles serve different
purposes, and organizes its rule classes accordingly. You can pick and
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choose among rule classes, to set up a custom style. Let’s look at rule
classes, and the writing styles made from them.

Writing styles

1. In the Grammatik dialog, pull down the Customize menu, as in figure
3.21.

Figure 3.21: the Customize menu

and choose Custom 1. In the resulting dialog, leave Name as is, set
Pattern After to General, and click Edit. You’ll see figure 3.22.
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Figure 3.22: the Edit Writing Style dialog

where a number of thresholds are displayed. The defaults are fairly stan-
dard principles of style. Numbers less than 10 are commonly spelled out,
for example, and all numbers are spelled out if they start a sentence.
Opinions differ: the New Yorker magazine, bless it, spells out all numbers.
Split infinitives used to be a no-no, but are common today. Should we
change “We want you to really understand WordPerfect” so that “really”
doesn’t come in the middle of the infinitive “to understand”?

With all this in mind, let’s click on the Rules… button in the Edit Writing
Style dialog. You’ll see figure 3.23.
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Figure 3.23: Edit Rule Settings

where you can deselect any rules that you don’t want in this custom writing
style. A description of each rule is available in WordPerfect’s on-line help,
explored in Chapter 6, and also from the Help menu in the Grammatik
dialog itself. Custom writing styles become especially useful since you can
turn off rule classes that you don’t want Grammatik to check, but have it
flag areas of concern you’d like to have pointed out to you.

This will speed up Grammatik quite a bit. For example, the “Commonly
Confused” rule class flags each occurrence of “principal” and “principle”. If
you don’t need this error-checking, turn it off.
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So we look upon Grammatik more as a learning tool than as an on-going
writing aid. It can be highly valuable for those with less writing experience.
It can certainly help everyone polish her writing and, using the different
styles, get a feel for what the media and the trade consider acceptable in,
for example, fiction or technical writing.

Word Count

This feature isn’t in the Grammatik dialog, but on the Tools menu. Click
Word Count… and, after a moment, a display appears like figure 3.24.

Figure 3.24: Word Count and other document information
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Form and substance

Grammar is fascinating. The governments of France and Germany have
commissions to protect the purity of their languages, including grammar.
The Duden, the six-volume official guide to the German language, will tell
you whether a particular grammatical construction is ‘right’. English has no
such police force and speakers of English may, we opine carefully, be the
better for it. Grammar and other components of language are living things,
and regional variations are a richness quickly disappearing in the age of
television, where children learn the language primarily from TV’s ‘stan-
dard’ usage.

An educated, perhaps an older, Southern person, for example, may say “He
might could have done it yesterday”. What? You can’t say “might could”,
since these are two modal verbs. “might have been able”, right?

Who’s to say? Immigrants to the American South came largely from
England and Scotland, while the rest of the United States was populated
mostly by immigrants who learned English as a second language as adults,
losing the continuity of a vocal tradition. Yet use of two modal verbs is not
standard in Great Britain.

Linguists fascinate us with the finding that, in ‘primitive’ societies, the
dialects of peoples living on two adjacent hills will resemble each other
more than they will the dialect of the people living in the valley between
them. The valley, as a travel and trade route, is susceptible to influence
from afar. In sum, the grammar book is more a history book than a rule
book.

Its great value is in the service of clarity. Strunk and White, at their best,
say “Clarity, clarity, clarity . . . although there is no substitute for merit in
writing, clarity comes closest to being one. Even to a writer who is being
intentionally obscure or wild of tongue we can say ‘Be obscure clearly!’”
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(The Elements of Style. New York: Macmillan, 1959, p 65.) Grammatik can
help here.

Beyond grammar and style, Strunk and White (p. 17) recall George Orwell’s
illustration of the value of the vivid and particular compared to the vague
and general. On the left is what Orwell made of Ecclesiastes:

Objective consideration of contem-
porary phenomena compels the
conclusion that success or failure in
competitive activities exhibits no
tendency to be commensurate with
innate capacity, but that a consider-
able element of the unpredictable
must inevitably be taken into
account.

I returned, and saw under the sun,
that the race is not to the swift, nor
the battle to the strong, neither yet
riches to men of understanding, nor
yet favor to men of skill; but time
and chance happeneth to them all.

which is to say that particularity, imagery and metaphor add a lot to
powerful writing. There’s no checker for these yet.

Looking further . . .

We showed you the Scrapbook as a place to store text since it comes with
the Mac. A better way to store (and faster way to retrieve) plain text, with a
menu of any number of passages of text you’ve named, and automatic date
and time codes, is the text glossary John’s WordPerfect UltraClip.

Also, Find and Change is substantially enhanced with John’s WordPerfect
Find Manager, containing these commands:

• QuickFind – a smaller faster Find dialog that shows find direction in its
title and doesn’t stay on screen.
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• Find in All Open – search for text in all open documents. Includes Find
Next in All Open and Find Previous in All Open.

• Find Recent – a menu of the five most recent strings you’ve found, plus
the Clipboard and any text you enter manually. Go back to any one
easily. Includes Find Recent in All Open.

• Find All – looks for every instance of text in a file. Makes a new docu-
ment with the paragraphs containing that text.

• Find Near – find any text that’s in the same paragraph as some other
text.

• Find, Find Next and Find Previous, macros which match the program
commands of the same name but also support the Recent list, as do all
commands in this set.

Search for file or folder names as string, Boolean and/or, files by creating
program, size, date and other criteria with QuickFind, which we’ll cover in
Chapter 18.

Finally, the monumental power of Unix-level find/change is offered by
John’s WordPerfect Regular Expression Search. This will be discussed in
Chapter 18.

QuickCorrect is easier to use with John’s WordPerfect QuickCorrect, which
lets you create entries more quickly, and turn the feature on and off
equally quickly. Another macro switches the last two letters you type, for a
fast solution to common mistyping.

All of these are free at WPMac.

Summary

This concludes our tour of the basic features of WordPerfect. Our inten-
tion was to guide you through the elementary parts of the program to show
you how straightforward and uncomplicated (with a little practice) this
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working environment can be, and how useful this level of program opera-
tion is.

There’s incredible power, elegance and versatility in WordPerfect we
haven’t looked at yet. But to enter text, format it, print, move text, import
graphics, and check spelling and word usage – what perhaps 75% of users
do with the program – you’re up and running.

So, at this point, you can rate yourself a competent user of WordPerfect
and the Macintosh. You’ve learned how to:

• save successive versions of files with new names
• use the cut, copy and paste commands to move text from one document

to another, or within one document
• move among open windows, and reposition them
• drag and drop text from one location to another
• copy and paste to and from the Scrapbook
• paste a graphic into your word processing document
• check spelling, and use WordPerfect’s Thesaurus
• edit WP’s main, user and document dictionaries
• find any word, part of a word, or string of words anywhere in your

document, and change it to anything else
• set any action to repeat any number of times
• check the grammar of your writing, with easily and extensively

customizable sets of rules, and custom writing styles

This is a lot. Congratulations again. But, since there’s so much more, please
stay with us.



Chapter 4

Basic Graphics

In this chapter, you’ll learn how to:

• create a variety of graphic elements: shapes and text
• size, shape, place and delete elements
• add and change pen and fill patterns
• view graphics at any size
• integrate graphics in your text document

In the last chapter, you learned how to import a graphic into WordPerfect
from the Scrapbook, and place it wherever on the page you wanted it.
While that’s a big plus in adding information and presentability to your text
documents, it’s only a hint of the power and flexibility that WordPerfect’s
graphics module offers you. Let’s look at how to create a graphic from
scratch, with a great variety of tools and options. Then we’ll bring it into a
text document and work with it further.

When you finish this chapter, you’ll have available to you most of the
features in any dedicated desktop publishing program, and with even more
graphics flexibility. You might find that WordPerfect has all you need for
sophisticated publishing and presentation.

Creating a graphic

1. Start a new document. You have, as before, a blank screen with the
Button Bar to the left. The first button on the bar is the tool that we
want. Move your mouse over it, and note that the Status Bar at the
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bottom of your screen tells you that this tool opens the Graphic
Editor.

2. Click that. You can also go to the Tools menu and choose Graphic, and
from the submenu choose New.

WordPerfect goes into its graphics mode. Several of the buttons on the
Button Bar, and several menus change at this point, to reflect the new
environment you’ve entered.

Your screen has also changed, and now sports a field of small dots. This
feature, called a grid, will help you later with placing and sizing graphics.

Most importantly, a new palette of tools has appeared on screen, at the top
left. You’ll use these tools, shown in figure 4.1, to create graphic shapes
(let’s call them elements), and work with them.

The tool at the top left, the Arrow tool, is what you use to work with
graphics once you’ve drawn them. The Rotation tool, at the top right, can
be used to rotate any existing graphic. The rest of the tools in the first set
are what you’ll create elements with.

You see that the Arrow tool appears indented, indicating that it’s currently
the active tool.

If you have a black-and-white monitor or have set your moni-
tor to display black and white, the active tool’s icon appears
with a gray background rather than indented.
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Arrow

            

Rectangle

            

Rotation

            

Oval

Figure 4.1: WordPerfect’s Graphic Tool Palette

3. Click the Oval tool, the third one down on the right. It becomes the
active tool.

4. Click your mouse, whose cursor has changed to a crosshair, anywhere
in the drawing area, and hold the button down.

If you don’t hold the mouse button down, you’ll see a dot or
small shape where you clicked, and the Arrow has again
become the active tool. Click the Oval tool again to make it
active.

5. Holding the mouse button down, drag a couple of inches down and to the
right. Let go of the mouse button. You should see something like figure
4.2.
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Figure 4.2: an oval drawn in the Graphic Editor

Here’s a good place to save your document for the first time.

When you finished drawing the oval, the Arrow again became the active
tool. Let’s choose another tool, this time the Rectangle tool, the third
down on the left.

6. Click the Rectangle tool, move your mouse to a blank place anywhere in
the drawing area, and click and drag down and to the right as before.
You should now have two elements in your drawing, as in figure 4.3, and
the Arrow is once more the active tool.

When you finished drawing the oval, you might have noticed four heavy
black dots surrounding it at the top left, bottom left, top right and bottom
right, as shown in figure 4.2. Now, just after finishing drawing the rectan-
gle, those four dots surround this latest element, and have disappeared
from the oval.
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Figure 4.3: an oval and a rectangle in the drawing window

7. Click once on the oval, and you’ll see that these dots disappear from the
rectangle, and reappear around the oval, as in figure 4.4.

These dots indicate that an element is selected, just as text can be selected.
Text is shown as selected by changing its color from dark on light to light
on dark. Graphic elements, though, are shown as selected by these four
dots, which we’ll call handles. 
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Figure 4.4: the oval and rectangle, with handles around the oval

8. Click on the rectangle again, and see that you’ve selected it.

As with text, if we want to change a graphic element in some way, we select
it first, and then make the change we want. With the rectangle selected:

9. Click and hold, and drag the rectangle somewhere else on screen. A
dotted line representing this element moves along with your cursor and,
when you let up on the mouse, the rectangle has moved according to
your mouse drag.

Here’s a good place to save again. Remember to save a lot.

You can easily move either the oval or rectangle so that one overlaps the
other. As you do this, you’ll see that the rectangle stays on top of the oval,
as in figure 4.5. This is because you drew the rectangle more recently.
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Figure 4.5: the rectangle overlapping the oval

The two elements are in separate layers in the drawing, with the rectangle
in the front layer. This flexibility is a great help in constructing complex
drawings.

Working with graphics

WordPerfect provides easy yet elegant tools for handling any number of
graphics, in any number of layers.

Layers

The second set of icons on the Button Bar, shown in figure 4.6, is meant
just for this.
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Figure 4.6: the second set of icons on the Graphic
Editor Button Bar

1. Move your mouse along these buttons, and note their descriptions in the
Status Bar at the bottom of your screen. Make sure the rectangle is still
selected (click on it to select it otherwise), and then:

2. Click on the second button, described by the Status Bar as one that
“Moves selected objects to the back layer”. You should see figure 4.7,
with the oval now in front.

Figure 4.7: The oval is now in the front layer, with the rectangle
still selected

Although the oval is now in the front layer, the rectangle is still selected.
You could now select the oval, by clicking it, and then reselect the rectan-
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gle once more. Clicking an object selects it, but does not change the layer
it’s in.

Changing fill patterns

So far we’ve created graphics, and moved them in the drawing window and
among layers. Interesting, but they’re just plain shapes with no patterns to
them. Let’s change that.

1. Select the oval.

In the Tool Palette, the second set of icons shows an icon at the top right of
a paint bucket pouring paint. Below this is an icon that, right now, is just a
white square.

2. Click and hold on this white square, and you’ll see a sub-palette of fill
patterns appear to the right, as in figure 4.8.

3. Holding the mouse button down, move around this sub-palette. Word-
Perfect magnifies each fill pattern as you move over it. When you find
one you like, let go of the mouse, and the selected element – the oval – is
now filled with that pattern.

4. Select the rectangle, and choose another fill pattern for it.
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Figure 4.8: Fill Patterns

You can change fill pattern of any object at any time. Some
experimentation with different patterns is often a good idea. In
general, a distinct but not jarring contrast between adjoining
elements works best. If you have a color or gray-scale moni-
tor, distinguishing elements by color or shade tends to look
more sophisticated than using different patterns. But patterns
are useful tools.

If you don’t have a color or gray-scale monitor, skip the next section and
go on to the following one, “Modifying graphic objects”.

Choosing colors

WordPerfect offers you astounding flexibility in use of color in graphics.
You can choose from up to 16.7 million colors, depending on your system.
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Your computer may have fewer colors available, but WordPerfect gives
you, in any case, the maximum your Macintosh can provide.

Just beneath the Fill Pattern tool is the Fill Color tool, as shown in figure
4.9. It shows one square overlapping another: these are the Foreground
Square and the Background Square. 

            

Foreground square

            

Background square

Figure 4.9: The Fill Color tool

The patterns you chose for the oval and the rectangle have foregrounds –
the design of the pattern itself, perhaps a series of dots or lines – and
backgrounds, the rest of the fill. Clicking each square in this tool gives you
another sub-palette of colors or shades of gray available to you. Again,
make sure you have an object selected before you choose an action to take
with it.

1. Click the Foreground Square of the Fill Color tool. As with patterns, a
sub-palette appears to the right. This should look like figure 4.10.
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Figure 4.10: Fill Colors

2. Choose a color for the foreground of the pattern of the selected object.

3. In like manner, choose a color for the background.

4. Save your work again.

You can do graphics work on a black-and-white Mac, and
specify colors that will appear when you move the file to a
color machine. Working in black and white, clicking either color
square gives you a list of names of colors, which you can use
to specify the color you want for the selected item.
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Modifying graphic objects

So far, you’ve learned how to create elements and move them around on
screen, and change the layers they’re in. You can also now change fill
patterns and, with a color Macintosh, change colors. The objects you’ve
drawn, though – an oval and a rectangle – are the same shapes as you drew
them.

Changing shapes

WordPerfect gives you unlimited flexibility, though, over the size and final
shape you want these objects to have. Is the rectangle too big, or too close
to a square? Is the oval not elongated enough? No problem.

1. Click on either element, to select it. You’ll see handles appear around the
object.

Earlier, you clicked somewhere within the shape to drag it around the
screen. This time:

2. Click on a single handle, and drag it in any direction.

The shape changes to reflect your motion. You can make the oval or
rectangle as elongated, or as large, as you wish. Figure 4.11 shows some of
the range available.
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Figure 4.11: Reshaped graphic elements

If you make one element so large that it covers up another element entire-
ly, no problem. Just use the buttons on the Button Bar, or equivalent
commands on the Arrange menu, to move either element to the front or
the back layer.

If you clicked and dragged on, say, the lower right-hand handle, and
dragged it up and to the left past the position of the upper left-hand handle,
you would flip the graphic. Elegant and flexible.

Some practice at this point in moving, resizing and reshaping
graphics is useful. It’s also fun. Save frequently, though.

Here’s an advanced tip (your first one – hey). Say you want to resize an
element, but want it to stay the same proportionally. The rectangle, for
example, has just the right degree of elongation but it’s a little too large.

Press the Shift key on the keyboard before you click on a corner handle,
and continue pressing Shift while dragging the handle. You can make the
object larger or smaller, but its shape will stay the same.
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If you want to draw a perfect circle using the Oval tool, or a perfect square
using the Rectangle tool, select the tool from the tool palette, and hold
down the Shift key before you start to draw.

If you want to draw more than one element of each shape at a
time, double-click on that shape in the Tool Palette. The tool
will then stay selected after you finish drawing each object. In
black-and-white mode, the background for that tool on the
palette will also show as black instead of gray.

If you at this point have too many objects in your drawing window, you can
always delete one by clicking it to select it, and then pressing Delete
(Backspace on some keyboards) to remove the selection. Just like in text
mode. You can also click on the top of the Tool Palette, where a gray area
looks somewhat like a title bar, and drag the Palette around your screen, to
keep it out of the way of your work.

Text in graphics mode

It’s easy to include text in your graphic. The Text tool, denoted by the
letter “A” just below the Arrow, lets you enter text as a graphic element.
This means that although you can always edit it later, and all the fonts you
have are available here, WordPerfect doesn’t recognize it as text as far as
spell-checking goes, or counting the words and paragraphs in your docu-
ment.

1. Click the Text tool, and then click anywhere on screen, perhaps at the
bottom and left of center, and drag three inches to the right, and about
half an inch down. A rectangle appears, with an insertion point within it.

2. Type some text, say, “Monday Morning at the Computer”.
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As in text mode, you can select these words by dragging through them, and
then applying font, style, and size choices as you wish.

If you clicked elsewhere after typing, the Arrow is again the active tool.
Reselect the Text tool again, and click within the text you typed. You’ll get
the insertion point back.

You can also double-click the text block with the Arrow tool to
regain the insertion point. Single-clicking the text block with the
Arrow tool will select the text block as a graphic element, so
you could then resize or move it.

3. Change the font and size as you like. If you choose a large size, Word-
Perfect may not be able to show all your text in the box you drew for it.
It’s easy, though, to change the size or shape of the box just as though it
were another kind of element, using the Arrow tool to drag a handle to
enlarge the text block.

Once you’ve formatted this text as you want it:

4. Click the Arrow tool to make it active, and then click your text block
again. Handles appear around it, as around any graphic object.

5. Drag the lower left-hand handle, to make the text block much narrower
and taller than it was before, and let go the mouse button. As you see in
figure 4.12, the text wraps to fit the size and shape of the box you define.

            

Monday morning at the
computer

            

Monday
morning
at the
computer

Figure 4.12: a reshaped text block
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Since this text block is a graphic object like any other, you can set a fill
color (or even a fill pattern) for it. Often, some text as a title with a light
shade of gray as a background looks quite elegant. Try this, but keep in
mind that discretion is important when decorating text. We’ll have more on
this later in the book, in the advanced topics.

The Pen Color Tool

As you’ve worked with graphic objects, each one has had a geometric shape
and, if you wanted it, a fill pattern and color.

The text block you’ve just entered shows, though, that each element has a
boundary shape around it, whether apparent or not. There’s a rectangle
around the text block, just as though it were a graphic shape.

You might not want that box around your text. It could look OK some-
times, funny at others. This is an illustration of the Pen Color tool, just to
the left of the Fill Color tool on the Tool Palette, shown in figure 4.13. Like
the Fill Color tool, the Pen Color tool has a Foreground Square and a
Background Square.

With a text block selected:

1. Click on the Foreground Square, and choose white. The box around the
text disappears.

The pen used to draw the graphic – text box just like oval – now has white
ink in it, so we can’t see it against the white background.
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Background square

Figure 4.13: The Pen Color tool

Any fill you placed in the oval or text box remains, though,
independent of the pen color used for the boundaries of the
element.

You can also turn the pen off, while keeping the fill. We’ll look at that in a
minute.

A Pen Color tool separate from the Fill Color lets you frame one color with
another. This is more apparent, and more useful, with a larger pen size.
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Setting Pen Size

At the bottom of the Tool Palette, just above the box saying “100%”, is a
box with a small dot in the center. This is the Pen Size (both width and
height).

1. Click on this icon, and you’ll see figure 4.14.

Figure 4.14: Setting Pen size

where each small square represents a pen size.

2. Choose the largest pen size. The box where you first clicked now shows
the size you chose, and the numbers to the left of the box show its
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dimensions, in pixels (the word comes from “picture element”), which
is the smallest unit of measure on a Macintosh screen, about 1/72 inch
on a side.

3. Pick a shape from the Tool Palette, and draw another object. The
outline of this element is much thicker.

As with fill, you can modify pen size for anything you’ve already drawn.
Select the object first, and then choose the modification you wish. With a
color monitor, you can also change the Pen Color to anything available in
your system.

You can also change the Pen Pattern just as you changed the Fill Pattern.

Changing Pen Pattern

The Pen Pattern tool, shown in figure 4.15, is just to the left of the Fill
Pattern tool. You can choose a new pattern before drawing a shape, or se-
lect a shape you’ve already drawn, and choose a new pattern.

Changing the pen pattern is of much use only if the pen size is large enough.
Here, as in so many places in the Graphic Editor, practice is the way to
learn.
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Figure 4.15: the Pen Pattern tool

Or, should we say that play, not practice, is the way to learn.
Current educational theory largely equates play and learning
many skills. So, if your significant other or supervisor has
questions at this point about what you’re doing with WordPer-
fect, you really are learning, intensively, just by drawing
shapes and changing sizes, patterns and fills.

Turning pens and fills on and off

So far, we’ve learned how to change pen and fill patterns, but both pen and
fill themselves have always been operative. You can, though, turn either
feature off By turning the fill off, you get a transparent shape, which we
sometimes want. By turning the pen off, the entire shape is then the pattern
and color of the fill, without a contrasting boundary.
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The Pen tool and Fill tool are just above the Pen Pattern and Fill Pattern
tools on the Palette. The Pen tool shows a pen drawing a line, and the Fill
tool shows a bucket pouring paint, as in figure 4.16.

Figure 4.16: the Pen and Fill tools

1. Click on the Pen tool, and see how the line drawn by the pen disappears
as the pen moves to the left and off the sheet of paper in the icon.

2. Click on the Fill tool, and see how the bucket rotates to an upright
position, and stops pouring. Also, turning either tool off turns the other
back on. This is because, with both pen and fill off, there would be no
object!

If you’ve made a transparent object (pen but no fill), you can’t
select it by clicking inside of the shape – you’re clicking on air,
so to speak. Put your cursor exactly on the line demarcating
the element, and click.
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Rotating graphics

You can rotate any selected graphic, including text, to any angle, using the
Rotation tool, at the top right of the Tool Palette. With an object select-
ed,

1. Click the Rotation tool. Your cursor changes to a diagonal crosshair. 

2. Click any handle and drag. A dotted representation of your object
follows the rotation you specify, moving around the axis of the opposite
handle.

In the next chapter, we’ll look at how to rotate an object by
exact number of degrees.

Viewing graphics at any size

Up to now, you’ve worked with everything at 100% size. It’s often valuable,
though, to look at your drawing at a larger or smaller size, either to work
with greater precision, or to see all or a larger part of your drawing at once.

1. Click the bottom icon on the Tool Palette, and see a pop-up menu drop,
with several choices. Full Page fits the drawing window to the size of
your screen, not unlike the Print Preview feature in text mode. Other
lets you set any size, from 25 to 800% – a measure of flexibility you
won’t find in many dedicated drawing programs.

2. Choose Other, and type in, for example, 150%.
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Remember that any size view in the WordPerfect Graphic Editor is an
editable view. All the tools work the same way. Also, you’re not changing
the size of your drawing itself, only your view of it.

Some other tools

Although we’re going to look at these in depth in the next chapter, you can
at this point try the Arc tool, the Rounded Rectangle tool, and the Polygon
tool. The Polygon tool works differently from the others: instead of
clicking and dragging, you click where you want the first line of the shape
to start, then click again where you want it to end and the second line to
start, and so on for as many sides as you wish for the object. When you
have all the lines you want, double-click at your beginning point to com-
plete the element.

If you want to draw freehand, press the Command key while using the
Polygon tool. Freehand lines will at this point be jumpy, since they’re set to
snap to grid, represented by the plane of dots throughout the drawing area.
We’ll learn how to turn the Grid Snap off, and Hide Grid, in the next
chapter.

The last tool on the Palette, the Curve tool, is conceptually more difficult
but very powerful. We’ll learn that in the next chapter as well.

Well, at this point you’ve made a good start towards competent illustration.
We’ll look at the rest of the drawing tools, and some more sophisticated
commands, in the next chapter. First let’s put your masterpiece back into a
word processing environment, and see how to work with it there.

In preparation for this exercise, move or delete elements in the graphics
window so that your overall drawing takes up about the top left quarter of
your screen.
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Moving back into word processing

Remember that when we began this chapter, you started a new document,
and then went into WordPerfect’s Graphic Editor. You didn’t open the
graphics module as a separate document, but went to it from an open word
processing file. So, now that we’re finished with graphics for the moment,
we can go back a step, to the word processing module.

1. Click the top button on the Button Bar, which now looks like the tip of a
fountain pen. You’re returned to a word processing window, and your
graphic work is displayed in this window, as in figure 4.17.

Figure 4.17: Back in the word processing environment

There’s a large insertion point blinking just to the right of your graphic.
The graphic is now considered just another letter in the text, and you can
type text right next to it.
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2. Type a few lines of text here, and see how the text relates to your
drawing.

Just as in the last chapter, when you copied an existing graphic from the
Scrapbook and pasted it into your word processing document, the graphic
takes up an entire line to itself – and maybe a tall line, depending on the size
of the graphic.

3. Click once (don’t double-click, or you’ll go back into the Graphic
Editor), on your drawing, and you’ll see a box around it.

4. Drag the graphic, in its box, just a small amount, and then click any-
where in your text. You’ll see your typing wrap around the graphic, as in
figure 4.18.

Figure 4.18: Text wrapped around the graphic

This is starting to look nice, but we might like a frame around the graphic.
Save again first, though.
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Graphic frames

1. Bring your mouse up to the Tools menu, and choose Graphic. From the
sub-menu that appears, choose Frame…, as in figure 4.19.

Figure 4.19: Tools > Graphic > Frame

You’ll see the Frame dialog, as in figure 4.20.
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Figure 4.20: the Graphic Frame dialog

with the various options all set to go. You might prefer a border type
other than the default single line, though, and there are 36 to choose from.

2. Click the Type pop-up menu, as in figure 4.21, and choose a look you
like. 
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Figure 4.21: Choose a frame type

OK this dialog, and then:

3. Click anywhere in your document outside of the graphic. You should
have something like figure 4.22, and your work is starting to look spiffy.
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Figure 4.22: a framed graphic in a word processing window

Now that your drawing has a border, you might want to reposition it a little,
so that it fits the text: so that there isn’t a single line of typing above it, for
example. We’ll look at the fine points of page design later in this book.

As you remember from the last chapter, you can drag the
drawing anywhere on screen, and text will rewrap around it. If
you drag the graphic to the top or bottom edge of your screen,
WordPerfect will scroll your document. You can’t, though, drag
a drawing from one page to another, but you can cut and
paste across pages.

Sizing and shaping

Although the best place to shape and size your drawing is in the Graphic
Editor, there are times when its effect on your page can best be judged and
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modified while in word processing mode. As usual, WordPerfect’s capabili-
ty here is flexible and powerful. Save again, and then:

1. Click once on your graphic, and notice the box reappear around it. You
first saw this box when, after returning to the word processing window,
you dragged the graphic a little so that text would wrap around it.

There are small black squares on the right and bottom sides and lower right
corner. These are handles, and work much like handles do in the drawing
environment. Their presence now indicates that the graphic is selected.

2. Move your mouse over the corner handle. Your cursor, an I-beam over
text, will change to an arrow when it’s over a handle. Drag to make the
graphic larger or smaller. If you don’t like the effect, choose Undo from
the Edit menu.

Undo has to be the next action you take, to fix the change you
made to the drawing. But, since you saved before starting to
resize and reshape your drawing, if you now have something
you don’t like and can’t undo it, just close the document
without saving, and then reopen it.

If you didn’t like the effect because your drag made the drawing flatter or
skinnier, you have the same option as in the Graphic Editor: pressing the
Shift key before and during your click and drag. Any change you make will
then be proportional.

The handles on the right and bottom sides will of course make the graphic
skinnier or flatter. But, if you use the Shift key with these handles, they
then work the same way that the corner handle does.
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Cropping, and moving the frame but not the
drawing

Dragging these handles changes the frame and the drawing within it to the
same degree. You might want, though, to make the frame smaller but keep
the illustration the same size. Less of the drawing would then be visible, a
useful effect called cropping. Restore your graphic to about its original
size, and:

1. Press the Command key, and then click and drag the corner handle
inward. This time, you’re dragging the frame but not the drawing itself.
When you release the mouse, you see only part of the drawing, but still
at original size. Only the frame, and the corresponding text wrap,
changes.

Using this feature, you could easily display only part of a graphic you
pasted in from the Scrapbook, for example.

When we speak here of the frame, we’re referring to the area
on the page holding the graphic, whether a border has been
applied or not. Without a border, the invisible frame would
behave the same way.

Although you’ve cropped your graphic to the size frame you want, you may
have the wrong part of the graphic visible. No problem. Here’s WordPer-
fect’s next “wow” feature:

2. Press the Command key, and click in the middle of your illustration.
Drag this hand, and the graphic moves within the frame. Elegant!

Practice some here, dragging the graphic and its selection handles, with and
without the Command key. Using the Command and Shift keys together
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when dragging a handle changes the size of the frame while maintaining its
proportions, and not affecting the drawing within.

For greater precision, or to see more of your page at a time, you can change
the viewing size just as in the Graphic Editor. The menu for this is on the
Layout Bar, as in figure 4.23:

Figure 4.23: the View Size menu on the Layout Bar

As you can realize, this environment offers you a great deal of power in the
eloquent and effective expressions of your thoughts on paper. There are so
many advanced tools and commands in WordPerfect’s Graphic Editor that
they need a separate chapter, coming up next.

If you’re more interested in furthering your word processing ability, you
can skip Chapter 5 and come back to it later. We recommend exploring
advanced graphics at some point. You may well find that you’ll never need
a separate graphics program. As well, WordPerfect’s extensive graphics
tools may reveal to you an artistic ability you never knew you had.



154 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

Summary

In this chapter, you’ve learned to:

• open WordPerfect’s Graphic Editor, and create drawings
• work in different layers
• change fill patterns, and foreground and background fill colors
• resize and reshape graphic elements
• make and work with text in graphics mode
• work with pen patterns and colors, and pen size
• turn pen and fill on or off
• view graphics at any size
• bring drawings into the word processing environment, and create a

border
• reshape and crop illustrations
• explore WordPerfect’s almost unlimited flexibility in integrating

graphics and text

all of which is worth knowing in word processing. Even if you’re not
artistically inclined, your documents may benefit from diagrams, flow
charts, any visual aids to information and understanding.



Chapter 5

Advanced Graphics

In this chapter, you’ll learn how to:

• make and modify complex graphics designs
• work with Grid, Alignment, Lock, Replicate and Group commands
• draw freehand
• draw and edit Bézier curves
• create advanced effects with text
• make custom patterns
• place graphics as separate objects in your file, or as overlays or water-

marks
• change WordPerfect’s drawing defaults, to customize the program for

the way you want to work
• enter PostScript code directly into a graphic
• import and work with EPS (Encapsulated PostScript)
• and, we’ll discuss types and formats of computer graphics, to give you

the expertise you need to import graphics of various types into Word-
Perfect, and export drawings into other environments

Complex tools

In the last four chapters, you’ve learned the essentials of word processing
and graphics, but you’ve barely touched what WordPerfect has to offer. In
this chapter we’ll look at just how much you can do in the Graphics Editor.

Let’s look first at what we’ll call the complex tools in the draw palette. The
simple tools, covered in the last chapter, let you draw shapes such as ovals
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and rectangles (or, with the shift key, circles and squares). Once you’ve
drawn such a shape, you can modify it in many ways – stretch it, make it
larger or smaller, or rotate it – all ways which are extrinsic to the shape.
The rectangle, for example, will continue to have four sides and sharp
corners, whatever you do to it.

The complex tools, by contrast, make shapes with intrinsic attributes you
can change. Let’s look once again at WordPerfect’s Tool Palette, shown in
figure 5.1. All the tools are identified here, and the top bar, shaded gray,
lets you drag the whole palette anywhere on screen, to keep it out of the
way of your work.

            

Pen Color

            

Pen Pattern

            

Pen

            

Polygon/Freehand

            

Arc/Chord

            

Rectangle

            

Text

            

Selection

            

 View Size

            

Pen Size

            

Fill Color
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Curve
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Rounded Rectangle

            

Line

            

Rotate

Figure 5.1: WordPerfect’s Graphics Editor tool palette
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Rounded Rectangles

Let’s start with the Rounded Rectangle Tool:

1. Click this tool, and draw a sample shape in the drawing area. Leaving the
object selected:

2. From the Layout menu, choose Rounded Corners. You’ll see
figure 5.2.

Figure 5.2: Rounded Corners dialog

The default radius of .25 inch is shown.

3. Change this number to 1 inch, by choosing that option from the pop-up
menu marked with a triangle, and click OK

Your rounded rectangle is now more aerodynamic.

As with any other tool, if you have an applicable shape selected and then
choose the menu command, your specification will apply to what you’ve
selected. if you don’t have a shape selected, the measurement you enter in
the dialog box will apply to all subsequent shapes you draw, until you
change it.
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This works just like fonts in word processing. Select and then
apply, to change anything already done, without affecting
future actions. Choose the command without anything select-
ed, to affect future actions.

If you want a radius that the pop-up menu doesn’t offer, you can type a
number in the box. The suggested number – .25 inch unless you’ve
changed it – is selected when the dialog box opens, so any number you type
will replace the original number automatically.

If you want a measurement other than inches, WordPerfect gives you a
good range of options, but the choice is unfortunately not immediately
apparent.

4. Click on the abbreviation for inch in the dialog box – “in” – and another
menu appears, as in figure 5.3. This shows the units of measurement
WordPerfect offers you.

Figure 5.3: Units of measurement
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WordPerfect defaults to inches as a unit of measurement, although we’ll see
later how to change this – and other defaults – to anything you want, and
have your choice apply to the word processing ruler and everywhere else.

The other units of measurement are: centimeters (2.54 per inch); points
(a printer’s measure, with 72 per inch. Type sizes are commonly expressed
in points); picas (another printer’s measure: six picas are an inch, and 12
points are a pica); ciceros or didots (European units of measure: there are
5.63 ciceros to an inch; 67.5 didots to an inch; 12 didots per cicero); and
Em widths, again a printing unit, with eight to an inch.

The Arc/Chord tool

1. Click this tool, and draw a shape.

2. From the Layout menu, choose Arc Types…. You’ll see the dialog box
shown in figure 5.4. WordPerfect defaults to a wedge, although we’ll
see later how to change any defaults in the Graphics Editor. Click on the
arc type you want, say a chord, and OK it.

When you have a series of choices like this, there’s no need to
locate your mouse precisely enough to click on the small radio
button to the left of the choice. That takes too much time.
Just click on the choice itself: on the words “Wedge” or
“Closed Chord”, for example, and that choice’s radio button
will darken. All of WordPerfect’s radio buttons and check
boxes work this way.

With the default white fill, it’s hard to see the straight line connecting the
chord or, with a wedge, the two straight lines forming the interior of the
curve. Changing the fill fixes that, as shown in figure 5.5.
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Figure 5.4: the Arc Type dialog

Figure 5.5: a wedge and a chord, filled

With a closed wedge or closed chord, the straight lines completing the
shape are the same pen pattern and fill as the curved line.

The Polygon tool

We briefly mentioned this wonderful tool in the last chapter. Let’s explore
it more now.
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1. Choose the Polygon tool, but don’t click and drag, as you’ve done with
all other shapes. Instead:

2. Click anywhere to start the shape, release the mouse button, and move
your cursor somewhere else in the drawing area. You’ll see that a line
from the origin point follows your mouse.

3. Click where you want the second point of your polygon to be, and again
release the mouse button. Move somewhere else on screen, and see how
a second line follows your movement.

4. Make as many sides to your polygon as you want. When done:

5. Bring your cursor over your origin point (it doesn’t have to be exactly
over it, but pretty close), and double-click. Presto.

6. Play with pen width and pattern, fill pattern, and pen and fill colors for
your polygon.

7. Choose the text tool, and give your creation a name. Select the text, and
give it a title. You might end up with something like figure 5.6, which
we’ve named “Dancer”:
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Figure 5.6: a polygon with pen and fill colors

Make about 20 of these, sign them and frame them on your walls, wear all
black clothes and a beret, and listen to jazz late at night. Your friends will
treat you with more respect.

If they don’t, you can modify the shape of a polygon, since it’s a complex
tool.
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You can create an open polygon shape as easily as a closed
one. Make any number of lines, and double-click when you’re
finished drawing the last line.

Modifying a polygon

Take any polygon you’ve drawn. If, after making it and doing something
else, you come back and click on it once, you will select it, as shown on the
left in figure 5.7. It will have four handles around the overall area of the
shape, and you can then move or rotate it, or change fill or color.

If, though, you double-click on it, the shape will then appear as shown on
the right in figure 5.7. The fill reverts to white, and a selection point
appears at every point in the shape, instead of around the shape:

Figure 5.7: a polygon, left, after clicking, and right, after double-clicking

The shape at the right shows a polygon ready for editing.
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1. Double-click on your polygon.

2. Click on any point in it, and drag that in any direction. You’ll see how the
two lines that meet at that point move in the direction you specify.
There’s not much limit to what you can do with this shape.

The other use of this tool lets you draw freehand; see below.

The Layout Menu

When you first opened WordPerfect’s Graphics Editor, you noticed that
the drawing area was full of evenly-spaced points and, as you’ve worked,
you’ve seen that the ends of the lines you draw, or the boundary handles of
other shapes, appear on those points, even though you might not have
started or ended a line on a point.

These points represent WordPerfect’s grid, a feature helpful to structured
drawing, but less useful for freehand or more artistic effort. You can
change the display of the grid, or hide it altogether. You can also turn off
the Snap to Grid feature, or change the spacing of the grid.

Using the Grid

1. From the Layout menu, choose Grid Snap Off. Try drawing a couple
of lines now. You’ll see you have greater accuracy in placement but, of
course, more difficulty getting e. g. three lines to meet at one point.

2. Look at the Layout menu again: the command has toggled to read Grid
Snap On. Although menus that toggle like this are elegant, compared to
having two separate, unchanging commands in the menu, they can be
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confusing. People pull down the menu, see “Grid Snap On”, and think
that it is on. Instead, like any menu command, that’s what you select to
turn it on: action not status.

3. Leave the grid snap as you like it, and choose the second command on
the Layout menu: Hide Grid. The points disappear. If you have Grid
Snap turned on, that feature functions as usual. Otherwise, the only
reason for a visible grid is for visual alignment, and as a ready reminder
that you’re in the Graphics Editor. Choose this command again, which
now reads Show Grid, and:

4. Choose the third command on the menu: Grid Options. Click on the
third pop-up menu: Grid Lines. You’ll see figure 5.8:

Figure 5.8: The Grid Options dialog with line options displayed

You can choose a heavier grid indication if you want, although the default
seems fine for most purposes.
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5. Go back to Grid Options, and note that the default size for the grid is 9
points. A point, remember, is 1/72 of an inch. The type you’re reading
here is 14 points. The default is fine for most uses, but click on the pop-
up with the triangle to see what choices this menu has. You can of course
type another figure in the size box.

6. Click on the abbreviation pts and, as in many other dialog boxes,
WordPerfect gives you a wide choice of units of measurement.

It may be worth a mental note to yourself that the choice of
these units in a dialog box isn’t immediately apparent. Some-
one who learned WordPerfect without documentation might
never know this selection was to be found throughout the
program. This is one reason to refer to this book or the
manual as you go but that, in turn, is no reason not to go off
and play with WordPerfect – that, a different style and pace of
learning, is valuable too.

Let’s go back to the Layout Menu.

Other Layout commands

The Pen Size command is just like the icon near the bottom of the draw
palette. The graphics tool on the palette, though, always works in points,
and gives you a range of 1 to 8. This menu command works in whatever
unit of measurement you want, and gives you a range of 0 to 72 points.

A size of 0, printed to a PostScript printer, doesn’t make an
invisible line; instead, it’s the thinnest line the printer can draw.
On a 300 dots-per-inch LaserWriter, the line is 1/300 of an
inch wide.
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Again, if an object (or more than one) in your drawing area is selected when
you change pen size, that attribute of your selection changes; shapes you
create in the future are not affected. If nothing in the drawing window is
selected when you choose a pen size, your choice will be the size for all new
objects, until you change it again.

We’ve looked at the Rounded Corners and Arc Types commands above.
Smooth is an elegant way to draw rounded and irregular shapes. To try
this, draw a polygon, perhaps a pentagon, in the approximate shape and
size you want your finished, rounded shape to have. Then choose the
Smooth command, and see if you have what you wanted – subject to
resizing or dragging a handle or two.

If not, choose this command (which now reads Unsmooth) again, double-
click on the polygon to edit its individual points, and reshape it to a closer
approximation of the finished object.

The PostScript command is powerful, but assumes your knowledge of the
PostScript computer language, a means of page description developed by
Adobe Systems. Ninety-nine percent of personal computer users will
neither want nor need to learn this language. Some conceptual knowledge
of PostScript is helpful, though, and if you want to explore further, please
look at “A Postscript on PostScript” at the end of this chapter.

The Get Attributes command is a real convenience. If you have any
shape, with any pen size, fill color, pattern and all, and you want to draw
something else with those same attributes:

1. Select an object with the attributes you want to copy, and choose Get
Attributes. Nothing will seem to happen. But the next shape you draw
– and all other shapes within this drawing window – will have these same
attributes.
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This is an elegant tool. Don’t bother to try to guess which
patterns and fills you used for an object you created in this
drawing last week and which you want to complement now;
copy its attributes this way. You could also keep a scrapbook
of sorts: one way to do this is to copy any shapes with attrib-
utes you like, and paste them into the Mac’s Scrapbook,
located on the Apple menu. Another way is to paste objects
into another WordPerfect “scrap” document, and open that file
as necessary to copy attributes (or entire objects, for that
matter) into your working document.

The Arrange Menu

Rotate

As a menu command, Rotate does just what the palette tool does, but
allows you much greater flexibility. As figure 5.9 shows, you can choose
the center of your object or the middle of any side as the axis of rotation,
and you can specify the amount of rotation with high precision by typing an
angle, or choose a standard figure with the pop-up.

If you rotated an object 18.25 degrees this way, then decided
you wanted it rotated 20 degrees from its original position, you
would rotate it 1.75 degrees further by specifying that amount
on your second call of the rotation command. Some drawing
programs remember the original position, and apply any
rotation command to that original. WordPerfect adds each
measure of rotation to what you’ve previously done.
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Figure 5.9: the Rotate dialog

As with many features, the button bar offers you some quick
clicks, for standard needs. Click buttons to rotate selected
objects 90 degrees clockwise or counterclockwise, flip objects
horizontally or vertically, align them, and move their layers to
front or back. The status bar at the bottom of your screen
describes the buttons’ functions.

Size

The Size command lets you set, as a percentage, the vertical and horizontal
resizing you want for a selected object, as shown in figure 5.10.
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Figure 5.10: The Size dialog

should you need greater precision than that afforded by simply dragging
any handle of a shape. It’s nice, though, to have the choice of the precision
of a menu command, and the spontaneity and immediate visual feedback of
a mouse drag, that WordPerfect offers in this and the Rotate feature.

Replicate

The next command on the Arrange menu, Replicate, lets you make as
many copies as you’d like of a selected object (or more), and do amazing
things to the copies, all automatically. Choose this command from the
Arrange menu, and let’s look at its dialog box, shown in figure 5.11.
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Figure 5.11: the Replicate dialog

which asks you for the number of replications, and for other specifications
to apply to the last replication of the series. What this means is that if you
want 10 replications of a box you drew, and tell WordPerfect that the final
offset is 2 inches both horizontally and vertically, the tenth box will be two
inches below and two inches to the right of the original, with the other nine
spaced evenly between, as shown in figure 5.12.



172 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

Figure 5.12: Ten replications of a box, with a final offset of
two inches horizontally and vertically

The Replicate command offers a great deal of flexibility. We took figure
5.6 and replicated it ten times, with changes in angle and in final colors, to
get figure 5.13, and you can put 20 of these on your walls, and trade in the
jazz for the Kronos Quartet. Your friends will give you some respect.

If you want only one copy of a shape, with an automatic offset
slightly down and to the right of the original, use Duplicate on
the Edit menu.
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Figure 5.13: A fancier set of replications

Except that you now have several shapes overlapping each other, which
you will want to treat as one shape, for repositioning, resizing or rotating.
If you want to move all 60 at once, you could do so carefully, taking the
arrow tool and drawing a marquee – a dotted rectangle that appears when
you position the arrow over a blank part of the drawing area, click and drag
– around the whole 60 objects, to select all of them, and then dragging
them where you want. But there's a much simpler and safer way.
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Group

Let’s move down the Arrange menu a bit, to the Group command. This will
simply combine any number of shapes into one – and a grouped shape can
later be separated into its original components.

1. Select all the replications you made by drawing a marquee around them.
If you mistakenly start to drag one of the replications, stop and choose
Undo to put it back where it was.

If the set of replications are all you presently have in the
drawing window, you can choose Select All from the Edit
menu.

With everything selected that you want to group:

2. Choose Group from the Arrange menu. You'll see that all the selection
handles – the four dots around each shape – disappear, to be replaced
by one set of handles. What used to be any number of shapes is now one,
for whatever purpose: rotate, fill, size, or anything you can do to any
other shape.

In figure 5.14, we selected the two ovals in the drawing, by clicking on one
and then shift-clicking on the other, and then chose the Group command.
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Figure 5.14: Only the ovals were selected, not the rectangle

The result is a grouped object of the two ovals, with handles around its
boundary. As you see in figure 5.15, the rectangle might look like it’s part
of the group, as it lies within the handles.
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Figure 5.15: the ovals have been grouped

We then dragged the grouped ovals down and to the left, away from the
other figures. The rectangle did not move, as you see in figure 5.16.

Figure 5.16: the grouped ovals have been dragged

3. Should you want, you can Ungroup these elements at any later time.
Note that whatever attributes you applied to the grouped shapes will be
kept by the individual ungrouped objects.

This is a nice way to apply some attributes to a number of
elements. They do not have to be contiguous, only selected.
Also, grouping, modifying, then ungrouping is especially useful
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in conjunction with sizing. If you group first, then size, all
elements will retain their relative proportions better than
individual resizing.

Lock

This command, and its companion Unlock, are useful additions to the
security and elegance of your work environment. You may have put a lot of
effort into one shape, have it positioned just as you want it, and it’s close to
several other shapes you want to continue working with.

You can select this one shape (or more, by grouping or by shift-clicking, or
drawing a marquee around what you want to select), and lock it. You can
then not move, modify or delete it (although you can still duplicate or
replicate it, or copy it in order to paste it into the scrapbook or another
file).

Align

Now that you can use the Group and Lock commands to modify objects
more efficiently and protect them from inadvertent modification, let’s look
at some powerful features to control shapes you’ve drawn, also found on
the Arrange menu.

Align will take all selected objects and align them either to each other or to
the grid. Figure 5.17 shows this dialog.
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Figure 5.17: the Align dialog

where you first see, at the top, the options of aligning objects to each other
or to the grid. In figure 5.17, Objects is selected (its radio button is dark-
ened), so all selected objects will align to each other, according to the
constraints you set below.

Both the Horizontal and Vertical columns of alignment options start
with None. In the Horizontal column, you may choose Left or Right, and
that side of each object will align with that side of all other selected objects.
If you choose Center, the selected objects will align along their horizontal
centers, even though the objects themselves have no visual indication of
their center points.

Similarly, the Vertical column of options allows a range of options. You can
of course align along two axes at once. Figure 5.18 shows two objects
aligned (A) right; (B) top; (C) top and right; and (D) vertical and horizontal
centers.
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Figure 5.18: Different alignments

You can also align objects by selecting them and clicking an
icon on the Graphic Button Bar.

If you want to keep object X in place, and align object Y to it,
lock X first, and then align.

Position

Although WordPerfect’s Graphic Editor doesn’t have rulers, it has the
equivalent on the Status Bar, along the bottom of your screen. In Chapter
6 we’ll learn how to activate it if necessary (but it’s in Edit > Preferences >
Show Bars), and how to activate the Position element on the Bar (from the
menu at the left end of the Status Bar). Raw position, and change in position
(delta) since you first clicked the mouse, are given to an accuracy of a
thousandth of an inch.
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Flip

WordPerfect lets you flip any selected object or objects, horizontally or
vertically, around the center axis of each selected object. You can choose
this command from the Arrange menu or from the button bar.

Here’s a good use of the Group command you learned a little while ago. If
you select three objects and flip them horizontally, each element flips
independently, while maintaining its spatial relationship with the others, as
in figure 5.19.

Figure 5.19: Three objects selected and flipped

While if you group the selection first, and then flip, you’ll get figure 5.20.
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Figure 5.20: Three objects selected, grouped and flipped

In similar fashion, grouping before aligning produces different results than
aligning ungrouped shapes. There’s a great deal of power to be found by
combining commands, and you’ll gain facility fast through practice or,
better expressed, play.

Move

You’ve already learned about layers, and how to move objects to the front
or the back layer. WordPerfect actually offers you a nearly unlimited
number of layers, and you can move any object forward or backward
within the stack. Access these commands either from the Arrange menu or
the Button Bar.

When moving objects from one layer to another, the Group command is
again useful. So is the Lock command: keep one object where it is, and
manipulate the rest.
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This covers the Arrange menu (and corresponding Button Bar icons), a
powerful and comprehensive set of tools. Now let’s look at the last two, and
the two most flexible, drawing tools in WordPerfect’s Graphics Editor.

Freehand drawing

Although WordPerfect’s draw mode is designed primarily for structured
illustration, you can draw freehand to your heart’s content. The freehand
tool is part of the polygon tool, accessed by pressing and holding the
command key while you draw. By selectively pressing and releasing the
command key, you can use both freehand and straight lines within the
creation of one shape.

1. Turn Grid Snap off for this exercise.

2. Double-click on the polygon tool. This will keep that tool selected until
you click another one.

3. Begin drawing a polygon as usual: click at an origin point, release the
mouse button, and move your mouse in the direction you want the first
line to take. That line follows your mouse movement.

4. Click your mouse to end the first line. Release the mouse button, and
move your mouse a little in another direction, to start another line.
Then:

5. Press and hold the command key.

6. Press and hold the mouse button, and continue moving the mouse.

You’ll see a freehand line follow your mouse movement. Whenever you
release the command key, the tool reverts to polygon. First press the
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command key, then your mouse, and hold these down as you draw, to add
freehand to the existing shape. Double-click when you’re finished drawing
the element.

This will take a little practice, but you can achieve great flexibility in
combining polygon and freehand to draw just the shape you want. But you
can increase that flexibility a great deal more! Here’s how:

7. Click the arrow tool, to select it.

Remember that with a regular polygon you had drawn, you would single-
click on it with the arrow to move, size, rotate and so on. But you can
double-click on a line of it to return to editing mode, to move individual
points within the shape.

Here, you have a shape that’s part polygon, part freehand. Same difference.
Double-click on a line, and see how WordPerfect adds editing points to
describe the freehand lines you drew.

Each point can be dragged, to change the shape as you wish. In a typical
freehand effort, there will be numerous points closely spaced. Working in
higher magnification is helpful here: choose whatever you want, from the
bottom of the tool palette.

Lotsa practice is also helpful here. We can teach you how to
use each tool, but we can’t teach you to become good at it.
You may feel at this point that you’re working with a powerful
graphics program that you’ll never be good with. But you may
well surprise yourself, if you make and play with lots of
shapes. Rembrandt didn’t do it in a day either, and he didn’t
have the intuitive, flexible and wonderful tools at hand that you
do.
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Bézier curves with the Curve Tool

Here’s the most powerful tool in WordPerfect’s Graphics Editor or, really,
in computer graphics period. High-end drawing programs like Adobe
Illustrator make extensive use of this tool, and you can too. The concept is
that a curve, as formulated by the mathematician Bézier, carries with it
control points that determine the shape of the curve. As drawn on a sheet
of paper, a curve is a curve is a curve. You can resize it or rotate it, but not
change its inherent shape. If you manipulate its control points, though, you
can make any change in it that you want to.

Figure 5.21 illustrates a curve and its control points and, for this example,
we’ve drawn lines from the control points to the places on the curve they
extend from, which we’ll call anchor points. 

Figure 5.21: a Bézier curve, showing control and anchor points

You change the shape of the curve by dragging one of the control points. In
this illustration, we dragged the right control point to the left, skewing the
curve, as you see in figure 5.22:
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Figure 5.22: dragging a control point changes the shape of the curve

In this way, you can draw a curve without elaborate concern for its accura-
cy and, once the curve is on screen, drag control points to move the curve
into exactly the shape you want it to be. Let’s try this:

1. Choose the Curve Tool from the tool palette.

2. Click where you want the origin point to be. Release the mouse button.

3. Move your mouse about two inches to the right.

4. Click and hold, and move your mouse upward about an inch. You’ll see
the curve start to form.

5. Click and hold again, and move an inch to the left. A second curve has
begun.

As you draw each curve, you’ll see control points (without the lines, which
we added for clarity of illustration, connecting them to anchor points)
move with the expanding curve.
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6. Click and hold again, and move your mouse to your origin point. Dou-
ble-click here, and you should have a complete shape as shown in figure
5.23.

Figure 5.23: A shape drawn with Bézier curves

If you begin a new curve segment by moving the mouse
without clicking (as though drawing a polygon), then click and
drag, the segment looks different. Ditto if you begin the
segment by dragging, then release the mouse button but
continue to move the mouse. The keyword here is experiment.

All this would be fine if what you drew were the exact shape you wanted,
but it rarely is, especially when starting out. The beauty of this tool is the
editing capability it gives you, through the control points contained in each
curve of the shape.

Let there be no doubt, this seems complex and hard at first. Practice is
necessary, but don’t overlook the concept: you can make any curve any
shape with this tool. Much of the current illustration you see in national
publications and on the web was done using this kind of tool. A little play
goes a long way towards demystifying it, and making it easy and powerful.

As you saw, there are two control points for each curve segment. Dragging
each point in turn produces different results. Dragging the anchor point
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changes the shape in another way. You’ll see that you can make literally
any change you want in the shape you drew a moment before. Consider the
possibilities, and don’t be concerned that it seems difficult right now. Draw
and play with at least a dozen shapes like this, and then tell us it’s too hard.
Bet you won’t.

For the moment, though, let’s stop all this intense learning of new drawing
tools (you’ve already learned them all, anyway), and put together what
you’ve learned, into an original masterpiece.

Working with multiple tools

For this exercise, start with the shape you drew in figure 5.23. Turn Grid
Snap off, turn Show Grid off, turn the lights off, we’re going to get creative.

1. Near the top left of the window, draw an oval, a little bit flatter than a
circle.

2. Somewhere to the right of it, draw a five-sided polygon to resemble a
star. Location and size don’t matter at the moment, since half the point
of this is to draw shapes as though throwing tomatoes at a wall. We’ll
reshape and resize the tomatoes in a moment.

3. Move, resize and modify these three shapes until they’re about like
figure 5.32. Note that the star is in front of the oval. This is as it should
be, since you drew the star after the oval. Otherwise, the layer buttons
will fix it.

The teardrop at the bottom will be our organism, and it needs an eye and
mouth, as you see in figure 5.24.
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4. Use the oval tool for the eye, and the arc tool for the mouth. You can
rotate the arc for just the right expression. Then select both the eye and
mouth, and set Pen Size to two pixels.

5. With the rectangle tool, draw a box that surrounds all the shapes. It will
cover up everything else. Keeping the box selected:

6. Set the background fill pattern of this box to all black. It still covers up
everything else.

7. Choose Move to Back from the Arrange menu.

Presto. All other shapes, with their default white fills, are now in front of
the black box, and you should have something quite like figure 5.24:
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Figure 5.24: Organism, Moon and Star

and you can frame that on your wall, and play Hindemith on your iPad.
Your friends will have you arrested, but so what, you’re an expert in
WordPerfect graphics.
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Advanced effects with text

As you’ve seen in Section One, WordPerfect offers you lots of flexibility
with text – fonts, sizes, and styles – but all the letters on your page stay in
the same shape as the font designer drew them. In graphics mode, though,
you can do quite a bit more. Let’s play with some text.

1. Choose the text tool, and draw a rectangle about one inch high and four
inches wide. You’ll see an insertion point at the top left of this box.

2. Type your name in this box. Drag the insertion point back through your
name to select it, or choose Select All from the Edit menu.

3. Choose a font you like, and 48 point size.

4. Click the arrow tool, and select the text block.

5. Turn the pen tool off. Most text looks better without a box around it.

6. Rotate the text box about 30 degrees.

7. With the box still selected, choose Group from the Arrange menu.

8. Drag on the lower right handle, to produce something like figure 5.25:

Figure 5.25: Skewed text



Chapter 5: Advanced Graphics 191
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

If you had not rotated before you grouped, your drag on a handle after
grouping would condense or expand the text. Used with discretion, this can
look very nice.

Text, like anything else in the graphics window, can be any color. The pen
and fill color tools we’ve looked at will set the color of the text’s border and
background. Color of text itself is done in the Style menu’s Text Color
dialog, as shown in figure 5.26.

Figure 5.26: the Text Color dialog

9. Select text, click a color you like and click OK. Color or gray-scale text
can look quite elegant. So can light text on a dark background, but this
should be used with care, since it is harder to read.
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Watermarks and Overlays

So far, we’ve worked with graphics that will, when you return to your text
document, appear in their own place on the page. The drawing may be to
the right or left of its accompanying text, but the two remain separate.

WordPerfect gives you more possibilities than that, though. You can elect
to have a graphic appear over text, called an overlay, or under text, called
a watermark. These two features use the same drawing tools and environ-
ment as the Graphic Editor, but produce graphics at these different layers.
With some practice, these features can help you make a really outstanding
page.

Note that watermarks don’t show on the screen until you choose Print
Preview from the File menu. They print as shown there.

Note also that Print Overlay Layer can be disabled in the Print dialog.

Customizing the Graphics Editor

As you worked with patterns, you had available to you the 64 default
choices WordPerfect comes with. You can change any and all of these,
though, just as you can change almost anything else in this program to fit
your liking. We’ll study customization thoroughly later on, but here’s a
look at what you can do with pattern editing.

Editing patterns

1. In the drawing window, choose Patterns from the Edit menu.
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2. From the box on the left, click the pattern you want to edit. A magnifica-
tion of it appears in the box in the center, greatly magnified. Each square
represents an enlarged pixel, (1/72 inch actual size) that can be turned
on (white) or off (black). As you remember, Pen Size is also measured in
pixels.

The editable pattern appears in black and white in the middle; the repeated
pattern surrounds it in gray, to show you how your editing will look. You
can move a gray area into the editable area by clicking the directional
arrows (just like scroll arrows in a standard window). You can thus edit
larger patterns.

3. Click on a black square to make it white, and vice versa. The surround-
ing gray area shows your choices at this same level of magnification, and
the smaller box at the bottom left shows your edited pattern at actual
size.

4. Among the buttons, Invert changes black and white assignments of all
pixels. Clear turns all pixels to white, for a fresh start, and Undo takes
you back a step – but only one step. So judge each change right after you
make it, so you can backtrack if necessary.

5. Click OK when done.

Once you edit a pattern and click OK, the original pattern is
gone, for the open drawing window. All new drawing windows
will have the default patterns, though.

You can edit several patterns in one drawing window, and save that docu-
ment, perhaps calling it “Pattern Scratch”. Open it, draw a shape and set a
custom pattern, and then cut that shape and paste it into the drawing
window you’re working in. The custom pattern goes along with the pasted
object.
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The Color Editor, also on the Edit menu, offers similar versatility. Note
that in many dialogs in WP, you can double-click on an editable color to get
the color wheel, with millions of RGB colors.

This is a great way to (a) burn several hours, or (b) personalize your work.
We occasionally publish sheet music, and decorate the covers with patterns
of musical symbols.

Save Settings

Many of the tools you’ve worked with – patterns, fills, pen size – appear as
they do because they’re the default settings that fit a wide range of illustra-
tion needs. If you find you’re often changing pen or fill patterns, for
example, you can set these as you wish, and then choose Save Settings
from the Edit menu. Whatever was in effect when you chose this command
will be the default for all new graphics windows.

The settings you can save are those for:

• pen and fill patterns and colors, and pen size
• all grid options
• arc types, and rounded corner radius
• text font, size, style, alignment and color
• location of the tool palette

Before you save settings, be sure you have no objects select-
ed. Doing so saves the settings, e. g. fill pattern, for that
object, not what you previously chose from the palette.
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Postscript on PostScript

The PostScript computer language can describe any object on a page,
and print that object to a PostScript laser printer.

It’s one of the easiest computer languages to learn, but it’s still a language,
and not many computer users know it. Actually, there’s no reason for any
user to learn it, or even many graphics professionals. Drawing programs
like WordPerfect’s Graphics Editor have so many features that writing
graphics descriptions in PostScript doesn’t offer as much advantage as it
used to.

Should you decide to learn PostScript, though, you will then be able to
access a flexibility and power in graphics that we users can only dream
about. You might want to look at the PostScript Language Tutorial and
Cookbook, and PostScript Language Reference Manual, both published by
Addison-Wesley.

To add commands in this language to your drawing, choose PostScript
from the Layout menu. Enter text in this mini-word-processing window,
and click OK. The following example:

gsave
initclip
/Helvetica-Bold findfont 128 scalefont setfont
144 72 moveto
.5 setlinewidth
60 rotate
(Confidential) true charpath
gsave .99 setgray fill grestore
stroke grestore
showpage
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will produce a large (128 point) “Confidential” in outline, placed diagonally
on the page, which will print as though it were a watermark, behind other
text or graphics.

Go to Print Preview to see it, since WP will not interpret the commands so
that the object you described appears in the drawing window. Instead, a
box will appear with the letters PS inside it, showing the location on the
page where the PostScript element will print. Double-clicking this box
opens the PostScript text editing window. Choosing the PostScript com-
mand again opens a second text window.

Notes . . .

WordPerfect’s Graphics Editor will import most common graphics formats,
including JPEG, TIFF, PICT and GIF.

Should you want to bring into WordPerfect a file created in another
graphics program, save it in one of these formats first. If you have a
document created by Canvas, say, or Illustrator, and saved to disk as that
program normally does it, WordPerfect won’t be able to read it. These and
just about all graphics programs, though, can save files in the most com-
mon formats.

While the Graphics Editor doesn’t have rulers, it offers equivalent informa-
tion with the horizontal and vertical Position indicators in the Status
Bar, which we’ll cover in Chapter 6.

WordPerfect exports its graphics in the PICT format, should you want to
move your drawing into another graphics program, or into a page design
program such as InDesign or Quark Xpress. WordPerfect’s own page layout
capacity is so good though, and its graphics tools so exceptional, that it
may well serve your page design needs very well.
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Summary

You’ve covered an extraordinary amount of material in this chapter and,
with practice, will be able to produce exceptionally competent graphics.
With the tools you’ve learned, you can:

• draw and modify complex graphics elements
• choose from an extensive list of units of measurement
• change the drawing grid’s appearance and behavior
• copy attributes from one shape to all new shapes
• rotate, size, replicate and group elements
• lock, align, flip and move objects
• draw and edit freehand and Bézier shapes
• create advanced effects with text
• add watermarks and overlays
• customize patterns, and save defaults
• use the PostScript language in WordPerfect
• work with different graphics file formats

which is a great deal, and represents mastery of WordPerfect’s drawing
module. We’re going back to word processing in the next chapter, with
many features to learn, but your accomplishment so far demonstrates that
learning the rest of this powerful program won’t be any trouble for you.





Chapter 6

Tools for the Environment

In this chapter you’ll learn how to:

• access WordPerfect’s on-line Help
• work with automatic backups, for greater safety of data
• password-protect documents
• configure the Button and Status Bars to best suit your needs
• practice precise file managment
• develop sophisticated use of tools to find text and formatting codes
• understand fractional character widths in type placement

Interactive, context-sensitive Help

WordPerfect gives you four kinds.

WordPerfect’s main Help feature

1. Click the Help Menu and you’ll see figure 6.1.
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Figure 6.1: WP’s Help menu

2. Let’s look at the fourth item, WordPerfect Help…. This gives you
figure 6.2.

Figure 6.2: WordPerfect’s main Help dialog
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with a list of all Help topics.

3. Click How Do I to get information on performing tasks. You’ll see
figure 6.3.

Figure 6.3: How Do I – Help by Task

4. Click the book icon to the left of the word Print. You’ll see three topics.
Click the link Print. You’ll see figure 6.4.
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Figure 6.4: How to print

where, in addition to the text, there’s an icon for a laserwriter, as you
remember from learning Print Preview. Underneath this icon, there’s a
dotted green line indicating a pop-up. Click that for a short description.

As you scroll within the Help window, you’ll see words that are similarly
underlined with green dots); the next one is Copies. Click this, and another
pop-up appears with clarification.

5. There are buttons along the top of the window. The first two are Con-
tents, to take you back to the first screen, and Previous, to take you
to the last screen you were on.
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6. Click Contents to go back to the opening Help window, and then
Glossary. You’ll get an alphabetical listing of every term you need to
help you learn and use WordPerfect.

7. Go to the last Contents entry, Using Help. Here’s an explanation of the
Help environment. Scroll until you see the Steps category, and the
fourth item, “Click a light bulb to display a hint”, followed by a light bulb
icon. Click this.

8. In like manner, explore the explanations given in the rest of this section.
It’s quite a valuable tool.

The ability to go from one point in the Help feature to another
based on following an idea is called hypertext, much like on
the web. As you explore a topic, you can jump from point to
point in the same way your interests and attention move.
Conversely, in the program manual or even in our book, you
have to proceed according to someone else’s map, or go from
idea to index or table of contents, to idea. The distinction is
important. But a reference is almost never the best learning
tool, and depending on the Help feature to learn the program
will leave holes in your grasp of things. It’s certainly a conve-
nience, though, and an elegant one, to check out this or that
exact point you’d like to know more about.

Help shortcuts

Instead of navigating with lists and jumps, you can search directly for the
topic you want.

1. Click this button, at the top of the screen, and type in any topic on which
you’d like help. By default, Text is checked but Titles is not. We find it
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much faster to search by Title, but a few run-throughs here will tell you
what you like. Click Start Search. 

2. A progress bar tells you how the search is progressing and, when fin-
ished, you have a list of topics relating to your question. Pursue it into
greater detail with the methods outlined above.

3. Keyword gives you a list of words that may be Help topics, parts of
topics, or descriptions similar to names of topics. It’s a good cross-
reference to find the right name for something. Notes lets you attach
your own notes to any point in the Help file.

4. Bookmark lets you go to any point in the Help feature that you’d like
to access repeatedly. From any topic, click the Bookmark pop-up and
choose Define.

Accessing Help from anywhere in the program

On-line Help becomes even more useful because you can access a relevant
Help topic from wherever you are in WordPerfect. Rather than bother to
call up Help and then navigate through it, just go about your business until
you come up against a menu item that isn’t clear. Let’s say that Kerning
from the Layout menu has you stumped.

1. Call WordPerfect Help… from the Help menu.

2. With the Help window on screen, now choose the Kerning command.

Instead of the kerning dialog, you get an explanation of kerning from the
Help feature.
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Although you’re getting good quickly at WordPerfect, this is a
very nice feature to have available. You now know how to get
an immediate explanation of any command on any menu
(including sub-menus).

To access repeated trips to on-line Help even more quickly,
don’t click the close box of the Help window when you’re
finished. Just click anywhere in your document window, and
you’re back in your document. When you need Help again,
type command-question mark, or call the Help feature from
the Apple menu, or the Windows menu at the right of the title
bar. Since Help is already there (just behind your document
window), it comes to the front that much faster.

With the Help window active, pressing any keyboard equiva-
lent, such as command-S, gives you Help on what that does.

Play with the Help feature a little at this point, if you like. It’s fast, easy and
fun, and a demonstration of WordPerfect’s commitment to give you a
program that’s supportive as well as powerful.

QuickHelp

For historical reasons, WordPerfect developed a completely separate help
feature for version 3.5e. It has a different format and search design, and
you might prefer to use it alongside of, or instead of, the main help feature.
It’s available separately from the program, at WPMac by itself and includ-
ed with the SheepShaver-WP Install at WPMac, which puts QuickHelp on
the Script menu. When you open it you’ll see figure 6.5.
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Figure 6.5: QuickHelp topics

Navigation of the contents and search features are accomplished in similar
manner to the primary help feature discussed above.

Balloon Help

WordPerfect also has a feature common to many legacy Macintosh pro-
grams called Balloon Help. Help balloons are very short descriptions of
tools or features, and don’t try to explain how to do anything. It’s not a new
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feature, was dropped from OSX, and never did get much respect. Nonethe-
less, it’s very helpful for exploring a Menu or a Button Bar.

1. Click the Help menu and choose Show Balloons.

2. Move your arrow pointer over anything in the window. A balloon with a
short description of the feature appears. Move your cursor away from
the feature, and the balloon disappears.

There’s no need to click your mouse. Balloons show up simply
by hovering over a feature. They sometimes take a couple of
seconds to appear.

6. Should the balloons become intrusive, choose Hide Balloons from the
Balloon menu.

If Balloon Help is hidden, most of its contents appear on the Status Bar, if
you have Help enabled there. We’ll look at the Status Bar later in this
chapter.

WordPerfect Guide

Apple developed a help system that resembles WordPerfect Help and
QuickHelp. Choose WordPerfect Guide… from the Help menu to get
figure 6.6.
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Figure 6.6: WordPerfect Guide

If you don’t see the WordPerfect Guide… menu item, the
Apple Guide extension may be disabled on your machine. Go
to the Extensions Manager control panel to check and, if
necessary, activate it and restart. Some versions of WPMac’s
SheepShaver-WP Install have shipped with Apple Guide
deactivated since, rarely, it may conflict with other Help Menu
items, with the result that they do not appear. We recommend
you activate Apple Guide, restart, and see what WP’s Help
Menu looks like. It should have all the commands shown in
figure 6.1.

As with the other help systems, WordPerfect Guide has a table of contents,
index and a search feature.
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Now that you have means to more insight into how to produce meaningful
and eloquent data, let’s take a look at how to take care of it.

Automatic backups

As you enter and edit text and graphics, WordPerfect saves your file on
whatever disk you have chosen, probably your hard disk, and each time
you save (frequently, right?), the new version replaces the old. This is all
fine except that, in the best tradition of Murphy’s Law, one of two things
might go wrong:

• you deleted a paragraph, saved your file, and then realized you didn’t
want to delete that thought. With most word processing (or other)
programs, it would simply be gone, and you’d have to try to recreate it.

• this wonderful computer goes blip, makes a mistake, burps, or some-
thing, and the document you were working on has disappeared, maybe
the program has quit as well, and you don’t seem to be able to open the
document again. With many programs, the file has simply gone to the
place the clouds go when they aren’t in the sky, and you get to start over.

WordPerfect, though, has powerful features to protect you against the
computer or yourself, more extensive protection than any other program
we know of. These consist of automatic backups, and they take two
forms:

• WordPerfect takes a snapshot, as it were, of all open files every 15
minutes (or whatever interval you choose). If the program quits or your
Macintosh crashes in the middle of something, you have this version,
called a timed backup, to go to.
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• When you save changes to a file, and so overwrite the original file,
WordPerfect can save an original file backup: the earlier version of
your document is not erased, but is saved separately. When you save
again, both your current version and the next-most-recent are updated,
so that you still have the last two versions on disk.

WordPerfect is preset to save timed backups, but not original file backups.
We, however, turn both on because, since we’re computer experts, we’d
lose more work otherwise. Here’s how to do this.

Setting program preferences

1. From the Edit menu, choose the last command, Preferences. You’ll
see figure 6.7.

Figure 6.7: WP’s Preferences dialog
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2. Click Environment, the button at the top left. Figure 6.8 appears.

Figure 6.8: Preferences > Environment

where there’s a great deal to consider, so we won’t – yet – but just look at
the first box in the dialog, Backup. Of the two options, the first (checked
by default), is an instruction to back up every 15 minutes. The second,
Original File Backup, is not checked.

3. Click Original File Backup, so as to turn it on.

4. Close the Environment dialog by clicking the close box, and then close
the Preferences window the same way.

WordPerfect ships the program with Original File Backup
turned off because the company judges that most users won’t
want it. We disagree, and feel that everyone will want it at first,
until they learn their way around the program and then don’t
need it any more.
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One reason not to have it turned on is that it simply takes up more disk
space. If you write 35 long papers that, combined, take up 20 megabytes of
your hard disk, and if you have original file backups, you’re using 40
megabytes of space. Not a high price to pay for peace of mind, we feel, but
disks do fill up, and there’s no need to keep the next to most recent version
of everything you’ve ever written.

The best solution, we think, is to turn this feature on, work on current stuff
and, when you’re finished, clean off the backups. But do this only after you
make an archive, which is a backup, intended as permanent, onto another
disk.

Timed backups work in a different way, as you’ve seen, and it’s on by
default because, in normal use, the feature will not take up excess disk
space. WordPerfect keeps these backups of all open files only as long as the
program is running. When you exit WordPerfect normally, it deletes these
files. But if the program quits suddenly because of an error, or your
computer crashes and you have to restart, these backups remain on disk, to
give you a guarantee of not losing more than your last 15 minutes of work.
This is often a real help, since computers or programs do crash now and
then.

If yours does, and you restart WordPerfect, you’ll then see figure 6.9.

Figure 6.9: Timed backup files exist
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and, unless you’re sure that you didn’t have unsaved work when you
experienced the error, you should click Open. WordPerfect then presents
you with an untitled file or files that are the most recent snapshots of what
you had open. You can then save these under a slightly different name (to
prevent overwriting their originals), and you’re in business.

If you press Delete, these files are erased, and starting the program
proceeds as usual. If you choose Cancel, you simply leave this dialog
without affecting anything: the backups stay where they are, and you’ll get
this same dialog the next time you start WordPerfect.

Cancel is a useful choice if you’ve sat down to use someone else’s computer.
The last time they used WordPerfect, the program or the computer
crashed. Cancel opening their timed backups, and they can figure them out
when they come back.

While powerful and elegant, these backup features are not in
themselves sufficient. See chapter 17 for discussion of Free
Backup, a separate program that automatically archives your
work to another disk or location.

Backing up data is extremely important, and is a major key to successful
computer use. And it’s free and easy. No excuses.

As info, when you turned Original File Backup on, you changed a WordPer-
fect default. This change will now be effective until you change it back.
We’ll learn how to change all the defaults later on. For now, let’s learn how
to work with other parts of program operation to best suit your needs.
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Password protection

Another aspect of safety is giving any document (new or existing) a pass-
word of your choosing, entry of which is required to open the file. To
assign a password to a new document:

1. When you first save to disk, you see a check box for Password Protect
at the lower right of the dialog. Check this box. Enter other information
as usual, and click Save. 

2. The Password dialog appears, asking for a password. This can be any
combination of letters, numbers and punctuation, up to a total of 59
characters. WP passwords are not case-sensitive.

3. As you enter the password, characters are represented by apple sym-
bols, just as a reference to how much of your password you’ve already
typed. When finished, click OK or press Return or Enter. Thus, those
two keys can’t be part of your password.

4. WordPerfect asks you to confirm your password by the same proce-
dure.

Your document is now protected by this password. You won’t need to enter
it again as long as the file is open. Once you close and want to open it again,
though, you’ll need this password. Should you type it in wrong, WordPer-
fect beeps and lets you try again.

Adding a password to an existing document uses almost the
same procedure except that, with your file open, choose the
Save As command. You may use a slightly different name for
the password-protected version of your document, or put it in
a different folder, or you can use the same name and place,
overwriting the existing version.
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Password considerations

WordPerfect offers this feature as a convenience against a casual attempt
by another person to open your document. Data encryption is high-tech
stuff, though, and the CIA can get past WordPerfect’s password protection
and some other software encryption too.

Data integrity is an important concern in many areas of endeavor, and you
can spend several hundred dollars on a program that encrypts your data so
securely that, allegedly, no one can get at it.

Rather than play on the upward spiral of increasingly advanced encoding
and cracking, WordPerfect offers a degree of protection effective against
casual snooping or a less sophisticated data thief. It is not meant for more
than this. Should you require more, there are several dedicated encryption
packages, with various feature sets of security, range and ease of use.

Should you forget your password, please do not call WordPerfect technical
support. They no longer support the Mac version, and anyway they can’t
be sure who’s on the phone. Call the CIA. You pay taxes, right?

Since people don’t want to forget their passwords, they often choose a
familiar word, maybe their spouse’s name. This makes it easy for others to
guess. Give some thought to a password. As well, if you work on a docu-
ment with a long active life: “Quarterly Employee Evaluations”, say, which
you update rather than start afresh, change the password periodically with
the Save As command. Many mainframe computer accounts and web sites
that require a log-in password make you change it every 90 days or so, it’s
such a good idea.

In the Customization chapter, you’ll see how to change WordPerfect’s
default so that all new documents will require passwords, unless you
specifically uncheck the box in the Save dialog.
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Button, Status and Ruler Bar settings

When you first started WordPerfect, the Button Bar appeared to the left of
the document window, and the Ruler and Layout Bars opened at the top.
Very nice, but what if you wanted the Button Bar across the top, above the
others, and wanted just the Ruler but not the Layout Bar? Or, for the Status
Bar at the bottom, there’s a range of information you can decide to include
there.

The Button Bar

1. Click the icon with the up and down arrows at the top, or left end, of the
Button bar. You’ll see figure 6.10.

Figure 6.10: Button Bar options
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with Left checkmarked in the second category, and Default Bar in the
third.

You may want to put the Button Bar, with its many convenient tools, along
the top of the screen, below the main menu, so that you can access more
tools on a wider screen, or so you can work with wider margins.

2. On the Button bar pop-up, choose Top. Hey. All them buttons are now
along the top. It’s a bit different, so poke around to get a feel for it.

This isn’t a trivial concern. The screen/work environment is
something most people are very sensitive to. It took the
personal computer itself to show us this. Your environment is
important to your interaction with your work, and where the
main tools are is a part of it. You might want to try placing the
Button bar on the other sides of the screen as well.

In the Customization chapter, you’ll learn how to move buttons, add or
delete pre-defined buttons, and even make your own. This is a powerful
feature for productivity since, as you’ve seen many times over, WordPer-
fect has features for everybody, and it’s helpful to put the ones you want
most where you want them.

The Status Bar

This bar lives at the bottom of your screen and, although you can’t move it,
you can change and reposition what’s on it.

1. Click the arrow pop-up at the left end of the Status Bar. Figure 6.11
shows what you’ll see.
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Figure 6.11: Status Bar Options

where a number of choices have check marks to their left. The top choice,
Hide Help, is an exception. Choosing this command will remove the short
Help messages from the right of the Status Bar, and the command would
then read Show Help. The other choices govern what you see on the left
side of the bar. Battery is useful only if you have an OS 9 laptop; Caps
Lock indicates when that keyboard feature is turned on. Cell Number
shows you what cell your insertion point is in when you’re working with a
table, which we’ll learn in Chapter 8. Date and Time display that infor-
mation, according to your Macintosh’s clock.

Document Number shows you where you are in however many open
files you have at the time, in the order the files were opened. Num Lock
indicates whether the numeric keypad is in navigation mode, as you
learned in Chapter 2, or will enter numbers. Navigation mode is the default;
press Shift-Clear to turn Num Lock on or off.

Page/Line are indicators we find especially useful. Physical Page is the
actual page number of the active document. It can differ from the regular
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page indication if you’re working on chapters as separate files but with
continuous numbering. Splitting a large document into separate files for
each chapter is a good idea since a possible loss of data then affects only
that chapter.

Position is the vertical and horizontal coordinates of the insertion point.
This is especially useful when placing and sizing graphics. Read/Write
tells you if the active document has been locked in the Finder. In that case,
you can not save any changes to it. See your Macintosh manual to see how
to lock files. It’s a useful feature if you want a file available for reference,
but don’t want to make inadvertent changes to it, or if you’re accessing a
file on a network to which you have read privileges only.

The Help messages in the Status Bar describe the active
indicators in that bar just as they do the other features on
screen.

As you’ve seen if you turned all these indicators on, depending on the size
of your screen, there isn’t much room left for the Help messages. What’s
shown is up to you – again, an environment good for your work. There’s
further flexibility here, since you can reposition any of these indicators as
you wish.

2. Click on any indicator. Your cursor changes into a hand.

3. Move any indicator to the left or right of its neighbor. The positions of
the indicators switch on the bar.

You can also adjust the width of each indicator. Drag separators between
indicators just as you dragged indicators themselves.
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Showing and hiding Bars

By default, WordPerfect opens the Button and Status Bars, the Control
Bar just below the title which governs all the bars below it and, of those,
the Ruler and the Layout Bar.

You can turn the Ruler and Layout Bar on and off with the Control Bar. Any
new document, though, will have these two Bars showing. Here’s how to
turn these off, or others on, by default:

1. From the Edit menu, choose Preferences. 

2. Click on the button near the bottom left: Show Bars. You’ll see figure
6.12.

Figure 6.12: Which bars to show
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At the top of this dialog, you can set these bars to show on open, that is,
when you start a new document or open an existing one, whether the
program itself is already running or not. This dialog does not show or hide
these bars for documents already open: the Control Bar performs that
action.

At the bottom of the dialog, the choices about the Button and Status Bars
take effect for currently open documents and for other documents you
start or open.

Searching for text, and file management

WordPerfect has a nice set of tools helpful to find text within any number
of closed files, and to work in a variety of ways with files and folders. These
are available when you choose the Open command.

At the top of the Open dialog you see six menus, with some or all enabled
depending on what’s selected in the scrolling list. If a file is selected then,
logically enough, the File Menu is enabled.

The File Menu

Click on this menu, and you’ll see several commands. New starts a new file.
Quick Text Import and Use Easy Open offer options that may facili-
tate opening files other than WP Mac files. Insert performs the same
function as the first command on the Insert Menu on the Menu Bar, of
placing the contents of the file you select into the active file at the insertion
point. Print will send the selected file to the printer without opening it.
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In the next set of commands, Copy asks you for a name and location for a
copy of the file selected in the dialog’s scrolling list. Rename simply lets
you give a file a new name, and Delete removes the selected file from disk.

Several third-party utilities will let you retrieve a file that you’ve
thrown in the trash, working in the Finder. Not all of these
programs will recover a file erased using WordPerfect’s Delete
command, though. This command may enhance security, but
should be used with care.

The Info command is helpful for more advanced users. Choose this, and
you’ll see figure 6.13.

Figure 6.13: File Info from the Open command

with information at the top that matches the Finder’s Get Info command:
creation and modification dates, size and (for applications), version. The
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Attributes section at the bottom displays, and lets you edit, technical
information that the Macintosh uses to determine what document goes with
what application, so that when you double-click on a document icon in the
Finder, your Mac opens the right program for it.

Do not edit the creator and file types unless you know what
these are. You may then not be able to open the file, or
double-clicking it will open it in the wrong application, or not all
the file’s data may be available.

The Folder Menu

In this second menu, New lets you make a new folder without switching
back to the Finder. This is simply a convenience, as is Rename. The next,
Delete, lets you remove an empty folder; you can’t use this command if
there are items in the folder, just as a safety measure. Info tells you the
creation and modification dates of the selected folder, and its size and the
number of files and other folders it contains.

The Search Menu

 This valuable feature is covered in discussion of search engines in Chapter
3, in the section More Extensive Search.

The Retain Menu

When you open a file, you may want only part of it. WordPerfect lets you
choose whether to open the entire document, or just text and attributes
(anything you can change on the Font Bar), text and graphics, just graphics
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or just text with formatting (as governed by the Layout and Ruler Bars). It’s
easier to pick out what you want to work with.

If you’re having trouble opening a file – you were working on it when your
computer crashed, say, and the file may be corrupted – you can often
recover what you need from the file by opening it and retaining only, for
example, the text. This is covered completely in discussion of WP File
Recover in Chapter 17.

The Templates and Latest Menus

These two features let you go directly to anything in WordPerfect’s Tem-
plates folder which, as a more advanced topic, we discuss in Chapter 12, or
to any of the most recent documents you’ve had open. This is equivalent to
the Open Latest command on the regular File menu. We’ll show you how
to change the number of files that appear here, again in Chapter 12.

Show and Preview

At the bottom of this dialog, you can tell the Open dialog to Show all
documents, or graphics, or several other choices. Setting this to All can, in
concert with the Quick Text Import and Use Easy Open switches in the File
Menu here, help you open a document not created by WP.

You can also choose to Preview Layout (the formatted document) or just
Contents (text with attributes). We find Layout the most useful.
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Menus in the Find/Change dialog

We looked at WordPerfect’s Find and Change commands in Chapter 3. So
as not to provide too much data in that early chapter, we left out some
details. Let’s look at these now.

Just as with the Open dialog, the Find/Change dialog has its own menu bar.
We covered the Direction menu in Chapter 3; of the others, the Where
menu lets you search for a word or phrase in the whole document, or only
in certain parts. We’ll learn what these are as we go along.

Match lets you search for Whole Word, for example, so that looking for
“end” will not bring up “depend” or “send”. Or, you can search for text in a
specific font, size or style. To specify these, enter the text you want in the
Find box, select it and, from the regular menus at the top of your screen,
set the font or other attributes.

Be careful when using the Change All command, without the
Whole Word option selected. Changing all instances of “he” to
“she” will change “banshee” to “bansshee”, and other such
surprises.

Affect is used if you’re changing as well as finding. You can change all
instances of one font or style to another here. Action tells WordPerfect
what to do when it finds what you’ve told it to. It can position the insertion
point before or after the find, select the find (the normal setting), or extend
the selection from the insertion point’s present position to and including
the text you’re looking for.

Insert provides a great deal of flexibility. You can use this to search for
formatting, rather than text. Say that you have a long document in which
each new paragraph starts with one hard return and one tab, the more
traditional style. You can change this so that each paragraph starts with two
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hard returns, so as to put a blank line between each paragraph, without
indentation. Here’s how:

1. In the Find box, insert a hard return and a tab.

2. In the Change To box, insert two hard returns. Your dialog box should
look like figure 6.14:

Figure 6.14: Change return & tab to return & return

3. Click Change All, and your document assumes a more modern format.

Another way to do this would be to replace all occurrences of
a hard return followed by a tab, with just one hard return.
Then use open paragraph spacing to make a blank line
between each paragraph.

The End of Field and End of Record codes will prove useful when we
learn merge in chapter eleven. Match One Character and Match
Multiple Characters are valuable at any point. If you’re not sure of the
spelling of a technical term, for instance, but know it begins with “ite” and
ends with “tion”, enter these with the Match Multiple Characters code in
between.
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To delete all instances of anything, put what you want to erase
in the Find box, and leave the Change To box empty.

If you select a little text (up to 64 characters) first, and then
call the Find/Change command, the text appears in the Find
box.

Find Codes

The Find command will search your file or specified parts for text, format-
ted or not, and for some codes. The Find Code… command, just below the
Find command on the Edit menu, lets you search for any code that Word-
Perfect uses. Call this command, and you’ll see figure 6.15:

Figure 6.15: the Find Codes dialog

in which you scroll to and then select the code you want to find, choose a
direction, and then tell WordPerfect to find, remove all, or (when one is
found), to remove or remove then find the next occurrence. You’ll see the
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value of this as we proceed through WordPerfect’s features, and discover
what all these codes do.

Fractional Character Widths

The last feature we’ll look at in this chapter shows up in an out-of-the-way
place: the Page Setup dialog box. We looked at most of the features there
earlier, saving this more complex one for now.

Some concepts first: Macintosh screens have resolutions of certain dpi, or
dots per inch, while many printers are capable of a much finer resolution.
Laser printers typically offer 300 or 600 dpi or more. Macintosh fonts are
designed so that each letter fits neatly next to its neighbors with a precision
that can’t be displayed at a lower dpi. If the Fractional Character
Widths box in the dialog is not checked, letters on your screen sit next to
each other as closely as possible, without colliding, for the lower screen
resolution.

If you check this box, printed text will benefit from the closer spacing that
high-resolution printing allows, but the text won’t look as even on screen:
letters will appear to bump into each other. If you want to use this feature,
you can either:

1. Enter and edit text using integral character widths. Then change to
fractional widths to format and print.

2. Leave fractional widths on. Your text may look a little funny on screen
with fractional widths, but will look better in print.

At different screen views, however, e.g. 200%, text may look better on
screen with fractional widths on.
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To set fractional widths as a default, select it and the option to its right:
Save As Default, and WordPerfect will leave it on.

This is too fine a point for many people, and you may want to
experiment a little with and without this option, to see if it
makes a difference to you. The Macintosh and WordPerfect
offer extraordinary quality of text in print, so the feature is at
least worth a look.

Summary

This chapter has given you a good look around much of your WordPerfect
operating environment. You can now:

• use WordPerfect’s four different kinds of on-line help, for immediate
information on tools, features and program operation

• configure two kinds of automatic backups and avail yourself of these
safety features

• password-protect documents, for a different kind of safety and integrity
of data

• locate the Button Bar where it suits you best, choose what information is
presented on the Status Bar, and where it appears, and choose which of
WordPerfect’s seven other tool bars open automatically

• use WordPerfect’s file and folder management tools,
• find and change formatting and codes as well as text
• choose integral or fractional character widths

While some of this you can set and be glad it’s there, the Help feature is a
nice tool to visit often, to become acquainted. The search command will
often prove a friend in need. You now have a lot of tools at your disposal,
helpful stuff as we explore more complex formatting in the next chapter.





Chapter 7

Intermediate Formatting

In this chapter, you’ll learn how to:

• indent paragraphs, with your choice of symbols marking each para-
graph, using the button bar, and indent with greater flexibility using
menus and the ruler

• choose from a variety of alignment options and commands
• utilize the full range of WordPerfect’s powerful formatting, including

attributes, borders and fills, text color and kerning
• use numerous shortcuts to let you work more easily and quickly
• create and edit multiple headers and footers
• place and format page and line numbers
• work with footnotes, endnotes, or both at once

At this point, you’ve seen how easily you gained expertise in WordPerfect’s
drawing mode, and you know your way around the basics of the word
processing environment. It’s time to start to develop the same degree of
expertise in word processing that you have in graphics – but, although
there are more tools and possibilities, the learning process won’t be any
more difficult.

The focus of this chapter is manual formatting because, later in this book,
you’ll learn how to teach WordPerfect how to format your documents
automatically. For example, if you like to write reports in 14 point Lucida
Grande, left-aligned, but have them print in 12-point Adobe Minion, with
sub-heads in 18 point Stone Sans, that can be a one-step operation. For
now, though, let’s see how to do powerful and flexible formatting step-by-
step.
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Indenting

Some kinds of writing depend for their effectiveness in making a number of
points on one topic. Whether in a letter, brochure or report, you might
want to list or review points you’re making, and setting them apart from the
rest of your text is a visually effective way to emphasize what you want to
say.

WordPerfect gives you several easily available options to indent text you
choose, and place a symbol, such as a bullet or a dash, before each para-
graph. Let’s look first at how the Button Bar does it.

Button Bar tools

There are four tools on the Button Bar just for adjusting text indentation,
two of which include symbols that appear before each paragraph of text
you’ve selected for this kind of emphasis. These work on text in paragraph
units, for any number of paragraphs you select before you click a button.
Figure 7.1 shows a sample of text organized this way.

The bullet button indents any paragraph(s) you select by one tab stop, with
a bullet at the left margin. The tab button indents your text two tab stops,
with a dash at the first tab.

You could not select this whole passage, indent with bullets,
and then further indent sub-selections with dashes. Each
button carries out its action only if the other button’s formatting
has not already been applied to the text you want to change.
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This book will teach you WordPerfect:

• step by step, as the author taught the program to hundreds of college students
- take each chapter at your own pace, without need to worry
- 400 illustrations and a wealth of examples make learning easy and fun

• with a minimum of effort
- the Macintosh and WordPerfect really do make things simple
- much of what you’ll learn is how to produce word processing,

professional graphics and entire page design more easily than you
thought possible

• from complete beginner to advanced programming level
- you can learn from this book even if you’ve never used a computer

before
- power topics such as AppleScript, tables, cross-referencing, document

linking , macros, equations and QuickTime movies are covered in
detail.

• Separate chapters provide extensive discussion and advice on
- virus prevention and protection from disk errors
- system utilities and exceptional software accessories you can add to

your Mac, many free, to enhance your work environment, productivi-
ty and accuracy

• includes a complete Glossary and Command Reference
- describing every command in WordPerfect
- a valuable tool during and after learning the program

Figure 7.1: Indented text

The button with a right arrow indents a paragraph one tab stop without any
symbols. The button with a left arrow moves the selected paragraph one
tab stop to the left. This is convenient for indenting a large block of text
(say paragraphs three through eight), and then selecting paragraphs four
and five, and ‘unindenting’ them.
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Menu Bar tools

As with most features, WordPerfect gives you fast choices on the Button
Bar, but more flexibility in the menus. Let’s look at three commands on the
Insert menu: Back Tab, Indent, and Left/Right Indent.

Back Tab moves the first line of your incipient paragraph one tab stop to
the left. This feature is especially useful for numbering paragraphs. By
typing as usual, numbered steps can be hard to distinguish, as in figure 7.2,

The Top Ten Reasons to Use WordPerfect Mac

1. This book says so, and this book knows its stuff. Just ask the author.
2. The program’s range of features matches anything available.
3. The program’s depth of implementation of its features exceeds the
competition’s considerably.
4. Third parties, some with Ph.D. degrees, have contributed features to WP
that are orders of magnitude more advanced than the competition’s features.
5. You may never need a separate page design or graphics program.
6. The Bézier curves of WP’s graphics module were rated as good as Adobe
Illustrator’s.
7. A large, well-informed and active user group at Yahoo provides better
technical support than that enjoyed by users of most commercial programs.
8. Attorneys and others who work with confidential information prefer
WordPerfect to Microsoft Word because of greater document security.
9. Writers of large manuscripts appreciate how stable WP is with long
documents.
10. The Great American Novel will probably be written using it, given its
quality, and some of the shine will rub off on everyone else who uses it,
especially, hopefully, this author. 

Figure 7.2: Numbered text without indents
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The Top Ten Reasons to Use WordPerfect Mac

1. This book says so, and this book knows its stuff. Just ask the author.
2. The program’s range of features matches anything available.
3. The program’s depth of implementation of its features exceeds the

competition’s considerably.
4. Third parties, some with Ph.D. degrees, have contributed features to

WP that are orders of magnitude more advanced than the competition’s
features.

5. You may never need a separate page design or graphics program.
6. The Bézier curves of WP’s graphics module were rated as good as

Adobe Illustrator’s.
7. A large, well-informed and active user group at Yahoo provides better

technical support than that enjoyed by users of most commercial
programs.

8. Attorneys and others who work with confidential information prefer
WordPerfect to Microsoft Word because of greater document security.

9. Writers of large manuscripts appreciate how stable WP is with long
documents.

10. The Great American Novel will probably be written using it, given its
quality, and some of the shine will rub off on everyone else who uses it,
especially, hopefully, this author. 

Figure 7.3: Numbered paragraphs have been indented

while Back Tab can make the list look like figure 7.3. Here’s how:

1. Take a sample of your writing, with several short, numbered paragraphs
all aligned to the left margin. For each paragraph, you’ve typed a num-
ber and a period, then a tab, then the content.

2. With your cursor at the top of the page, click the left margin on the
Ruler and move it a half inch to the right.
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3. Click just to the left of the first indented paragraph.

4. Choose Back Tab from the Insert Menu.

You can also press Shift-Tab on your keyboard.

5. Repeat this for the other paragraphs.

Pretty slick. Mondo slick, when we learn later how to automate this into a
one-step operation.

Another way to make figure 7.2 into 7.3 would be to go to the ruler, and
drag the paragraph indent icon to the left of the left margin, by one tab
stop. Everything that was selected, or everything you subsequently typed,
would have this formatting, until you changed it to something else.

So using the ruler would be the better idea for longer lists, and using Back
Tab would be easier for a few numbered points within regular text. In many
ways, WordPerfect gives you choices to suit both the situation and how
you best like to work.

Indent moves any number of selected paragraphs one tab stop to the
right. Easy enough. Left/Right Indent does this too, and also moves the
right margin one tab stop to the left, for a narrower and, as it were, cen-
tered block of text. This formatting is commonly used in academic writing,
where you want to quote more than five lines of somebody else’s writing.
Less than five lines is generally done with quotation marks, within your
regular margins.
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As with other formatting commands on the menus, you don’t
have to select text to use Indent or Left/Right Indent. You can
choose either of these first, and then type.

1. Start a new paragraph, choose Left/Right Indent, and type. Your
entire paragraph is indented at both margins. After you press return
again, your margins go back to their original positions.

2. Select part of any paragraph with regular margins, and choose Left/
Right Indent. This formatting takes effect, again not influencing other
text.

3. Press the Return key to start a new paragraph, and then – before typing
anything – choose Indent. Your new paragraph is indented one tab
stop. Succeeding paragraphs are not indented.

As you remember, you can indent just the first line of all
paragraphs by dragging the paragraph indent icon on the
ruler.

Alignment

In Chapter 2 we looked at text alignment: both left-aligned, also called
right-ragged, and fully justified. Other options to consider are right-
aligned, also called flush-right, and centered.

WordPerfect gives you two ways to choose right-aligned or centered
formatting, and they work a little differently. One command right-aligns or
centers everything you type after you choose the command, until you
change it. The other formats only the line you’re just about to type.
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Layout Bar choices

You’ll find the set-until-change commands on the Layout Bar, as the second
menu. Graphic representations of alignments accompany the choices, as
shown in figure 7.4:

Figure 7.4: Alignment menu on the Layout Bar

Like many other commands in word processing and graphics,
these affect future action unless you have something selected
when you choose the command. Then what’s selected is
formatted, and future typing is not affected. If nothing is
selected when you choose the command, you’re formatting
future text entry.

Try using these alignment commands in both the possible ways: selecting
text and formatting it, and choosing the formatting command first, and
then typing.

If you select text, format it, and then go on typing, all your
selected text disappears, since anything you type (except
directional commands, e. g. arrow keys), replaces whatever’s
selected. So, after you select and format, click outside the
selection or press the right arrow. Then you can continue
entering text.
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The last two commands, Justify All and Decimal Align (which is
grayed-out right now), are choices you’ll need less often. Justify All, which
some programs call Force Justify, brings all lines in a paragraph out to the
right margin – including the last line in the paragraph, even if it has only
two words in it. This is occasionally useful for display advertising. Decimal
Align is something we’ll use when we learn Tables.

Button Bar choices

The other way to center or right-align text will format only the current line.
You may only want one or two lines centered, for a title, or one line set
flush-right, say for the date at the top right of a letter. You’ll find these
alignment commands on the button bar, one with an arrow pointing right at
a vertical line, the other with two arrows pointing towards each other.

Clicking on the first of these two buttons makes the line you’re on, and
about to type, right-aligned. Clicking the next button centers the single line
you’re about to type. This can be confusing, so follow these easy steps:

1. Press Return to start a new line.

2. Click the button you want.

3. Type the line of text.

4. Press Return to go back to the alignment previously in effect.

We’re getting so specific here because these commands are
very specific. For example, if you were halfway through typing
a line, and then decided you wanted it flush-right, so you
clicked the Right-Align button, what you typed after clicking the
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button would be right-aligned. Looks bizarre. If this happens,
just backspace out of it.

The second use of these two alignment buttons is to format text you have
selected. Then, these commands work just like their cousins on the Layout
Bar: whatever is selected is aligned as you wish, and further text is not.

Attribute formatting

Early on, you learned a little about choosing fonts and sizes. It was a lot for
a beginner but, since you’re rapidly achieving competence with WordPer-
fect and the Macintosh, let’s look at the full range of character formatting
available with this program.

The Font Bar

1. Click the Font button on the top Control Bar to display the Font Bar,
as shown in figure 7.5.

Figure 7.5: the Font Bar

The first two menus on this bar are font and size. Click the pop-up menu
(click on the arrow, not the font name or size), for a list of fonts your
system has available. The size menu only sizes 9 through 24 point, while
the Font Menu in the top Menu Bar lists many more. However, you can
drag through a font name or size to select that text and then type in other
text.
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As always, if you make a choice on the Font Bar without selected text in
your document, your choice applies to what you subsequently type. If you
do have text selected, this choice applies only to that selection.

The buttons to the right let you choose attributes to apply to any text. P is
plain text; B is bold; I is italic, and U is underlining. Each button toggles on
and off: if you wanted a word in italics, you would click this button once,
type the word, and then click the same button again.

The plain text button is provided as an alternative to turning off
any other button, or to turn off all of them at once. If you had
text that was bold, italicized and underlined all at once (you
really wanted to make a point, and had not read the upcoming
section on appropriate use of character formatting), you could
turn all these attributes off at once.

If any of these formatting options is active, its button is highlighted.

Another nice way to choose bold, italic or underlining is with a
keyboard equivalent. We do it that way, since we like to keep
our hands on the keyboard. Just press Command-I for italics
(and press again when done), Command-B for bold, U for
underline.

You can show and hide the Font Bar by pressing Command-
Option-F.

The next two buttons choose superscript and subscript. We’ll look later
at how you can change by how much this text is moved vertically from the
baseline, or from normal text on either side of it; for now, the default
settings are fine. Again, you click the button to turn the feature both on and
off, and the button is highlighted when the feature is on.
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Don’t use superscripting for footnotes. WordPerfect has its
own comprehensive footnote (and separate endnote) capabili-
ty, which we’ll look at later in this chapter. Also, WordPerfect
has a fine Equation Editor, which we’ll learn in Chapter 14.

The next pop-up menu lets you set text color – very nice for color printing,
or for some interesting special effects with grayscale. You could, for
example, set the text color to white, and set a dark fill for the paragraph,
much like in the Graphic Editor. Titles and such can be especially effective
this way. We’ll have an example later in this chapter.

Symbols

For now, though, let’s look at the other icons on the Font Bar. The next
button shows you all the symbols in whatever font you’ve chosen. Clicking
it gives you a window like figure 7.6.

Figure 7.6: All the symbols in the current font. Click any one to place it at
your insertion point. This window floats above all others and stays on

screen until you close it.

and you’ll see that although it has a close box at the top left and a title bar,
that bar looks different from most others you’ve seen. It has the same
texture as the title bar on the Tool Palette in the Graphic Editor. This
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texture means that a window with it floats above all other windows. So,
with the Symbol window open, clicking in the text window behind it doesn’t
bring the text window to the front. The Symbol window stays in front until
you close it.

Once it’s open, you can click on any symbol in it – the sign for the British
Pound, for instance – and that symbol is placed in your text, at the inser-
tion point. This is a great feature for those of us who make use of the
extensive range of characters available in most Macintosh fonts, but use
several so sparingly that we forget where they are. Who’d remember, say,
that the last character in the name Johann Strauß is typed option–s?

Copying attributes

As you remember from Chapter 2, the Layout Bar has a nice feature that
lets you copy ruler formatting to the clipboard, whence you can paste it
into another point in your file instead of re-creating margins, tabs and so
on. The Font Bar has a feature very much like this, but which lets you copy
character attributes to the clipboard. The two buttons are shown in figure
7.7, and may easily be used in conjunction with each other.

The terms attributes and formatting are often used inter-
changeably, but their precise meanings differ. An attribute is
anything intrinsic to a character, such as its font, size, color, or
whether it’s in italics or bold. Formatting is arrangement of
characters on a page that is extrinsic to the letters themselves,
such as margins and spacing. We’ll look at this more in
Chapter 9.
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Copy Attributes, on the Font Bar

            

Copy Formatting, on the Layout Bar

Figure 7.7: Copy Attributes or Formatting

To copy attributes:

1. Put your insertion point within a word with the attributes you want to
copy – no need to select anything.

2. Choose Copy from the Edit menu.

3. Move the insertion point to your target.

4. If you want future typing to have these attributes, just choose Paste
from the Edit menu at that point. If you want text already typed to gain
these attributes, select it and then paste.

The next item on the Font Bar is a pop-up menu labeled SpeedStyles.
Although it’s here, its function as a kind of style sheet is better discussed in
Advanced Formatting, Chapter 9.

We’ll come back to the Font Bar, with its final button, in a moment. Let’s
take a look now at another way to access the commands you’ve just
learned, and then some.
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Setting attributes with the menus

As you already know, you can choose font, size (or font and size, with a
compact screen) and style from the standard menus (“standard” because
they’re always there in text mode, whether you have the Font Bar open or
not).

The Style menu has a few more features to it, though. These include Small
Caps, an elegant way to present a title or an acronym. For example, UNICEF

looks more articulate than does UNICEF in body text. To make small caps,
do not type all capital letters, since Small Caps changes only lower-case
letters. Type lower-case, select, and then choose Small Caps.

This command doesn’t influence capital letters, so you can use both regular
caps and small caps at once: COME INTO MY PARLOR was typed just as you’d
type the caps and lower-case.

Some fonts look better in small caps than others.

Lower on the menu, Redline and Strikeout are most useful if you edit
text and make revisions. Select some text, and apply either of these com-
mands: Redline puts a vertical line just to the left of the text you selected –
and it’s in red on a color monitor. This is often used for text suggested for
addition to the original.

Strikeout is just the opposite: it denotes text removed from a manuscript
by drawing a line through it. Remove takes Redline and/or Strikeout
formatting out of whatever text you choose.
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Uppercase changes all the text you select to capital letters. Lowercase
does just the opposite. Initial Caps makes the first letter of all selected
words a capital letter. Handy for titles.

The Character Format dialog

On the Font Bar, the last button says Other…, and the same command
appears on the Style menu. Choosing either takes you to a big dialog box
where you can set all the character attributes we’ve learned so far, plus
quite a few more. It looks like figure 7.8.

Figure 7.8: the Character Format dialog
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and this may seem daunting at first. Most of its options, though, are self-
explanatory: scroll through the list of available fonts (or type the first letter
or two of the name of the one you want, and watch WordPerfect scroll to
it); click on the pop-up next to the point size to choose another, or type in
any number you want (between 1 and 32767 which, you remember, is
about eight feet tall). To the right, character formatting is as you’ve seen,
except that double underline is offered here, as are Outline and
Shadow.

The Continuous Underline feature is flexible and useful. With neither
Spaces nor Tabs checked, the Underline command (as found on the font
bar, by pressing Command-U, the Style menu, as well as this dialog box)
underlines discrete words, and nothing else. Checking only Spaces would
let you underline titles of columns, for instance, without underlining the
whole line containing the titles, since you would have tabbed from one to
the next.

All of the changes you make are illustrated in “The quick brown fox”
example.

If you like to keep your hands on the keyboard, as we do,
there are lots of keyboard equivalents here, as you see in
figure 7.8.

All of the keyboard equivalents available are displayed. This is true for
most of WordPerfect’s dialogs, and it is helpful. There are times when the
continuity of working at the keyboard is an advantage, and several equiva-
lents become good friends. Command–S to save is the classic example.

One place where keyboard equivalents don’t work, though is in pop-up
menus. One of these, at the center of the dialog, lets you choose text color,
and we’ll work with that in a minute. Another, just below the font choice
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box, says Size. It has point sizes to its right, but the box itself is a pop-up,
to access Relative Sizes. 

Relative Sizes

Click this pop-up, and you’ll see figure 7.9.

Figure 7.9: the Relative Sizes pop-up

allowing you to change text already typed and selected, or text you’re
about to enter, to one of these sizes relative to what’s currently in effect. If
you’re writing a report in 12 point, for example, you could go to the Very
Large relative size for a chapter title, and get 18 point.
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Why not just change point size itself? You certainly could, but it might
involve several extra steps for you if you’re writing your report in 12 point
(more legible on screen), but want to print it in 10 point. You’re entering
titles, meanwhile, at 18 point, a size you like relative to the 12 point body
text.

When it comes time to format for printing, it’s easy enough to select the
whole document and specify 10 point. Your titles are then also 10 point,
and you have to change each one back by itself. Low-level work, the kind
WordPerfect wants to do for you.

Later, when we learn style sheets, we’ll find one way out of this dilemma.
Meanwhile, here’s another. Instead of changing point size to 18 every time
you come to the place for a title, choose Very Large from this pop-up. Go
back to normal size for further body text. When done, select the whole
document and change the font size to 10 point. Your titles will now be 15
point, the same relative size as 18 point is to 12.

This is not only a time-saver, but is conducive to accuracy.
You might have titles at one size, subheads at another, and
indented quotes at a third, smaller size. By specifying relative
sizes, you don’t run the risk of missing any of them when you
format.

Wait a sec, you say. This is fine if “Very Large” is 18 relative to 12, or
150%. Can we change that? You bet. Click the Relative Sizes… button at
the bottom left of the Character Format dialog, and you’ll get another
dialog, shown in figure 7.10:
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Figure 7.10: the Relative Sizes dialog

where you can change any of these sizes, expressed either as a percentage
or a point size. If you do the latter, and define Very Large as 20 point
relative to 12, WordPerfect will calculate the ratio when you format your
file as 10 point.

Let’s look at the last button in the Character Format dialog, for modifying
super- and subscript specifications.

Superscripts and subscripts

WordPerfect defaults to reasonable and effective relative sizes and posi-
tions for superscripted and subscripted text, but you can change these if
you want. Press the Super/Subscript… button in the Character Format
dialog, and you’ll see figure 7.11:
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Figure 7.11: Superscript/Subscript Options

where any change you consider is reflected dynamically in the example in
the box. Using this dialog doesn’t turn super- or subscript on or off; it only
sets the specs. Turn these attributes on or off in the main Character Format
dialog, or using the buttons on the font bar.

Borders and fills

In Chapter 4, Basic Graphics, you brought a drawing into a text document,
and put a border around it. Borders do a nice job of setting objects apart on
a page, so WordPerfect lets you put a border around anything – not just a
graphic. What’s more, you can set a dark fill to a paragraph of text, just as
you did with a shape, and then make the text itself white. This kind of
emphasis is both effective and elegant, although light text on a dark back-
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ground isn’t a good idea for larger blocks of text, since it’s more difficult to
read.

1. Select one or more contiguous paragraphs in your document.

2. From the Layout menu, choose Borders and then Paragraph. The
dialog, similar to figure 4.20 on page 148 for a Graphic Frame, looks like
figure 7.12:

Figure 7.12: the Paragraph Border dialog

3. In the Border section at the top left, choose a Type to your liking.

4. In the Fill section at the top right, check Fill On. Everything else is fine.
Click OK or press return. Everything turns black.
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5. Drag through the paragraphs to select them, just as though you could see
the text in them. It turns white. If you’re working with just one para-
graph, triple-click to select it.

From the Font bar, click the Other button, or choose Other from the Style
menu, or press Command–H. In the Color pop-up menu, choose white.
Make the fill something less than solid black, and you should have some-
thing like figure 7.13, which is a nice way to do a title page. 

Figure 7.13: Reversed text
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Show Codes

As you’ve done all this, you might have come close to losing some text! Say
you changed text color to white, without changing to black the fill of the
paragraph it was in. It would be like looking for a contact lens, except that
WordPerfect has another window you can open, to show you what’s really
going on in a file. This will seem a little complicated at first, so take a deep
breath and:

1. Choose Show Codes from the Edit Menu. You’ll see something like
figure 7.14.

Figure 7.14: WP’s formatting codes

which, for this illustration, shows what’s going on in the title page you saw
in figure 7.13.
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2. Use the left and right arrows on your keyboard to move your insertion
point around the text, and see how the insertion point moves in the
codes window as well as the document window.

As in normal text editing, you can move the insertion point just to the right
of something, and press Delete (Backspace on some keyboards) to erase it.
In the codes window, you can delete a code, such as the Paragraph Border,
or Color. However, if the codes window is closed, the Delete key erases
content but not formatting.

Should you make a mistake, it’s often easiest to back up a step or two, and
try it again.

You don’t ever need to work in the codes window, and some
people prefer not to, just because it looks complex. Well, it is,
but you’re fast becoming an expert, so it’s there if you want it.

Headers and footers

WordPerfect lets you place text and/or graphics in your document such
that it repeats on every page, or every other page. You place these repeat-
ing elements in a header or a footer, so-called because other word
processing programs give you only a certain amount of room at the top or
bottom of the page for this. WordPerfect lets you place a header or footer
as large as the page, should you want to. Other options include adding page
numbers, or an automatically updating date and/or time (called date- or
time-stamping).

As with many features, there are two ways to access either a header or
footer, depending on how many options you want. The simplest way to
start either is by clicking the appropriate icon on the Button Bar, as shown
in figure 7.15:
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Figure 7.15: New header and footer buttons

1. Click the Header button, and a new window opens at the bottom of your
screen, with the title of your document and the addendum “Header A”.
Like any window, it can be moved, resized and closed. It has Ruler Bars
like other text entry windows, with one additional, called a Header
Bar. The window will look like figure 7.16.

Figure 7.16: a Header window

with the special icons on the Header Bar as follows: the pages with the left
and right arrows display the previous and next header, if you have any (this
is to say, you could have a separate header for each chapter. While in
Chapter 7, you could look at the Chapter 6 header).

The button showing the page with the large number inserts page numbers
into the header – left, center or right-aligned as you wish, using the Layout
bar in this window – and you can add text to it, so it might read “Chapter 7,
page #”.

The next button inserts a date or time-stamp, so it will always show that
current information. Whether this button inserts the date or time, or both,
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and in what format, can be set in WordPerfect’s Preferences, which we’ll
learn in the chapter on Customization.

The last item in the Header bar is a pop-up menu that allows you to specify
where this header will appear: all pages, or only odd or even pages.

2. Enter text in this window as you wish, and format it to your liking –
changing fonts etc. in your main document does not change them here –
and close the header window when done.

3. Click the Footer button on the button bar, and try this as well.

Neither headers nor footers show in your normal text view of your docu-
ment, just to keep them out of the way of your work. When you want to see
how your page will look when printed:

4. Choose Print Preview from the File menu, to see headers and footers –
and watermarks, for that matter.

5. Back in your text, if you click the Header or Footer button again, you go
back to the header you’ve already created. Next, we’ll look at how to
create more than one, and edit them separately.

A more detailed look at headers and footers

As with many features, greater depth is available to you from the menus
than from the Button Bar.

1. From the Layout menu, choose Header/Footer, and then New. You’ll
get a dialog box like figure 7. 17.
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Figure 7.17: New header or footer

which gives you your choice of headers or footers A or B, while the button
bar option is limited to header or footer A. This is useful for putting header
A on odd pages, and header B on even.

2. Start a new header this way (use header B if you already have a header
A). Then see what you have with Print Preview.

If you have two headers or footers set for the same pages, they’ll run right
over each other, although they push the body text out of their way.

3. Using the menu access Layout > Header/Footer, you can Discontinue
a header or a footer at any point. You can then start a new header A or B
to replace it.

The last two items on this submenu, Header Style… and Footer Style…,
we’ll cover when we learn style sheets, a powerful feature that lets you set
any formatting as defaults for headers, footers, body text, and everything
else.
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Page and line numbering

Adding page numbers to your document by placing them in the header or
footer is convenient enough, but WordPerfect offers you another way to
do it. The keynote here is flexibility: put a bunch of stuff in a header, and
then only a number at the bottom of a page. Or change headers from one
chapter to the next, but turn page numbering on once and forget it.

Or, the page numbering feature lets you use Roman numerals for the front
matter (such as Table of Contents and Foreword), then switch to Arabic
numerals for the body. Page numbering lets you alternate the numbers to
the right side, say the top right, of odd-numbered pages, and the top left of
even pages, without having to define two headers, and align the page
numbers left and right as you would other text.

You can number individual lines as well.

1. Choose Page Numbers… from the Layout menu. You’ll see a dialog
like figure 7.18.

Figure 7.18: the Page Numbers dialog
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where Number lets you start page numbering at any page. This is useful if
you’re keeping different chapters in your novel as separate files – a good
idea for safety’s sake, as well as convenience. Type gives you either Arabic
or Roman numerals (lower-case, as is proper). Position has a nice set of
possibilities, including alternating positions accomplished more easily than
in headers or footers.

Force Page lets you move an even page number to the right side, using the
Front option, or move an odd number to the left side. Place Number At
Current Position lets you e. g. enter the total number of pages on the last
page. These last two are rather specialized commands.

2. Choose Line Numbers… from the Layout menu, and explore what you
can do here.

Suppress

On a given page, you might not want header A or B, footer A or B, all of the
above, or page numbers. The Suppress command on the Layout Menu is
meant just for this. Choose it, and you’ll see figure 7.19. This feature lets
you suppress any of this formatting for the page your insertion point is in
when you use this command. One nice use of this feature is to put a page
number, which normally should be at the outside margin of the page (since
they’re easier to see), at the bottom center on, for instance, the first page of
a chapter.
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Figure 7.19: Suppress dialog

If you want to suppress a header on page 35, and you do so
this way, and then add several paragraphs on page 30, you
may push the point at which you entered the Suppress com-
mand from page 35 to 36. Type first, then format. But since
formatting may include changing font, and some fonts take
more space than others, it’s still worth checking where you’ve
inserted things like headers.

Keep Together

This dialog, shown in figure 7.20, offers yet more detailed control over
formatting your page. You can select some lines you don’t want separated
by a page break, and tell this command to keep them together on one page.
Or, you can specify that the next certain number of lines will not cross a
page break.
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One reason for having two different commands here is that if you select two
paragraphs to keep together, and then later put another paragraph between
them, all three are then kept as a block. If you specify that the next 12 lines
should stay together, those lines comprising a paragraph, and then add
material, some of your original 12 lines will no longer be part of this block.

Figure 7.20: Keep Together dialog

A widow is the first line of a paragraph, by itself at the bottom of a page.
An orphan is the last line of a paragraph, alone at the top of a page. This
terminology is common usage among graphic designers for formatting that
many wish to avoid by choosing Widow/Orphan Control from this
dialog. Single lines of paragraphs that would then otherwise cross a page
are kept with the rest of the paragraph.

The advantage is that the single lines can look awkward. The disadvantage
is that there may then be more white space at the bottom of some pages
than others. Look at a few examples of page design that appeal to you, and
decide which you like better.

Dormant Return is an elegant feature. Say you are entering text in
paragraphs separated by a blank line, as we’re doing for this book. (The
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best way to do this is of course to use the Paragraph Spacing Menu on the
Layout Bar.)

If you use a blank line, e.g. a blank paragraph, and it falls just after a page
break, that page then has a blank line at the top. Turning Dormant Return
on fixes it – and should you add or delete text or change formatting, that
blank line becomes active when you need it.

Footnotes and endnotes

WordPerfect gives you reference notes that appear at the bottom of the
page, and a separate set that appear at the end of your file. These notes are
dynamically linked to your document, so that numbering is automatic: if
you add a footnote between existing notes 30 and 31, then number 31
renumbers to 32; and every footnote begins on the page where its reference
lies.

You can designate either with numbers, and the other with letters, to keep
them separate. Characters of your choice, such as asterisks, are another
option.

Footnotes

1. To start a footnote, choose the Layout menu, then Footnotes, then
New. You’re given a new window that, like a header window, is small
and at the bottom of your screen. The correct footnote number appears
at the beginning of the text entry area. There is thus no need to enter a
number.
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If you happen to erase that number, the last button on the Footnote Bar in
that small window re-inserts it. The two buttons to the left, pages with left
and right arrows, move you to your previous or next footnote.

As with headers and footers, footnotes (and endnotes) don’t appear in the
normal text view of your document, but do appear in Print Preview.

WordPerfect offers a lot of flexibility in these notes. Let’s look at the
Options… submenu of the Footnotes menu, as shown in figure 7.21:

Figure 7.21: Footnote options

The Numbers pop-up lets you change footnote designation, in your text
and at the note, to letters or characters. You can select a New Number if
you’re working on a new chapter as a new document, and want continuous
footnote numbering. Restart on Each Page is just your preference, as is
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Note Characters. Should you choose characters rather than numbers or
letters, the second footnote uses two characters, e. g. asterisks, and so on.
Characters are thus less useful for numerous footnotes, but pleasingly
informal in tone if there are not too many of them or you restart on each
page.

Spacing is again a matter of preference. We take out the spacing between
notes, feeling that it creates an unnecessary amount of white space. In the
Options section, the Bottom of Page pop-up gives you the option of
putting notes After Text instead. Keep Together specifies the minimum
number of lines of your footnote that WordPerfect will keep on the same
page as the note’s reference. WordPerfect may put additional lines of the
note on the next page, in an attempt to balance text and notes.

The Separator is what WordPerfect puts between your text and the first
footnote. None or Line Across Page are the other options. In any case,
WordPerfect puts a line across the page when it’s carrying a footnote over
from the previous page.

As with headers and footers, changing the formatting of your
text does not change footnotes. Change the formatting of a
footnote in the same way you’d change formatting of body
text. We’ll see how to make global changes – all footnotes at
once – when we learn style sheets.

Once you change any of these options, your change remains in effect for
the present document. A new file, though, will revert to the defaults you
saw when you first opened the Options window. You can change any of
these as defaults, though, again through style sheets. This is the use of the
last command on the Footnotes submenu, Style. For now, though, let’s
look at Endnotes.
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Endnotes

Endnotes function exactly as do footnotes, but are a separate set of refer-
ences linked to your document. While many popular word processing
programs have one set, which you can place as foot- or endnotes, the two
you have here allow especially extensive and complete support for your
writing, one reason why WordPerfect is consistently a preferred word
processor for academic work.

We use footnotes for examples and for further references,
while endnotes serve for direct citation. We set footnotes as
letters, endnotes as numbers. You’ll likewise find a structure
that serves you best.

Let’s look at Endnote Options. Choose this command, and you’ll see
figure 7.22:

Figure 7.22: Endnote options

which is a bit simpler than for footnotes. Note position is not a question
here; endnotes simply follow the last line of your text. We like endnotes to
start on a new page, so we follow the end of our body text with a Page
Break, selected from the Insert menu (or you can press Command-
Return). We then put the word “Notes” or “References” on a new line, and
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center it, and press Hard Return for a blank line before the notes start.
That’s it: when we preview or print the file, the endnotes start on the
following line.

WordPerfect has a third set of references you can link to a
document, called Table of Authorities. This is used primarily
for legal reference and for academic citations and bibliogra-
phies, where you might want to follow a point with a credit for
it, e. g. “[Dewey 1939]”. You can then mark that citation, and
so include it in an automatically generated list to be put
elsewhere in your document. As this is a more specialized
feature, we’ll learn it at a later point.

Margins and tabs

We’ve covered these earlier, as applied from the ruler. That’s a fine way to
do it but, if you want greater precision, you can access these features from
the Layout Menu.

Margins

1. Choose Margins… or press Command–M, and a dialog like figure
7.23 appears. (As a reminder, we’ve clicked on the “in” measure, to show
how to select other units). You can of course set left and right margins in
the Ruler, but not top and bottom margins. One thing to keep in mind is
that most printers, especially laser printers, don’t print to the edge of the
page. A typical limit is one-half inch from the edge.
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Figure 7.23: the Margins dialog

Another thought is that insufficient margins make a page look heavy.
WordPerfect’s default of one inch all around is fine for text, but display
work (title pages, presentation, signs) benefits from larger margins.

Tabs

1. Choose Tabs from the Layout menu. The dialog, shown in figure 7.24,
shows, in addition to the options available on the ruler, choices for
relative or absolute tabs. With relative tabs, say you have tab stops
every one-half inch (the default). Then you move the left margin inward
by one-quarter inch. All of the tabs move to the right as well. With
absolute tabs, they stay put. This is a feature you might not use often,
but it allows for exquisitely exact formatting with columns and such
when you do.
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Figure 7.24: The Tabs dialog

Another advantage to this dialog box, as opposed to using the
ruler, is that you can set tabs all across the page at once. If
you only want to change a couple of them, though, you of
course want the ruler.

It’s worth taking the time to experiment with the options here,
so you’ll know they’re there when you need them. Sadly, a
number of people install a powerful program like WordPerfect
on a beautiful Macintosh, and then spend years aligning text
by typing spaces!

Align Character is the other feature unique to this dialog box. Used in
conjunction with two decimal tabs, this is a fast way to set up a column,
although WordPerfect’s newer Table feature is easier and more powerful.
With Align Character, text you type before you enter the character goes to
the left of the character; text typed afterwards goes to the right.

Kerning

This feature lets you move two individual letters closer together or farther
apart. It’s helpful in larger type sizes, where the white space between some
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capital and small letters detracts aesthetically from otherwise nice typogra-
phy. An example is figure 7.25, where the “Y” and “o” are shown as typed,
on the left, and after being kerned, or moved together:

Figure 7.25: Kerned letters

If this seems nitpicky, pick up an expensive magazine and look
at display heads in their advertising. The effect without kerning
would look much less professional.

To kern letters:

1. Put your insertion point between the two letters you want to kern.

2. Call the Kern command from the Layout menu. You’ll see figure 7.26.

3. Enter a number of points, and specify move together or apart. Most of
the use of this command is to place letters at display sizes closer togeth-
er, to remove white space. Click OK.

You can also use the two buttons at the right side of the Layout Bar. Succes-
sive clicking, kerning one point at a time, may be faster than using the
dialog and you can see the results of each adjustment.
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Figure 7.26: Kerning dialog

Looking further . . .

Two third-party enhancements supplement WP’s footnote/endnote/cita-
tion facilities. John’s WordPerfect Citations comes with a FileMaker
runtime database (i.e. self-contained , not requiring the FileMaker pro-
gram) for academic references, and AppleScripts and macros to transfer
reference information into footnotes, endnotes, or tables of authorities,
with extensive control over formatting. Users say it compares favorably to
Endnote. John’s WordPerfect Note Editor lets you enter footnotes and/or
endnotes into a table in a separate document, for easier editing, and then
automatically copy all notes to the main document. Both are free at
WPMac.
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Summary

This chapter has covered a lot, with the result that you now have extensive
capability in WordPerfect. Although much of the “wow” stuff is yet to
come, you can see that you’ll be able to learn it easily, because of how
effectively you’ve learned everything so far. You can now work efficiently
with:

• a great variety of alignments and formatting
• all character attributes available in word processing
• a sophisticated graphic environment for word processing, including

paragraph fills and text color
• WordPerfect’s formatting codes and detailed commands, for high

precision, professional output
• specialized parts of documents, including headers, footers, footnotes

and endnotes

As ever, don’t forget to practice all of this, and to save your work often.
These will hold you in good stead, as we hit word processing hyperspace in
the next chapter.



Chapter 8

Columns and Tables

In this chapter, you’ll learn how to:

• create and format newspaper columns
• create and format parallel columns
• set borders and fills for columns and rows
• create tables
• add and delete columns and rows in tables
• format tables, including borders and fills
• perform calculations in tables
• move data from text to a table, and back
• protect data
• design visually appealing, highly effective tables

Columns

WordPerfect has a great column feature: powerful, and easy to use. With
the addition of tables, which we’ll learn next, followed in Chapter 9 by text
boxes, it becomes possible to put text in nearly any configuration, any-
where on the page. To start with columns, you’ll want to decide first which
of two general column layouts you want, illustrated in figure 8.1.
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Figure 8.1: Newspaper and parallel columns

The first, the newspaper type, has text flow to the bottom of the page (or
part of the page) in one column, thence to the top of the column to the
right. The other type is parallel, where you might have product names on
the left, and descriptions on the right.

WordPerfect defaults to newspaper columns and most of our discussion of
columns will concern this type, because the tables feature is simply better
than parallel columns for most uses. So why have parallel columns? Many
people are used to them and, for their basic purpose, they work well.
Tables are a newer feature in word processing programs.

If you do much work where parallel columns might be useful, you might
want to take the time to learn the feature, to compare it with tables.
Otherwise, tables are just easier, besides offering math functionality and
greater flexibility. Anyway, off to newspaper columns. First, the quick and
easy way:

1. Click in your document where you want multiple columns to start. This
might be at the beginning of body text, below a title.
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2. On the Layout bar, click the pop-up that at present says No Columns.
Choose 2 Columns. Presto.

3. Click somewhere else in your file, and choose another number of
columns.

We won’t devote much discussion to optimum number of
columns for given purposes, primarily because no one can
agree on it. In most general terms, an observer of text in page
design might conclude that narrower columns of type are
meant to be read faster, since they can be, and thus carry
lighter weight material. But newspapers of the broadsheet
format (large page, as opposed to tabloid) used to have eight
columns on average, and it’s now more generally six.

Sometimes, a better solution than working from principles of page design
to results is simply to make note of results that you like, and how various
elements of layout, including columns, relate to the personality and
effectiveness of a given style of book, magazine, newsletter or brochure.
The New Yorker and The Economist are two magazines whose designs seem
well suited to their content. But perhaps the most intensive use of text
formatting is found in advertising.

There’s nothing wrong with experimenting with your publication, especial-
ly since it’s so easy.

More flexibility in columns

The Columns menu on the Layout Bar gives you columns of equal width.
For unequal columns, you can drag the margins around on the ruler, or:

1. From the Columns menu, choose Other…. You’ll see figure 8.2.
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Figure 8.2: Column Format dialog

Newspaper is the default. Type in the number of columns, and watch
WordPerfect calculate the margins for each one. Set spacing as you wish –
deselect Evenly Spaced for more versatility.

Column breaks

When you create newspaper columns, WordPerfect fills each with text in
turn, going to the bottom page margin before starting to fill the next
column. You can insert a column break at any point, though, to move all
following text to the next column. To do this, choose Column Break
from the Insert menu, or type Command-Shift-Return.

End multiple column formatting by choosing No Columns from the menu
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A hard page break can also be useful. There’s a menu
command for this, or typing Command-Return does the trick.

Either of these breaks effects a new paragraph, in addition to its main
function – noteworthy if you’re using paragraph indenting, for example.

Parallel columns

1. Pull-down the Columns menu on the Layout Bar (which always starts
off saying “No Columns”), and choose Other…, the last choice. You’ll
get the Column Format dialog again.

2. This time, choose Parallel for type, set number of columns at two, and
click OK. Your insertion point is now in the left-hand column.

3. Type some text, perhaps a product name, in this column.

4. Press Command-Shift-Return, to get a column break.

5. Type some complementary text, perhaps a product description, in the
right-hand column.

6. Press Command-Shift-Return again, to move to the next column. You
cycle back to the left column, moving one row down.

7. Proceed in this way until you want to change the number of columns
again. You’ll do that using the Column Format dialog as well. To end
columns, press Command-Shift-Return to go back to the left of your
page, and then just choose No Columns from the menu on the Layout
bar.
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Column borders

When we learned paragraph borders, you may have noticed that WordPer-
fect allows you to set a border around almost any unit of text or graphic –
page, character, and column. WordPerfect places a border (and fill, if you
want) around the column your insertion point is in, and around all subse-
quent columns until the point where some column formatting change is
reached – you change the number of columns, or the spacing, for example.

With parallel columns, you can limit the number of rows that receive
borders by selecting those rows.

To make a column border:

1. Click in your text, in the column where you want the border to begin.

2. From the Layout menu, choose Borders, and then Column. The
dialog is the same as for all other borders. A particularly nice use of this
feature, for newspaper columns, is to put a simple (and thin!) line border
between columns. This looks elegant and in some circumstances can aid
legibility.

Column fills

Another nice idea, to enhance legibility with parallel columns, is to fill only
some, perhaps alternating, columns or rows. Figure 8.3 illustrates this.
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Icon Name Use

Note Denotes advice, information of a general nature that the
user should know

Caution Requires the user’s immediate attention; she must know
this information

Stop User should stop what she is doing immediately – loss
of data or other misadventure may otherwise result

Figure 8.3: Only the left column has been filled

This is easy to do:

1. Select the row or column, or multiples thereof, that you want to fill.

Be careful when dragging to select text, in columns or else-
where: if you select some, then realize you wanted to select
one more word, so you put your cursor within the selection
and drag, WordPerfect thinks you want to drag and drop the
already selected text, and you end up moving it where you
didn’t want it. If your first drag didn’t select all you wanted,
shift-click to get the rest, or click outside of your selection and
start over.

2. With the appropriate columns or rows selected, go back to the Borders
dialog, and turn fill on. Bingo.

When in doubt, a lighter fill is better. Fills are much more even
and consistent when printed to a Laserwriter than they look on
screen. Printing to a Deskjet or Stylewriter is similar. It’s best
to try a few different fills and compare.
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Tables

1. Click on the Table menu, looking like a grid, on the Layout bar. A grid
will drop, as shown in figure 8.4.

Figure 8.4: Creating a table

This grid, entitled “C x R” for columns times rows, specifies the original size
of your table. You can always expand or reduce the number of cells (a cell
is an intersection of a column and a row, into which you can place data)
later.

2. Drag through the grid, to select the number of columns and rows you
want. Release the mouse at that point. A table appears, with the insertion
point in the first (top left) cell, ready for entry.

WordPerfect identifies cells by column letter and row number. The top left
cell is thus A1.

Go to the Status Bar menu at the bottom left of your screen
and see that Cell Number is checked. When your insertion
point’s in a table, you can see which cell on the Status Bar. 
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3. Pressing Tab moves you through the table, from A1 to B1 and down the
row, and then back to the first column in the next row. Pressing Shift-
Tab moves you backwards. The arrow keys move you in any direction.

4. Enter some text in the left column, and some numbers in the adjacent
column. If you’ve started a new document for this table, and want to put
a title or such above it, go to the Insert menu, and choose Paragraph
Above.

Selecting cells

With some data in the table, you may want to select some cells – perhaps an
entire row or column – for formatting, or you may want to change the size
of a row or column.

Depending where you move your cursor over the table, it will change shape
and so indicate a special function.

The outlined arrow that you see if your cursor is just to the top or left
edge of the table lets you drag to select an entire column or row respective-
ly.

1. Move your cursor until it’s just at the top or left of your table (it needs to
be pretty exact), and see it change to an outlined arrow.

2. Click to select the entire row or column.

3. Drag to select multiple rows or columns.

The diagonal outlined arrow that appears when your cursor is at the
lower right corner of any cell lets you drag up and to the left, to select cells
to the top and left.
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Actually, rather than concern yourself with whether an arrow has appeared
or not, you can just click in any cell and drag in any direction you choose.
The selected area grows in the direction of your motion. Once data is
selected, you can change attributes and formatting just as you would with
text not in a table.

Or, the selected area should grow. WordPerfect Mac’s biggest
drawback is its poor display. Text may be selected but not
appear so, or the converse. If you have a SheepShaver
package from WPMac, its install of WP contains a macro
named “Redraw”, with the keystroke Control-F9 (WPMacApp)
or F9 (SheepShaver-WP). Otherwise, the Redraw macro is
downloadable at WPMac. If selection on a page doesn’t look
right, run this macro to fix it. You can also toggle paragraph
markers or fractional character widths. A macro can make
either a single-keystroke operation.

Changing cell size

The double arrows that appear when your cursor is over a cell border
(either an interior border, or the bottom or right side) let you drag that
border in either direction, to increase or decrease the size of the cell to the
top or left.

You can set cell sizes numerically, and for more than one cell at a time, with
the Column Width… and Row Height… commands on the Table
menu. 

We’ll see how to drag the entire table around on the page in
the next chapter, when we look at text boxes.
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Adding or deleting columns and rows

Bring your mouse up to the Table Bar, which WordPerfect opened when
you created a table. (You can open and close the Table bar manually by
clicking the button on the Control Bar, above all the others.)

The first three icons on the bar let you add a row, add a column, or delete
either. To add a row or column, put your insertion point in a cell first. The
added row will be above the one containing the insertion point, and an
added column will be to the left of the insertion point.

For greater flexibility in adding or deleting, use the Insert… or Delete…
commands on the Table Menu. You can also delete the entire table here.

Moving data within a table

If you want to move text or numbers from one cell to another, the easiest
way is to select what you want to move, then drag and drop it into the other
cell. To select an entire cell, triple-click in that cell.

Triple-clicking in a paragraph of regular text, i.e. outside a
table, selects the entire paragraph.

Formatting a table

As originally entered, either text or numbers align flush left within a cell.
Text is most often best this way, but numbers like to be flush right. Curren-
cy also should have dollar signs, and why not let WordPerfect do all this?
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A sample table is shown in figure 8.5.

Category Type Amount

1 Book sales 25

2 Book signings 2,000

3 Celebrity lectures 12,500

4 Payments from WP not to write any more 250,000

Total

Figure 8.5: Proceeds from “Teach Yourself WordPerfect Mac”

1. Select the cells you wish to format. Let’s start with the first row.

2. Place your mouse just to the left of the first row (i.e. just outside the
table). It will change to an outlined arrow pointing right.

3. Click, and the entire row becomes selected.

4. From the Font Bar or from the Style Menu, choose Bold.

5. From the Layout Bar’s second menu, choose Center Align.

6. Click in the “25” figure in cell C2, and drag down through C5, to select all
the currency amounts.

7. From the Layout Bar, make these numbers right-aligned.

In our sample table, we’re going to calculate a total of the
amounts. Although the cell where the total will go (C6, or the
bottom right cell in figure 8.5) is empty now, we can still format
the cell as currency, so that when a number goes in there, we
won’t have to come back and format just that cell.
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We’ll get to math in a minute, but as prep:

1. Click the Math button at the right end of the Table bar. The Math Bar
opens.

2. Click the pop-up menu between the Σ and Calculator buttons, which now
says Text. 

3. Try these options with your selected numbers. None of them will format
the figures flush right, but the second menu on the Layout bar takes care
of that.

4. Choose Other from this menu for a more extensive choice, as you see in
figure 8.6.

Figure 8.6: Number Format dialog
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Table borders

The Border… button gives you the flexibility with table borders that we
enjoyed with graphic and paragraph (and page and character) borders.

1. With your insertion point in a table, click the Border button on the
Table bar, or choose Table Border… from the Table menu. You’ll see
figure 8.7.

Figure 8.7: Table Border dialog

where the graphic representation is of a single cell, if Selected Cells
appears in the pop-up below the graphic, or of exterior and interior border
lines, if Entire Table is selected, as we show here.
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2. Click on any border line. In the figure, we clicked on the top line. There
are arrows at both ends of the line, showing it’s selected.

3. From the border type pop-up to the left of the graphic, choose a border.
Hairline, the thinnest line your printer can produce.

4. The smaller pop-up above the border type sets border color.

5. Deselect each line in turn, select another, and format it.

Using both the Entire Table and Selected Cells options, you
can format a table very elaborately. Please read the end of the
tables section, on visual appeal, before you do this.

Other formatting options

The Fill menu (which appears as No Fill) gives you the formatting elegance
we explored with parallel columns, so that the reader can distinguish each
row more easily. Again, a lighter fill is most often the better choice. The
Text Align button will move text from the top of a cell (the default) to the
center or bottom. This is useful when one column has more data than its
neighboring rows, and you might wish to center the neighbors.

Math in a table

WordPerfect gives you mathematical functions you can apply to numbers
in any column. If you already know how to use a spreadsheet, this will be a
cinch. If you don’t know how to use a spreadsheet, this is a start on how you
do it, and it’s still a cinch.



288 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

1. Click in the cell where you want the sum of the numbers above. In figure
8.5, this is cell C6 (third column, sixth row).

2. The Math bar should be showing. If not, click on the Math button so that
it highlights, and the Math bar will appear just below the main body of
the Table bar.

3. Click on the down arrow just to the right of the long blank pop-up in the
Math bar. The menu that drops has two choices, Average and Sum.
Choose Sum, and the pop-up now has a formula in it, namely “Sum()”.

4. Click in the first cell you want to sum, and drag through to the last, to
select them. In our sample, we wanted to sum cells C2 (25) through C5
(250,000), so we selected those. As we dragged, the two parentheses in
the “Sum()” formula filled with the first cell name, C2, then a colon, then
the last cell name. So, when we finished dragging, the formula read “Sum
(C2:C5)”.

5. Click in the Check Box (not the X) just to the left of the formula
display. The sum of the selected cells appears in the cell holding the
insertion point, cell C6.

If you had wanted to cancel this operation, perhaps if you had
selected the wrong cells and wanted to start over, you would
have clicked the X Box rather than the Check Box.

If you want to sum a column and put the total in the cell just
below the last number, select the numbers and click the ∑
button just to the right of the formula box. If you select num-
bers in cells in one row, and sum them with this button, the
total appears to their right.
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Updating calculations

In our sample, we now have a total of $264,525. Not bad, but our publisher
just called, to say that upcoming book signings look good, and to expect
$4000 instead. So we changed that cell, but the total didn’t change. To up-
date calculations in a table, once data has changed, click the Calculator
button at the right of the Math bar.

More complex calculations

Besides the available functions, you can type in any formula you want.
Specify cells by their name, and use the operators +, -, * and / for the
operators, including parentheses where necessary to affect the evaluation
order. Click the check box to place a formula, or the X box to cancel it.

Moving from a table to text and back

You may have a bunch of data in what used to be called a table: tabs
between columns, and returns between rows. WordPerfect lets you convert
this tab-delimited text into a real table.

This is a great feature: you can import plain text from lesser word process-
ing programs, with its tabs and returns, and make a true table from it.
Here’s how:

1. Enter some text, in a plain document format, with tabs between col-
umns, and returns between rows. (It doesn’t matter what the tab settings
are.)

2. Select all of it, and go to the Table menu, on the regular menu bar.
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3. Choose Text to Table…. You’ll see figure 8.8.

Figure 8.8: Text to Table dialog

which in the figure shows two columns, the number of tab-delimited quasi-
columns of text we selected.

4. Click OK, and watch your text turn into a table. Very nice.

To move from table to text, select the part of a table you want to reformat,
and take the same course, choosing Table to Text from the Table menu.
Tab-delimited is the best choice here.

But we don’t see a need very often to move data from a table to text. Tables
are functional, clean and easy. Put your appropriate data into a table to
start with, or convert it as soon as you can. It’s just better design than using
tabs and returns, or parallel columns, for most uses other than straight-
ahead text.
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Protecting data

It’s useful to be able to lock all or part of a table, to prevent accidental
editing or erasure as you work with the surrounding text.

1. Select the cells you want to lock.

2. Click the Lock button on the Table bar, just to the left of the Math
button.

These cells are now locked: the insertion point will not move to them, and
you cannot edit or delete anything in them. To unlock cells:

1. On the Table Menu, note that the last command, Protect Table, has
a checkmark next to it. Choose this command, so as to turn it off.

2. Click the Lock button again. All cells are now unlocked.

3. Choose Protect Table again, to turn it back on. This ensures that the
next time you lock cells, you won’t inadvertently unlock them by
clicking the Lock button later, without going through the safety step of
turning Protect Table off.

Designing visually appealing and effective tables

One big reason to use WordPerfect is the quality of output available to you,
but some thought and practice needs to go into use of the various tools and
formatting that make up the whole. We’ll discuss this more later, but let us
make a couple of quick but noteworthy points here, on table design.
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Consider the excellent book Envisioning Information by Edward R. Tufte
(Graphics Press, 1990). He explores many kinds of representation of
information: tables, maps, mechanical diagrams, to show what is effective
and what isn’t, and why. Figure 8.9 shows a railway timetable:

Figure 8.9: A New Jersey Transit timetable (redrawn), 1985

Tufte notes that:

“Proportion and harmony” need not be vague counsel; their mean-
ings are revealed in the practice of detailed visual editing of data
displays. For example, in this train timetable a heavy-handed grid
interacts with the type, generating a stripy texture and fighting with
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the scheduled times. The prominent top position in the table shows
the least important information, a four-digit train identifier used by
railroad personnel and nobody else (p. 54).

Compare the remarkably different appearance of figure 8.10.

Figure 8.10: Another design

A redesign calms the dominating grid, moves the New York departure
times to the very top, de-emphasizes less important data . . . . The
focus is now given over to information, transparently organized by an
implicit typographical grid, defined simply by the absence of type
. . . (p. 55)
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The fact that the reader is looking at a table should be as unobtrusive as
possible to her: the structure of the presentation of information should not
interfere with the information itself. To make an analogy: when you’re
watching an interesting film, you are only slightly conscious that you’re
seeing a film. Anything that makes you more aware that you’re viewing a
film: a bad print, or difficulty with the projector, interferes with your
understanding of the message the film wants to convey.

Looking further . . .

John’s WordPerfect Table Manager adds several interesting commands to
tables. While it’s not difficult to manually create a table in a text box (see
Chapter 9 for that feature), Table Manager automates the procedure,
thereby giving you a table you can drag around the page, or anchor to a
page or a paragraph. It also lets you caption and cross-reference a table,
and make lists of tables in a document, perhaps placing that list just before
the index in a longer document.

Table Manager also increases math functionality, letting you put numeric
values in e.g. cells A1 and A2, and filling the column from there, as in figure
8.11.
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Figure 8.11: Automatic table increment

You can automatically stripe a table by columns or rows, such as shown in
figure 8.10, making it easier to read. And, navigation commands let you
locate or select a given number of cells, columns or rows. Free at WPMac.

Summary

You’ve expanded your word processing horizons considerably in this
chapter, with the extensive formatting possibilities and vital communica-
tion tools afforded by columns and tables. You can now:

• design, edit and format multiple newspaper or parallel columns
• create and modify tables
• set borders and fills for columns and tables
• perform math, including entry of formulas, in tables
• exchange data between tables and text
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• lock cells in a table, to protect data
• judge relative visual effectiveness of table designs

Depending on how you work, tables – perhaps with invisible cell borders –
can make formatting much easier, explaining why their use is becoming
more common all the time.



Chapter 9

Advanced Formatting

You’ve learned a great deal so far, and can easily call yourself a competent
WordPerfect user. But in truth, it’s just at this point where we’re able to
show you how much this program can do for you. In this chapter we’ll
cover:

• creating and editing style sheets, for automatic formatting
• basing one style on another, and linking styles
• text boxes
• extensive control over hyphenation
• outlining and automatic paragraph numbering
• make it fit

Style sheets

In past chapters, we used the word ‘style’ to refer to bold, italic, and other
text attributes on the Style Menu, seen as individual elements of format-
ting. Let’s look at something different, a style sheet (which many people
term a style, causing some confusion).

A style sheet is simply a collection of formatting choices that, taken all
together, define how words look on a page. If, for the text of your quarterly
reports, you use the Times font, 12 point, 1.5 spacing, left-aligned, you can
call all of this your “Quarterly Report Text” style sheet. And you can tell
WordPerfect that, and put it on a menu, so you can go to it right away.
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One advantage style sheets offer is consistency. Your Quarterly Report
may have headings, subheadings and captions as well as body text. Your
readers get used to your formatting choices and find the report more
accessible. Consistency in formatting aids comprehension of content.

Another advantage is convenience. When writing your quarterly report,
you might use different style sheets: the one we described above for the
text, plus another at the end of each chapter for notes and apocryphal
discussion, which might be 10 point Helvetica, single-spaced. Then, to start
the next chapter, you’d want a title style, in 18 point Avant Garde, cen-
tered.

To switch from one style to another by a menu would be no great trouble,
but WordPerfect offers the added convenience of linking style sheets, so
that you can type some text in one and, when it’s time to switch, press the
Enter key and you’re in the next style.

You can of course apply styles to text you’ve already typed, and edit
styles as you wish. You can define styles for specific parts of a document –
a header, say, or a footnote – and so set the formatting of all your footnotes
at once.

If you then decided that the body text for your quarterly reports would
look better in 12 point Times than in 10 point Palatino, you could make
that change in the style sheet, and when you opened any document con-
taining that style, all the body text in 10 point Palatino would update to 12
point Times. 

For this reason alone, if you do very much word processing
past simple letters and memos, style sheets should be an oft-
used part of your digital toolkit.



Chapter 9: Advanced Formatting 299
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

To top things off, you can save styles either in WordPerfect’s Library,
which WordPerfect uses for all new documents, or you can save styles
within a specific document, where they will override Library styles of the
same name. You can thus have different styles for e.g. subtitles in different
documents.

This would be less of an advantage if you had to define these document-
specific styles each time, but WordPerfect has a Templates feature that
lets you define any formatting you want in a file, and save it as a default.
Then call this example from a menu, enter text, and when you save the file,
it’s just as though it were a new document, but with all the formatting you
specified for that template.

So – do you want to learn styles yet? Off we go.

Creating a style

First, click the Styles button on the control bar, so that the Styles Bar
appears. The pop-up at the left lists all styles available at the moment.
Update is grayed out. No problem; we’ll use the next button, New. 

1. Select any text in your document with attributes and formatting you
want to make into a style.

As we mentioned in Chapter 7, the terms attributes and
formatting are used more or less interchangeably. We need to
make a distinction, though, so let’s call attributes anything you
can set on the Font bar, and formatting anything you set on
the Layout Bar or the Ruler Bar. Font, size, and plain/bold/ital-
ic are all attributes, and alignment and spacing are formatting.
Tabs and margins are also formatting. You could think of an
attribute as anything intrinsic to a character, such as its font.
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Formatting is anything extrinsic to the letter, such as line
spacing.

A style sheet can include both attributes and formatting, or either one, as
you prefer.

2. Click New on the Styles Bar. A dialog like figure 9.1 appears.

Figure 9.1: New Style dialog

which asks you first for a name for your new style sheet. Use something
both short and descriptive (not a bad idea in general, on the Mac). Save In
is a pop-up that lets you choose between the currently active document,
and WordPerfect’s library.

At this point, we recommend saving resources like styles, and macros
(which you’ll learn in Chapter 13), in the Library.

The library is where WordPerfect gets information for many
things, including styles, for all new documents. A style saved in
the library is more readily available, but a style saved in a
document, including a stationery document, overrides a library
style.
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Preserve lets you choose Attributes, Formatting or both. Remember,
attributes are qualities intrinsic to a character, such as font, size and
plain/italics/bold. Formatting refers to qualities extrinsic to a character,
such as margins and spacing. Attributes are managed on the Font Bar, and
Formatting on the Layout Bar. Your choice to preserve one or the other or
both in a style sheet is a matter of how you like to work. 

Apply to Selection (which will be active if text in your document is
selected) is an initially confusing idea. When you selected text to create a
new style, the text was e. g. 12 point Times, 1.5 spacing, etc. You distilled
that formatting into the Quarterly Report Text style, but the text you took
the description from still knows nothing about a style sheet. Once you
create a style, you need to apply it, generally by selecting it and choosing
the style from the menu in the Style Bar. In this case, since you already
have text selected (which you used to create the style), you can then
specify that the new style govern that text.

Otherwise, the text stays 12 point Times, no matter what goes on with
styles. If you apply the style to the selection, though, and then later edit the
Quarterly Report Text style to 10 point Arrus, this text will change with it.

3. Leave Apply to Selection checked, name your style, preserve both
attributes and formatting, and save it in the library. OK this dialog, and
you’re back in your text.

4. Pull down the Styles menu on the Styles bar, to verify that your new
style is there.

Now that you have a style on your menu, let’s practice applying it to text.
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Applying a style

If you choose your new style when you’re halfway through a letter, with the
insertion point after all existing text, the style will then apply to everything
you subsequently type. If you select text first, and then choose a style, that
style will apply to all the text in the paragraph that contains the selection.

If you don’t select anything, but have your cursor within a paragraph when
you apply a style, the style will then govern all the text in that paragraph
and succeeding paragraphs, to the end of your document or until some text
that already has a style applied to it.

While this may seem arbitrary, it’s a powerful way to do things.
It’s easy and fast to apply a style just to the paragraph you’re
in (select any part of it first, even one letter) or apply a style all
the way to the end of your file unless some subsequent text
has had a style applied.

1. Select some text in a paragraph that is unformatted.

2. From the Styles Menu (in the Styles Bar, not the Style Menu on the top
Menu Bar), choose your new style. Presto. The paragraph now has the
attributes and formatting of your style and, should you edit that style at
any later date, then open this document again, this paragraph’s attrib-
utes and formatting will reflect that edit.

Editing a style

1. Choose your new style from the Styles Menu, and click the Edit button
on the Styles Bar. A dialog appears with the current style highlighted.
Click Edit, and a window will open at the bottom of your screen, some-
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thing like a footnote window, as shown in figure 9.2, but with the format-
ting codes showing, as you learned in Chapter 7. Let’s first change the
font in your style sheet.

Figure 9.2: Editing a style

2. From the Font Menu at the top of your screen, choose a font you like.

and you see that the code for this new font has been added to the line. We
pressed the Delete key (Backspace on some keyboards) to delete the code
for the Times font first, but it’s not necessary.

If, though, we had pressed the keyboard’s left arrow a few
times first, to put the insertion point to the left of the code for a
font and then chose another font from the Font Menu, it
wouldn’t have done much good. It’s the last code, whether for
font or anything else, that governs the text following it. This is
true as well in the Show Codes window for a regular text
document.

3. Close the style editing window. All text in all open documents, and in any
you open subsequently, that has been assigned to this style, will now be
in the new font.

If it were more convenient, you could of course have made
that font change from the Font Bar’s Font Menu, or from the
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Character Format dialog box, reached by the Other… button
on the Font Bar, or the Other… command from the main Style
Menu at the top of the screen. If you want to use the Font Bar,
however, be sure you use the one for the style editing window,
rather than the one for any text document you have open.
Clicking anywhere in that text document just brings that
window to the front, and you’ll need to go to the main Window
Menu to get your style editing window back.

In just this way, you can make any changes you want to the styles in your
library or in separate documents. Anything you can’t change will be grayed
out in the Font and Layout Bars in the style editing window. The Table
command, for instance, on the Layout Bar between paragraph spacing and
view percentage, is gray. It wouldn’t make sense to include a table in a
style.

Updating a style

Editing a style offers more precision than we sometimes need. WordPerfect
lets you update a style without bothering to go to the editing window and
fuss with all those codes.

Actually, WordPerfect lets you do almost anything without
fussing with codes. You can opt for convenience most of the
time, and use the surgical precision of codes when necessary.

1. Select some text governed by a style sheet.

2. Choose another font and, if you like, some formatting change, perhaps
spacing, from the Layout Bar.

3. Click Update from the Styles Bar.
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4. Change Update Attributes to Update Attributes and Formatting
if your update has included the latter. There – the style is updated.

Linking styles

Let’s say your quarterly report is mostly text, but with many subheads
throughout, which you want to format in a much different style, say in 18
point Humanist Bold Condensed, and you want these subheads indented
one inch from the left margin. You can create such a style, and then move
back and forth manually, as you enter text, or you can link the text and
subhead styles, and go back and forth much more easily, just by pressing
the Enter key.

1. Create a subhead style. Preserve formatting as well as attributes.

2. Click the Options button on the Styles Bar. You’ll see figure 9.3.
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Figure 9.3: Style Options dialog

with a list of available styles at the top, most of which came with WordPer-
fect. Our “Quarterly Report Text” and “Quarterly Report Subhead” are
among them, though; you just need to scroll to see them, as shown.

3. Click on the “Quarterly Report Text” style, to select it.

4. Click on the Link To pop-up. A menu of available styles appears.

5. Choose the “Quarterly Report Subhead”, or your equivalent.

Your text style is now linked to your subhead style, and here’s what that
means: any time you’re in the text style and you press Enter, your active
style changes to subhead. Let’s get even fancier:
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6. Link the subhead style to the text style. Your subhead and text styles are
now linked to each other.

So pressing Enter while you’re in either style moves you to the other style.

7. Practice entering text, changing styles for a subhead, and then changing
back.

You can later unlink styles, or link more than two. If you want
complex formatting, link five or six. This feature sure helps
with the speed of your work and, more than that, with the
accuracy. Each section of your document will look just as you
want it to.

Basing one style on another

As you work, you may develop a style with quite a few elements: margins,
spacing, alignment, paragraph spacing, fonts and sizes. You may then want
to create a style almost like this one, but with one or two distinguishing
features: italic, say, or indented at the left and right margins. WordPerfect
lets you make a new style but, instead of re-creating all its features, it can
be based on any other style.

1. Create a new style, and give it only the distinguishing attribute or
formatting, perhaps italic or indenting. The easiest way to do this is to
select some text that’s italicized or that has the margins you want.

2. Open the Style Options dialog, as you saw in figure 9.3, and click on the
Based On pop-up. Choose the style you want.

The distinguishing attributes and formatting you’ve added to
this style take precedence over any conflicts with the style
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you’re copying from. For example, you might have had
different margins in the base style, and want to change them
for this new style.

While you’re in the Style Options dialog, you can type in a description of
the style. This has no effect on the style or other parts of program opera-
tion; it’s just a convenient reminder.

Editing the Document Style

We’ve worked with style sheets that change attributes and formatting from
the Document Style: 12 point Geneva (14 point Lucida Grande in the
SheepShaver packages at WPMac) flush left, no indents, and so forth, that
WordPerfect uses for every new document. If you want to change these
defaults, you can. We’ll talk about customizing WordPerfect extensively
later on, but an important means to set the program up to your liking is to
edit the Document Style.

Do this just as you would edit any other style. Some discretion is advised,
though, because what looks best printed often isn’t what works best on
screen, and the Document Style will govern the screen appearance of all
new documents. We don’t print in the default Lucida Grande font very
much, but it’s clear for screen display. 14 point is also a little big for the
printed page, but a good choice for the Mac screen.

These questions become more important when you consider that it’s best
to keep your computer screen at least an arm’s length away from you, and
you might try to work with the brightness turned down a little, so your eyes
don’t tire as easily. It’s also best to sit without hunching forward, so that
computer as backache remains a metaphor. All of these suggest the advan-
tages of a clear screen display. There’s no reason, though, not to edit the
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Document Style for formatting, if much of your writing uses indented
paragraphs, for example.

Another option, if you share a computer, is to make your own standard
style. You can also assign a keyboard equivalent to a style (in fact, to
about anything WordPerfect can do), to access that style more quickly.

Assigning keyboard equivalents

1. Click Options on the Styles Bar, and choose the style you want to assign
a keyboard equivalent to.

2. In the box at the right labelled Keystrokes, click Assign.

3. Press any combination of modifier keys and regular keys that you want
to use to choose this style. The modifier keys are Command, Option,
Shift and Control. Additionally, only in WordPerfect) the 5 or 7 on the
keypad, called the Gold Key, is another modifier. It does not work in
conjunction with other modifiers.

If the keystroke is already in use, a dialog will tell you.

You would remove a keystroke from the Style Options dialog in the same
way. Choose the style from the list, and its keyboard equivalent(s) will
appear in the Keystrokes window. Click on it to select it, and then click
Remove.
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Using the Librarian for styles

The last thing you need to learn about styles is how to rename, move or
delete a style. There’s another command and set of dialogs for these
procedures. With a document open:

1. Choose Preferences… from the Edit Menu. You’ll see figure 9.4.

Figure 9.4: Preferences dialog

2. Click Librarian. Figure 9.5 appears.



Chapter 9: Advanced Formatting 311
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

Figure 9.5: WordPerfect’s Librarian

with a pop-up at the top left. It says Styles at this point, which is what we
want. We’ll learn about the other options at a later time.

In the two main windows in the dialog, the one on the left has a list of styles
in WordPerfect’s library: you can see that a number of styles ship with the
program, for specialized parts of documents such as footnotes. There isn’t
much formatting in these styles; they’re included so that you can set a
footnote style, probably after finishing your report, and in that way format
all your footnotes at once, instead of opening the window for each one in
turn.

3. Click on “Quarterly Report Text” or your equivalent, to select it. The
action buttons in the middle of the dialog become black – ready for use.
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4. Click Rename, and give the style a shorter name, say “QR text”.
WordPerfect pros like yourself like to use shorter names, just for
efficiency.

The Librarian will let you copy a style from the library into a specific
document and vice versa. This is useful if you created a style in one place,
and then wanted it in the other. Another nice use for this feature is that you
can create a wealth of styles in the library, copy them into a document, and
give that to a colleague who uses WordPerfect. This saves her the time of
creating these styles and, more importantly, ensures that her Quarterly
Report style and yours are the same style, for a consistency that’s critical
to professional output.

This is a good reason not to make the names of styles, or anything else, too
short, and to try for some descriptive quality. “Style 12” doesn’t tell your
colleague what it includes.

SpeedStyles

The style sheets we’ve learned so far operate at the paragraph level:
everything about them affects one or more entire paragraphs. WP has
another set of style sheets that operate at the character attribute level, so
you can have any number of SpeedStyles in one paragraph.

To create a SpeedStyle:

1. Select some text with any font, size, and text color you’d like to save,
and choose the SpeedStyle pop-up on the Font Bar. You’ll see figure 9.6.
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Figure 9.6: Creating a SpeedStyle

2. Assign a keystroke and add a description if you like, and click New.

Thereafter, choosing that SpeedStyle from the Font Bar menu or typing the
keystroke will apply those character attributes to existing text that’s
selected, or to text you’re about to type.

Edit any existing SpeedStyle from that command on the Font Bar’s pop-up
menu. Move SpeedStyles from the Library to specific documents and back
using the Librarian.

Unlike regular style sheets, SpeedStyles do not update
existing text to which they’ve already been applied, when you
edit a SpeedStyle.

Text Boxes

When we learned graphics, we saw how to draw or import any kind of
illustration, take it out of the Graphic Editor into the text document, give it
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any kind of border, and drag it into position wherever you want on the
page.

WordPerfect lets you create a separate text box in your document, and do
all of this magic as well. This gives you great flexibility in how you design a
page. Dedicated page layout programs have this kind of model: everything
is its own box: text or graphics.

You can also caption the text box or graphic, and automatically generate
lists of them. You can refer to that caption in your regular text, e. g. “See
Table 6”, where 6 is an automatic number. Should you add a table between
5 and 6, Table 6 renumbers to 7 in the caption and everywhere in your
document where you refer to Table 6. This is what you got a Macintosh
for. We’ll learn this cross-referencing in the next chapter; let’s cover text
boxes now.

Creating a text box

1. From the Tools menu, choose Text Box and then New. You’ll see a
dotted rectangle, with an insertion point blinking inside.

2. Type (or paste in) some text. The box grows vertically to accommodate
it.

3. Click outside the box, then click on the box again. The text box now has
a border with handles around it that you recognize from your work with
WordPerfect graphics, as shown in figure 9.7.
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Figure 9.7: Text box

4. Drag the box anywhere on screen. Regular text in your document will
wrap around it.

5. Dragging the two handles – the small black boxes on the bottom and
right sides of the text box – makes the box larger or smaller. Doing this
does not change the size of the text within the box.

If you wanted to increase or decrease or distort text by drag-
ging a handle, you would enter text in the Graphic Editor, and
then manipulate it in text view.

6. Double-click in the text box to reopen it for editing.

Adding a frame

1. Click outside the text box, to leave editing mode, and then click once on
it, to select it.

2. From the Text Box menu on the Tools menu, choose Frame….
You’ll recognize the dialog from the graphics environment. Set a frame
type, and fill if you want. You can also change spacing, both inside and
outside the frame. Click OK.
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Text box options

1. With your text box selected, choose Options… from the same menu.
You’ll see figure 9.8.

Figure 9.8: Text Box options

to allow precise positioning and several other features. At the top of this
dialog, the Anchor To pop-up menu lets you position the text box at a fixed
place on the Page, or fixed with respect to a Paragraph, or treat the text
box as a Character, so that it will move as you add or delete text above it.

On the right, Wrap Text Around Box is the normal setting. Otherwise,
regular text runs over text in the box.
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Text box style

The last command on the Text Box menu opens the style sheet window for
all text boxes in WordPerfect or, at your option, just this document. As with
styles for other special parts of your document, such as footnotes and
headers, styles are useful to format text after you’ve entered it. Create a long
document with 20 text boxes, leave them all in 14 point Lucida Grande as
you type, and then format them all at once.

Using text boxes

Among the uses for this versatile tool, annotation is a nice one. Include your
notes on the main document this way, when you pass a file to a colleague for
her thoughts. See the Looking further . . . section near the end of this chapter
for a way to automate annotations, with numerous formatting options.

Drop Caps

Other uses include elegant formatting such as drop caps. Figure 9.9 is an
example, where the first letter of a stanza or chapter is in a larger font, and
perhaps a decorative one. Here’s how to do this:

1. Cut to the clipboard the letter that you want as a drop cap.

2. With the insertion point where you want the drop cap to appear, create a
text box.

3. Paste the letter in the box. While still in the text box:
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HE curfew tolls the knell of parting day,
The lowing herd wind slowly o’er the lea
The plowman homeward plods his weary way, 
And leaves the world to darkness and to me. 
T

Figure 9.9: Drop cap at the start of Gray’s Elegy

4. Select it (command-A will work fine), and choose the size that you want.
Three or four times the size of the rest of the text is about right, depend-
ing on the look you want. Change the font as well if you like.

5. Click outside the text box, and then click on it to select it.

6. Size the box so that it fits the letter.

7. If other text is not wrapping cleanly around the box, with the text box still
selected go to Tools > Text Box > Options and set Anchor To: to
Paragraph.

You might want to fine-tune the size of the text box, so that your regular text
wraps cleanly around it.

As complementary formatting, you might like to set the first two or three
words following the drop cap in Uppercase or in Small Caps, done by select-
ing the text and choosing this command from the Style menu.
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Pull quotes

Many magazines take a few words from the text of a story, format them to a
larger size, and put this in a box within the story column, helping to draw the
reader’s interest, as in figure 9.10.

Suppose that someone confronts the choice between them having as yet embraced
neither.  He can be offered no reason for preferring one to the other.  For if a given
reason offers support for the ethical way of life — to live in that way 

If it already has force
for him, he has already
chosen the ethical .  .  .

will serve the
demands of duty or to live in that way will be to
accept moral perfection as a goal and so give a
certain kind of meaning to one’s actions — the
person who has not yet embraced either the ethical
or the aesthetic still has to choose whether or not to

treat this reason as having any force.  If it already has force for him, he has already
chosen the ethical; which ex hypothesi he has not.  And so it is also with reasons
supportive of the aesthetic.  The man who has not yet chosen has still to choose
whether to treat them as having force.  He still has to choose his first principles, and
just because they are first principles, prior to any others in the chain of reasoning, no
more ultimate reasons can be adduced to support them.

– Alasdair McIntyre, After Virtue

Figure 9.10: Pull Quote

WordPerfect makes this easy to do:

1. Copy the text you want to put in a pull quote.

2. Create a text box, and paste this text there.

3. Set border and fill, and position the text box as you like. Again, some
fine-tuning is helpful, but practice makes this sort of thing much faster.
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Hyphenation

As you’ve typed regular text, you may have felt the need to hyphenate a
long word, so that right-ragged text wouldn’t be so uneven, or so that
justified text wouldn’t have so much spacing between words. With smaller
margins for text, such as in tables or text boxes, a more even right margin
becomes yet more important for a polished appearance.

WordPerfect has a great hyphenation feature that you can use in any body
of text. Unlike almost all other word processing or page layout programs,
WordPerfect hyphenates words according to its extensive dictionary only,
so that it will always be accurate. Other programs use an algorithm – a set
of instructions, like a recipe – to choose where to break syllables, and this
method often makes mistakes. The user can then spend a lot of time
making corrections, or let things go and end up with some funny line
breaks.

To hyphenate manually: if you want to insert a soft hyphen:
one that will appear if the word falls at the end of a line, but
not show otherwise – when you change fonts or sizes, for
example – press Command-Hyphen. If you want a non-
breaking hyphen, so that “Stratford-on-Avon” will not be
separated by a line break, press Command-Shift-Hyphen.

 For most cases, when you’d like WordPerfect to hyphenate words auto-
matically:

1. From the Layout menu, choose the last command, Hyphenation….
You’ll see figure 9.11.
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Figure 9.11: Hyphenation dialog

2. Click the Type pop-up, and choose Automatic. This causes WordPer-
fect to look in its dictionary for each word that ends a line, to see if there
are hyphenation points: places where syllables can be separated, to
make each line of text more even.

This command works equally well whether you turn hyphen-
ation on first, and then type, or type first and then use this
command. Either way, this is a simple yet pleasant part of
WordPerfect: accurate hyphenation adds to quality of format-
ting. If you want to turn hyphenation on as a default (we have),
go into style sheets to edit the Document Style, and choose
automatic hyphenation there.

The other available type is Auto-aided, in which WordPerfect asks you
whether you want to hyphenate a word, every time it finds one it can. We
don’t use this feature, although it does give you more control over the
appearance of your text. Setting the hyphenation zone (see below) works as
well, and is more convenient.

Hyphenation zone

Fine printing is careful about hyphenation. WordPerfect can be as careful
as you’d like. You can hyphenate nearly every polysyllabic word that falls
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at the end of a line, or only longer words. WordPerfect uses a hyphen-
ation zone, or H-Zone, to decide how long a word has to be before it’s
hyphenated. Setting a larger H-Zone causes fewer words to be hyphenated,
for a more aesthetic effect when you have a longer line length. Setting a
smaller H-Zone causes more words to be hyphenated, giving a more even
right margin, an important consideration with narrow columns. With
justified right text, a smaller H-zone produces less extraneous spacing
within lines.

Newspapers hyphenate more than academic texts with wide margins. Text
in smaller point sizes requires less hyphenation.

How the left H-Zone works is illustrated in figure 9.12. The right half of the
illustration has a lot of hyphenation, and the right margin is thus more
even. How much hyphenation to use is a judgment call. WordPerfect’s H-
Zone offers unmatched precision for this.

The right H-zone is often best left at zero. A positive value here tells
WordPerfect to squeeze onto a line words that extend a little past the right
margin. Use this feature sparingly, or type in a line may end up looking
compressed. Newspapers with narrow columns need this.

Some hyphenation is helpful for a less ragged right margin, if you’re using
left-aligned text, or for less obtrusive inter-word spacing, if you’ve chosen
justified text. We’ll talk more about this in the section on page design, since
the color and flow of text matters, and hyphenation is an influence. Book
designers know that we can read comfortably many hours longer if the
font, size, spacing and hyphenation are right.
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Figure 9.12: H-Zone without hyphenation, left, and then with.
Words that start to the left of the H-Zone and extend to the right

margin are hyphenated. Words that start within the zone and
reach the margin are wrapped to the next line. 

If you have narrow columns, or are working with text in a table
or text box, a small H-Zone is advisable. With wider margins, a
larger H-Zone causes fewer words to be hyphenated, a
desirable effect. WordPerfect defaults to a .694 inch (50
points) H-Zone. Change this as you wish, and you can change
the default by editing the Document Style.
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Outlining

An outline is a structured list of topics in various levels of abstraction and
detail, indicated by indentation. As a map to a text document, an outline
gives you a sense of development and emphasis in your thesis. We can’t
think of a reason not to begin writing anything of any length and depth with
an outline. WordPerfect has two outlining facilities: basic and enhanced.

Basic outlining

1. Choose Outlining… from the Tools menu. You’ll see figure 9.13,

Figure 9.13: Outlining (basic) dialog
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with numerous options for outlining styles.

2. OK this dialog as is. Note that Outline On is checked.

3. Type a title for your outline. There’s no change in format yet.

4. Press return. You now have a Roman numeral I to the left of your
insertion point, a label. Type a major thought here, and press return.
You have a new line, with the Roman numeral II to start it.

5. For a thought at this same level of abstraction, simply type. If you want
to go to a greater level of detail, though:

6. Press Tab, and the current line is indented, with a heading denoted by a
capital A. Type something here, and press return.

7. You again have a new line, with Roman numeral II. Press Tab again, and
your line is indented to match the line above, but this time with the
capital letter B.

8. You can type something here, or press Tab again, and get a further
indentation, with the Arabic number 1.

9. To go back to a level of greater abstraction, press Shift-Tab. Pressing
Tab indents you further.

To edit an outline:

1. To rearrange labels in an outline, select, drag and drop both the label
and text elsewhere.

2. If you delete a label, other labels renumber to accommodate the change.
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Choose the Outlining command again to turn this formatting off. Your
outline is then a regular text document for normal editing purposes. You
can turn outlining on again at any point.

Enhanced Outlining

Figure 9.14 shows the most-used commands.

Figure 9.14: Enhanced Outlining Button Bar
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While Basic Outlining is just that, Enhanced Outlining has a feature set and
power equal to anything that’s ever been written for the personal comput-
er, on any OS, including the venerated outliner and presentation program
More. This may be because WP’s Enhanced Outliner was almost a direct
copy of More’s. WP then adds the benefit of its advanced word processing
features, and as well a fair amount of input from the outliner in FullWrite,
another powerful word processing program for legacy Macs.

A review in the magazine “About this Particular Macintosh” (vol. 10 no. 3,
p. 27) judged that WP’s Enhanced Outliner “beats the modern [i.e. OSX]
Microsoft Word in several respects” and could be “the most writer-friendly
outliner available”. (p. 28)

1. From the Button Bar’s menu, choose Outlining Bar.

2. Click Mode Menu to set styled text, single indent, as in figure 9.15.

Figure 9.15: Outline Mode menu

3. Click Label Type Menu and choose B: Outline, as in figure 9.16.
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Figure 9.16: Label Type Menu

4. Use the next three buttons on the Outlining Bar, Outline Return,
Outline Tab and Outline Back Tab, create a short outline something
like this:

I. This is a first topic.
II. This is a second topic, at the same level.

A. Click Outline Return and then Outline Tab to get here. Any
amount of text is indented to the topic label.
1. Outline Return and Outline Tab again.

a. And again.
b. Just Outline Return this time, although there are

four more levels available.
2. Outline Return and Outline Back Tab.

B. Outline Return and Outline Back Tab again.
III. Outline Return and Outline Back Tab once more.

Each level has a different color because each level has a different style
sheet: “Outlining Level 1” and so on up to 8. You can edit these as you
would any style sheet, or choose Plain Text rather than Styled Text from
the Mode Menu when starting, or outline in styled text and then Select All
and choose None from the Styles Menu.

5. Click anywhere in topic II.A. and, on the Button Bar, click Outline Back
Tab. The topic and its subtopics are moved one level left.
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6. The next two buttons let you collapse a topic: hide its subtopics. Click
anywhere in topic II.A. and collapse it. Note the bullet after the topic
label A, indicating it’s collapsed. Click the next button down to
uncollapse it.

7. The next two buttons let you fold and unfold a topic: show only the
first line. Our short outline above doesn’t need much of this, but with
longer topics it’s helpful to condense topics for a better overview of the
document’s conceptual structure.

8. The last set of buttons are for all Enhanced Outlining Features, Utilities,
and Help. The Quick Start, Ready Reference and Command Overview
help sections explain the feature set, and the demo shows the difference
between formatting in basic and enhanced outlining.

Note that at any time, enhanced outlining mode is neither on nor off: you
can press Hard Return after a topic and type regular text for a while. When
you want another topic, just click the Outline Return button again.

So much for an overview. Adequate discussion of this feature is beyond the
scope of this book so, if you do much outlining, take a look at the “En-
hanced WP Outlining” documentation at WPMac.

Paragraph numbering

As you see in the Outlining dialog box in figure 9.13, there are a number of
options for labelling and formatting. To try one of the most useful, in that
dialog change Type to Paragraph, and set Level/Style for Arabic
numbers. You can restart numbering at different points in your document.
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Subtitles

Inserting subtitles is useful for word-by-word translations, but can be used
to insert anything else as well. It’s best to size and format original text first,
then add subtitles.

1. Select a line of text to which you wish to add subtitles.

2. From the Language menu, choose Subtitle. Figure 9.17 appears.

3. Enter the subtitle (up to 255 characters). Choose font and style. Size is
designated in relative sizes, as you learned in Chapter 7. WordPerfect
defaults to Fine (50% of Normal, unless you change it) but we used
Normal for figure 9.17. We formatted the original in bold, and subtitles
plain.

Da neigt sich die Stunde und rührt mich an
Now the hour bows down, it touches me, throbs

mit klarem, metallenen Schlag:
metallic, lucid and bold:

mir zittern die Sinne. Ich fühle: ich kann –
my senses are trembling. I feel my own power –

und ich fasse den plastischen Tag. 
on the plastic day I lay hold.

– Rilke, The Book of Hours (Deutsch, trans.)

Figure 9.17: Subtitled text

As you see, subtitles are spread evenly along the line.
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To remove a subtitle, open the Codes Window, locate the subtitle code,
and delete it. To edit a subtitle, click anywhere in the subtitle line (the
insertion point will appear to blink within the original text, not the
subtitle), and reopen the Subtitle dialog.

Make It Fit

A document may at times need to be a precise number of pages, or more
or less than a certain number. Instead of manually adjusting attributes,
e.g. font size, or formatting, e.g. margins and spacing, you can ask WP to
produce the desired number of pages for you.

1. From the Layout Menu, choose Make It Fit. Figure 9.18 appears.

Figure 9.18: Make It Fit dialog
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Depending on your document, you may want WP to adjust any of the six
possible items or only e.g. all margins.

Looking further . . .

Enhanced WordPerfect Outlining, the complete documentation, is
available in both PDF and OS9 Reader formats.

For better keyboard control over outlining, see John’s WordPerfect
Outlining Keystrokes 2.0. This also fixes conflicting keystrokes between
the Enhanced Outliner and recent Mac OS versions. A separate macro
allows automatic paragraph numbering with Arabic numerals, and all
outlining keystrokes can be toggled on and off, for greater convenience.

We mentioned using text boxes for annotations. This is automated by
John’s WordPerfect Notes Pro, which supports one-step creation of text
boxes with any of eight background colors – perhaps for different
authors of annotations in a shared document, or different purposes or
priorities. Notes can be hidden, either all notes or notes of specific
colors.

All free at WPMac.

Summary

You’ve really learned a lot in this chapter, including:

• style sheets, and their significant contributions to ensuring consisten-
cy and saving time
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• text boxes, which by themselves qualify WordPerfect as a page layout
program

• hyphenation, and its value to legibility and readability
• outlining, a tool critical to quality in writing

This has been a substantial amount, but we think you’ve surprised
yourself already not only at what you have learned, but the rate at which
you’re learning now. The Macintosh and WordPerfect create a friendly
as well as a powerful environment, and learning it is one of the most
exciting things we know. The real magic, though, starts in just the next
chapter.





Chapter 10

Data Management and Lists

In this chapter, you’ll learn how to:

• define material for and generate a table of contents
• do the same for an index
• generate and update a bibliographical reference, also called a table of

authorities
• cross-reference captions for figure, table and text boxes and other

special parts of a document
• dynamically link any place in a document to any other place
• sort and filter data according to several levels and criteria

At this point you’ve covered a great deal of material in word processing,
graphics, and Macintosh use in general. We’re now ready to learn ‘comput-
ing’ in a more powerful sense of the term.

In past times we thought of the computer as monolithic and mysterious and
making millions of calculations per second. Up to now, in word processing
and graphics at least, there hasn’t seemed to be very much of this millions
per second. Appearances are deceiving – rotating a graphic requires
extensive calculation – but in general, the Macintosh and WordPerfect
have done what you’ve told them to, step by step.

Here’s where we depart from that model. We’ll learn commands in this
chapter that you execute once, and WordPerfect then performs hundreds
or thousands of steps automatically. Many of these serve to organize data,
to make it more accessible or easier to comprehend. They serve as well to
save you from a great deal of low-level work, and make your efforts more
accurate, since people don’t do their best at repetitive tasks. We do better
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when we can think, and let the computer do the hundreds of steps to
manage data according to our conceptual model.

An example of this is cross-referencing. This, in theoretical terms, is just
placing indications at particular points in a document that refer the reader
to other places in the same document. “See figure 36” is such an indication.

Great, you say, I can type that fast. Yes, but let’s assume that you then add
another figure towards the beginning of your manuscript, and what was
figure 36 becomes figure 37. With the cross-referencing WordPerfect can
do, every reference to the figure changes: anywhere in the text, notes, and
your list of figures.

Lists

In other lists, such as an index, a table of contents or table of authorities,
you can similarly mark the points in your text that you want to appear in
the list, tell WordPerfect where you want the list to go and what you want it
to look like, or define it, and, when everything else is done, generate it.

Following any amount of editing or formatting that will change pagination
all over the place, just hit the generate command once more, and the list is
again accurate.

1. Click in the Control Bar to open the List Bar, as in figure 10.1, where
you see Define buttons for both the Index and Table of Contents.
These boxes are black on white, while the icons to the right of these
buttons are grayed out.
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Figure 10.1: List Bar

2. Select any word in your document. The Define buttons are now grayed
out, while the icons to their right are clear. You can use these to mark
this selection for an index or a table of contents entry. When you
generate either kind of list, your selection is included, and its accurate
page number shown. Deselect the word you just selected, and let’s try an
index.

Creating an Index

For this exercise, open any document of two pages or more.

1. Select any word or phrase you’d like in your index. If it’s one word, just
double-click it to select it.

2. Click the icon in the List Bar to mark this as an entry. You’ll see small
symbols appear on either side of the marked text.

Do this for 10 or 15 words, over the several pages of your file.

3. Go to the end of the file, and press Return to start a new line.

4. Click the Define button in the Index box on the List bar. You’ll see the
notation «« Index Generated Here »» appear at your insertion point.

If you want the index to start on a new page, you can insert a
Page Break from the Insert menu first. You might also like to
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type “Index” above the place where you define the generation
point.

5. Click Generate over on the right side of the List bar. WordPerfect
responds with figure 10.2.

Figure 10.2: An index will be generated

6. Click OK, and WordPerfect calculates an index.

Half the value of automatic indexing is that you can change
formatting, move paragraphs from one page to another,
whatever, and then click Generate again. If you’ve ever
revised an index by hand, you’ll appreciate this.

If you’ve established page numbering for this file (perhaps starting at page
50 since it’s chapter two, for instance), or changed numbering style from
Arabic to Roman numerals, your index will reflect this.

If you want to remove a marking, put your insertion point near the word
and choose the Show Codes command on the Edit menu to show the
Codes window. Delete the code from either side of the marked word. The
code on the other side of the word is deleted automatically.

To help you find markings more easily, WordPerfect shows a marked word
or phrase by means of small arrow symbols on both sides, visible when the
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List Bar is open or when Show ¶ is active (choose this command from the
Edit menu to toggle it on or off.

Creating an Index with a Concordance

In the last exercise there was still work to do to make an index: finding
every instance of every word you wanted to index, and marking it. That
could get old, so WordPerfect gives you a much easier way to do it, by
making a list first, of all the words and phrases you want to index. This list,
entered as a separate file, is called a concordance.

You might know your text well enough simply to type a concordance list
(place a return after each entry), or, with both your text and concordance
open, copy and paste from one into the other.

When we learn macros, we’ll learn how to make copying a
word in one file and pasting it into a second file a one-step
operation, i. e. click in the word, and press command-1, or
such. WordPerfect copies the word, switches to the second
file, pastes, presses return, switches back to the first file and
deselects the word it just copied. Stay tuned.

The advantage of using a concordance is of course the steps saved: you
won’t need to mark individual occurrences of words in your text. A possi-
ble disadvantage is that WordPerfect indexes each occurrence of each
word in the concordance. If you wanted to index a word only where you
first defined it, and then where you spent a couple of pages on it, marking is
a better choice.

Of course, you can do both. If you specify a concordance and also mark
words, they both show up. A word you’ve marked but not added to the
concordance then isn’t referenced 27 places in the index.
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There’s no need to alphabetize your concordance, although WordPerfect
can work a little faster if it is. Don’t alphabetize it manually, though: just
enter the list and then sort it, as we’ll learn later in this chapter. Avoid
duplicate words, though.

When your concordance file is ready:

1. Click Other, the last button on the List bar. From Type, choose
Define Index. A dialog like figure 10.3 appears.

Figure 10.3: List dialog

with the insertion point blinking in the Concordance File box. Instead of
typing anything here, though, click Find File. A standard open dialog lets
you show WordPerfect the path to your concordance. Click Set in the open
dialog when you find it.

You’re returned to the List dialog, and you can see how WordPerfect
defines the path to the location of, and the name of, your concordance. If
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you change the name or location of this file, just repeat these steps. You
can at this point define and generate an index from the List dialog. Let’s
look at some formatting choices first, though.

Formatting an Index

1. Click the Page Numbers pop-up, which now reads Dot Leaders.
You’ll see figure 10.4.

Figure 10.4: Formatting options for lists

These options produce formatting like figure 10.5.
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Figure 10.5: Index formatting
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In each case, we deselected Line Between Entry in the List dialog.

2. Define and generate your index as before.

The best place to put an index is at the end of text, not just by
convention but because WordPerfect calculates an index first,
then builds it. If you have the index in front, with consecutive
page numbering, the index itself will push other text onto
subsequent pages, and page numbers will be incorrect. If you
wanted, you could generate your index to see how many
pages it is, then define it somewhere else and set page
numbering starting on that page to accommodate.

Indexes with two levels of entries

In this past exercise, all index entries were at the same level: each entry
was at the same level of abstraction as another. You can specify that each
reference in an index be either a main entry or subentry. The List
dialog box needs to be open to do this, and here’s a tip for that:

Open the List dialog and size your active document, and place document
and dialog so both are visible on screen. You’ll be going back and forth
frequently, and this makes the task much easier.

1. Select a word in your text that you want as a main entry. Click in the List
dialog to activate it. The Type pop-up will switch to Mark for Index,
if it doesn’t read that already. Your selection appears in the Entry box.
Click Mark. You’re returned to your file, and the selected word is
marked.
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2. Select a word you want as a subentry, and click in the List dialog. The
word appears in the (main) Entry box since, of course, WordPerfect
does not at this point know you want it as a subentry.

3. Type the name of the main entry for which you want this to be a suben-
try. As soon as you begin typing, the word in the entry box moves to the
subentry box. Click Mark when done.

4. Your next selection defaults to a subentry, if your last one was, with the
last main entry still there. Tab to move between the two boxes.

When you generate an index, you’ll have subentries underneath and
indented by one tap stop from the main entry. If you checked Line Be-
tween Entry in the List dialog, main entries will have a blank line between
them while subentries will not.

If you check Include Cross Index when you’re creating two entry levels,
WordPerfect will create a second reference in the index with the two levels
switched. Where the first reference might read “Computer, confusion”, the
second would be “Confusion, computer”.

An index (or table of contents, or any other list) is fully editable
after you generate it. If you generate it again after you’ve
edited it, though, your editing will be lost. Look in the codes
window, at the codes surrounding index text. Delete those
codes and your index then becomes plain text that will not be
regenerated when you update lists.
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Table of Contents

Generating a table of contents is very similar to an index. WordPerfect
gives you more levels, though: two on the List Bar, and five using the List
dialog. Let’s start with the List bar.

1. With the List bar open, select a word or phrase you’d like for a first level
entry. On the List bar, in the Table of Contents box, the Define button
goes gray, and both marking buttons become clear.

2. Click the first level marking button.

3. Continue finding, selecting and marking first and second level entries.

4. Go to the front of your document, to the point where you want the table
of contents to appear. This might be after the title page, and before text
page numbering starts.

5. Click Define in the Table of Contents box. You receive a message
saying «« Table of Contents Generated Here »».

6. Click Generate, and WordPerfect calculates your table of contents.

For either an index or table of contents, there’s no need to
generate right after you define, or define right after you mark.
It’s easier, for example, to format before generating these
lists. Pagination is then right the first time. Also, the Generate
command builds every list you’ve defined. If you have a lot of
lists or a long document, the Generate command might take a
few minutes.
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Using the List dialog for a Table of Contents

As before, WordPerfect gives you more options when you use the List
dialog. Let’s open it and see what’s there.

1. Select a word or phrase you want in your table of contents.

2. Either click the Other… button on the List bar, go to the Tools menu
and choose the List… command, or type Command-J. You’ll get
figure 10.6.

It’s useful to resize your document window and place it and
the List dialog so that both are visible at once, if you’re going
to be doing much marking of text.

3. Choose Mark for Table of Contents from the Type menu. Note that
all options in the Attributes box are gray except Level and
Autogenerate Hyperlinks through level.

4. Click Level. Mark your selection at any of five levels. Figure 10.6 shows
the first level chosen.

Many Tables of Contents have only one level but, like multiple levels of an
index, you can have that here, in fact up to five. You can also specify that
each entry, up to the fifth level, will be a hyperlink – just click on the
Table of Contents entry, which appears in blue and underlined, as though it
were a link on a web page, and WP takes you to that chapter, subheading,
or whatever you marked for the TOC.

5. When done marking, recall the List dialog (without any text selected),
and choose Define Table of Contents from the Type pop-up.

6. Set Max Level to the maximum number of levels you have marked.
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Figure 10.6: Table of Contents marking

7. With Level Format set at 1, choose the formatting in the Page Num-
bers pop-up that you want for the top level of your table of contents.

8. If you have more than one level, choose level 2 and set the formatting
you wish for that level. A nice formatting choice is to have the top level
set flush right with dot leaders, and the second level with the page
numbers following their entries. Continue to format as many levels as
you have marked.

9. A useful option for the last level is to wrap it by clicking the Wrap Last
Level check box. This produces something like figure 10.7.
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Figure 10.7: Wrapped Last Level

for a table that is well detailed or with longer labels.

To remove an entry from a Table of Contents, you would remove the
marking from the text by showing the Codes window and deleting the code
on either side of the word or phrase. Or, you can choose Find Code from
the Edit menu, and get figure 10.8.
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Figure 10.8: Find Code dialog

in which you can choose a code from the scrolling list, and find or remove
one or more occurrences of that code in your text.

Tables of Authorities

Here comes one elegant feature. Structurally, it’s similar to indexing and
tables of contents: references to marked text are gathered in one place, and
can be dynamically updated. Conceptually, it bears a resemblance to
footnotes or endnotes, in that it’s an excellent way to list citations or
quotations in a legal or academic document.

You can have up to 16 sections: that many separate lists of different kinds
of citations. Cases might be one; statutes another. Its most common use
might be for legal briefs, but its advantages in listing any kind of reference
or source suggests wider bibliographic application.

There’s one distinction to understand first. For an Index, you marked all
the occurrences of words you wanted indexed (or had a concordance do it
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for you). For a Table of Authorities, you select the full reference or citation
as it first occurs in your text, and call it a full form. You then mark
subsequent occurrences with a nickname, calling it a short form.

The Table of Authorities (or bibliography) then lists the reference and
everywhere it occurs in your text. Here’s an example. You’ve referred to
and quoted Nel Noddings’ fine book Caring at several points in your paper.
You wish to list bibliographic information so that references within your
text will give the whole citation [Noddings, Nel. Caring. Berkeley: Univer-
sity of California Press, 1984] only in the first instance, and then just show
“[Noddings 1984]” every succeeding time, with the full reference again
appearing as a bibliography entry at the end of your paper. Here’s how you
do it:

1. Select the complete citation as it first appears in your paper, and call the
List dialog (command-J).

2. Choose Mark Full Form from the Type pop-up, and choose which
Section (i. e. which of the 16 possible lists of citations) you want.

3. In the Short Form text entry box, you’ll see the first 40 characters of
your selected citation, but you’ll want to use less than that as a nickname
for this reference. Just the first word, i. e. the author’s last name, is best.
Delete everything in the Short Form box except the author’s last name,
and click Mark or press Return.

You’re given a window similar to a footnote or endnote editing window.
Make any changes you want in the text of the full form, should you want it
to differ from the text as it appears in your document. Close this window
when done.

4. At every subsequent citation of this reference, put your insertion point
within the text, call the List dialog, and choose Mark Short Form. If
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this was the last citation you marked, the short form should already be
in its box. If not, just type it in. That’s the point of using just a last name
or other short nickname in the short form.

5. Mark other references using the full and short forms. When marking a
full form, be sure to indicate the correct section number if you’re using
more than one.

6. Put your insertion point at the place in your document where you want
the Table of Authorities to appear. If you are creating more than one
section, you can put each section in a different place.

7. From the List dialog, choose Define Table of Authorities. As with
other lists, you can choose the Attributes for Page Numbers accord-
ing to Section. You can also select Line Between Entry, and Allow
Underlining. The last option is specific to legal use: it’s standard
within the text to refer to a case with the names of the parties under-
lined, as in “Brown v. Board of Education, 347 U. S. 483 (1954)”. In the
table or bibliography, though, you might object to such concentrated
underlining. So disallow underlining in this dialog, to save the trouble of
editing the table after generating it.

8. Click Define. Repeat as necessary for each section.

9. Click Generate. You’ll have a list like figure 10.9.
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Figure 10.9: Bibliographic references from a Table of Authorities

Editing a Table of Authorities

You can edit this or any kind of list by hand after you generate it. Subse-
quent regenerations will delete your editing, though, and WordPerfect has
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a single generation command that updates all lists. Thus, you can’t update
the Index while keeping editing changes to the Table of Contents.

As far as Indexes or Tables of Contents go, you should simply edit the text
you’ve marked, or edit the Table after you’re sure you won’t want to
regenerate again. A Table of Authorities is more flexible, though. To edit a
citation as it will appear in all regenerated lists:

1. Put your insertion point near the text you selected and marked as the
full form. Showing the codes window or using the Find Code… command
may be helpful here.

2. Call the List dialog and, from the Type pop-up, choose Edit Full Form
(Previous) or Edit Full Form (Next), depending on whether your
insertion point is sitting before or after the full form you want.

You see an editing window again. Make changes here, and close the window
when done.

Other lists

What we’ve looked at so far are lists with certain structures helpful to their
purposes. WordPerfect will let you make up to nine additional lists as well,
so you can include in your document ready references to tables, graphics,
text boxes, and any other parts of your file you wish. You can include all
graphics, for example, in one list, and some graphics and some tables,
according to subject, in others. Your readers will be very impressed.

As preparation for this exercise, make or import a couple of simple graph-
ics into your text document.
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1. Click on a graphic to select it, so that a box appears around it with
handles at the right and bottom.

2. From the Tools menu, choose Graphic and then Caption…. Enter an
appropriate caption. Leave the figure number intact, and type whatever
else you want. Click outside the graphic to return to the body of your
file, and repeat this for another graphic. Again, click outside the graphic
to return to your document.

Just as you double-click a graphic to go into the Graphic
Editor, you can double-click a caption to access it for editing.

3. Place your insertion point where you want the list of figures to be, open
the List dialog, and define the list, choosing the type of page numbering,
line between entries or not, and Figure as the list type, all as in figure
10.10.

Figure 10.10: Defining a list of figures
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and generate your list. You’ll have something like figure 10.11:

Figure 10.11: Figures captioned and referenced in the list below

Updating lists

1. Select and cut the second graphic (the rooster in our sample, figure
10.11), by selecting it and choosing Cut from the Edit menu.
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2. Click to put your insertion point above the first graphic, and choose
Paste. Click and move the rooster a little to wrap text around it. Move
the dancers if you need to, to get them out of the way. See how Word-
Perfect has changed the figure numbering.

3. Generate the figure list again, and see how it has updated. This would
work the same way if you had added or deleted a figure.

We cut and pasted, rather than just dragging the graphic,
since WordPerfect numbers them according to the graphic box
code that was inserted in your file, at your insertion point,
when you first pasted or drew these. The code doesn’t move
when you drag a figure.

Listing tables

Listing references of pre-defined types, such as figures, is fairly automatic,
since WordPerfect knows where all the figures are – they’re internally
labelled as figures.

You can take other parts of your document and label them yourself.
WordPerfect will then gather a list of them in just the same way. One use of
this is for tables which, by themselves, can’t be captioned in a way that
WordPerfect can reference.

Putting a table in a text box permits this, though – and is often a good idea
anyway, since you have greater flexibility in positioning and sizing text
boxes. With a table inside, it positions and sizes along with the box.

If you have a table not in a text box, it’s one quick move to
select all the contents by dragging through the table, cut them,
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create a text box and a table in it, and paste the contents into
the box. We can then call it a Table Box. 

When we learn macros – automating steps – we’ll learn how to
make a Table Box all in one motion.

Let’s make a couple of table boxes, and list them.

1. Start a new document, and create a text box by choosing Tools > Text
Box > New. You should have an insertion point blinking in the box.

2. From the Table menu, choose New. Specify the number of rows and
columns you want.

3. Click outside the table box, and then click on it so as to select the box –
it will have a thin frame around it, with handles at the bottom and right
sides.

4. Again from the Text Box menu, choose Options.

5. From the Label Type pop-up, choose Table. You’ll see figure 10.12.
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Figure 10.12: Text Box Options

6. Label as many table boxes as you have.

7. Caption each Table Box, in the same way as you captioned figures.

8. Put your insertion point where you want this list. Call the list dialog, and
define page numbering and such as you wish. From the List Type pop-
up, choose Table.

9. Generate your list of tables. Say hey.

You can do this for user defined lists – simply one more kind of list of
anything you first label and then gather, and for equations, when we get to
the latter.
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Custom lists

As you noticed in the List dialog, there are List Types for figure, table, user-
defined and such, and also five lists identified simply by number. Using
this, WordPerfect lets you define a list of anything.

Let’s say that although you’ve defined a list of all the graphics in your
document, you want to define another list according to subject.

One consideration is that since you know what you’re making a list of, and
WordPerfect doesn’t, you have to mark the items you want on the list, just
as though for an index.

1. Open the List dialog, perhaps resizing and repositioning your active
document so that both it and the dialog are visible. Go to your document
and:

2. Double-click on the caption for a graphic. This will open it for editing,
and you can then drag across it to select it.

3. Switch to the List dialog, choose Mark for List from the Type pop-up,
and choose List 1 from the List Type pop-up.

4. Mark the caption for another graphic in the same way.

5. Define your list, with List 1 as the type, and Generate.

Cross-referencing

So far what you’ve done has been to reference something to a list. Nice, but
WordPerfect lets you cross-reference anything to anything, which is even
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nicer. Let’s use your last sample document, something like figure 10.11, to
look at this.

Somewhere in that file, you want to refer the reader to figure 12, with the
words “See figure 12”. If you just type that, and then add or move figures,
though, what was figure 12 may end up as figure 1, or 20. So let’s do it
better.

1. Put your insertion point where you want this reference, and type “See
figure ” leaving a space between the word figure and the closing quotes.
With your insertion point to the right of that space, call the List dialog
and:

2. Choose Create Reference. In the Target Type pop-up, choose
Figure. 

3. You’ll need to type a Target ID in the box labeled for it. This can be
anything – one word is best – to identify this reference and its target. In
figure 10.11, we wanted to refer the reader to the figure captioned
“Party while ye may”, so we used “party” for the Target ID. Lower-case
is fine.

4. Click Create, and you’re back in your file with a question mark where a
number will appear.

5. Select the figure you want as a target and, just to check, open the Codes
window. See that the insertion point in the codes window – a thick
vertical bar – is just to the right of the code for your target, as in figure
10.13.
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Figure 10.13: Codes Window, showing the insertion point

6. Go back to the List dialog, and choose Mark Target. In the Target ID
box, type the name you chose for that. Click Mark.

7. Again from the List dialog, click Generate. The question mark in “See
figure ?” will be replaced by the number of the figure you targeted.

8. Cut and paste the figure you’ve referenced, so as to change its order with
another one. Call the Generate command again, and see how your cross-
reference remains accurate. Awesome, no?

As you saw when you created the reference, you have your
choice of several target types: figure, page, paragraph and so
on. You can easily create a reference and mark the same
target for it twice, using both page and figure types, so your
reference will read “See page 62, figure 14”. Use the same
target ID for both.

You can also create any number of references for one target, or refer the
reader to multiple targets (“see figures 95, 96, 97”). WordPerfect puts the
commas in for you.

Referring the reader to a paragraph is of special use when you’re using
paragraph numbering, discussed in the Outlining section of Chapter 9. You
can as well refer your reader to a point in an actual outline. You can also
create dynamic references to footnotes and endnotes, a most versatile
feature.



362 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

As with marking other targets, the insertion point in the Codes Window has
to be just to the right of the target. This should be automatic, if you put
your insertion point to the right of the footnote or endnote itself in the
document window.

WordPerfect’s lists and cross-referencing are powerful tools that can make
your document much more coherent and accessible to a broad readership.
Don’t feel, after only one run-through, that they’re too complex to use. It’s
like driving a car: after a while, you don’t even think about the tool, just
about where you want to go.

Sorting

WordPerfect provides an extensive and elegant sort facility.

Compile some data you’d like to work with. Figure 10.14 is an example
where each food’s data is on one line, with tabs separating the columns, and
hard returns demarcating lines. We want to sort this alphabetically by
name.

There are two ways to sort in WP, Simple Sort and Sort…. Let’s look at
the simple option first. Select the lines, i.e. paragraphs you want to sort
and:

1. From the Tools Menu, call Simple Sort.

In the first section, different commands will be active if you’re sorting a
table. In the second section, Ascending is e.g. A to Z or 1 to 10. Use
Alphabetic if the word you’re sorting by, e.g. the first word in each line
starts with an alpha character, or Numeric otherwise.
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Protein Content of Vegetarian Foods (Average Servings)

Food Type Amount (oz.) Calories Protein (grams)

Bread (whole wheat) grain 1 65 3
Banana (1) fruit 6 100 1
Raspberries fruit 8 85 2
Collards vegetable 6 40 5
Orange (1) fruit 8 70 2
Egg (1 large) dairy 2 80 7
Beans legume 4 100 8
Broccoli vegetable 8 50 6
Milk dairy 8 140 10
Rice grain 8 225 4
Spinach vegetable 6 25 4
Cottage Cheese dairy 3 40 8

Source: Rudolph Ballentine, M.D., Transition to Vegetarianism

Figure 10.4: List of foods ready for sorting

The second and third sections don’t cause a sort; these are options. Set
them as needed, calling the menu once or twice to do so, and then choose a
command from the first section, e.g. First Word in Line. Your data is
sorted.

Simple Sort is all most people need most of the time, but the last command
on the Tools Menu, Sort…, is much more powerful.

You can call the dialog without text selected, in which case WP assumes
you want to sort an entire file, and gives you an Open dialog to locate the
file. Or, if you select text first, just that text will be sorted. Let’s try that.

1. Select what you want to sort.
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2. From the Tools menu, call the Sort… command. You’ll see an initially
bewildering dialog as shown in figure 10.15.

Figure 10.14: Sort and Filter dialog

Fortunately, everything’s as it should be for the first sort we’re doing.

3. Click Begin. WordPerfect alphabetically sorts the text you selected.

If this didn’t work right, make sure you select only the text you want to
sort. Settings should be as in figure 10.15, which are defaults. Try again.

What you just did was sort items of text that each ended in a hard return.
WordPerfect calls each unit of text separated by a hard return a zone. You
also sorted (in our example) by the contents of the left column. WordPer-
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fect calls such a column a field. Note in figure 10.16 that the Field box,
towards the top of the dialog, has the number 1 in it – the leftmost field, or
the name of the food.

We could as easily sort by any other field.

Sorting by alternate fields

1. Select all the zones you want to sort, and call the Sort dialog.

2. Change the Field number to (in our case) 5, so as to sort by amount of
protein. Click Begin. We got figure 10.16.

Protein Content of Vegetarian Foods (Average Servings)

Food Type Amount (oz.) Calories Protein (grams)

Banana (1) fruit 6 100 1
Milk dairy 8 140 10
Orange (1) fruit 8 70 2
Raspberries fruit 8 85 2
Bread (whole wheat) grain 1 65 3
Spinach vegetable 6 25 4
Rice grain 8 225 4
Collards vegetable 6 40 5
Broccoli vegetable 8 50 6
Egg (1 large) dairy 2 80 7
Cottage Cheese dairy 3 40 8
Beans legume 4 100 8

Source: Rudolph Ballentine, M.D., Transition to Vegetarianism

Figure 10.16: Alphanumeric sort on the fifth field
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and we can immediately see that something went wrong. WordPerfect
defaults to sorting in ascending order (A to Z or 1 to 10), although you can
easily reverse that in the Sort dialog. The amounts of protein, though, go
from 1 to 10, then to 2. Huh?

This happened because we did an alphanumeric sort, again the default.
WordPerfect treated the numbers like letters and, since the 1 in 10 comes
before 2, that’s where it went. Let’s try it again.

3. Select all the zones (paragraphs) again, and call up Sort. This time:

4. Change the Type pop-up from Alphanumeric to Numeric. Now sort.

Using multiple sort levels

When we sorted by name of food or amount of protein, we used one or the
other sort key – the basis for the sort. We then got either kind of ordering.

The telephone book has something more sophisticated: everyone is sorted
by their last name and then by their first name. In computerspeak, we say
that the phone book has two levels of sort. Last name is the primary key,
and first name is the secondary key.

For our food list, let’s say we want to sort first by amount of protein, and
then by number of calories. This will be helpful because spinach and rice,
beans and cottage cheese, and oranges and raspberries have the same
amount of protein per average serving.

1. Select the zones, and call the Sort dialog.

2. For the first sort key, see that field 5 (protein), and numeric for type are
still chosen.
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3. For the second sort key, choose field 4 (calories), and numeric type.
Click Begin. 

WordPerfect’s nine levels of sort let you do some amazing
things with data. Multiple levels are only useful if you have
overlaps, though, as we had with amounts of protein.

For example, if you’re sorting a list of employees, first by last
name, then by first name, then by employee ID number
(unique to each employee), the third key will be useful only if
more than one employee have the same first and last names.
Also, if you sort by the unique ID number as the first key,
sorting by any further keys is meaningless.

Sorting in groups

So far we’ve only sorted single zones, in this case single lines. More than
one (wrapped) line of text can be a zone, as long as there’s only one hard
return before and after it.

Easy enough, but on many occasions we’ll want to sort groups of lines. An
example that comes to mind immediately is names and addresses, all in one
column, where the first line is a whole name, the second line is the street,
and the third is city state zip. There’s then a blank line, and then the next
address. Groups in this example are thus items of text separated by two
hard returns, creating the blank line.

WordPerfect understands not only that you want to sort these groups, but
that you might not want to sort by the first letter of the first word in each
group, or even by the first zone in each group.



368 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

Just as you can sort by the zone of your choice within a group – or, indeed,
as many zones as you like, up to the nine levels of sort WordPerfect offers
– you can sort by the individual word within a zone. Consider the list of
addresses in figure 10.17.

Janet Sullivan
155 Lakeview Rd.
Ithaca NY 14850

Barbara Williams
71 Mechanic Place
Ithaca NY 14850

Jodi Martin
612 Iris Drive
Auburn NY 13882

Ted Harris
2883 Willow Ave.
Dryden NY 14301

Figure 10.17: Addresses

We want to sort this list by last name. Note that these people all have just
first and last names (for the moment).

1. Select your addresses, and call the Sort dialog.

2. Specify a group sort, one key of zone one, field one (there’s only one
field, i. e. column, anyway), and word 2. You’re telling WordPerfect to
sort by the second word on the first line.

3. Go for it.
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4. Choose Undo, to reverse this sort. Here comes some power. Let’s
change the names to look like figure 10.18, where some names have a
middle name or initial.

Sorting by imbedded words

Janet Sullivan
155 Lakeview Rd.
Ithaca NY 14850

Barbara Ann Williams
71 Mechanic Place
Ithaca NY 14850

Jodi Martin
612 Iris Drive
Auburn NY 13882

Ted K. Harris
2883 Willow Ave.
Dryden NY 14301

Figure 10.18: Addresses with middle name or initial

Now, sorting by the second word isn’t going to work. Not a problem. When
you entered the numeral 2 in the Word box, you told WordPerfect to count
from the left within that zone. If you enter a negative number in the Word
box, WordPerfect will count from the right. So change this sort option to
–1, and go for it some more.

You can also use a negative number for zone or field.
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Sorting a table

Actual tables, rather than the tab- and hard return delineated text we’ve
worked with so far, are a nice place to use the sort feature.

We moved our original food protein chart from a quasi-table (tabs and hard
returns) into a real table, where it belonged in the first place. When you
select cells in a table the Simple Sort submenu changes to look like figure
10.19, with line commands deactivated and table commands activated.

Figure 10.19: Simple Sort for a table

The main Sort dialog changes too: the Item pop-up defaults to Table
Row, and the key specifications that used to read Zone, Field and Word
now read Cell, Zone and Word.

We set the primary and secondary keys to cells 5 and 4, and sorted, to get
protein and then calorie orderings.
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Other considerations in sorting

All of the sorting we’ve done has been to parts of a file: we selected what we
wanted to sort, and called up the dialog. If you call the Sort dialog without
selecting text first, WordPerfect assumes you want to sort an entire file,
and asks you for it. Simple Sort commands are inactive unless text is
selected.

You can Redirect Output as well, with a check box in the dialog, and WP
asks you what to name and where to put the sorted file. You can thus sort
data without ever seeing it on screen. You can also keep a file in its present,
unsorted state, sending the sort to a new file.

There’s one last kind of sorting to cover: how to sort a mail merge (some-
times called print merge) data file. This will make quite a bit more sense if
we cover it after you learn what mail merge is, in the next chapter.

Filter

WordPerfect gives you the means to filter data by almost any criteria you
set, so that from 100 or 10,000 addresses or other data in a file, you can
select only the 20 or 200 that match those criteria. Let’s take a look at this.

1. Recall our food list (figure 10.14), or your equivalent. We want to derive
a sub-list of grain foods only.

2. Select the list, or the part of it you wish to work with.

3. Call the Sort dialog. In the Action box, we selected Filter and deselect-
ed Sort. In Items, we chose Group. For the keys, we used only the first,
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setting it to Field 1, Word 1, so that WordPerfect will locate the kind of
food.

4. Now we need to tell WordPerfect what to look for in the food kind. Since
we want to filter for grain, we typed the following in the Filter Accep-
tance Criteria box at the bottom:

key1=grain

so that the whole setup looks like figure 10.20.

Figure 10.20: Filtering data

and we’re ready to filter. First, though, note this caution:
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When you filter a list or table, WordPerfect removes whatever
doesn’t match the filter criteria. So unless you want to throw
away the original data, use the Save As command after the
filter, and save derived data under a different name.

It’s actually a better idea to use Save As first, so that you don’t
inadvertently forget, after performing the filter.

Alternatively, we could Redirect Output, to send the filtered data to a
new file, leaving our original document intact.

5. Click Begin. We get the two foods in our list that are grain.

Filter criteria operators

In the example, we used an equals sign to tell WordPerfect what to look for
and filter. There are eight operators in all, and you can use them in any
combination. They are:

= equals
< > doesn’t equal
< less than
> greater than
< = less than or equal to
= > greater than or equal to
* and
+ or

Let’s use multiple operators on our food list. We want to derive two lists:
the first is a filter of all foods that are grain and have less than 100 calories
per normal serving; the second is a list of all foods that are grain or have
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less than 100 calories per serving. This use of ‘and’ and ‘or’ is called Boole-
an logic. 

1. Use the first key setting as in the last example, to locate the word grain
in the table.

2. Set the second key to numeric, field 4, word 1, to pick up the number of
calories.

3. To find foods that are grain and less than 100 calories, the key accep-
tance criteria should read:

key1=grain*key2<100

4. Click Begin. The result should be one food: bread.

5. To test for foods that are grain or less than 100 calories, the key accep-
tance criteria should read:

key1=grain+key2<100

which will return all the foods except banana, beans and milk.

If you want to test an entire item, rather than one key, use
KeyG (for global).

You see how elaborate your filter criteria can be.

WordPerfect evaluates a formula from left to right, but any parts within
parentheses are evaluated first, as standard algebraic usage prescribes. For
hierarchical parentheses, WordPerfect evaluates from the inside out.
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Sorting and filtering at the same time

In the Action box, select both Sort and Filter. In our last example, the
first key filtered for grain, and the second for calories. The third and
succeeding keys are still available for sorting.

Once again, you may want to keep your original file intact
when you sort or (especially) filter a copy. If you forget to do
this, it’s a good reason to have WordPerfect’s original file
backup feature turned on, as you learned in Chapter 6.

Summary

You’ve really made progress in this chapter and, more than that, you’ve
developed a sense of WordPerfect’s data environment, and how powerful
and flexible it is. You can now:

• create tables of contents, indexes, and tables of authorities (or bibliogra-
phies)

• make lists of figures, tables, text boxes, and any other features in any
kind of document

• cross-reference your writing to given pages, paragraphs, figures, tables,
footnotes or endnotes

• set up sort functions according to multiple keys and levels of criteria
• filter data using all the power of the sort function, plus arithmetic and

boolean operators

and, once again, we strongly endorse practice of any of these features you
find interesting. You can see already how powerful they are; another run-
through will confirm how friendly their implementation is.





Chapter 11

Document Linking: Merge, and
Publish & Subscribe

In this chapter, you’ll learn how to:

• print any number of personalized letters, using a form letter and an
address list

• have that process ask for user input as it proceeds
• tell that process to branch to other files
• have WordPerfect documents update other WordPerfect documents

automatically
• bring data from a great number of Macintosh programs into WordPer-

fect, so that changes in the original update changes in the WordPerfect
file automatically

• take data from WordPerfect into any of these programs, again with
automatic updating

Merge

How often have you received mail that had your first and last names and
parts of your address splashed all over the sales letter? The computer took
a list of hundreds of names and addresses, and one form letter and merged
them to compile any number of seemingly individualized letters.

This feature can save enormous amounts of time, promote accuracy, and is
a substantial help for mailing lists of every type, including those that use
electronic media as well as paper – an AppleScript (which we’ll learn in
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Chapter 13) can easily take merged letters created by WordPerfect and
make emails out of them. Let’s take a look.

The two parts

Merge works by having two documents, a Form File and a Data File, and
merging information from each.

The Form File

Let’s try an example of a form letter, personalized for several recipients.
The first thing to do is simply write that letter but, in place of information
specific to any individual, we’ll put a placeholder, called a field, where
something like the individual’s first or last name or favorite food is going to
go.

1. Display the Merge Bar by clicking its button on the Control Bar.

2. Start a short letter, maybe a note to a few friends, with an idea about the
sorts of places in the letter you’d like to include personal information.
Think of these places as fields, with the first field their first name, the
second field their last name, the third their street address, the fourth
their city/state/zip, and the fifth the name of their cat, or something.

3. When you get to the first place in your letter where you want individual
information to appear:

4. Click the Field… button on the Merge Bar. Figure 11.1 appears.
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Figure 11.1: Merge Field Number dialog

and what we want is field number one, so just click OK. The code
<Field:1> is placed in your letter.

5. Repeat this for the five or six fields you have in mind, numbering the
fields sequentially as you go. Your result should look something like
figure 11.2.

In this example we’ll use Field 1 for a first name, and Field 2 for a last name.
Note that we entered the Field 1 code, then typed a space, then the Field 2
code so, in the finished letters, there will be the proper space between first
and last names.

Save and close this document, and let’s look at the data that we’ll merge
with the form.



380 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

<<<<FFFFiiiieeeelllldddd::::1111>>>>  <<<<FFFFiiiieeeelllldddd::::2222>>>>
<<<<FFFFiiiieeeelllldddd::::3333>>>>
<<<<FFFFiiiieeeelllldddd::::4444>>>>

Dear <<<<FFFFiiiieeeelllldddd::::1111>>>>:

We are sorry but we cannot send you a free copy of our new book Teach
Yourself WordPerfect Mac.

Although you are undoubtedly correct to say you’re the only person to use
WordPerfect for <<<<FFFFiiiieeeelllldddd::::5555>>>>, you still have to buy our book like everyone
else.

Thank you, and do say hi to <<<<FFFFiiiieeeelllldddd::::6666>>>>  for us.

Sincerely,

Figure 11.2: Form letter showing field codes

The Data File

What we need at this point is a list of information about each person we
want to send a letter to. Each line on the list would have the name and other
information about one individual. A table format would work well, where
each column would be a field, and each row would have the individual
information. We could call each row of the table a record, and the various
fields of each record would fit in the slots indicated. When we finished, we’d
have a complete letter for each record.

An example of such a table is figure 11.3.
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Larry Smith 123 Maple St. Somewhere
NY 14558

ransom notes the King of
Spain

Moe Jones 456 Elm St. Elsewhere
FL 30366

communicating
with Klingonss

Captain
Spock

Curly Joe Brown 789 Oak St. Nowhere CA
94568

translating Proust
back into French

Napoleon

Figure 11.3: Records to use in a merge

1. Create a table with however many columns (fields) and rows (records)
you’ll need. Enter whatever data you like here. Save this file.

Now, we have to make one change in this file for WordPerfect to be able to
merge it with the form letter.

2 Select all of your table: triple-click in the bottom right cell and drag up
and to the left, to the top left cell.

3. From the Table Menu, choose Table to Text….

4. In the resulting dialog, choose Merge Format. The table will change to
text as you see in figure 11.4.
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Figure 11.4: Data in Merge Format

In the form letter you inserted <Field: > codes, and there are similar
codes here. Wherever you went to the next cell in a row when entering
data, there’s an <End of Field> code, and wherever you went to the next
row in the table, there’s an <End of Record> code. This is just the format
that WordPerfect needs to work in, and we’ll call this the data file. 

5. Use Save As, to save this as a different file from the table, and close the
file.
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Merging the two parts

Now that the work’s done, here comes the fun part.

1. Start a new file and display the Merge Bar.

2. Click Merge…, the button at nearly the right end of the bar.

WordPerfect opens a dialog that asks you to Select Form File. Navigate
to your form letter, select it and click Merge…. A second dialog then
appears, asking you to Select Data File. Again tell WordPerfect which
file to use – this will be the data in merge format, as in figure 11.5.

WordPerfect thinks about it for a moment, and then produces something
impressive like figure 11.5.
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Larry Smith
123 Maple St.
Somewhere NY 14558

Dear Larry:

We are sorry but we cannot send you a free copy of our new book
Teach Yourself WordPerfect Mac.

Although you are undoubtedly correct to say you’re the only
person to use WordPerfect for ransom notes, you still have to buy
our book like everyone else.

Thank you, and do say hi to The King of Spain for us.

Sincerely,

Moe Jones
456 Elm St.
Elsewhere FL 30366

Dear Moe:

We are sorry but we cannot send you a free copy of our new book
Teach Yourself WordPerfect Mac.

Although you are undoubtedly correct to say you’re the only
person to use WordPerfect for communicating with Klingons, you
still have to buy our book like everyone else.

Thank you, and do say hi to Captain Spock for us.

Sincerely,

Figure 11.5: Merged Form and Data files
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If your result has field data colliding with surrounding text, check your
form to see that you have the appropriate spaces between field codes and
text.

The horizontal lines between each letter in the output are hard page breaks,
so each letter sits normally on a page when you print.

Other merge codes

Speaking of printing, you may want to print these merged letters as you
merge them, rather than look at the file, maybe save it, and then print it.
You will probably want to keep the form and data files, but there’s often no
point in keeping the particular merge of the two. It also consumes disk
space.

You can put a code in either the form or data file, and WordPerfect will
send the merge to the printer when it encounters this code during a merge.
There are several such codes you can use to govern a merge, available from
the Other pop-up on the Merge bar, as shown in figure 11.6.

Figure 11.5: Merge Codes
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where the code To Printer is listed next to last. Choosing this puts a
<Print> code at the insertion point. The Date command, the first one on
this menu, inserts the date of the merge.

Release the menu for a moment, and let’s look at the codes on the Merge
Bar itself. The first two, End of Field and End of Record, let you insert
these codes if you’re entering a data file directly, instead of making a table
as we did in the example. We sure prefer a table so we can see what we’re
doing, but it does involve the extra step of converting the table to text in
merge format. You may prefer to cut the data file in one step, using these
codes, especially if your data file is a short one.

We used the Field… code button when making a form file. You can of
course use any field as often as you want in a merge. In our example, we
used the recipient’s first name both in the address and in the salutation.

The next button, From Keyboard, is used in a form file and tells Word-
Perfect to stop and ask you for input at that point, when it encounters a
<Keyboard> code each time it repeats the form. This is a useful feature to
customize letters as you go through the merge. WordPerfect will stop at the
code; type what you wish, and click the End of Field button on the Merge
bar to resume the merge.

In fact, if you have some boilerplate as the form and only a couple of places
to customize, you can create a merge with a form file but without a data
file. Remember, when you start a merge WordPerfect asks you first to
identify the form, then the data files. In the latter’s open dialog, there’s a
button saying No file. Click this, and then enter data as you go: WordPer-
fect won’t need <Keyboard> codes, but will stop at each <Field: > code.

At the right of the Merge bar, the Markers button (which stays lit while it’s
on, to remind you it’s on, substitutes small icons for field or other codes.
Open your form letter again, and see how these look. These are useful for
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writing or proofing a form without the perhaps visually disrupting influ-
ence of the spelled-out codes.

At this point, you have everything you need to use the Merge feature
effectively. Let us end the basic discussion with a thought on structuring
data files, and then go on to the power features of WordPerfect’s merge
capability.

Before starting to create a Data File

In our example, we put each person’s street address in one field, and all of
their city, state and zip in another. That was fine for our simple use, but you
might make more extensive application of your address list, either now or
in the future.

It’s especially important to be able to use data as flexibly as possible. If you
had zip codes in a separate field, for example, you could then sort the table
by that field, then select only zip codes for the state of Texas or which met
certain demographic criteria, copy and paste into a new file, make that into
a data file, and talk to just those people.

In general, it’s best to cut data into chunks as small as you’re
ever likely to want.

Power Merge

Let’s go back to the Other Menu on the Merge Bar, to see what else is
there.
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Defining Field Names

Define Names is an elegant feature. In our example, we numbered the
fields as we went. No problem, except that it’s not hard to forget which field
has which number, especially with larger merges. So why not name the
fields instead of numbering them? To do this:

1. Open your data file (the one in merge format). This could be a blank
document at this point, or you could have the data already there.

2. With your insertion point at the top of the document, choose the Define
Names command from the Other Menu on the Merge Bar. A <Define
Names> code is placed in your data file.

3. Type the name of your first field. For our example, a good name would
be “First Name”. Press Return.

4. Type a name for each succeeding field, pressing return after each one.
When done, click the End of Record button on the Merge bar. You
should have something like figure 11.7.
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Figure 11.7: Data file with defined field names

which is the same as figure 11.4 above, with the equivalent of a first record
containing field names.
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5. Save and close this file, and open your form. This could again be a new
document at this point. In practice, we often write new forms to merge
with existing data files.

6. Where you want to enter a field, click the Field… button on the Merge
bar, as before. Figure 11.1 appears again. This time, in the Type area,
click Field Name.

At this point, you could type in the field name if you’re sure of its exact
spelling, including spaces. An easier way is to:

7. Click the Get Field Names button. WordPerfect responds with an
open dialog box for you to open the data file you’ll use for the merge.

8. Navigate to your data file, and click Names. WordPerfect will pick the
names out of the top of this file.

If you’re told instead that no field names were found, and
you’re sure you’re using the right data file, open that file and
make sure that the <Define Names> code is right at the start
of the document.

You’re returned to the Merge Field Number dialog with the name we gave
the first field showing in the Field Name box. If the first field is the one you
want, click OK. Otherwise:

9. Click on the pop-up to the right of the Field Name box, to see a list of all
field names in the chosen data file, as in figure 11.8.
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Figure 11.8: Field Names

10. Choose the field you want, and click OK. We deleted the field number
codes from our form letter, shown in figure 11.2, and replaced them
with the equivalent fields by name. Our form now looks like figure
11.9, and this extra step, like setting data up in a table to begin with,
makes the whole procedure easier to do.
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Figure 11.9: Form letter with named fields

Messages

You can include a message in your merge data so that, during execution of
the merge command, that message is displayed on screen. This is helpful as
a reminder to a regular user of these files, or to provide instructions or
hints to another user. Let’s try a message in a form file.

1. With your form file open, choose Message from the Other Menu on the
Merge Bar. Figure 11.10 appears.
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Figure 11.10: Merge Message dialog

with the following kinds of messages available:

• User Message puts up to 255 characters in a box at the bottom of your
screen while the merge is running. You can put this kind of message in
either a form or data file. In a data file, put it at the start for best results.

• Keyboard Response is a user message plus a From Keyboard code.
This is quite helpful for another user, so that they will know what kind of
data is expected when the merge stops for keyboard input. As with the
regular keyboard input, the user must click the End of Field button on
the Merge bar to resume the merge. (It’s often good to include that
instruction in the message.) You can put this kind of message only in a
form file.

• Macro pauses the merge, and opens a dialog box so that the user can
select a macro to run. We’ll learn about macros in Chapter 13: they’re
sets of instructions that can automate hundreds of steps and commands.
Your message, if any, is displayed on the screen during this time,
perhaps to help the user select a macro.
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• Form File pauses the merge and asks you to select a new form to use.
This is a nice feature if, say, you’re sending the same set of data to your
representatives in different states, but want to change the form for each
state, since some information pertinent to that state will be the same for
all letters going there. It’s easiest to use a new form rather than include
the specific information in all the records for the reps in that state. To
do this, you’d put this message in a data file. Use it in a form file if you
want a succession of form files, one for each data record, until the merge
reaches a form without this code.

• Data File pauses the merge so that you can change data files. This is
useful if you have one form you want to send to more than one data file.
In that case, put the message code at the point in a data file where you
want to switch data files. Used in a form file, it will switch data files at the
end of the form in which it appears.

• Field Number presents the Merge Field Number dialog, so the user
can choose which field to include at that point. This message can be
inserted in a form file only.

Next Record

You may have a nice data file for general use, and want to use only part of it
for this particular merge. Insert this code in your form at the point where
you want the merge to move on to the next record, leaving the rest of the
fields unused in this merge.

Form File…

Without invoking a message as above, this code pauses the merge and asks
the user for a new form file. Used midway through a data file, the code lets
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you send the first half of the records in a data file to one form; the remain-
der to another. Used in a form file, WordPerfect asks you for a new form
immediately after using the one containing the code.

Quit

This code stops the merge. If you want to use only part of a data file,
inserting this code in it tells WordPerfect where you want to stop.

Run Macro

Without invoking a message as described above, inserting this code pauses
the merge and asks the user to choose a macro to run. Macros are versatile
and powerful tools to automate sequences of tasks, or even give WordPer-
fect commands not available on menus. We’ll learn macros in Chapter 13.

Data File…

Without invoking a message, inserting this code tells WordPerfect to let
you choose a new data file. Used at the end of one data file, you can then go
right to another with the same form. Used midway through a form file, this
lets you switch data files and continue with the merge. You can customize
merges greatly this way.

Since it’s a more basic command, we covered To Printer above.
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Transfer

Used in a form file only, this command stops execution of subsequent
merge commands, and includes these commands, literally, in the merged
file. The second time WordPerfect encounters this code, it transfers again
and executes merge commands as usual.

Merge with database files

Although WordPerfect’s table, sort and filter features give it remarkable
database capability, you may want to use a dedicated database program
for record entry and management, and export records to WordPerfect for
merge tasks. Nearly every database program (such as FileMaker Pro,
Fourth Dimension, Omnis, Panorama, Helix, Foxbase) can export records
in a format WordPerfect can read. The most common is tab-delimited
text, a plain text file in which fields are separated by tabs, and records by
return characters. A spreadsheet program would also work for this pur-
pose.

WordPerfect converts this file type or others to its own format, with the
appropriate codes, using a macro. We recommend reading the macro
chapter so you will understand the background as well as the specific steps,
covered in that chapter, to take a data file exported from a database and
convert it to a WordPerfect merge data file.

Envelopes

WP’s merge feature interfaces with its envelopes facility. If you print
envelopes, please look at that section in Chapter 16.
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Publish & Subscribe

The feature looks like copying and pasting text or graphics from one
document into another, but there’s a major difference. When you write
some text or draw a figure, and put it in the scrapbook or in another file,
the data in the receiving file does not change if you change the original.

What we’re going to look at here is a means for copying data from one
document and putting it into another, so that if the original is later revised,
the receiving file is updated automatically. In the terms Macintosh uses,
we’ll choose all or part of one file, and publish it. We can then take
another document and subscribe to the published edition. Since most of
the good Mac OS 9 programs use this technology, any sort of program –
word processing, graphics, spreadsheet – can publish data, and any of these
programs can subscribe to it.

It’s a tremendous benefit to accuracy and productivity. The copy of your
accounting department’s spreadsheet and accompanying chart that you’ve
put in your quarterly report will remain current with the accounting
department’s original, even with all the changes those guys make.

There’s no limitation on how many subscribers one publication can have.
Hundreds of Mac users, probably but not necessarily on a network, can
subscribe their documents to your spec sheet. Conversely, you can sub-
scribe one document to any number of publishers. The parts catalog on
your Mac can stay current with individual product descriptions created on
25 other machines.

For our first example, let’s both publish and subscribe within WordPerfect.
Here’s what to do:
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Publishing data

1. In any file, select the text that you want to publish.

2. From the Edit menu, choose Publishing and then Create Publish-
er…. You’ll get a standard file dialog, but with a Preview section to the
left with, in this case, the text you selected. Figure 11.11 gives an exam-
ple of this.

Figure 11.11: Publisher dialog

This dialog asks you for the name of a new edition: the term for the actual
chunk of information. Enter anything appropriate as a name, and locate it,
just like saving a file, where convenient. We’ll talk more about locating
editions in a bit. Click Publish.

The dialog box goes away, and you’re back in your text but, instead of
being selected, it now has a new kind of border around it, indicating that it’s
an edition, as shown in figure 11.12.
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Figure 11.12: Published text

and is available for subscription by any document in any program that can
use this technology. This border stays visible as long as the insertion point
is within the edition.

Subscribing to data

For now, let’s subscribe to this edition with another WordPerfect file.

1. Open any other WordPerfect document, and place the insertion point
where you’d like this edition to appear.

2. From the Edit menu, choose Publishing and, this time, Subscribe
To…. Navigate to the edition you just published. The Preview area to
the left now shows the text in the edition. Click Subscribe.

3. The text appears in the window of the subscribing file, as shown in figure
11.13.
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Figure 11.13: Text as published and subscribed to
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Characteristics of an edition in a subscribing file

Although the edition as subscribed to looks just like regular text, you
cannot update it in the subscriber. Double-click anywhere in it, and the
whole edition highlights – and gains the border around it that it has in the
publishing file.

If you could update it in the subscriber, you’d lose the guarantee that
updates in the publisher would always be reflected in the subscriber.

This means also that spell- or grammar-checking, or search-
ing for synonyms with the thesaurus, will not work with a
subscription.

Updating data

Here’s the fun part.

1. Open both the publisher and the subscriber (although they don’t need
both to be open at once for Publish & Subscribe to work), and offset
them so that you can see the text in both.

2. Update anything in the publisher.

Nothing happens as long as the change is only in RAM. The publish/sub-
scribe structure doesn’t see the change until you save the publishing file.

3. Press Command-S to save, watching the subscriber as you do. Bang.

This is handiest on a network, where each subscriber has
immediate electronic access to the publisher, or on an individ-
ual computer where a project includes many parts comprising
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a whole. But it works just as well if you put an edition on a
flash drive and circulate it to other Macs. Each subscriber then
updates as soon as it is opened, with the drive available. If the
subscriber isn’t open when you update the publisher, the
subscriber updates whenever you open it.

Publisher Options

With your sample publisher as the active document, and your insertion
point in the edition (the border is showing), go back to the Publishing menu
and choose Publisher Options. This command, which is active whenever
you’re in a document that you’ve published in whole or in part, produces
the dialog shown in figure 11.14.

Figure 11.14: Publisher Options dialog

which, in the pop-up at the top, shows you the path you set to the edition.
You can then opt to Send Editions Manually instead of automatically on
save, if you’re making a lot of intermediate changes and don’t want to cause
unnecessary activity all over the network. The Send Edition Now button is
for manual use. The date and time of the latest update are shown and,
finally, you can cancel this publication. Other publications from this
document will be unaffected.
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Subscriber Options

Switch to your subscribing document, select the subscription and, from the
Publishing menu, choose Subscriber Options. The dialog box now looks
like figure 11.15,

Figure 11.15: Subscriber Options

which lets you choose to get editions manually and, if so, click on a button
to update to the latest one, or to cancel this subscription or all subscrip-
tions in a document, and to open the publisher – from WP or a different
program.

You also have the option to Preserve Formatting Changes. Although you
can’t change text in the subscriber, you can change formatting. If you want
to do this, check this box so that a publishing update won’t overwrite the
formatting you’ve given the subscriber.

You can also double-click on an edition to open the Subscriber
Options dialog.
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Working with graphics

Publishing a graphic involves only the extra step of going into the Graphic
Editor to create it. Once that’s done:

1. Close the drawing window.

2. Click on the graphic once, to select it.

3. Go through the same sequence to publish it, and then to subscribe to it.

In the Subscribe To dialog, the Subscription Format to Use pop-up will
normally default to the best format choice. Note that here it says PICT,
the generic drawing format WordPerfect uses for graphics.

Working between different programs

Now that you know what you’re doing, let’s look at how publish and sub-
scribe work going from one program to another. For these examples, we’ll
use Lotus 1-2-3, a spreadsheet, charting and database program. Feel free to
substitute another program while following along; any program that has the
legacy Mac’s publish and subscribe capability has the commands we’ve
discussed on the (almost always) Edit menu.

Figure 11.16 shows a pie chart made in Lotus from spreadsheet data.
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Figure 11.16: Subscription to a pie chart

The chart was selected and published, using exactly the same commands as
you used a moment ago in WordPerfect. We then subscribed to the chart in
a WordPerfect document, selected the chart and gave it a border. Any
changes our marketing people make in their worksheet numbers will reflect
in the pie chart in Lotus and, in turn, in our word processing file here.

One difference between an edition and a regular graphic is
that, if you subscribe to an edition with your Preferences set to
treat a graphic as a character, you can’t drag the edition and
thus anchor it to the page. Select it and change the anchoring
in the Graphic Options dialog, or set Preferences first.

Putting live spreadsheet numbers into WordPerfect is easy, and data will
update whenever it’s changed in the Lotus worksheet.
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Amazing connectivity

The dynamic linking of live data is a powerful tool, and it’s made even more
so by the ease with which you can track linked data back to its source. We
spoke a moment ago of double-clicking on the subscription to open the
Subscriber Options dialog, and of the button in that dialog to open the
publisher.

The upshot is that with a total of three clicks of the mouse, Lotus 1-2-3 has
in effect become a part of WordPerfect – just another window, with
additional menus and features – that you can open at any moment to
update original data. We can think of the programs, as well as their docu-
ments, being dynamically linked.

Handling an edition

The editions created by publishing programs are small files of their own at
the location of your choice, probably on your hard disk or on a network
server. Their icons are bordered with the same pattern that a publisher
shows when it’s selected. Since the path to their location is how both the
publisher and subscriber(s) find them for updates, they should not be
moved. Since there’s little reason to access them directly, they may as well
be nested in some little-used corner of your disk, such as the WordPerfect
folder in the Preferences folder of the System folder. They can be viewed
directly, though. Double-click an edition icon to get a preview, the type
(e.g. PICT), and a button to open the publisher.

If you discontinue publication of this edition in the Publishing
Options dialog, the edition file is deleted from disk.
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Summary

This chapter has looked at two powerful and versatile ways to link data
from different documents, and so provide a linking of program features –
first, between WordPerfect and databases; then, between WordPerfect and
most major programs of any type – that increase what you can do by
orders of magnitude. You can now:

• create form and data files, and merge them
• exercise extensive control over the merge process, using discretionary

commands and codes
• include instructions for other users of your merge files
• publish all or part of any WordPerfect document, and subscribe other

WordPerfect documents to it, on one computer or several, or over a
network

• publish data in a wide range of other programs, and subscribe a Word-
Perfect file to it

• publish data in WordPerfect and subscribe any document in hundreds of
other programs to it

• work with WordPerfect and these other programs as though they were
one program, lending a “document-specific” instead of “program-
specific” versatility to your work

With so many tools now available to you, it’s time to look at the workspace
in which you use them. WordPerfect gives you extensive choices in how to
customize that space to suit you best. We’ll look at this in the next chapter.





Chapter 12

Customization

In this chapter you’ll learn how to:

• set up WordPerfect’s environment just as you like it
• make any changes in command key equivalents in menus
• create automatic access to folders for resources, including folders on

networks
• set formatting defaults using templates
• add and delete buttons from bars, and make entirely new bars
• change language in WordPerfect

This chapter will be, for many of you, one of the most pleasant parts of
learning this program. Up to now, you’ve worked with the settings, de-
faults, or parameters that WordPerfect developers either felt would suit
most users best, or were a less complex setup and so more amenable to
learning.

Real power users, though, take pride and satisfaction from setting up their
copy of WordPerfect to reflect both the kind of work they do most often,
and their personal preference as to where things are and how they work.

This is hardly a trivial pursuit. Study after study shows that quality of
output and enjoyment of the producer of that output are greatly enhanced
by the producer’s ability to arrange workspace to suit herself.

The Macintosh began with a desktop metaphor, and the windows and
folders you see when you first turn on your Macintosh in the morning (all
right, afternoon) were designed to seem to you like an electronic desktop.
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WordPerfect takes the metaphor a step further, by giving you maximum
latitude to arrange your workspace to suit yourself.

We’ve already looked at some important tools for customization. Style
sheets, including editing the Document Style as discussed in Chapter 9, is a
major component. We’ve also looked at Button, Status and Ruler Bar
display options, and WordPerfect’s backup feature, all in Chapter 6.
There’s lots more.

Preferences

All that we’ll look at here governs defaults, or the way the program will
work until you make a change.

Environment

From the Edit Menu, choose Preferences. From the window of buttons,
click the one in the top left, Environment. You’ll see a dialog like figure
12.1, where the first features you see are the backup options that we looked
at in Chapter 6.

Here, many chapters later, it’s worth a reconsideration of what these do,
and their value to you. Our experience of the Macintosh system (as well as
others of course) is that it does crash, bomb, hang and go south from time
to time, and backing up data is vital to successful computing.
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Figure 12.1: Environment dialog

We’re lucky that WordPerfect is an exceptionally stable program, but other
factors – such as the inherent complexity of the Macintosh operating
system, the extensions and control panels (small programs that you can
drop into your system folder, and which then load into memory when you
turn the Macintosh on, and which can cause conflicts leading to system
errors), or viruses (see Chapter 17 for a discussion of these) – can all disrupt
WordPerfect’s operation, and even destroy (or, more exactly, corrupt) a
document, making that backup a very handy thing to have.

Screen colors

These options, for foreground text, background and highlight (the color that
surrounds selected text), will differ according to the color or gray-scale
capabilities of your Mac, and the system settings you’ve given it.
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Monitor appearance is important – the appearance of anything you look at
for hours at a time is going to be – and varying the fore- and background
colors may significantly reduce eyestrain as you work. There are many
things to consider; the kind of lighting in your workspace is one, so there’s no
one correct setting for screen color. And you certainly don’t want to look
like a Windows user on their way to Disneyland. Try a very light gray for
background, though, and see if you don’t like it. It lowers contrast, too much
of which can lead to eyestrain.

Format Menu

The Environment dialog has its own Menu Bar, across the top. Click on the
first menu, Format. You’ll see figure 12.2.

Figure 12.2: Environment Format Menu

The first section lets you choose either Paragraph or Single Paragraph
(checking one will uncheck the other). This is an important distinction
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when formatting text, and users certainly tend to prefer one or the other.
Here’s the difference:

Paragraph: let’s say you’re in the eighth paragraph of a 20-paragraph file.
You change anything on the Ruler or Layout Bar: margins, tabs, line or
paragraph spacing, or alignment. The change flows from the paragraph
your insertion point is in through to the end of your file (or until the point
where a style sheet takes effect).

Single Paragraph: the formatting change you make affects only the
paragraph your insertion point is in. If you have used either Microsoft
Word or WriteNow, you’re familiar with this configuration.

If you select text first, then change formatting, you essentially
reverse this distinction: with the Paragraph option in effect, if
you select two paragraphs and change margins or alignment,
only those two are affected. With Single Paragraph in effect,
you can change more than one paragraph by selecting that
amount first, and then applying the change.

Dormant Return is an elegant feature, turned on and off for a specific
document in Layout > Keep Together; the setting here is the default for
new documents.

Font Mapping is a feature that’s useful if you’re importing WordPerfect
documents from other computer platforms. With the feature on, WordPer-
fect will substitute a character in the active font for a character in the file
you’re importing, should that character be unavailable in the font you’re
changing to. If the feature is off, WordPerfect substitutes the character at
the same point in the Macintosh font character set.

The additional items on this menu are useful only if you have an Asian
version of Apple’s Worldscript installed, letting you use nearly any
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character set in any language. Contact your dealer, WordPerfect Corpora-
tion or Apple Computer to obtain non-Roman language scripts. The last
release of WP unfortunately predates Apple’s implementation of Unicode.

Options Menu

Let’s look at the second menu within the Environment dialog, as in figure
12.3.

Figure 12.3: Environment Options Menu

with these features: Graphic Font Menu is a useful and enjoyable option
that will show every font in your menu in its actual design, rather than 12
point Charcoal. This is great for font freaks like ourselves, who forever
search for that perfect typeface, and forget half the time what those we
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already have look like. (Fonts in the Character Format dialog in the Style
Menu (Command-H) also appear in their actual design).

The downsides are two: some special fonts such as symbol or display
characters, are hard to read when displayed on the menu this way. The
other is minor: since WordPerfect builds its map of what all your fonts look
like when you start the program, it takes a moment longer to load.

Extra Menu Command Keys shows keystrokes for many more com-
mands on the menus. Try this and see the difference. We’ll learn how to
change these keystrokes later in this chapter.

Command key equivalents work whether or not they’re dis-
played with this option.

We would recommend leaving the extra keys displayed, so you can learn
them. Keyboard equivalents are helpful when you’re entering text and
don’t want the interruption of reaching for the mouse. Some people don’t
select many commands from the keyboard, but we think that’s because
they haven’t learned how valuable a part of the word processing environ-
ment command key equivalents are.

Password Protect Documents sets this as a default. Normally, you’ll
need to check a box in the Save As dialog to enable a password. With this
default, that box is checked for you.

If you password-protect a document, don’t lose the password.
Aside from employing a tech security firm, there’s no way to
recover the document.

Drag and Drop is an elegant way to move (or, with the Option Key, copy)
text.
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Num Lock sets your numeric keypad to enter numerals. With this off, the
keypad helps you navigate in a document, as explained in Chapter 2. The
default is set here; change use of the keypad on the fly by pressing the Shift
and Clear keys.

Wrap Around Search tells WP to look for the word or phrase you’ve
entered in the Find/Change dialog starting at the insertion point, moving
forward or backward as you’ve specified and, when either end of the
document is reached, to keep searching from the other end, until the
insertion point is reached again. You can choose this option from the
Find/Change dialog itself (from the Direction menu). The option here sets
the default, every time you open the Find/Change dialog.

We leave it on as a default; then, if we’re sure we want to check only the last
1000 words in our 10,000 word essay, we can turn it off. More often, we’re
not sure of the exact location of what we want to find, and wrapping the
search is a simple convenience.

Snap to Grid in Ruler is a convenience for precisely locating margins,
first-line indent, tabs and columns. Snap points are every 1/16 inch, or a
comparable distance in other units of measurement. With this feature on,
press the Shift key to disable it as you move an individual marker.

Show Ruler Guides is a great feature. Click in the tab set area of the
ruler, and a dotted vertical line extends to the bottom of the active window.
This is a nice help for precise work.

Preselect Items in Ruler darkens an item, such as a margin indicator or
tab stop, when your mouse is hovering over it. You can thus tell whether
your click will be at the right place.

Spell As You Go enables contextual spelling – a word you’ve typed that’s
not in one of WP’s dictionaries (main, user or document) gets a squiggly red
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underline. Clicking on the word will produce a menu of suggestions; choose
any one to replace the misspelled word.

Thesaurus As You Go lets you click on any correctly-spelled word to
get a list of synonyms; choose any one to replace the original word.

Windows Menu

This menu is shown in figure 12.4.

Figure 12.4: Environment Windows Menu

Remember Window Locations assumes that you work with multiple
windows open, perhaps tiling or cascading them with the Window Menu at
on the main Menu Bar, and that you want a given window to retain its
position and size each time you open it. Otherwise, WordPerfect will size it
to full screen each time you open it.
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Remember Cursor Location causes an existing document to open with
the cursor in the same place as when you closed the file. A helpful mini-
bookmark, as it were.

Wide Insertion Point is a miracle for anyone with a large monitor, or
who otherwise doesn’t like to search for the thin blinking insertion point.
The wide option is twice as wide when it’s not just to the right of a charac-
ter, and blinks over the width of an entire character when it is just to the
right. A simple idea, as Tolstoy said all good ideas are.

Show White Space is useful if you pay special attention to margins, or
are doing page formatting and also using headers, footers or footnotes.
WordPerfect doesn’t show these parts of a document when you’re in editing
mode; you need to open their individual windows, or go to Print Preview,
to see them.

If you select Show White Space, however, WordPerfect leaves room for
them in editing view, and shows page breaks as actual beginnings and ends
of sheets of paper, rather than the dotted line. This can be a good help for
page layout, including positioning graphics.

Show ¶ turns tab, space, return and list marking symbols on as a default.
You can turn them on and off for any one document with the command of
the same name (or Hide ¶) on the Edit menu. It’s a useful feature from time
to time to see where returns, tabs (shown as arrows) or spaces (shown as
dots) fall. We don’t leave these symbols showing otherwise, although some
people like to see them.

Show Merge Markers tells you where codes are that will affect a merge
operation. Again, it’s a matter of preference, but helpful when creating
merge documents.
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Show Codes opens the codes window with every document. The Codes
are more detailed than the paragraph markings visible with Show ¶, but the
Codes window takes up room, and slows scrolling down drastically, since
WordPerfect is now drawing two windows instead of one. The Codes
Window is tremendously helpful at times, and available as a default here.

Graphics Menu

This menu’s commands are shown in figure 12.5.

Figure 12.5: Environment Graphics Menu

The first three commands govern how WordPerfect treats a graphic you’ve
placed in the document. Character means that the graphic is treated just
like any letter or numeral in your file. It is placed on one line, and probably
adds height to the line. Entering text to the left of the graphic moves the
figure to the right. Text does not flow around the graphic.
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Alternatively, you can anchor the graphic to the precise place in the
paragraph in which you’ve placed it, or to the exact point on the page. In
both of these cases, text flows around the graphic.

You can select any of these options for any individual figure in the Graphic
Options dialog; the command here sets the default.

Anchored to a paragraph, the graphic stays with that paragraph, and at the
same position relative to the beginning of the paragraph. (That position can
be changed in the Graphic Options dialog.) If you add text to an earlier
paragraph, causing the paragraph with the anchored graphic to move to the
next page, the graphic moves with it. This takes a little getting used to, but
is the most effective setting for most graphics embedded in a document.

Anchored to a page, the graphic does not move. If you add or delete text at
an earlier place in your document, text moves around the graphic. If you
add or delete enough text that the code for the graphic moves to another
page, the graphic moves from one page to the other but stays in the same
position on the new page.

This setting applies to Text and Equation Boxes as well as Graphics.

Once you place a graphic with whatever setting here, if you
drag it from its original location it becomes anchored to the
place on the page to which you dragged it.

Display Figures is a command you will certainly want active much of the
time. The advantage to not displaying graphics is that WordPerfect can
scroll faster. Any figure is displayed if you select it, returns to a blank box
on screen once you deselect it, and prints in any case. Display Overlay is
much the same idea.
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Units Menu

This menu governs the default for units of measurement. You can change
units in any individual dialog box by clicking the abbreviation (e. g. “in”), to
cause a menu to drop with the other units available. There’s no indication
that the abbreviation holds a menu, but abbreviations for units of measure-
ment in all dialogs in WP do this.

The other units of measurement are: centimeters (2.54 per inch); points (a
printing measure, with 72 per inch. Type sizes are commonly expressed in
points); picas (another printing measure: six picas are an inch, and 12
points are a pica); ciceros or didots (European units of measure: there are
5.63 ciceros to an inch; 67.5 didots to an inch; 12 didots per cicero);and em
widths, again a printing unit, with eight to an inch.

Language Menu

You will never need to change these settings unless you’re working with
alphabets other than English and (especially) scripts other than Roman.
Obtain a copy of the Apple Language Kit, software that allows use of
different scripts, such as used by Asian languages.

Show Unknown Alphabets causes WordPerfect to display a character
with the Unknown symbol (two question marks, with one inverted) when
importing a character from another script for which there is no equivalent
in the script presently in use.

Search Mixed Alphabets is used when one language may be written in
two alphabets. The Find command will look for one character in both, if
this feature is on. The Match menu in the Find dialog will include two more
commands, Character Representation and Alphabet, when this
feature is enabled.
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Switch Font With Keyboard defines the relationship between a script,
e. g. Cyrillic or Kanji, and a font appropriate for that script. If activated,
when you choose another script WordPerfect switches to the last font you
used with that script in the current session or, if you have not used that
script in this session, to a font it recognizes as appropriate.

Switch Keyboard With Font does the same in reverse. Choose a font
that is used with a different script, and WordPerfect switches to the appro-
priate script.

Allow Setting Fonts of a Different Script lets you modify text in two
scripts in one action, just by changing fonts.

Use Inline lets you enter text in non-Roman script into the main window
of the Document Editor, rather than a separate window, if you have in-
stalled Apple’s Language Kit.

See the Language section later in this chapter for other
commands relating to different languages.

Close the Environment dialog, and you’re back in the Preferences window.
Let’s look at what the next button down has to offer.

Keyboard

Click the Keyboard button, and you’ll see figure 12.6,
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Figure 12.6: Keyboard dialog

with a large scrolling window chock full of WordPerfect commands. Scroll
down this list for a look at these, some of which aren’t available on menus.
Others are available on the small menus on the ruler bars.

Using this dialog, you can create (or change) these command key equiva-
lents, or keystrokes, for any command in this scrolling window. Let’s say,
for example, that we want to add a keystroke for the command to place a
bullet and a tab indent at the insertion point. We could use the button on
the Button Bar but, sophisticated word processors that we are, we want to
keep our hands on the keyboard.

1. Scroll down the command list to Bullet With Indent. Hint: If you can
type “bul” fast, you can select this command on the list that way.
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2. With a command selected, the Assign button in the Keystrokes box
becomes active. Click Assign. The Assign Keystroke dialog appears.

3. On your keyboard, hold down the Command and Shift keys, and
press the letter B. This will look like figure 12.7.

Figure 12.7: Assign Keystroke dialog

4. Click Assign. You’re returned to the keyboard dialog, which now looks
like figure 12.8.

5. Click Done. 

Test your new keyboard equivalent. Pretty slick, no?

You can as easily remove a keystroke. Select the command in the scrolling
list, and its equivalent (one or more) will appear in the Keystrokes box.
Click on the one you want to remove, to select it, and click Remove.
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Figure 12.8: Keystroke has been assigned

To assign a keystroke, you can use the Command Key and any regular key,
or any combination of Command, Shift, Option and Control keys.

As well, you can use the five or the seven key on the keypad, which Word-
Perfect calls the Gold Key. With the other keys, you have to press the
Command or other keys and hold it down while you press the regular key.
With the Gold key, you can press and release it, then press the regular key.

You can press the Gold Key once, then the regular key or, for a separate
keystroke, you can press the Gold key twice. So, Gold-M might mark a word
for a table of contents level one, while Gold-Gold-M would mark for level
two.
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When you press the Gold Key once, the cursor changes to the numeral 1, to
reflect this. Press it again, and the cursor is the numeral 2. Press a third time
to cancel.

Here’s a hint: there are plenty of modifying key combinations for whatever
you want, and the secret to not forgetting them is to structure them. All the
Control-Shift combinations might be for one kind of command; all the Gold
Key combinations for another.

Keystrokes for other program features

The keyboard dialog defaults to Commands in the Type pop-up above the
scrolling list. Click that menu to see what else is available; you’ll see figure
12.9.

If you choose Characters here, you can assign a keystroke to any charac-
ter. Tired of typing “c” to get that letter on screen? Want to type “h” instead?
Why sure. Actually, the more common use for this is if you type many
characters that require use of the Option and Shift keys, you can simplify the
task this way.

You can, to be sure, remap an entire keyboard here, but it’s
time-consuming and besides, someone else has probably
already done it. The Dvorak keyboard is an example, part of the
Mac OS.

In WordPerfect’s Keyboard dialog, if you choose Menus as the type, you
can assign a keyboard equivalent to a whole menu. Type the equivalent and
the Open Latest menu, for example, appears in its own dialog box in the
center of your screen. Type the letter next to what you want, and it’s done.
Who needs a mouse?
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Figure 12.9: Type Menu in the Keyboard dialog

While not all menus show letters to the left of the commands, all letters
work. Type D, for example, to get the fourth command on a menu you’ve
opened this way. While awkward at first, this is a helpful way to access from
the keyboard any menu command you use often, but not often enough to
assign its own keystroke.

If you choose Styles here, you can assign a keystroke to a style sheet.
You’ve already learned how to do that in the Style Options dialog; here is
just another place to do it.

The other possibilities, Macros and Variables, are topics we haven’t
covered yet.
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Alternate keyboards

As you see, you can make extensive changes to keyboard mapping and
functions, and you might want more than one keyboard setting to do all of
this to. Your associates who share your computer and WordPerfect might
want that also.

1. Click Copy Keyboard. You can create and name a new keyboard here,
which will then appear on the pop-up at the bottom left. Set up different
keyboards for different specific tasks. To delete a custom keyboard,
select it from the pop-up, and click Reset Keyboard. You’ll have the
chance to rename the custom keyboard first, to avoid losing its data.

2. Click Create Listing, to get a text file with every keyboard equivalent
assigned in the active keyboard. This will be helpful if you’re planning to
assign a lot of equivalents. It’s also helpful, just to see what’s there that’s
not on menus. Did you know you can hit Command-Option-W to
remove the Status bar (and restore it)? Same with Command-Option-
B for the Button bar.

If you assign an equivalent to a command, and the same equivalent is
already assigned to another command, WordPerfect removes the assign-
ment from the original command. The program asks you first, by noting its
assignment in the Assigned box in the Assign Keystroke dialog, as in
figure 12.7 above.

Libraries

We discussed Libraries in Chapter 9, as a location for style sheets. You can
keep most other resources in the Library as well, keyboards among them.
You can also copy a keyboard into a document and give it to a colleague, so
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she doesn’t have to repeat the elaborate key mapping you spent all week-
end on.

To make a copy of WordPerfect’s library, switch back to the Finder. Then
go to your System Folder, thence to the Preferences folder, thence to the
WordPerfect folder. You’ll see a file named Library followed by (AUS),
(CAN), (GBR) or (USA). We’ll call it the Library file.

Give a copy of that to your colleague. Archive another copy on a backup
disk, now that you have all that work in it.

Your colleague can put the Library file in the same place in her System
Folder (having quit WP first), but doing that will replace the Library file
already there. No problem, if she hasn’t done any customizing yet. But if
she has, her modifications are stored in her Library file, and she won’t want
to lose them.

Instead, using the Librarian feature in Preferences, she can copy
anything she wants from your Library style into hers. See the Styles section
of Chapter 9 for a discussion of how to copy Library resources.

A better way to do this, if you have a network, is to copy the Library onto a
network volume and rename it Common Library. All the styles and
keyboards (and macros, which we’ll learn in the next chapter) will then be
available to every WordPerfect user on the network. Users will not have to
perform any steps to access these resources; they will simply appear in the
appropriate menus.

Locating a Common Library

If you put a Common Library on a network, you will have to tell WordPer-
fect where it is. This procedure also lets you tell WordPerfect where many
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other resources are, either on your hard disk or the network’s. If every-
one’s hard disk is full, for example, your network administrator can place
one copy of WordPerfect’s dictionary and thesaurus on the network, and
everyone can use it there.

To tell your copy of WordPerfect where these resources are, open the
Preferences window from the Edit menu, and click Folders. In the result-
ing dialog, click the Type menu. You’ll see figure 12.10.

Figure 12.10: Preferences > Folders

The first choice, Documents, tells WordPerfect always to go to the
specified folder when you choose the Open command from the File Menu.
It’s a timesaver, rather than navigating your way around your hard disk.
You can of course put many folders inside the specified folder, and go to
any of them, from the standard Open dialog, by typing the first letter of
their name. Click Set Path, and proceed through the standard file dialogs.
Click Set when the folder of your choice is open in the dialog box.

The Library choice is already specified: the Current Path should point
to your System folder > Preferences folder > WordPerfect folder.



Chapter 12: Customization 431
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

The Common Library path will depend on where your system adminis-
trator has put this file, on the network server. Once again, click Set Path
and navigate to the file in the standard manner.

Language Tools are the main dictionary and thesaurus. These files
should be in the Language folder in the WordPerfect folder that the
Installer program created on your disk when you first installed WordPer-
fect. This is a good place for them unless you have a specific reason other-
wise.

Mostly, where WordPerfect puts things is a good place for
them. Many people like to move the WordPerfect program out
of the WordPerfect folder, so it’s more readily accessible. Well
and good, but run the program at least once from its original
location before you do this. The other folders: Language,
Templates, etc., are best left where they are. You can then
tuck the WordPerfect folder out of sight on your disk, and
leave the program icon in view. Or, leave the application in the
folder and place an alias to the application wherever you like.

User Dictionary contains the specialized spellings you’ve included as
legitimate by clicking the Add button when checking spelling. This file
belongs on your disk, not on the network, because of its specificity and
because you frequently make changes to it. The main dictionary and the
thesaurus aren’t files you change the contents of (although you can change
the main dictionary, including the hyphenation points, using the ST
Utility that comes with WordPerfect). So WordPerfect lets you place the
User Dictionary separately from the other language resources.

Help is the on-line treasure we studied in Chapter 6, plus separate help files
for macros and grammar, and the balloons. Again, best left where it is,
unless you want to put it on a network.
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WordPerfect Folder is the folder the Installer created and put every-
thing in. If you move the program itself out of the folder, check to see that
this setting points to the folder containing the various resources, rather
than the application.

This is because there are not separate paths to set to the Conversions and
Templates folders in the WordPerfect folder. Conversions are those
resources WordPerfect needs to open files created by other programs, and
Templates is a set of default documents, which you can add to and change
as you wish, that can save a lot of time setting up individual documents of
certain types – letters, reports – that you do often.

We’ll learn how to add and modify templates later in this chapter. For now,
let’s explore the rest of the Preferences window. We looked at Show Bars
in Chapter 6. Here’s the others.

Files

Access this by the third button on the right in Preferences. You’ll see figure
12.11.

The Open Latest Menu governs the command on the File menu that lets
you go directly to the last several documents you’ve opened. Of interest is
the Number of files. Although the default is ten, we recommend a larger
number – why not make maximum use of this convenience? As explained
above, we’ve assigned a keystroke to the Open Latest Menu: pressing that
will open the menu in its own window, with letters to the left of each menu
item. Type a letter and that file opens. So we’ve set 26 files to show in this
menu, one per letter of the alphabet.
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Figure 12.11: Preferences > Files

Open File Dialog lets you set what kind of documents you want to be
listed. This, set for a particular work session, is a helpful timesaver – you’re
working intensively with figures, say, and are opening graphic files from
folders that have many other files besides. By specifying that you want only
graphics files displayed, what you want is easier to find. For general use, we
prefer to leave Documents as the setting.
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Show Preview in Open Dialog is elegant and practical. You can see at
least part of whatever file is selected in the open dialog’s scrolling list, a
feature easy to appreciate. You can turn this feature on or off from the
dialog itself; the present checkbox sets the default. One reason to leave it
off is speed.

Save As File Dialog gives you a choice among the various file formats to
which WordPerfect can save or export. You can choose any of these when
you first save a file, or choose Save As for an existing file. This menu sets
the default.

The standard, Mac WordPerfect, is what you want for most purposes. Of
the others: Mac WP Template creates a template of the kind we’ll look at
later in this chapter. HTML (Hyper Text Markup Language) is the format-
ting protocol used for web pages. RTF (Rich Text Format) is a file type that
Microsoft Word can read – use this for files you’re giving to people who
still use that word processor, when you want to retain formatting, some-
thing that a text file (also called ASCII Text or Plain Text) can’t do. Use
Text to write a file that nearly every Macintosh word processor, database,
spreadsheet, etc. can read.

User Dictionary lets you export a list (one word per line) into WordPer-
fect’s user dictionary format, so that you can add a few hundred words at a
time to it. This is rarely useful as a default, though. WordPerfect 2.1
Export writes in a format that the earlier version of WordPerfect can read.
WP 3x writes a file that WP 3.0 through 3.4 can read.

Now that WP 3.5e (which is really version 4) is free, there’s no need to use
earlier versions. See the WPMac Support Group page at the start of this
book to download this latest version.

WP for PC 5.0 and 5.1, 5.2 write a file that these versions of WordPer-
fect for DOS or Windows can read. This is a great feature if you work with
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people who use those platforms, especially on a network. XTND Export
is a file exchange format developed by Claris Corporation.

Date/Time

When you choose either Text Date/Time or Auto Date/Time from the
Insert menu, or add this data via the button in a Header or Footer window,
the date, time or both are placed in your document, in a format governed
by this setting. Text does not update once placed; Auto updates every time
you open or print the document.

These three menus allow extensive flexibility in how this data will appear in
your file. Click to place your insertion point, delete a code with a key-
stroke, and add another from a menu.

Font

When you learned how to edit the Document Style, you saw that one use
was to change the default font. This button in the Preferences window does
the same thing. It’s faster to set, but a font set in the Document Style will
override the setting here.

Once again, may we caution against changing the font or size too radically
at this point, instead of when you format or print. How long you can
productively stare at your screen results from a combination of factors.
Screen colors are a part, as we saw earlier this chapter. Font and size play a
role too. WordPerfect ships with Geneva 12 as default; the two
SheepShaver packages at WPMac, designed for more modern screens with
higher resolution, use Lucida Grande 14. Something large enough and easy
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enough to read onscreen is best for composing, and you can change it to 10
point Times for formatting and printing.

Word Services

This button lets you add utility programs, such as dictionaries, that are
newly programmed to interface with other applications using a protocol
called Apple Events. Programs you choose in this dialog are added to
WordPerfect’s Tools menu, and are then available every time you run
WordPerfect, just as though they were part of the program. The freeware
Excelsior dictionary, for example, is an excellent resource you may want to
use in addition to or even instead of WP’s own dictionary. Download
Excelsior from the Files section of WPMac and install it here.

Other buttons in Preferences

The two remaining buttons in Edit > Preferences are HTML and Mailer.
HTML is covered in Chapter 16 in the section on Hyperlinks. Mailer
accesses an Apple feature called PowerTalk, a means for sending and
receiving email as documents of different formats, such as WP’s. This
feature was introduced in Mac OS System 7 and has since been deprecated.
It was a good idea but, when email first moved from mainframes to person-
al computers, dedicated programs like Eudora captured the public’s
imagination first.

Templates

In our discussion on style sheets, we noted that you can save style sheets
either in the Library or in a document. A style in a document will override a
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Library style of the same name, allowing you the flexibility of a second set
of specific styles any time you open a particular document.

Instead of cooking up a new document every time you want a new set of
styles or other defaults, you can cook once and save it as a template.
Then, every time you open a template document, you’re actually opening a
copy of it, to enter text and graphics as you wish and save as normal. The
formatting, attributes and style sheets you’ve added, go with it. Let’s head
for the kitchen.

Creating a Template

1. Start a new document. Change the left and right margins to 1.25 inches.
Type “A Note from [your name]…” and make that 18 point bold italic.
Press return. Set font size to 12 and attributes to plain text.

2. From the Layout menu, choose Borders and then Paragraph. In this
dialog, in the Border box, allow only a top border. Choose a type you
like (double thin lines?), and click OK. Press return twice more.

3. On the Layout bar, set line spacing to 1.5, and paragraph spacing to 1.

4. Save this document in Mac WP Template format, and save it in the
Templates folder in the WordPerfect folder. Title it “Note”.

You’ve created a template that you can use repeatedly, without disturbing
the original.
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Using Templates

1. From the File menu, choose the Templates submenu. You’ll see “Note”
among the choices.

2. Choose this, and a new document will open as Untitled. The formatting,
text and border (and style sheets if you had made any and saved them in
the document) are all there.

3. Press down arrow until you’re at the end of this file (still near the top),
type a note, and save this. It saves as a new document, prompting you
for a name, and does not alter the Note template.

You can make and save as many templates as you want, and add to each all
of the program features you’ve learned so far in this book. You can add
macros to template files, once we learn them. There isn’t much you can’t
do.

For boilerplate, you can create a template with most of the text you need,
and just a few blanks. You can then clear all tabs except for one at the start
of each blank. Distribute this template around the office, or over the
network. You’ll be seen as a Macintosh guru.

You can create WordPerfect templates, using that file format, and put them
anywhere. The single advantage of putting it in the Templates folder is that
it’s available from that submenu.

Aside from the convenience, templates offer accuracy in formatting. Each
of your various kinds of word processing output will be consistent, coming
from the same source.
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To modify a template, open it as Untitled, make changes, and save it, in
template format, to the same place with the same name, replacing the
original file.

Templates that affect all new documents

If you want to change default formatting for all new documents, create a
new file, set formatting as you wish, and save it as a template in the Tem-
plates folder with the title “New Document Template”. Every new file you
start will then have these settings. Move this document out of the Tem-
plates folder to restore WordPerfect’s original defaults.

Button Bar customization

You’ve seen how to move the Button bar around on screen. You can also
edit it, or make new ones. Let’s try a new one first. Start a new document,
and:

1. Click the Button Bar menu, represented by the down arrow at the top of
the bar (or at the right, if you’ve aligned your bar horizontally). Choose
New. In the resulting dialog, from the Save In pop-up, choose Cur-
rent Document, as in figure 12.12.
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Figure 12.12: New Button Bar dialog

2. Name the bar “Sample Bar”, type a short description if you want, and
click New. You’ll get figure 12.13.

Figure 12.13: Edit Button Bar dialog
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3. Move your cursor over the collection of buttons; it changes into a hand.
In the Help box, you see a description of what that button does. When
you find a button you want:

4. Click and hold on it, and drag it over to the Button bar. A dotted square
follows your motion.

You can also double-click the button.

5. You can rearrange buttons on the bar by dragging them.

Add some buttons, from among the possibilities in the Editing, Formatting
and Layout categories (feel like you’re in a shopping mall?).

Changes to this new Button Bar, saved with your document,
are not saved until you save the document itself. In a major
Button Bar effort, exit the edit mode every so often to save
your file.

6. Click the Show pop-up to go to the Drawing buttons which, although
you can add them to your new bar in the Document Editor, will be
grayed out until you enter the Graphic Editor.

7. Choose Custom from the Show menu. Fun begins here. None of these
buttons are assigned to anything. You do that.

8. Double-click a button that looks nice. Figure 12.14 appears.
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Figure 12.14: Assign Command to a Button

with the same list of commands you saw when assigning keyboard equiva-
lents. Choose any of WordPerfect’s commands for this button.

Moving on, you see that you can assign macros, templates and styles to
buttons.

We asked you to save this new Button Bar in the document
rather than the Library just to facilitate practice. If you like your
customization, you can move this Button Bar into the Library,
using the Librarian feature in Preferences.

You can as easily move a Library Button Bar to a document for transport,
and Button Bars can be added to the Common Library on a network.

If you’ve edited a Library Bar, and want the original back:

1. Switch to a different bar, and then open the Librarian.
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2. Delete the bar you edited. WordPerfect replaces it with the original bar
of that type.

Changing languages

WordPerfect has main dictionary and thesaurus files for 18 languages. All
are available at WPMac. You can combine languages in a document: have a
first page in English and then switch to Spanish, for example. You will want
to tell WP where you’re making the switch, so that when you spell-check or
look for synonyms, WP can access the correct language files.

You might also want the default language to be other than English. Just
make a New Document Template and set language there.

1. From the Tools menu, choose Language and then Set Language….
You’re given a list to choose from, as in figure 12.15.

Figure 12.15: Set Language
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Your choice from this list takes effect at the point in your document where
you make it. The importance of this is that you may have a document in
two or more languages and, for spell-checking, hyphenation or thesaurus
purposes, you need to tell WordPerfect where in your document to switch
from one dictionary to another.

2. If you want to delete a change in language, show the Codes window,
where a code for each language change appears. You can also use the
Find Codes command.

Use Inline

This command is operative if you have Apple’s Language Kit installed, and
will let you enter and edit two-byte text, such as Japanese scripts, in the
Document Editor rather than in a special text entry box similar to the
subtitle box.

Summary

This chapter has given you a wide range of capabilities to personalize your
word processing environment, an important consideration for high-quality
and creative work with text and graphics. More advantages of
customization will occur to you as you go along, but you have the tools
now. You can:

• make substantial changes to WordPerfect’s environment
• add and change keyboard equivalents for any WordPerfect commands
• establish paths to resources, permitting great flexibility in individual

and network use
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• create templates and add them to the menu, offering substantial flexibil-
ity with standard forms and documents, accuracy and consistency in
formatting, and ease of use

• create and modify Button bars, including adding any of WordPerfect’s
commands to Buttons

• work with language modules and set subtitles

and we think the description “advanced user” is beginning to apply to you.





Chapter 13

Macros and AppleScript

In this chapter you’ll learn how to:

• record your own macro, in two quick and easy steps
• use the many macros that come with WordPerfect
• copy, rename and delete a macro
• edit the script of a macro
• write, rather than record, a macro
• use macros for organization of large amounts of textual data
• use variables, loops and other programming concepts in a macro
• do much the same with AppleScript, Apple’s system-level equivalent to

WP’s macros

In generating lists, cross-referencing, sorting, and merge, you set up the
kind of thing you wanted to do, and told WordPerfect to do the perhaps
hundreds or thousands of steps involved. These features promote accura-
cy, and save a lot of time, but they’re limited to the certain structures that
cross-referencing, for example, may provide.

What if you taught WordPerfect a certain sequence of steps – any se-
quence – and then had it do that sequence the hundred or thousand times
you wanted? Such a sequence might be:

a. Find the next word in your file that’s in bold.
b. Copy it.
c. Switch to another document and paste the word there.
d. Add a hard return, to start a new line.
e. Switch back to the first file, ready to look for the next word in bold.



448 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

You could then tell WordPerfect to repeat these steps all through your file,
as long as it might be.

This sequence is largely how we constructed the index for this book. As we
wrote, we put a word or phrase in bold if it was the first time we used the
term or command, or if we gave it extended discussion. These are also
nearly precisely the words and phrases we wanted to index. We could have
marked the words for the index at the same time we made them bold, but
what would be the point? WordPerfect already had a way to distinguish
them from the rest of the text.

Such a sequence of steps is called a macro. It can also be called a script,
and these can be synonymous, or we can say that you record a macro and
write a script. WordPerfect lets you do both. Let’s look at some easy
examples.

Macros

Let’s start by recording a simple macro, to end a letter.

Recording a macro

Think of this exercise as turning on a tape recorder, doing some actions,
and then turning the recorder off. You can then play those actions back at
any time. Let’s make a simple recording to close a letter in one keystroke:

1. From the Tools menu, choose Macro and then Record…. Figure 13.1
will appear:
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Figure 13.1: the New Macro dialog

with the contents in the Name box, “untitled Macro”, selected.

2. Type “Close Letter” here.

3. In the Keystroke box, click Assign, and give it the keystroke Com-
mand-Option-C. Save it in the Library (USA), as is the default.

4. Type a short description if you like, although the title should do in this
case.

5. Click New.

WordPerfect is now recording the steps (keystrokes and menu commands)
that you do. It is not recording the time you take to do them. Go slow – this
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is your first macro – and type the following:

1. Press Return twice.

2. Press Tab nine times.

3. Type “Sincerely,” or whatever you wish to use.

4. Press Return four times.

5. Press Tab nine times.

6. Type your full name.

As you do all this, note that the Status Bar says “Recording Macro”.

7. From the Macro menu, choose Stop Recording. You’ll get a dialog like
figure 13.2:

Figure 13.2: the Save Changes dialog

8. Click Save. That’s all there is to it.
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Playing back a macro

Erase the “Sincerely” and your name that you typed while recording, press
Return to start a new line in your open file, and type what might be the last
line of a letter. After you finish that, just hit Command-Option-C. Bingo.

WordPerfect will record a macro consisting of anything you
type, plus anything you do in the menus, buttons, or dialog
boxes with your mouse. It will not record general mouse clicks
you make in a document itself, to move your insertion point
down two lines, for example. Use the arrow keys or the
keypad for this.

You can play a macro by pressing its keystroke, if you gave it one, or by
choosing it from the Macro submenu off the Tools menu or by going to the
Macro Menu and choosing Run, as in figure 13.13.

Figure 13.3: the Run Macro dialog
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You probably won’t want to give lesser-used macros keyboard equivalents,
or even show the macro in the menu – if you rarely use it, say – or it’s going
to be a component of some other macros.

Macros that come with WordPerfect

The macros that come with WordPerfect often perform actions that are
just too complex for a single program command to accomplish. Try Daniel
Midgley’s “Emboss”, for a useful decorative graphic. We selected text and
ran the macro for the following display, as shown in figure 13.4.

            

WordPerfect Mac
            

WordPerfect Mac
            

WordPerfect Mac
Figure 13.4: Result of the Emboss macro

A useful macro if you’re doing a merge with a file from a database is “Data-
base <-> Merge File”. Databases can export records in formats such as tab-
delimited, a text file in which the contents of each field is separated by a
Tab, and each record separated by a Return. This macro turns these
characters into the End of Field and End of Record codes WordPerfect
needs to merge this data with a form.

To use this, first determine how the data text file you’re importing sepa-
rates its fields and records. Then open the data file in WordPerfect, and run
the macro, answering its questions as you go. Quick and easy.

A number of macros, among other useful resources, have been provided by
WordPerfect Corporation in “Document Experts”, free at WPMac.
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Editing a macro

What if, in the process of recording your first macro to close a letter, you
spelled your name wrong? Change your name to match? Buy another copy
of WordPerfect? No, there’s an easier way. Let’s edit your macro.

1. From the Macro menu, choose Edit…. You’ll see figure 13.5.

Figure 13.5: the Edit Macro dialog

2. Scroll to the Close Letter macro, and click Edit Content, or just
double-click on the name of the macro. A new window opens showing
the following lines, the actual script of your macro:
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Hard Return
Hard Return
Tab
Tab
Tab
Tab
Tab
Tab
Tab
Tab
Tab
Type (Sincerely,)
Hard Return
Hard Return
Hard Return
Hard Return
Tab
Tab
Tab
Tab
Tab
Tab
Tab
Tab
Tab
Type (Charles Babbage)

where the letters in bold form a WordPerfect command, and the plain text
in parenthesis is what the command is to type. The plain text is called a
parameter or an argument to the command.

3. Make what changes you want here: delete or add tabs or returns, or
change what the macro types.
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4. From the row of buttons at the top of the macro window, click Save.
Then close this window.

If you make a mistake editing the script, and include a command WordPer-
fect doesn’t understand, the offending text will be underlined. If you then
click Save, you’ll see figure 13.6.

Figure 13.6: the macro error alert

At this point, you shouldn’t be having problems with the commands “Tab”
and “Hard Return” but you might have mistyped one.

A couple of useful macros

By now, you’ve probably had, several times, the gem of an idea, “Hey, I
could use a macro for …”. Yes. For instance, if you’re as sorry a typist as we
are, you can record these next two:

Letterswitch

We often get two lettesr switchde when we tyep. Such a drag. Here’s a fix.
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As setup, type a word with two letters in switched position, e. g. “Thsi”.
Leave the insertion point just after the second letter, and start recording.
Letterswitch might be a good name and, for keystroke, find something like
Control-Z, or one of the F (function) keys, that you can get to easily with
one hand. Now that you’re recording:

1. Holding down the Shift key, press Left Arrow to select the “i”.

2. Choose Cut from the Edit menu.

3. Press Left Arrow, to move the insertion point to the left of the “s”.

4. Choose Paste from the Edit menu.

5. Press Delete to remove the space added after the pasted letter.

6. Press Right Arrow to move the insertion point to the right of the
switched letters. Stop recording, saving changes.

Check this macro out. You should let WordPerfect do this kind of low-level
stuff for you. Since studies say that switching letters is among the most
common typing mistakes, this macro may save you energy as well as
irritation. Let’s try another:

Cap It

Another common typing mistake is failing to capitalize the first letter of a
word. As setup for a macro to fix it, type a word in all lower-case that
should have an initial cap, such as “tahiti”. With your cursor just at the
right end of this word, start recording, again giving this macro a convenient
keystroke.
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1. Press Option-Shift-Left Arrow, to select the word.

2. Choose Initial Caps from the Style menu. The first letter of the
selected word will become capitalized, with the word remaining selected.

3. Press Right Arrow, to move the insertion point to the right of the word,
deselecting it in the process.

4. Stop recording.

This macro works at any point in the word that needs an initial cap or, when
you’re proofreading, you can just click anywhere in a word and hit the
keystroke.

Page X of Y

Here’s a simple macro that will let you enter, as one keystroke, the current
page and the total number of pages in the document. The data updates as
you add or delete pages. You could do this manually, but it’s a good exam-
ple of automating the several steps of a task.

Open a multi-page document, put your insertion point where you want
“Page X of Y” to appear – or put it on a separate line anywhere, since you
can cut and paste it later – and start recording, with a name and (optional-
ly) keystroke you like. Then:

1. Type “Page” and a space.

2. Choose Page Numbers… from the Layout menu.

3. Click “Place Page Number at Current Position”, and click OK. You
should have “Page X” so far. Type a space, “of” and another space.
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4. Choose the List command on the Tools menu. In the dialog, choose
Create Reference as Type, with Page as the Target Type. For a
Target ID, type something short, descriptive and easy to remember (as
always); “end” will serve well. Your dialog should look like figure 13.7.

Figure 13.7: the List dialog, appropriately set up

5. Click Mark. 

6. Go to the very end of your document (Gold-Gold-2 on the keypad), and
recall the List dialog. Your target ID should still be there, since this is the
next action. Choose Mark Target, and click Mark again. There’s now
a question mark in your file where page “Y” will be.

7. Stop recording, saving changes.

8. Call the List dialog again, and choose Generate. Recreate lists when
asked. Page X of Y should now be accurate, and stay accurate as you add
and delete text.
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If you paste text at the very end of your file, though, you might
put it after the target, so simply open the codes window before
you do this, and see that the insertion point is to the left of the
target code.

9. Play this macro in any document. You can include the generate com-
mand in it if you want, but that’s a command most profitably run at a late
point in document creation, since it updates all defined lists.

A nice place for this page information is in a header. It won’t
work if you play the macro there, since the target at the end of
the file will then be put at the end of the header. So play the
macro in your document, then cut “Page X of Y” and paste it
into a header. It will work just fine.

Automatic paragraph numbering

We often number paragraphs, such as the steps in this book, but don’t want
every paragraph numbered, e.g.:

3) This is a numbered step.

This is further explanation.

4) This is another numbered step.

Easy enough to do manually, until you then do much editing, including
deleting a step or adding one in the middle, and the numbers are off. Why
not let WP count for you? Start a new macro, name it whatever you like,
and record these steps:
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Hard Return
Set Paragraph Level (5)

Type a hard return
Open Tools > Outlining…,
uncheck Outline On, and check
Insert Outline Number. Note
the styles in Level/Style below.
From the popup to the right of
Insert Outline Number, choose the
style you want. Level 5 is just our
choice here. Click OK.

Indent

Display (On)

From the Insert menu, choose
Indent.
Click in the macro editing window
to bring it to the front, and type this
line. This just refreshes screen
display at the end of a macro,
always a good idea.

Save and close this script.

The point of all this is that anything that you do more than once, and
involves a series of steps, might as well be defined as a macro. To facilitate
handling macros, let’s look at how to handle them as resources which, in
Macintosh speak, is just a general name for things like style sheets and
Button Bar configurations as well as macros – anything that’s handled by
WordPerfect’s Library.

Handling macros

As with styles, you can do some things with macros in their own edit dialog
– change or add a keyboard equivalent, for example – but other tasks are
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performed in WordPerfect’s Library, accessed through the Preferences
command on the Edit menu.

Copying, naming and deleting macros

Go to Edit > Preferences > Macros. You’ll see figure 13.8.

Figure 13.8: the Librarian, showing Macros

where you can select a macro and remove or rename it. You can also copy
it into the active document (or vice versa, if you created a macro in a
document in the first place). So an individual document can contain macros
as well as styles and other resources, which will override Library resources
of the same name. A Common Library on a network can provide macros
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to all network users too. See Chapters 9 and 12 for further discussion of the
Common Library feature.

Macro file formats

When you edited a macro, you saw several buttons at the top of the macro
window, as in figure 13.9.

Figure 13.9: The Macro editing window

with the Save button first. Then, Save As will let you save this macro
under another name, in the same manner as saving files with a new name.
Save Text saves the script as regular text, for editing as a normal Word-
Perfect file. Read Text does the opposite: you can make a text file into a
macro. Pause and Resume are of special use when editing a macro by
recording new parts: you can pause the recording, do some actions that are
not added to the script, and then resume recording the macro. Pause and
Resume are also available on the macro main menu.

Saving a macro as text is often the easiest way to share it with others, or
edit it at length. WordPerfect will parse it when you read it back into macro
format. Saving As under a new name is helpful for taking one macro,
making changes to it to fit other needs, and saving the new one while
keeping the old.
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Scripting

After you recorded your Close Letter macro, you looked at the script
WordPerfect wrote as you recorded it, and maybe made some changes.
Let’s record another macro, planning to make a change in the script after-
wards. This is a macro that will print the one page containing the insertion
point, with no muss no fuss.

To set things up, open any document of more than one page.

1. Start a macro recording, name it “PrintPage”, and assign a keystroke of
Command-Option-P.

2. Choose the Print command, set the page range from 1 to 1, all other
options as normal, and print it. Stop recording.

3. From the Macro menu, choose Edit, and navigate to PrintPage. You
should see a script like this:

Print Options (1;1;1;Document;Every Page;Forward;Print Overlay)
Print (Document)

which describes your recent print command. On the first line, in the
parenthesis following “Print Options”, there are three numerals, each a 1,
separated by semicolons.

We’re concerned here with the first two numerals, which specify the start
and end pages for the print job. Let’s change both these numerals from 1 to
what WordPerfect calls a variable.

A good way of thinking about a variable is as a name for some data. “Ad-
dress” is an example. Your address is 123 Maple Street; mine is 456 Elm
Street. The data is different, but the name we’ve given that particular kind
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of data is the same. We call this a “variable” because the data it names can
vary.

The variable we want to use is PhysicalPage which means, simply, the
page the insertion point is in, discounting any page numbering you have
set. If you’re in a document called “Chapter Five”, for example, and have
set page numbering to start at 160 – the first page of this chapter – but
you’re in page 12 of the chapter, the physical page number is 12.

1. In the macro window, select the first numeral 1 and change it to
“PhysicalPage” and do the same for the second numeral.

2. Click the Save button at the top left of the window. Both instances of
“PhysicalPage” should change to bold, and you should be able to save
the macro. It should now look like:

Print Options (PhysicalPage;PhysicalPage;1;Document;Every
Page;Forward;Print Overlay)
Print (Document)

3. Close the macro editing window.

4. Press Command-Option-P. Without going through the Print dialog, the
page you’re on should print.

This is an example of recording a macro, as far as we’re able
to, and then refining it by editing the script. You could have
written the script from scratch, but it would have been more
work, with greater possibility for error.
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Macros with pauses for user input

What we’ve done so far is make macros that always run the same way. Press
a button, get a sequence. Let’s write a macro that will pause in certain
places to let you personalize the product. This example will be a memo, one
that’s easier to use than the stationery memo that ships with WordPerfect.
We’ll set the word “memorandum” flush right, white text in a paragraph
with black fill, and other formatting as shown in figure 13.11:

[Figure 13.11: a Memo form done with a macro. Everything except the
addressee and subject enter automatically]

where the “To” and “Subject” fields are left blank by the macro, for you to
enter data. When you do, and press Return, the macro resumes until the
insertion point is below the double line. No need to move around manually
as you enter data in the address. Very slick.

Except that the script seems very long and involved, so we’ll record most of
it, and switch in and out of the macro editing window as needed. Why not?

1. Close all open documents, and start a new one. Drag the window down a
little so there’s about half an inch between the title bar and the menus,
and start a macro recording. You see the macro editing window behind
and above the document window, just where we want it.

To record, have the document window in front and choose
commands or type data as usual. To script, click in the macro
editing window, to bring it to the front. Whatever you type in
this window goes into the script, not into the recording.

2. Let’s work from the following macro script. Follow along, and record
this macro according to the instructions on the right, which produce the
script on the left:
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New Document
Clear All Tabs

Set Tab (Right;No Leader;1.0in)
Set Tab (Left;No Leader;1.250in)
Font Name ("Arial")

Font Size (18)
Attribute (On;Outline)

Set Text Color (65535;65535;
65535)
Begin Border Options (Para-
graph)
Border Fill Options (0;0;0;1;On)

End Border Options
Right Align
Type (memorandum)
Hard Return
Begin Border Options (Para-
graph)
Border Fill Options (0;0;0;1;Off)
End Border Options

Start a new document.
From the Tabs dialog, click Clear
All.
Set these from the Ruler.

Choose a font you like from the
menu.
18 is a good size for the title.
Click Outline in the Character
Format dialog.
In this dialog, set text color to
white. OK it.
Choose Paragraph from the Borders
menu.
Turn Border off, Fill on, color
black, pattern solid.
OK this dialog.
Choose this from the Layout Bar.
Type this word.
Press Return.
Open the Paragraph Border dialog.

Turn Fill off.
OK this dialog.

Plain Text

Set Text Color (0;0;0)
Hard Return
Left Align

In the Character Format dialog,
turn outline off.
Change text color to black.
Press Return.
Choose left-aligned text from the
Layout Bar.
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Font Size (12)
Tab
Attribute (On;Bold)
Type (To:)
Attribute (Off;Bold)
Tab
Pause Until (#Hard Return#)

Set font size to 12.
Press Tab.
Turn Bold on.
Type this word.
Turn bold off.
Press Tab.
Now – switch to the macro window
by clicking in it, check to see that
what you have matches this script
so far, and then type, in plain text,
“Pause Until (#Hard Return#)” and
press Return. WordPerfect bolds
the command if it’s correct, or
underlines the error otherwise.
With the insertion point on a new
line in the script, click in your
document window, to switch back
to it.

Hard Return
Tab
Attribute (On;Bold)
Type (From:)
Attribute (Off;Bold)
Tab
Type (Cathy Jones)
Hard Return
Tab
Attribute (On;Bold)
Type (Date:)
Attribute (Off;Bold)
Tab

Press Return.
Press Tab
Turn bold on.
Type this word.
Turn bold off.
Press Tab
Type your name.
Press Return.
Press Tab
Turn bold on.
Type this word
Turn bold off.
Press Tab.
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Date Text

Hard Return
Hard Return
Tab
Attribute (On;Bold)
Type (Subject:)
Attribute (Off;Bold)
Indent

Pause Until (#Hard Return#)

Hard Return
Hard Return
Hard Return

Choose Text Date/Time from the
Insert menu.
Press Return twice.

Press Tab.
Turn bold on.
Type this word.
Turn bold off.
Choose Indent from the Insert
menu.
Again – switch to the macro win-
dow, and type this command. Press
Return to put the insertion point on
the next line, and switch back to
your document.
Press Return three times.

Up ()
Up ()
Down (Select)

Press Up Arrow twice.

Press Shift-Down Arrow.

Begin Border Options (Para-
graph)
Border Sides (Top Off;Left Off;
Bottom On;Right Off;)
Border Options (0;0;0;1;Sq1Sq1)

Border (On)
End Border Options

Open the Paragraph Border dialog.

Set the bottom border on; others
off.
Choose a Border style you like for
this line.
Turn Border on.
OK this dialog.
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Down ()
Down ()
Down ()
Home()
End()

Display (On)

Press Down Arrow three times.

Press the Home key.
Press the End key (these two
commands just bring the whole
document back into view).
Type this last line in the macro
script, and save and close the
macro.

All of which produces figure 13.10, with pauses for user input.

Figure 13.10: Result of an automatic Memo macro

Two things of note here: first, you can record most of a macro, and easily
switch into the macro editor to script the rest, and second – you’ve just
learned how to read a WordPerfect macro script. There are other com-
mands, of course, but nothing very hard to understand.
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Macro help

Here’s a good place to take another look at WP’s Help feature, the part
about macros. Choose the sixth command on the Help menu, WP Macro
Help… and, this first time, click on the third item, Using Help. As shown in
figure 13.11, explanations are given for the kinds of topics in Macro Help,
such as commands (like “Type”), objects (like “Window”) and variables.

Figure 13.11: Macro Help dialog

Take a moment to become familiar with navigation here, and then click
Contents at the top left, and from there click Index in the list of Help
Topics. WordPerfect’s 900 commands, objects and variables are at your
fingertips here. The separate QuickHelp file also has macro information.

We don’t recommend learning the macro language this way, though, any
more than learning Spanish by using a dictionary. This is more of a refer-
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ence. See the last section of this chapter, Looking further . . . , for a better
way to learn more.

Graphics macros

You can do anything with macros in the Graphic Editor as well, and we
think WordPerfect advertising missed a beat by not advertising that this is
the only graphics program for the Macintosh with full-fledged scripting.

Some draw programs say they have macros, but they mean object macros,
which is a fancy name for their own scrapbook. What we’re dealing with
here are command macros.

You can draw a shape while recording, and then edit the script forever, to
make any changes with complete precision. You can have a graphics macro
pause for user input, so any user can customize a complex drawing in great
detail.

Managing data

At the start of this chapter we mentioned finding bolded words in one file,
copying and pasting them into a list in a second file. To start, open the file
you want to copy from, and a second document for the list (there should
only be these two files open).

Here’s the script we used. It was entirely recorded, not written. We won’t
give you so many hints this time:
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Find/Change Direction (For-
ward;No Wrap)
Find/Change Where ({All})

Set these options in the Find dialog.

Find/Change Match (Partial
Word;Case Insensitive;Alphabet
Insensitive;CharRep Insensitive;
{Style})

Match partial word, and style only.

Find/Change Action (Select
Match)
Find String ("[Font:Geneva]
[Size:12][Language:
USA-English][Bold On][Match
n]")

Find
Copy
Cycle Windows

Paste
Hard Return
Cycle Windows

Select match.

From the Insert menu, choose
Match Multiple Characters.
Drag across that code to select it,
and choose Bold from the Style
main menu.

This is the Next Window com-
mand on the Window Menu.

You can change options depending on what you want to find. Writing this
book, we identified the location of every figure with a line in the manu-
script with the figure number and caption, all enclosed in brackets. Then,
to produce a separate list of figures for the first edition’s book designers,
we ran a macro that found every instance of “[Figure” and then selected the
entire line the match was on (by selecting the match and pressing Com-
mand-Shift-Right Arrow, to select the rest of the line). The macro then
copied the line and pasted it into another file.
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Managing text with macros

Besides the little gems we’ve looked at, macros can be used far more
extensively, to organize large amounts of textual data. Interviews are a
prime example. An in-depth interview may span diverse conceptual areas,
and the responses need to be categorized logically to be studied effectively.

We are indebted in the following discussion to Professor Dalva Hedlund of
Cornell University, who has conducted research in problems of rural
adolescence and the importance of interaction with adults (Hedlund,
“Listening to Rural Adolescents”, J. Research in Rural Education, Vol. 9,
No. 3, 150-159, and to Albert Reid, “Computer Management Strategies for
Text Data” in Crabtree and Miller, eds., Doing Qualitative Research
(Newbury Park CA: Sage, 1992).

Professor Hedlund and his research team have engaged adolescent subjects
living in rural areas in New York State in extensive interviews relating to
their views on achieving maturity, values and self-direction. Relevance of
school, family, and community to feelings, needs and beliefs were primary
to the study.

Each interview thus included discussion in disparate areas. A critical step in
organization of data of this type is identification and manipulation of
responses on specific topics. There may be ten major categories of re-
sponses to be studied, with subcategories among them. There may be 500
pages of transcriptions of interviews of 50 subjects. How can we manage
this data?

Professor Hedlund divided the transcripts into segments, often only a
paragraph or two, dealing with specific topics. Researchers, working on the
transcriptions in WordPerfect, then headed each paragraph with a code,
developed from guidelines in Reid, that would allow subsequent work to
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select the interview data, segment by segment, into an ordering that would
benefit further study. Hedlund describes the coding procedure:

The first level of coding was conceptually defined by the interview
structure, which focused on the perceptions of community, family,
school, social life or self. We developed a second and third level of
codes inductively by reading interviews and iteratively comparing
notes among three raters (Miles & Huberman, 1964). Reliability of
the coding procedure was increased by defining the lower level codes
so they will fit under different first level codes. A segment could be
coded @FMY (1st level) %SXX (2nd level) %VLU (3rd level). In this
instance, the coder judged that the segment described family values
about sexuality and dating behavior…. With this coding system it is
unlikely that interview segments of interest to a particular researcher
will be lost…. (“Listening to Rural Adolescents”)

With each interview segment given a code at the start of the segment as it
appears in the word processing file, and with a blank line at the end of each
segment, a researcher can find and copy into a new file all segments from
the original data that contain the pertinent codes. Putting codes at different
levels of abstraction, and using the Match Multiple Characters command in
the Find dialog, lets researchers find all occurrences of, for example, a first
level and third level code, for all second level codes. The @ and % symbols
serve only to identify the following letters as codes, to make it unlikely that
the Find operation will include text of the interview. Numbers placed
immediately after each set of codes identified the page and paragraph of
the original interview, so the context of each segment would be immediate-
ly available.

A macro to gather interview segments by code would first search for the
code, select it, then search for a blank line, and extend the selection (from
the Action menu in the Find dialog) to the blank line. Copy, cycle windows
and paste.



Chapter 13: Macros and AppleScript 475
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

As Reid (1992) says, “Computers cannot perform analysis of qualitiative
data, but they can perform many of the labor-intensive tasks of data
management quickly and easily, freeing the researcher’s time for the more
interesting and rewarding work of analysis”. (p. 125)

Reid also offers the valuable advice that since macros can do so much with
one keystroke, it’s wise to test a new one on a copy of your data. It’s
another reason to save and make backups often.

More on variables

We looked a few pages ago at a variable called PhysicalPage. This is an
example of information WordPerfect stores internally, and that your
macro can call as needed. Because the information is set, and the the macro
can’t change it, we call this a read-only variable. Another kind of
variable is called a read/write variable because a macro can put infor-
mation in it as well as get it.

There are three kinds of read/write variables in WordPerfect macros:
document, global and local. Document variables are saved with an
individual document, and are available whenever that document is open.
Global variables are available for any macro in any document in a par-
ticular session of WordPerfect. Local variables are available only in a
specific macro.

You could, for example, put some text or numbers in a variable, and then
access that later on. Using multiple variables, you could set up the e-
quivalent of multiple clipboards, for flexible and extensive pasting of text
in various parts of your document. You can further refine macros with
if…then…else kinds of statements, so that the macro will perform one
action if certain conditions are met, and another action otherwise.
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An elegant example is WordPerfect’s own macro “Multiclip”. This gives
you ten clipboards for text (up to 255 characters each), asking you which
one you want to put selected text in. When you want to paste from a
clipboard, press Command, Option, and a number from one to zero, the
clipboard identifiers. The dialog box, produced by the macro, looks like
figure 13.12.

Figure 13.12: Ten Clipboards

Here’s the script to put text on the clipboards. It has to be written – it digs
too deep into the program to record.

If (SelectionFlag)

Copy
Menu (Var01;"Which Clipboard?";
{"one";"two";"three";"four";"five";"
six";"seven";"eight";"nine";"zero"})
; 

Do the following only if text is
selected.
Copy to the clipboard.
Present a menu with this question
and ten possible answers. The index
of your answer goes into Var01.

Case (Var01;{1;one;2;two;3;three;
4;four;5;five;6;six;7;seven;8;eight;
9;nine;10;zero};cancel)

Branch the macro: chooses which
label to go to, depending on the
value of Var01.
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Else
Alert ("You must have text
selected for this macro to work.")

If no text is selected,
Present this text in a dialog box for
the user to OK.

End If
Label (cancel)
Return
;

Label (one)
Assign (GlobalVar01;Clipboard)
Return
;

Label (two)
Assign (GlobalVar02;Clipboard)
Return
;

End the If…Then…Else part.
Do this if user clicks the close box.
The End Macro command will
work here too. That ends all macro
activity, while Return exits the
current label if any and the current
macro otherwise.

The Case command will branch
here if Var01 is one. Clipboard
contents are then assigned to
GlobalVar01, and the macro ends.

Same thing, if Var01 is two.

(Any line starting with a semicolon
is a comment line. WordPerfect
ignores it, so it’s useful for people
scripting and reading macros or, in
this case, to separate labels for easy
reading.)

Label (three)
Assign (GlobalVar03;Clipboard)
Return
;

(You can copy a label and comment
line, paste it nine times, and then
make the two changes in numbers
for each one. Note that it’s easy to
skip one or more changes inadver-
tently.)
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Label (four)
Assign (GlobalVar04;Clipboard)
Return
; 
Label (five)
Assign (GlobalVar05;Clipboard)
Return
;
Label (six)
Assign (GlobalVar06;Clipboard)
Return
;
Label (seven)
Assign (GlobalVar07;Clipboard)
Return
;
Label (eight)
Assign (GlobalVar08;Clipboard)
Return
;
Label (nine)
Assign (GlobalVar09;Clipboard)
Return
;
Label (zero)
Assign (GlobalVar00;Clipboard)
Return

For the final step, go to Edit > Preferences > Keyboard, and choose
Variables from the popup, to get figure 13.13.  Scroll down to GlobalVar0
and click Assign… on the right. Assign any keystroke, perhaps Command-
Option-0, to this variable. WP will then type the contents of that variable
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into your document at the insertion point when you press that keystroke.
Continue up through GlobalVar09.

Figure 13.13: Assigning keystrokes to variables

Large-scale macros

The first edition of this book benefitted from Henry Holt & Co.’s expert
editing and production staff. This second edition did not. Macros were
essential to its publication with anything approaching a reasonable expen-
diture of time and effort.

The Table of Contents was produced by gathering the three levels of
subheads by searching for style sheets: head (level) A in 24 point Stone
Sans, head B in 21 point italic, and head C in 18 point. Head A finds were



480 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

checked to see whether they contained the word “Chapter”, since part of
the chapter title formatting is also in A-Head style. If so, they were given
Table of Contents (TOC) level 1; otherwise they were given level 2. B-heads
became level 3 and C-heads became level 4 with this macro:

Repeat

Find Next Code (Forward;Style
On)
;
If (CurrentStyle="A-Head")
End of Line (Select)
Copy
SubString Position (Var00;"Chap-
ter";Clipboard)
If (Var00)
Mark TOC (1)
Else
Mark TOC (2)
End If
End If
;
If (CurrentStyle="B-Head")
End of Line (Select)
Mark TOC (3)
End If

Repeat until no more changes in
style sheet are found
Find next style sheet

If style is “A-Head”
Select the line
Copy, so we can look at it
Does the clipboard text contain
“Chapter”?
If so,
Mark it for TOC level 1
Otherwise,
Mark it for TOC level 2

If style is “B-Head”

If (CurrentStyle="C-Head")
End of Line (Select)
Mark TOC (4)
End If
;
Right ()
;

If style is “C-Head”

Press right arrow to deselect text
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Until (!FindStatusFlag) End repeat when no more style
changes are found

For the index, we collected every word or phrase in bold, noted its page
number, and placed that information in a list:

Display (Off)
Repeat
Find Next Code (Forward;Bold
On)
Right (Select)
;
Repeat
Raw Read (function;Right)

Until (!BoldFlag)
Copy
Right ()

Assign (Var00;LogicalPage)
Select Window (NextWindow)

Turn screen display off for speed
Start repeat loop
Look for bold attribute

Start selecting text

Start nested repeat loop
Read formatting codes in file, going
right
Stop when bold attribute is off
Copy selection
Deselect text, a best practice when
done with it
Record page we’re on
Go to next window, which will
contain Index

Paste
Tab

Type Var (Var00)
Hard Return
Select Window (NextWindow)
;
Until (!FindStatusFlag)
Display (On)

Paste the bold text we found
Tab to page number column, i.e.
right side of page
Type the page number
Return for next line
Go back to document

Stop when no more bold is found
Turn screen display back on (a
good way to end any macro)
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For a 700-page book, these were exceptional time-savers, and accuracy
always benefits whenever you can automate repetitive tasks. These add up
to a good example of power in word processing.

AppleScript

This elegant technology is something like WordPerfect’s macro feature.
Although AppleScript does not record actions you perform in WordPerfect
as macros can, you can use AppleScript’s Script Editor to write scripts
that will then govern WordPerfect’s actions, as well as those of many other
programs.

What’s the point to a scripting utility? WordPerfect already has macros.
Yes, but many other programs don’t, so Apple decided to write system
software that we could use with any program designed to be aware of it and
which would, as a big plus, let one program control another. Additionally,
AppleScript is seamlessly integrated with WordPerfect’s macros: a script
can run a macro with just one line of instruction, and pass up to 50 vari-
ables of information to the macro. A WordPerfect macro can also run an
AppleScript.

Some sample scripts

To start this exercise, open WordPerfect and a file with some text in it.
Then open Script Editor (it came with your Mac. Later versions of OSX
have changed this program’s name to AppleScript Editor.) Its initial
window looks like figure 13.14.
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Figure 13.14: AppleScript’s editor

1. In the larger text entry area, type the words:

tell application "WordPerfect"
delete word 1 of window 1
end tell

in the script window. Your typing will appear in 10 point Courier, the
default for script that the editor hasn’t yet checked for accuracy.

2. Click the Check Syntax button at the right (or press Enter).
AppleScript may first need to know where WordPerfect is on your disk.
It will save this information with the script. Locate WordPerfect in the
standard dialog, and click Open.

After a moment, the Script Editor’s text changes to 10 pt. Geneva, with
some words in different colors. Your text is good, and you’re ready to run
with it.
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3. Click Run (or press Command-R).

4. Switch to WordPerfect. The first word of your text should be gone. Call
the Undo command to get it back.

5. Return to Script Editor, delete that script, and try this one:

tell application "WordPerfect"
set style of word 1 of window 1 to bold
end tell

Conditional statements and dialog boxes

AppleScript, like WordPerfect macros, can use conditionals and will let
you set up your own dialogs. Here’s an easy example of both.

display dialog "Enter password to beep Macintosh" default answer ""
if result = {text returned:"boogie", button returned:"OK"} then

beep 3
else

display dialog "Sorry." with icon stop
end if

where the default answer’s empty quotes produce the blank space to enter
the password. The word “result” here is a read-only variable, and the
use of the equals sign is Boolean logic. AppleScript can make use of the
Boolean operators equals, does not equal, greater than, less than, and, or
and not. The beep command will repeat the number of times specified, and
the command to display “Sorry” is followed by the icon specified.
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More complex scripts

We might have several WP files open, and want to concatenate their
contents into one file for archival. Let’s have AppleScript do that for us.
We’ll use a read-write variable or two and a repeat loop. These are
similar in AppleScript and WP macros (and in other programming languag-
es). The differences are that in WP macros, read-write variables are
numbered, e.g. “Var00”. In AppleScript they are named, and that name can
be any alphanumeric string without spaces, e.g. “thisText”. In WP, repeat
loops start with only the command “Repeat” and the ending line, “Until”,
contains the test to end the repeat. In AppleScript, the test is on the Repeat
line. So:

WP macro:

repeat
; do something
assign (var00; var00+1)
until (var00=10)

AppleScript:

repeat with thisVariable from 1 to 10
-- do something
set thisVariable to thisVariable + 1
end repeat

The point is that now that you know the concepts of variables and repeat
loops, you can move from one programming language to another without
much trouble.  Here’s the script:
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set allText to ""

tell application "WordPerfect"

activate

repeat with i from 1 to (count
windows)

set thisText to text of window i
set allText to allText & thisText

& return & return

end repeat

make window with data allText

end tell

Initialize a variable, or set it up
(WP variables come pre-initialized
to the equivalent of "" or zero)
A “tell block” contains commands
directed to an application
Start running if not already, and
come to the front
Repeat with a counter variable (“i”
is common, an abbreviation for
list item)
get the text of this window
add it to allText, and add two hard
returns to separate items being
concatenated
end of repeat loop

open a new window and place
concatenated text in it
end of instructions to WP

Saving a script as a separate program

While you can save a script just as any other document – double-clicking
on it opens the Script Editor, whence you can run the script – you can also
save a script as an application itself. This paragraph distribution script
would be a handier tool if the user could just double-click on its icon,
choose a file and go.

1. Choose Save As from the File menu.  The standard dialog has a pop-up
added at the bottom, as in figure 13.15.
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Figure 13.15: Saving a script as an application

2. Choose Application, and check “Never Show Startup Screen”. Give your
program a name and click Save.

3. Close the script window (you don’t need to quit Script Editor).

3. In the Finder, test this stand-alone script.

If you don’t check the “Never Show Startup Screen” option
when saving a script as an application, you’ll see an initial
window with a description if you added one, and a button to
click to run the script. Few scripters use this option.
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AppleScript control of WordPerfect macros

To include a WordPerfect macro in a script, just use the command “Do
Script” followed by the WordPerfect macro in quotes. Put the tell com-
mand first if it isn’t already active. Thus:

tell application "WordPerfect"
make new window
activate
Do Script "memo"

end tell

You can pass up to 50 variables to the macro with the Do Script command,
for extraordinary power. See page 485 for further reading.

Using AppleScript to get information from a data-
base

One of the more important interapplication uses of AppleScript is to
retrieve specified information from a database and insert it in a WordPer-
fect file.

While Publish & Subscribe works well for information that is all of a chunk:
contiguous cells or a chart in a spreadsheet or text in another word pro-
cessing file, database information is hard to handle in this way.

This is due to the modal quality of a data file. The information you want is
in this record and in that field and in the other layout. Working with a
scriptable database program such as FileMaker Pro, you can write a script
to open any data file and retrieve any information, and put it where you
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want in a WordPerfect document. It’s something like merge but at another
level of sophistication.

AppleScript, Prefab Player and Menu Events

WP supports many AppleScript commands and objects, but not every
command on the menus is supported. Prefab Player and Menu Events
are two system extensions, free at WPMac, that let AppleScript access
WP’s menu commands. See Chapter 18 for more information.

WP’s AppleScript Dictionary

Every application that is scriptable – can be controlled by AppleScript –
has a dictionary of the commands and objects it supports. You can view
the dictionary with the Open Dictionary command in Script Editor, or drag
the WP application icon on top of Script Editor.

Looking further . . .

WordPerfect has an extensive macro language, with over 900 commands
and objects, as well as complete object model support for AppleScript,
which can control applications other than WordPerfect in a single script,
for an added dimension of power. Delving further into these powerful tools
is beyond the scope of this book, but the 185-page John’s WordPerfect
Scripting Guide teaches all of it. The Guide is free at WPMac. WP has its
own Macros Manual: this teaches the basics and then has a complete
reference.
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Another 140-page file, John’s WordPerfect Tips & Macros, has over a
hundred macro scripts and, beyond the explanation and examples in the
Scripting Guide, going through these examples is the best way to learn. Also
free at WPMac.

Summary

In conceptual terms, you’ve probably learned more in this chapter than in
any other. You can now:

• record a macro, to do anything you can do manually
• edit a macro in its own script window
• copy, rename and delete macros, and convert them from and to plain

text
• record and script parts of the same macro
• conceptualize use of macros for research data organization and retrieval
• write scripts with such programming tools as variables, conditional

statements and branches
• write and edit AppleScripts, to futher automate WordPerfect and enable

its interoperability with other programs

Although what we’ve looked at might seem to be a wealth of possibilities for
powerful, elegant and sophisticated word processing, we’ve actually only
scratched the surface. WordPerfect’s macro feature is a robust program-
ming language, and you may well be inclined to learn more about it. Same
with AppleScript. 



Chapter 14

Equations

In this chapter, you’ll learn how to:

• create an equation in a specialized module of WordPerfect
• move within and select parts of an equation
• fine-tune placement of symbols and expressions
• format and size the equation to fit the text around it
• work with frames and options for an equation

A lot of technical writing in diverse fields – from physics to business –
needs equations. Creating these used to be the job of separate Macintosh
programs, from which the equations could be pasted into your word
processing document. Your word processor couldn’t edit or format them,
so revision meant going back to the separate program. Formatting was iffy
in any case, and creating lists of equations in documents and cross-refer-
encing such as saying on page 20, “See equation 12 on page 18” were
manual operations.

Word processing programs then began to allow equation entry into their
own documents, but the syntax to produce an equation was often more
complex than the equation itself. Again, WordPerfect to the rescue. The
Equation Editor we’ll look at now is friendly and full-featured and, to make
things even easier, shares some design with the Graphic Editor. More than
that, the box that an equation appears in is structurally the same as graphic,
text and table boxes, so positioning, sizing, captioning and cross-referenc-
ing all work in ways you already know. One caveat – WP can create and
display equations, but can’t solve them.
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The tools

With your insertion point at the place in your file where you’d like an
equation, go to the Tools menu and choose Equation, and then New.
The Equation Editor window appears, as shown in figure 14.1.

            

Equation Tool Palette

            

Equation Button Bar

Figure 14.1: Equation Editor window
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Note that the Button Bar and Menu Bar have changed to reflect this new
mode, just as in the Graphic Editor. The parts of the button bar are shown
in figure 14.2.

            

Return to Document Editor

            

Move selected element(s)
one point in this direction

            

Align Left

            

Typeset Equation
            

Decrease font size by 1 point
            

Increase font size by 1 point
            

Bold
            

Italics
            

Print Preview
            

Select In
            

Select Out

            

Align Right

            

Align Center

Figure 14.2: Equation Button Bar

Also as in draw mode, there’s now a floating palette of tools as in figure
14.3.



494 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

            

Square Root
            

Bars
            

Diacritical Marks
            

Limits
            

Uppercase Greek Symbols
            

Operators
            

Arrows
            

Additional Symbols

            

Fractions
            

Super/Subscript
            

Delimiters
            

Matrix
            

Lowercase Greek Symbols
            

Relational Operators
            

Set Symbols
            

Miscellaneous
            

View Percentage

Figure 14.3: Equation Editor Tool Palette

Click any of the 16 icons in the Tool Palette, and you’ll see that they are all
pop-ups, containing categories of symbols or placement commands. You’ll
make use of these and also symbols from the keyboard to create equations.
Let’s try one.

Creating an equation

Figure 14.4 shows an interesting equation.

Figure 14.4: A first equation. (Einstein, Albert: The Meaning of
Relativity, 5th ed. Princeton: Princeton University Press, 1956, p. 53).
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To enter this equation:

1. Type a capital K. It appears at the insertion point in the equation
window.

2. From the Super/Subscript Tool, choose Subscript, as shown in
figure 14.5.

Figure 14.5: Super/Subscript Tool

The insertion point is now smaller and subscripted, relative to the K.

3. Type a lower case x.

4. Press the Right Arrow key. The insertion point should resume its full
size and normal (or baseline) position.

5. Type an equals sign.

6. Choose the Fraction Tool from the tool palette, as shown in figure
14.6.
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Figure 14.6: Fraction Tool

Your incipient equation now looks like figure 14.7.

Figure 14.7: Inserting a fraction

7. Type a lower case d, and then press the Down Arrow key. The insertion
point will move to the denominator.

8. Type dl here, and press Right Arrow again. The insertion point moves
out of the fraction. It’s time to enter a set of delimiters, also called
fences. 

9. Choose the first tool in the delimiter palette, as shown in figure 14.8.
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Figure 14.8: Delimiter

10. The fences are added to your equation, with the insertion point
between them.

Another way to do this is to enter text first, select it, and then
choose a delimiter. It will surround the selected text.

11. Type the m and then enter the numerator of the succeeding fraction,
including the subscripted 1. Click in the denominator field to move
there. Following the d, enter the Greek letter Tau by picking this
symbol from the Lower Case Greek Symbols palette, as in figure
14.9.
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Figure 14.9: Greek letter

12. Continue with the equation as you see it in figure 14.4. Don’t worry
that it doesn’t look quite as good yet, as far as formatting goes.

13. When you get to the square root symbol, select it from the Square
Root Tool at the top left of the palette. The insertion point will then
be within the root; type the data there. Symbols expand to hold the
data you give them.

You could also enter the text within the root symbol first, then
select it, and then enter the root symbol. It will then enclose
the selected text.

Other symbols

To place a Bar over or under any symbol or expression, select it and
choose the appropriate bar from the palette. To place a Diacritical Mark,
don’t select the variable; instead, put the insertion point to the right of it.
To place a Limit, choose the one you want from the palette. The insertion
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point will then be in the right place to type a following variable. If the limit
requires two variables or numbers, use the Arrow keys to move around in
this field.

To enter a Matrix, choose that tool from the palette. You’re given a
display like figure 14.10.

Figure 14.10: Matrix for data entry

This resembles choosing the number of columns and rows for a table. For a
matrix, you can use up to 32 columns and rows. Let’s choose 3 x 3 here.

The insertion point will blink at the top left, and the dotted rectangles
indicate other locations for data. You can use the Tab or Arrow keys to
reach these, or click on them. You’ll notice the dotted rectangles accompa-
nying entry of other symbols as well.
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Navigating in levels

Conceptual point: anything in an equation will be in one Level or another.
Data under a root symbol, for example, is one level deeper than the data
outside it.

Click just to the left of your finished equation, to put the insertion point
there. Then move the insertion point to the right using the Right Arrow.
With each press of that key the insertion point moves, first to the right of
the K, then to the equals sign (bypassing the subscript x – you could not
edit the subscript at this point), past the equals sign, then past the entire
first fraction, so you could not edit it either, then past the entire first
delimiter.

You’re moving at the Top Level of the equation. You can move into
deeper levels by pressing Tab. Move around in the level you want to be in
with the Arrow keys; move out with the Tab or Arrow keys. You can use
the mouse, as well, to click anywhere in an equation.

The Button Bar has two especially nice tools for selecting on succeeding
levels:

1. Click within the equation to put the insertion point at a deeper level,
perhaps at the superscript within the root symbol.

2. Click the last Button on the Bar repeatedly, to see how the selection
increases. When the entire equation is selected:

3. Click the next to last Button on the bar repeatedly, to reduce the amount
of selection.

The Select In and Select Out commands on the Layout menu perform
the same actions as these two buttons.
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Formatting an equation

Your equation may look all right to you just as you entered it. If you want
to change the font, you can select the entire equation with the Select All
command, and then choose a new font. Be careful about any Greek letters
you’ve included, though, as those will now be Roman equivalents in the new
font. Select any such letters, delete them and replace them from the tool
palette. You can also select one or more characters by dragging across
them or, at any one level, by shift-clicking.

The simplest solution, if the default equation font doesn’t fit your needs, is
to select the one you want before creating the equation.

To format the equation further, into a standard style, choose Typesetting
from the Layout menu, or the equivalent on the Button Bar. The result, an
aesthetically pleasing construction, is intended to be good for most uses.
You can refine it further, though: WordPerfect lets you move any symbol
in any direction, one point at a time, or align any character with great
precision.

Moving elements

You might want to increase the view percentage for at least part of this
exercise. The default of 200% is fine for most use of this module, but the
fine-tuning we’ll look at now would benefit from 400%.

Drag across any symbol, to select it. On the Button Bar, the first four
Buttons (not counting the fountain pen, which returns you to the document
editor) become active. Click on each to move the selected symbol one point
in the direction the Button indicates.
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This feature is available as well on the Arrange menu, with the Move
commands on that menu. A nice addition on this menu is the last command,
Reset Move. This returns the selected symbol to its default position.

The keyboard equivalents are useful here. Option plus any of
the four arrows moves the selection.

The menu lists these keyboard equivalents in an odd way:
vertical movement is shown as Command-Shift-PageUp or
PageDown, while the Option and Arrow keys work just as well.

Select both parts of a fraction to move the whole fraction.

Aligning elements

Select any symbol that’s part of a numerator or denominator of a fraction,
and let’s look at the next set of Buttons on the bar. These Align symbols
relative to the Field they are in: the area of e. g. the numerator that will
hold them. Test center, left and right alignment here. These commands are
available on the Arrange menu too.

You can create more than one equation in a single window. With the
insertion point at the right edge of your first equation, press Return, and
the insertion point moves down a line and horizontally aligned with the
center of the first equation. The center alignment will be maintained as you
enter the second equation, as shown in figure 14.11.
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Figure 14.11: Two equations (Einstein, p. 93)

If you would rather have the equations aligned on their equals sign, select
them both (in this case, since we want to align everything in the window,
you can choose Select All from the Edit menu), and then choose Align on
Character from the Arrange menu. The selected equations are aligned on
their equals signs, as in figure 14.12:

Figure 14.12: Equations aligned on one character

There’s also the Alignment Character command on this menu, letting
you choose the character to align to. The equals sign is the default, befitting
normal use.
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With two or more equations, you might also want to change the amount of
space between them. Again select what you want to work with, and choose
Line Spacing… from the Layout menu. Before you do this, you may want
to change the magnification at which you’re viewing the equations back to
100%, on the tool palette.

Equations in documents

WordPerfect’s handling of equations as parts of a word processing file is
much like the handling of graphics. You can save either as a separate
document, with the File Menu commands “Save Graphic As” and “Save
Equation As” in the Graphic Editor and Equation Editor, respectively. A
difference, though, shows up when you go to open these files.

With a WordPerfect graphics file, you can double-click the icon in the
Finder, or choose Open or Insert File from the File Menu. The graphic
opens up in the Document Editor (the normal WordPerfect window for text
entry). With an equation file, if you do any of these things it opens up and
you get gobbledygook. You need to open a standard WordPerfect file (new
or existing), then choose Edit from the Equation Menu, and get to the
equation file in the standard open file dialog.

With both graphics and equations, once you’re finished creating and
polishing them, you can just choose Close from the File Menu, or click the
close box of the active window, and you’re back in the Document Editor,
with the graphic or equation on the page.

If you select a graphic and drag a corner handle, the graphic stretches or
contracts as you resize or reshape the frame (command-drag to crop). With
a text box, the text in the box will rewrap as necessary to fit the size of the
frame, but does not resize. An equation behaves like a graphic: the symbols
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and expressions, although entered as text, resize and compress or expand
in both dimensions, according to your mouse drag.

To resize either a graphic or equation proportionally, press the Shift Key
and hold it while you click and drag. To change the size of the frame (visible
or not) without affecting what’s inside, use the Command Key while you
click and drag a handle. To move what’s inside without moving the frame,
perhaps to crop it, use the Command Key and click and drag the contents.

Equation frames

As with a graphic or a text box, you can frame equations. Select the equa-
tion you want to place in a visible frame, and choose Frame from the
Equations Menu, with border, fill and spacing choices like other kinds of
boxes. If you choose a visible frame, you may want to change the inside
spacing measurements rather than have the equation touch the frame.

Options

Options for an equation box match those for other types, where the equa-
tion can be anchored to a character, paragraph or page. It’s originally
anchored to a character, but you might want to anchor it to a paragraph.
There’s one caution to keep in mind, though, when anchoring any kind of
box to a paragraph:

When you add a box to your document, WordPerfect inserts a
box code at the location of the insertion point. As you remem-
ber from Chapter 10, when we moved two graphics to update
their caption numbers, simply dragging the boxes around on
the page won’t update the caption ordering – you have to cut
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and paste the boxes in the order you want them, to move the
codes as well.

If you anchor a box to a paragraph, the code might be placed
in the middle of a paragraph, but the box is anchored to the
beginning of the paragraph. Fine, but if you add text above
this paragraph, so that the code moves across a page break,
the whole paragraph moves to the next page. Disconcerting,
but just a function of placing boxes in text with the anchor
options.

If this happens, select and cut the graphic, put your insertion
point close to where you want it, and paste it. Then check the
options dialog to see that the anchor type is correct. This is
also a handy fix for uncooperative caption numbers.

Of the other options in this dialog, we find the numeric sizing of an equation
box to be especially useful. For a graphic it’s easy to drag a handle, using
the Shift key with the corner handle unless you’re sure you want a distor-
tion. For text boxes, the text doesn’t change size when you drag the box, so
it’s most often just a matter of getting the box sized about right for the text
it contains, something easily done with the mouse.

For equations, though, consistency in a document benefits if they’re all the
same size, unless there’s reason for an exception, and that consistency is
hard to obtain by dragging. Leaving everything at 100% works most of the
time, but we sometimes like 125%, and that’s best done by the numbers.

Looking further . . .

A supplemental utility, John’s WordPerfect Equation Manager, lets you
title equations (which titles don’t appear with the equations, in confor-
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mance to standard style, but which do appear in references elsewhere and
in lists), cross-reference equations from other places in your document,
make a list of all equations in a document, and include automatically-
updating numbers for equations. This is free at WPMac.

Summary

This chapter’s specialized material, vital to a comprehensive tool for
specialized word processing, has taught you how to:

• enter numbers, variables and expressions in WordPerfect’s Equation
Editor

• navigate around an equation using the Button Bar, menus and the
keyboard

• select different levels of an equation
• move any part of an equation, relative to the rest, in one-point incre-

ments
• let WordPerfect format the equation to typesetting standards, make

your own choices, or any combination
• work with an equation box in a document just as with a graphic, table or

text box

and we have a special commendation for you at this point, since you now
know how to enter all the different kinds of data WordPerfect can accept –
except movies, still a couple of chapters away. Let’s see how best to put it
all together, in the next chapter.





Chapter 15

Typesetting and Page Design

In this chapter you’ll learn:

• the art of typography
• principles and standards of legibility
• fundamentals and fine points of page layout
• how to design publications for maximum impact

Even if you’re just generating a simple one-page letter, there are a number
of ways to make it more presentable and inviting. Conversely, the first
thing many users do after learning the technical capabilities of a program
like WordPerfect is create documents that are over-formatted, sometimes
to the point of illegibility.

The nearly unlimited flexibility you have with WordPerfect in placing and
formatting text and graphics does not by itself guarantee a high quality
page out of the laser printer. Working with type and designing a page are
forms of artistic expression that make a great deal of difference in the
personality and appeal of the finished document.

There is a body of practice in graphic design that is accomplished not only
in making a page of anything look good, but in making it reflect its purpose:
from a financial report to clothing advertising, form should reflect content.

The nice thing about a tool as powerful and flexible as WordPerfect is that
any of what you’ll see in this chapter is the work of a few minutes, not the
day and a half that used to be the norm. The speed with which you can
format a page has another bonus: you can make any number of changes
and, with the Mac’s immediate feedback, see right away what you like best.
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Let’s start with a look at fonts.

Tips on type

You need to start with the right materials, in this case, the right kind of
fonts. There are many different ones available for the Mac, and your initial
choice is critical to quality. Fortunately, it’s easy to choose the right kind.

Type formats

While the earliest fonts for the Macintosh were bitmap – simply pictures
of letters at a fixed resolution, a much higher quality is available from
outline fonts, where a letter isn’t a collection of dots but mathematical
descriptions of a shape, which would print at the highest resolution avail-
able from a given output device. The first kind of outline font, Adobe’s
PostScript, uses bitmaps for the screen image while the outline shapes are
either included in the printer or reside on disk where WordPerfect or
another program would send them to the printer along with the document
being output. Wherever the fonts were, though, the laser printer had to
have the PostScript page description language built in to use them, or the
bitmap fonts used for the screen display would go to the printer instead.

Adobe’s Type Manager utility (see Chapter 18 for more on this) gave
PostScript fonts much wider application: no longer did you need a Post-
Script printer in order to use them, and they appear on screen at the
highest possible resolution, using outlines. At about the same time, Apple
released the TrueType font format, conceptually similar to Postscript but
and which uses outlines for both screen representation and printer output.
The fonts that come with WordPerfect are all TrueType. The more recent
OpenType format is a development along the same lines. Adobe Type
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Manager supports the use of OpenType fonts in legacy Mac and
SheepShaver systems that run WordPerfect.

The selection that comes with WordPerfect is fine for general use; if you’re
shopping for more, the large font houses such as Bitstream, Adobe and
Monotype offer the highest quality at an appropriate price. Elsewhere,
there are packages that look like great bargains – 100 PostScript and
TrueType fonts for $49, for example – but quality of the glyphs (letter
shapes) may be compromised, and the character sets may be incomplete.

As we go, in any case, you’ll see that part of the point is not how many fonts
you can get away with using, but how few. Graphic designers have a term
for any document that uses more than three fonts: a ransom note.

Type styles

As we saw at a glance in chapter two, choice of type styles makes a differ-
ence in the effect of the printed word. There are three broad categories of
type: serif, sans serif and display. Serif typefaces have small strokes, or
caps, at the ends of the main strokes of each letter. Sans serif, as you might
expect, do not. Common examples are shown in figure 15.1.

Figure 15.1: Serif and sans serif

The first distinction to be made is counter-intuitive: serif faces are easier to
read in text. The sans serif face looks cleaner and simpler, so you’d think it
would be easier to read, but the caps on the serif letters are thought to
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increase our recognition of each letter within the word. Since we read
words (or even entire phrases) rather than letters, the distinction is impor-
tant. As we approach the idea of ‘rules’ in page design – that is, it’s fine to
break them once you understand why they’re there – we can think of it as a
rule to use serif for body text.

It’s also fine to use serif for titles, subtitles and captions, but sans serif
suggests itself because of the pleasant contrast it provides. Just as using
more than three fonts suggests a ransom note, using only one can produce a
monotonous effect.

What the choice of font does, always, is convey a connotation to the words
presented that can help or hinder what the publication is trying to do. An
effective page is no accident.

Let’s look at some varieties of serif fonts.

Typeface and personality

The details of the strokes and caps of letters in a font serve to give that face
a personality that can powerfully influence how the reader perceives your
message.

Say that you’re directing two print campaigns for an advertising agency,
and want to use the fonts shown in figure 15.2: one in your ad for a washing
machine, and the other for a sports/luxury car. Which do you choose?
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Figure 15.2: Two serif fonts

This is Marshall McLuhan’s “The medium is the message” in
action. The letters’ shapes themselves set the tone for the
statement composed from them.

Personality becomes more pronounced when we consider display fonts, as
in figure 15.3.

Figure 15.3: Contrasting display fonts

Part of the reason for the big difference in the effect of these two fonts is
that although they’re shown here in technically the same size (18 points,
where there are 72 points to an inch, from the baseline (the imaginary line
on which the letters sit) to the tops of the tallest ascender, the lower-case
letters of Antique Olive are relatively much larger than that of Bernhard or,
as typographers say, their x-height differs. This distinction affects how
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open or how refined a font looks. Figure 15.4 illustrates these measure-
ments.

            

beguiling

bewitching

            

leading

            

x-height
            

descender

      

ascender
            

baseline

Figure 15.4: Components of type

Figure 15.5 shows quite a range of display fonts.

Figure 15.5: Display fonts

These are more specialized display fonts that clearly would not work in
body text. Antique Olive and Bernhard Modern should also not be used in
text, actually for the same reason: their personalities are too pronounced,
and the reader would tire easily.

For text fonts we want to look at individual letter shapes (called glyphs)
but also at the color, or weight, of a block of text, as shown in figure 15.6.
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Figure 15.6: Blocks of text
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Good choices for text use are fonts that aren’t too thin or heavy, with
around a medium x-height, and without especially distinctive letter shapes.
Fonts within this range look different in samples of a few words at a large
size but also in blocks of text.

Take a moment to judge the personality of each typeface, as a block rather
than individual letters. One may look more literate to you, or better reflect
the personality of your publication. One may simply seem more legible.

Sans serif fonts are nice choices for subtitles and captions. They look less
formal – and for this reason a title is best set in serif – and more direct, in
addition to providing a balanced contrast with serif text. Sans serif faces
connote a simplicity, even an honesty, that well serves a few important
words. Some nicer sans serif typefaces are shown in figure 15.7.

Figure 15.7: Sans Serif typefaces

and, as with the serif faces, we’re looking at designs that require aesthetic
judgment – just like painting your house. When painting, though, the
questions are not only what color for the walls (serif) and for the trim (sans
serif), but how the two fit together. The text of this book is set in Georgia, a
serif font with a large x-height optimized for reading onscreen. Alternate
text, for captions and note/shortcut/tip icon text, is Ariel; headings are
Stone Sans. Only these three fonts are used in the entire book (except, of
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course, for examples such as in this chapter), and they were chosen in part
because they look good together.

The best way to educate your judgment of what goes with what, and which
font to use where, is to look at pages that appeal to you, either editorial
content or, in magazines, advertising, and start your analysis with the
publication and its personality as a whole. Why does advertising in Vanity
Fair look different from that in The Economist? What parts do typefaces
play in that? What about the editorial pages?

Attributes

The range in text attributes (e.g. bold, italics) WordPerfect offers you is
reminiscent of a candy store. Just as too many fonts produces a ransom
note, though, using styles injudiciously detracts from the presentability of
text. While not commenting on the content of religious tracts, we think it’s
worth noting that the amount of emphasis some tend to add to text has the
opposite effect: if everything’s emphasized, then nothing is.

Italics is the best form of emphasis in general, since its use doesn’t change
the color of text in a block. Using bold, by contrast, gives a block of text a
checkerboard look. We have many terms to introduce in this book and
decided, in the spirit of a friendly and accessible learning tool, to present
new technical words in bold, reserving italics for editorial emphasis. It
wasn’t an easy choice to make.

It is important that you use italics sparingly. This avoids an overemphasis
in style and makes your text easier to read. For example, what if the entire
first sentence of this paragraph were italicized? Would intensity of expres-
sion be better served? Italics can be used well in captions and such, though
again best as a contrast to the Roman (regular serif type) body text.
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Because underlining and all capital letters were the only means of emphasis
available on typewriters, their use is still seen, and it is regrettable. Under-
lining serves primarily to make text harder to read, and all caps looks like
the writer is SHOUTING AT YOU. Neither belongs in professionally
designed text. A title can be all caps and get away with it, but the next time
you want to put a title in caps, do so and then put it in mixed case too, and
take a hard look. All caps is much harder to read, primarily because the
lack of ascenders and descenders makes it more difficult to distinguish one
letter from the next. The American government recently mandated that
every new street sign in the country be mixed case, as a safety issue, for
this reason.

Another inappropriate form of emphasis is using quotation marks. Single
quotes can be used within double quotes to mark an actual quotation within
a quotation, or can be used to mark a word or phrase as mention as op-
posed to use. Double quotes are employed when someone else said the
words, or when the word is given an unusual or ironic meaning. Neither
should be used as simple emphasis – it’s downright “silly”.

Page design

Type of course does not exist in a vacuum, any more than graphics do.
They combine to make a page that works. Ask yourself how many times
you’ve discarded one brochure and read another, although their messages
were similar. Have newsletters from your workplace or children’s school
seemed somehow hard to give attention to? Why does some advertising
catch your eye more than others?

We don’t mean to suggest that presentation counts more than content, but
design is important. Architects know that the shape of a space affects
greatly how people feel about what they do inside it. The shape or design of
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what you see on a page likewise has much to do with how receptive you are
to its content. Simply put, even ideas go further if they are well dressed.

The first thing to realize is that there’s nothing here you can’t do well. You
know the tools already; the next stage is a look at steps to putting text and
graphics on a page for maximum effect.

That maximum effect, to be sure, doesn’t exist in a vacuum either. You
need to ask yourself who your intended audience is, and what they want to
see, consciously or otherwise. Will they be attracted to a businesslike page,
or should it be sumptuous? Understated or exciting? Keeping in mind who
you’re talking to, let’s learn the language.

Putting a page together

To begin, let’s think of a column of text as it appears on a page as a block. A
headline is another block, a logo a third and a graphic a fourth. What we
want to do is place and size these blocks so that:

• they don’t crowd each other. Each block has room to breathe.
• the page feels balanced, but not static
• the reader’s eye is led from one element to another
• the design makes a statement independent of but complementary to

content

The first consideration is widely overlooked, but the easiest to correct.
Graphic designers know the importance of white space – parts of a page
with no text or graphics. The empty areas serve to emphasize what blocks
there are on the page. Let’s look at an example.
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Reports

Note how the parts of “Cap’n Cook Software Report” in figure 15.8 are
crammed together on the page. The categories are separated only by
indents, and the reader is barely able to find them.

Figure 15.8: Original report
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Report and category titles are in all caps and underlined, hallmarks of bad
typographic design. Compare it to figure 15.9.

Figure 15.9: Redesigned report

This has a great deal more white space, allowing each block, or element on
the page, enough room to breathe. We used three fonts – a practical
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maximum for one page, and too many unless there is clear separation in
both location and concept between them.

The Cap’n Cook name is in the Brush font, suitable for a name and, since it’s
a distinctive face, the point size can be smaller. The size and position of the
word Report leaves no doubt as to the page’s purpose; the title and catego-
ry headings are set in GeoSlab, whose square serifs fit the official character
of a report. We used Justify All from the Layout Bar to spread the word
evenly across the page, and gave it a double underline, remembering how
judicious its use should be. A paragraph border would have worked as well.

When you first turn on a paragraph border, it appears around
all paragraphs on the page. Turn the border on in the para-
graph where you want it, then move your cursor to the first
paragraph where you do not want the border, and turn it off.

You can also select part of a paragraph and place a para-
graph border, which will then affect only that paragraph. This
will change with the setting of the Paragraph/Single Paragraph
environment preference, discussed in Chapter 12.

We set the headings and body text in a table, removing all borders. The
reader who wants to skip to Customer Views can do so easily. The white
space between categories emphasizes that they are categories, again in
keeping with the nature of a report. The large type of the category names,
with surrounding space, serves to balance the body text on the right, for a
look that is balanced and yet dynamic, an effect that would be ruined if the
vertical column break were in the middle of the page instead of offset to the
left.
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Newsletters

Let’s look at a newsletter like “Sportsfreak” in figure 15.10. It’s logo is set
between the two parts of the title, which aren’t quite the same width, so the
logo is slightly off center. The story’s headline is too small and fits awk-
wardly with a column of body text directly to its right, and is set in a font
that doesn’t fit the personality of the publication.

The running men graphic has a different, heavier border than the woman in
leotard, producing an uneven effect. Both graphics extend into their
margins, looking sloppy. The running men touches its frame, looking even
sloppier. There’s exactly one line of text in the center column, and the
reader has to search for continuation of the story at a couple of points.

In terms of overall balance the headline and both graphics, set into the two
left columns, make the whole page lean to the left. The right column, all
text, looks separate and might be mistaken for a different story.

We can redesign this page into figure 15.11. The logo is moved out of the
title, eliminating its trite appearance and, set to the right of the page,
balancing the title. The font for the title, Oz Handicraft, suggests a frisky
personality relevant to the publication, rather than the generic and staid
Times. The headline is also in a more suitable font, Swiss Black Extended,
and isn’t boxed in by other page elements.

Since the title and headline are still heavy, the borders around the graphics
are not, thereby not overwhelming the page or their contents. Margins are
not violated, and the story text jumps around much less on the page. The
text has been changed from justified to the less formal left-aligned, which
reading studies show is more legible.
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Figure 15.10: Original newsletter

Just as importantly as any of these details, consider how the balance of the
page has changed. The title and one graphic are on the left; the logo and
other graphic on the right. Yet the effect is not static, as would be the case if
each element on the left had a balancing block at the same horizontal
position on the right.
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Figure 15.11: Redesigned newsletter

Instead, the reader’s eye is led from the title at the top left to the centered
headline, then to each graphic in turn. This composition, exactly as in
fine painting, gives the page a sense of an active and coherent whole. The
newsletter is inviting, not jarring, and the motion its elements induce again
fits its personality and message.
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Magazines

A periodical such as “Black Magic Review” has a cultivated personality and,
for a given issue, specific items to sell. Its cover has to reflect both. Figure
15.12 shows what a cover might look like, with the title in an appropriate
point size, but the line break, between Black and Magic, causes the reader
difficulty in recognition of the name. Putting Review by itself on the second
line would be an improvement, but putting all words of the title on one line
(true for any title, as long as it’s not too long) is better yet.

The list of featured articles is center-aligned, a format that will work for
single or (especially) multiple lines only if they’re short. Some of these
lines, though, span the page while others are short, for an effect that’s hard
to read. It’s unclear where one article description stops and the next begins.

The graphic is too small for the page and is lost at the bottom. Its caption is
longer than the graphic is wide, looking awkward and, although the graphic
provides some balance for the magazine’s name, the overall effect is
unpolished.

A revision produced figure 15.13, which puts the review’s name on one line
for improved recognition, and sets it in a more suitable font, Black Letter.
The rule below the name emphasizes the name without separating it from
the rest of the cover. The article list benefits greatly from being recast into
a narrow vertical column that the reader can span quickly. The introducto-
ry words, “In this issue”, are separated from the list by font and left align-
ment, forming a kicker to the list. The name, list and graphic caption were
all done in text boxes for flexible alignment.

The 20% gray fill (also called a screen) in the list box adds elegance and
emphasis. The list font, Humanist Bold Condensed, is heavy enough to be
clear in front of the fill and contrasts nicely with it. Each article is separated
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by a dingbat: a small symbol of almost any kind used to this effect in
printing. Most font collections have a selection of these.

The graphic is much larger – it’s not bad practice to test making graphics
larger, wherever you are – and farther up on the page. Its caption would
still be lost at the bottom were it not for its bold personality.

It’s important that separations between blocks be even. On this page, the
distance between the journal name and the horizontal rule, and between the
rule, list box and graphic are all equal.

Editorial pages

Let’s look at the first editorial page of a magazine, “The Good Life Journal”,
in figure 15.14 on p. 530. Although a periodical knows its first impression is
that of its cover, that’s what has to sell the magazine so the editorial person-
ality the journal wants to project may necessarily be compromised. Once
the magazine is sold, though, the table of contents perused and the ads dug
through, the issue can present itself as it sees itself. For Time or Newsweek,
this often means a photograph covering much of a two-page spread, with
one column of text to the side. For The New Yorker  it means an understat-
ed and classy logo and much more to read. Look three pages forward here
for a comparison.
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Figure 15.12: Original magazine cover
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Figure 15.13: Redesigned magazine cover
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Figure 15.14: Original magazine first page
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Figure 15.15: Redesigned magazine first page
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Figure 15.14 is not as bad as our earlier first drafts. The Journal’s name and
the headline are presented in a tasteful way as might befit the personality of
the publication. The headline, though, is overpowered by the name and the
thick horizontal rule between them.

Concerning the composition of the page, an attempt has been made at
balance by setting the graphic at the lower right. Since the graphic is so
much larger than the name and headline, though, the page is still out of
balance even with the help of the horizontal rule. There’s also a great deal
of text on the page, giving a heaviness that we should avoid on the first page
of the story.

Balance of composition is especially important to this periodical’s message
– Aristotle saw the mean as intrinsic to the good life – and a sense of
motion would be less important, in fact less wished here than in
Sportsfreak. We recast the page as figure 15.15, in which the magazine
name, the more elegant thin double rule spanning the page, the story
headline and beginning of text are all given more room. The graphic is
centered in the text. The equilibrium of the design would be ineffective for
the active business message of the Software Report, but supportive of this
publication’s character.

Advertising

We’ve mentioned that a page shouldn’t look too busy with either content or
emphasis. Figure 15.16, hawking (the appropriate description) the com-
plete recordings of the Beatles, seems to want to sell something, but it’s not
only busy, it’s just loud. The delivery, reminiscent of late-night TV ads for
kitchen appliances not available in stores, is dissonant to and distracts the
reader from her memory of sublime music.
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A redesign in figure 15.17 does two things: it takes the noise away, and it
presents a harmony attractive to a suitably inclined reader. With fewer
elements on the page, their placement becomes more important. Note that
the picture is slightly closer to the word “Beatles” than to the word “Com-
plete”. If the distances were the same, optical balance would be diminished.
That would be mechanical balance which, millimeter ruler at hand or not,
often does not look as good. Rather than measurement, move things
around on the page (text boxes are helpful for a lot of display work), and
see what looks right. If it looks right, it is right.

The font, graphic and white space all contribute to an aesthetic statement.
Each word now carries more weight. Mies van der Rohe’s observation that
less is more is just as relevant to page design as to architecture. 
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Figure 15.16: Original advertisement
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Figure 15.17: Redesigned advertisement
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Undefined

There is basically no page to be printed that would not benefit from these
principles. The following are examples of what might be a political tract, a
handout to members of your community or colleagues, a leaflet or poster.

Figure 15.18: Original tract
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The original in figure 15.18 is set in the Courier font that comes with the
Mac and is cleverly disguised to look like a typewriter. Since this font is
monospaced it’s harder to read, and the lack of contrast over the whole
page is decidedly uninviting. We revised it to figure 15.19,

Figure 15.19: Redesigned tract
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using vertical type, a technique that if not overdone is quite appealing. We
did this by entering the text in the Graphic Editor and rotating it. We then
came back to the Document Editor and stretched the graphic, giving the
Humanist Light font a special effect. We made the two subheadings a much
different font (Humanist Bold Condensed) from the text – subheads should
always be distinct from body text in font, size, color, attribute or other
formatting – and left enough space on the page. The fairly light text is
easier to read than a heavier font would be, but balances nicely with the
heavier title and subheads.

Spreads

Interior pages of a publication are less often seen and judged by them-
selves; rather, left and right pages constituting a spread are seen as parts
of that whole, with a single effect on the reader. Where one or both pages
are advertising there’s not much to be done, but where both are editorial –
especially if the same story – the balance between the two pages becomes
important. Figure 15.20 shows a well-designed spread, where each page
balances the other by having two graphics, at roughly the same place on the
page. The illustrations are also roughly the same size. The key here is
roughly: what would the spread look like if the graphics on each page were
exactly the same size and place? Not nearly as pleasing. Instead, the sizing
and placement make the spread dynamic as well as balanced. The effect will
matter to readers, although they may not be conscious of it.
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Figure 15.20: Spread of two pages in a journal

Summary

There’s a great deal behind successful desktop publishing, but page after
page of rule and example implies that the practice is borne of rules when it’s
really an art form in which experience is important to success. For further
examples we recommend Roger Parker’s book Looking Good in Print but,
even more, we suggest that you find something looking to be published, and
try it out.
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Don’t even think of distributing your first effort. Instead, complete the
page or pages and then, saving versions, go back and make some change to
every element on every page. Resize and move blocks and rules, keeping in
mind both the principles of balance and composition, and also who your
intended audience is and what you want to tell it. Design and content have
to harmonize, and the simpler option is usually the better one. Compare
your efforts to professional work, and try to analyze the latter constantly.
You’ll be surprised how quickly you improve.



Chapter 16

Advanced Features

These features are less what you’d call “word processing” and more what’s
thought of as “document processing” – approaching a complete environ-
ment for your thinking and its expression.

• QuickTime
• Bookmarks
• Hyperlink
• Envelopes
• Speech

QuickTime

What we’ll cover here includes:

• inserting a QuickTime movie into a WordPerfect document
• treating the movie like anything else in a box: you can resize and reposi-

tion it, caption it, list and cross-reference it
• playing the movie forward, step-frame, backwards, at any speed,

looping repeats or forward, then backward, and repeat

Inserting a movie

A QuickTime movie looks like any other Macintosh file. It has an icon,
perhaps only a blank dog-eared page, and can be copied from disk to disk in
the normal way. Find a movie, of file extension “.mov” and:
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1. Copy it onto any disk that will be available when you’re running Word-
Perfect. Put it in any folder you want, and it’s best to leave it there. This
is because WordPerfect will refer to the movie while it plays it, and
needs to be able to find it once you tell WordPerfect where it is.

2. Open WordPerfect, and either start a new document or put your inser-
tion point anywhere in an existing document where you’d like to place a
movie.

3. From the Tools menu, choose Movie and then Insert. In the standard
open file dialog, navigate to the movie’s location. If you have Preview
turned on in the Open dialog, you’ll see a preview of the first frame of
the movie, called its poster, in the preview window. Click Insert.

You now have a graphic image in your file. It looks like figure 16.1.

Figure 16.1: Quicktime movie in a WP document

You see a difference between it and an ordinary graphic image: this has an
icon that looks like three frames of movie film, at the lower left of the
image. This is QuickTime’s badge.

Resize the movie so it’s easier to see: click once on it to get graphic handles,
and shift-drag the lower right handle.
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Playing a movie

1. Double-click the movie. It plays, once forward, at normal speed. Isn’t it
fun? The movie stops on the last frame. Click anywhere outside of the
movie box to return it to its poster.

For more control over playback:

2. Click once on the QuickTime badge, the icon of three movie frames at
the lower left. Controls appear at the bottom of the box, as in figure
16.2:

Figure 16.2: QuickTime controls

3. Click the Play button to play the movie forward normally.

The Play button changes to a Pause button during play. To pause the
movie:
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4. Click this button or click once on the movie itself. Double-click the
movie to resume play.

With the movie not playing:

5. Click on the Step buttons on the right end of the play bar, to move
single-frame, at one per click, or at high speed if you hold either button
down. The scroll box or thumb moves along the scroll bar as the movie
plays. You can also drag the scroll bar with your cursor, and the movie
responds dynamically.

If the movie has sound, the speaker icon at the left end of the control bar
will be clear; otherwise it will be gray. If it’s clear, click it to get a volume
slider. Or, you can option-click the speaker to toggle the sound on and off.

To change the direction of playback and start playing, com-
mand-click the forward or backward step buttons. To change
the rate of play and optionally the direction, control-click either
Step button, then drag the sliding bar that appears. To go to
the beginning or end of the movie, option-click either Step
button.

Movie Settings

For more precise control over how a movie plays, click on it once to select
it, and choose Settings from the Movie submenu on the Tools menu.
You’ll see a dialog like figure 16.3.
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Figure 16.3: Movie Settings

in which you can turn off the visible badge, replace the poster or restore
the original, revert to original size, and change playback options. You can
also play the movie from the preview window. This gives you the advantage
of the elapsed time counter below the movie window, expressed in minutes,
seconds and thirtieths of a second.

Working with a movie as a document element

The movie is in a box that actually is a figure box. It can thus be treated like
any other graphic in a WordPerfect document. Drag it to reposition it if
you like. If you’ve set your Preferences so that incoming graphics are
treated as a character (the default), the movie will originally sit on a line,
and move back and forth as you add and delete text before it.

Once you drag it on the page, it becomes anchored to the page, and text will
wrap around it. If the graphic box code, which stays imbedded in the
text, is moved to the next page by insertion of text before it, the graphic
will move to that page too, but stay in the same position on the new page.



546 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

If you anchor a graphic to a paragraph and insertion of text before that
paragraph pushes the code to the next page, the figure goes with it. So does
all the text between the beginning of the paragraph and the figure code.

After repositioning the movie as you like, why not resize it? Nothing like
the big screen, but some movies can be sized so big that they become blurry
– as can other graphics, depending on their format.

You can caption this box like any other, cross-reference it, and include it in
a list. WordPerfect doesn’t have a separate label type for Movie, so you’ll
want the list to be either user-defined or custom. See Chapter 10 for details
on lists and cross-referencing.

It’s one thing to say “See figure 12”, and quite another to say
“movie 12”. As QuickTime movies become as commonplace
as other graphic formats, think of the added dimension your
documents will offer.

However, file formats have evolved since WP’s last release in
1997, and recent files with the “.mov” extension may not play
well in WP.

Bookmarks

Bookmarks, and the related Hyperlinks, are fast ways to move around a
document. To set a bookmark, open the Bookmark Bar from the Control
Bar, to see figure 16.4.

Figure 16.4: Bookmark Bar, also used for Hyperlinks
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While it’s not necessary to select text before creating a bookmark, it saves
a step later, so select what you want to serve as a bookmark and click
Mark…. You’re asked to confirm the bookmark name as the text you
selected. Click OK.

To go to a bookmark, just select it from the menu on the bar. To unmark a
bookmark, choose Unmark… from the bar and choose the bookmark you
wish to unmark.

Hyperlinks

A text hyperlink in WP appears in blue and underlined. Just like a link on a
web page, you can create a hyperlink in WP that goes to a bookmark in the
current document or any other document on the same computer, or to an
internet address, or to a macro, i.e. runs that macro.

The text that will become your hyperlink needs to be selected first. When
text is selected, the Create button on the Bookmark Bar becomes active.
Click that button to produce figure 16.5.

Figure 16.5: Create Hyperlink dialog
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If you want to create a link to the current document, type the name of
the Bookmark or choose from the list produced by clicking the down arrow
to the right of the text entry area. To link to another document, choose
that option from the Link To: Menu to get a standard file dialog. Choose a
file and you’re back in figure 16.5. Click the down arrow to get a list of
bookmarks in that document, or just type its name, and click Create.

To link to an internet address, choose that option from the Link To:
Menu and type the link, e.g. “http://…” and click Create.

Or use the macro Link to URL, which comes with the
SheepShaver-WP package, where you select the link and then
run the macro. No need to type it a second time.

To Disable Links, click that button on the Bookmarks Bar, which will then
change to read Enable Links. To the right of that button, a menu will let you
return to the hyperlinks you’ve gone to in the current session, and left and
right arrows let you revisit each hyperlink in order.

If you create a hyperlink in a WP document and nothing happens when you
click it, you may have to designate a web browser. Depending on your
installation, that could be a simple matter of identifying a browser on your
machine. OSX browsers, though, are often released as packages, a file type
that WP predates. Open URL, free at WPMac, is a solution. If you have
SheepShaver-WP installed, Open URL is in the Script Menu.

You can also get WP Browser at WPMac. This lets you click on a web link
in a WP document to go to that web site, just as the original design sup-
ports.

Adding a hyperlink to a macro is a real convenience. Just click on that link
and the macro, as you know, can do almost anything.
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Envelopes

WordPerfect’s Envelopes facility, as shown in figure 16.6,

Figure 16.6: Envelopes dialog

lets you print envelopes with addresses and return addresses you enter
manually, or get from your current document or from a database, or derive
from a merge operation, as explained in Chapter 11.

1. From your current document select the address you’re sending to.
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2. From the File Menu, choose Print Envelope…. You’ll see figure 16.6,
with the To: address on the envelope.

3. Look at available options from the dialog’s menus. Envelope gives you a
range of sizes. Include lets you add a US Postal Service bar code, either
above or below the delivery address, as well as a Facing Identification
Mark (FIM) of types A, B or C, another kind of bar code the US Postal
Service uses.

The Printer Feed menu shows different positions and orientations available
to support different printers. Please refer to your printer’s manual for the
proper setting here.

Speech

WordPerfect can read out loud a document or any part of one. To speak
part of a document, select the text you want. Otherwise, WP speaks the
whole thing.

1. From the Control Bar, select Speech.

2. To speak part of a document, select that text. The leftmost button on
the Speech Bar will read Speak Selection. Otherwise it will say Speak
Document.

3. From the Voice Menu, choose the voice you want to use. Some of the
voices are considered humorous; you may find one you like. “Fred” has
become something of a default.

4. Click the Speak… button.

5. To stop or pause the speaking, click the appropriate button.



Chapter 16: Advanced Features 551
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

You can find more voices on the internet.

Summary

This chapter has illustrated a little more of what WordPerfect can do. You
can now:

• insert and use QuickTime movies for another dimension to presentation
and word processing documents

• create and use bookmarks to navigate quickly within a document
• create hyperlinks to bookmarks within the current or another docu-

ment, or to an internet address, or to a macro
• create envelopes, using varying degrees of automation, and including

bar codes, with a range of formatting
• speak a document or a selection, using a range of Apple’s voices

Although your computer is capable and valuable without these power
features, we encourage learning their complete use if any of what you’ve
seen here seems at all enticing. If you remember first seeing a Macintosh on
a colleague’s desk or in a store, you understand how a tool often turns out
to be ten or a hundred times as useful as you first imagined it to be.





Chapter 17

Safety and Security

In this chapter, you’ll learn about:

• computer viruses: what they are, why you need to protect yourself
against them, and how you can do that effectively

• disk diagnostic and protection programs
• file recovery measures
• automatic backup utilities, and their importance to data safety
• general tips for safety and convenience

Here’s some specific ideas and recommendations for programs, skills and
attitudes to protect your text and graphics. They are not meant to be
conclusive or exhaustive but will give you a good start. Although data isn’t
as fragile as we tend to think when we’re learning about computers, steps to
safeguard data are well worth it.

Viruses

Since the Macintosh operating systems historically have had much less
trouble with viruses than the Windows OS, some Mac users assume there
will never be future problems. There have been problems, though, and
there may be more. May we refer you to an excellent website, The Safe
Mac, at http://www.thesafemac.com/, which points out that incidence of
Mac malware has increased significantly in recent years and offers this
caution:

http://www.thesafemac.com/
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If this trend continues, Mac users will need to take security far more
seriously than they do now.

Let’s take a quick look at viruses. Here’s the scoop on what they are, where
they come from, what they can do, and what you should do.

A virus is in some respects just like any other computer program, but it
doesn’t wait for your commands to create or format text or graphics.
Instead, it operates by itself and does what its programmer, not you, wants
it to do.

That most often consists of two things. The first is to make a copy of itself
onto any disk it can. So, if a disk or flash drive from a friend has a virus,
and you put it in your floppy drive, it automatically copies itself from there
onto your hard disk, without your knowing it.

Next, once it’s on your disk and in your computer, it does something else.
What that is, is up to the programmer – it might just make your Mac beep
all the time, it may cause system errors on the next Friday the 13th, or it
may erase everything on your hard disk.

Who would write a program like this? The first virus we know of was
written by a programmer angry at having been fired, and his virus was
designed to erase only those programs his former employer published.
Other virus programmers have been high school students whose computer
skills were better developed than their scruples. There’s no limit to who,
with sufficient knowledge, can write a virus.

How do they get around? Typically through less salutary web sites, such as
those that offer porn or pirated software. But any web site (or disk or flash
drive connected to your computer) is in theory a possible conduit for
malware.
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In any case, you can obtain – often free – and use programs that counter
viruses.

There are two kinds: first, programs that monitor your Mac and any disks
you insert for viruses we know about, and that can eradicate any they find.

Second, there are programs called watchdogs that monitor not for known
viruses but for the types of activity that viruses are likely to do. They can
thus catch some new viruses that the eradication programs were not
designed to detect. The programs listed here do one or the other, or some
combination of both.

Virus prevention and eradication programs

Given that WordPerfect runs on legacy and classic systems, many or most
of which are installed as part of OSX systems, let’s look at a program for
classic/legacy/OS9 systems, and then a couple for OSX. All are free.

The best virus utility for legacy Macs and the Classic environment in OSX
is Disinfectant, by John Norstad. Its main window is shown in figure 17.1.
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Figure 17.1: Disinfectant has just scanned a disk

Note that Disinfectant says it does not protect against the Microsoft Word
and Excel macro viruses. Those are a threat only to documents created
with those programs.

It’s strongly recommended to go to Disinfectant’s Protect Menu and choose
Install Protection INIT. You’ll receive the message in figure 17.2.
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Figure 17.2: Disinfectant INIT has been installed

While we haven’t heard of any new viruses for legacy Mac systems in a
while, your neighbor’s classic Mac may have some older malware, and it
may make its way to your classic Mac or your SheepShaver disk on your
OSX Mac. Disinfectant is free in the Files section at WPMac.

For OSX, take a look at this page at The Safe Mac site:

http://www.thesafemac.com/time-to-re-evaluate-safety-of-mac-os-x/

which suggests the value of installing and maintaining malware protection
on OSX systems. There’s a range of commercial and free programs, and the
free ones appear to be as good as commercial offerings. Let’s look at two,
Sophos and ClamXAV.

Sophos offers a range of commercial offerings with extensive capabilities,
but their basic protection program for home Mac systems is free. See
https://www.sophos.com. Its splash screen is shown in figure 17.3.

http://www.thesafemac.com/time-to-re-evaluate-safety-of-mac-os-x/
https://www.sophos.com
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Figure 17.3: Sophos anti-virus

ClamXAV, at http://www.clamxav.com/, is donationware: free if you
like, but the author would appreciate some support. He deserves it. Its
splash screen is shown in figure 17.4.

http://www.clamxav.com/


Chapter 17: Safety and Security 559
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

Figure 17.4: ClamXAV anti-virus

Maintaining current protection

With either of these OSX protection programs, it’s critical to keep up-to-
date.

It’s an advantage to have a constant internet connection, since Sophos and
ClamXAV will send you updated signatures, or indicators of particular
viruses that the programs will then use to look for them. You can request
those manually or have the program schedule its updates.
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Installers of some applications may ask you to turn off virus protection
before you run the installer. Your judgment should reflect your trust of the
source of the program in question.

Disk Doctors

Think of your hard disk as a CD or DVD: there are several tracks on its
surface, each of which holds a different piece of data. The CD has music, or
Shakespeare’s plays, or the Physician’s Desk Reference; your disk has the
Macintosh system, and WordPerfect, and all of the letters, reports, essays
and graphics you’ve created thus far.

With the stable environment of a CD, track three has Paul McCartney’s
“Yesterday”, and will have that data there forever. Your disk, though, is a
much more dynamic place: what you put on track three last week you
might have erased ten minutes ago, so the letter you wrote five minutes ago
was put in its place.

Or, the report you wrote last month, all ten pages of it, went onto track
three, but then you added a couple more pages. Your Mac couldn’t just
push track four out of the way, so the Mac took the new pages and put them
in track 19, making a note to itself that this certain report began on track
three, and was continued on track 19.

As you create, delete and modify files, the Macintosh’s job of managing the
hard disk gets complicated. And, every so often, the Mac can misplace data
and a trip to the doctor is in order. You might have gotten a system error,
or your Mac might just have stopped working: everything’s still there on
screen, but keyboard input or mouse clicks do nothing. You have to force-
quit the active program or even restart the computer itself.
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Time for a visit to the doctor. Let’s talk about disk doctor programs – we
think every Macintosh owner should have one – and what they can do.

As with malware programs, offerings for legacy/SheepShaver systems are
different from those for OSX. Legacy first: there’s a simple program Apple
distributed called Disk First Aid. Open it, and its window looks like figure
17.5.

Figure 17.5: Disk First Aid’s window

This can check a system’s startup disk, as shown, and any other disks
connected when you opened the program. Click on any disk icon to select it
to check.



562 Teach Yourself WordPerfect Mac
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

The SheepShaver-WP package runs this at startup, from an AppleScript
that will check only the startup disk automatically, and quit the program if
you click Stop or press Return while the check is in progress (run by itself,
Disk First Aid will just stop if you press Return or click Stop).

If Disk First Aid finds an error, you will be able to repair it only by restart-
ing your system from another startup disk. For a SheepShaver-WP installa-
tion, the way to do that is to quit SheepShaver, locate the ShSh-WP.dsk
disk, change its extension from .dsk to .dmg, and then repair it with Disk
Utility, an OSX program we’ll discuss next. For older systems, you should
keep a startup disk, perhaps a CD, with a System Folder and Disk First Aid,
for this necessity.

Disk Utility is distributed with all versions of Apple’s OSX. It does much the
same thing as Disk First Aid. Its window initially looks like figure 17.6 once
you select a disk in the list on the left and click First Aid from the ribbon
near the top. In the buttons under the largest blank area, note that Verify
Disk is active but Repair Disk is not, because the selected disk at the left is
the startup disk. Neither Disk First Aid nor Disk Utility can repair the
current startup disk – that would be like doing brain surgery on yourself.
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Figure 17.6: Disk Utility’s main window

SheepShaver-WP is set up, as noted above, to run Disk First Aid at every
SheepShaver startup, and it’s recommended to run Disk Utility’s Verify
Disk command frequently too – at least once a month.

More extensive diagnostic programs

Let’s look at a free program that will verify your startup disk, as will Disk
Utility, and do many other things besides. OSX has maintenance scripts,
which more recent OS versions run automatically. Computer problems,
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though – running slowly, files not appearing where they should be, and
such – warrant running these scripts sooner than scheduled. Onyx is a good
free program that runs maintenance scripts, clears caches and other such
cleanup. Its window, after it verifies your startup disk, looks like figure
17.7.

Figure 17.7: Onyx’s Automation window

Download Onyx from its web site (listed in the links section at WPMac),
and check back occasionally for updates, or you can set Onyx to do that for
you. YASU (Yet Another System Utility) is another good, shareware
choice.
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File Recovery

Despite keeping your disk(s) healthy, a file may occasionally become
corrupted: a program or OS bug caused your computer not to write chang-
es to a file to disk correctly, and that file will either now not open or will
open but displays gibberish.

A utility that may help here is WP File Recover. Drop a file on its icon, and
you’re given the options of recovering the entire file, including the pro-
gram’s formatting instructions to itself, or just the text of the file, as in
figure 17.8.

Figure 17.8: File Recover’s initial dialog

You’re then prompted for a name and location for the recovered file. That
will be a text file, openable with SimpleText on legacy systems or TextEdit
on OSX. File Recover comes in legacy and OSX versions since SheepShaver
packages at WPMac work well with WP files in the OSX environment –
Spotlight and Quicklook, for example. File Recover is free at WPMac.

Automatic backup programs

Rather than keep track of which of your files need to be backed up, you can
tell a program like this to do it for you. Backup programs can, at your
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option, make a copy of everything on your hard disk, or just in certain
folders. You can make a complete backup of these types of data, or only
back up the files of these types that have changed (or are new) since the last
backup.

Backup programs are good at keeping track of which files those are. You
can manually tell the program to make a backup, or schedule it to do so at
startup or shutdown. You can have it put backups on another connected
disk, an added measure of reliability since disks do crash. Houses burn
down, too, making cloud backup ideal. If you don’t have too much to back
up, Dropbox, Box.com, Amazon and Google Drive offer some space free,
with more at surprisingly affordable rates, given the value of your data.

But to get your valuable data in WordPerfect format from the SheepShaver
disk to your OSX disk, or from one local disk to another on a legacy
machine, here’s a free, full-featured legacy program that’s already installed
in SheepShaver-WP and free for everyone else.

Free Backup

MacUpdate gave this program five stars, it was a top download at Version
Tracker and yes, it’s completely free. Install just by putting a copy any-
where you want (SheepShaver-WP has it in the Shutdown Items Folder).
Use as many copies as you like – each copy keeps its own settings. A copy
may be renamed to reflect those settings, e.g. Shutdown Backup.

Drop files and folders on the icon in the Finder to add them to the backup
list. It will thereafter run when double-clicked, but settings may be changed
by holding the Command Key when Free Backup’s splash screen first
appears. This gives you the Preferences dialog as shown in figure 17.9.
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Figure 17.9: Free Backup’s Preferences

Click Options here, and figure 17.10 appears.
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Figure 17.10: Free Backup Options

You see that you can back up files in Finder format or as Stuffit archives,
taking much less disk space (and Stuffit Expander, a program to expand
those archives into Finder format, is free). Numerous Stuffit options at the
right become active when Stuffit is chosen as format.

Scope lets you choose to back up all files in the backup list, or just those
changed since the most recent full backup, or since the most recent backup
of only changed files, or changed relative to the corresponding file, if any,
in the destination.

Extensive control of Finder labels and comments helps you keep track of
what was backed up when, as in figure 17.11.
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Figure 17.11: Labels and Comments

which can make backup history easy to see, as in figure 17.12.

Figure 17.12: When files were last backed up
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Free Backup comes with a dozen extensions to enhance its functionality, in
such ways as synchronizing backup folders, backing up to variable destina-
tions such as removable media with differing disk names, maintaining a set
number of previous backups, and selecting items in a given disk or folder
for backup according to two criteria, where the selected items must meet
both, either or both, either but not both, or one but not the other, all
illustrated with Venn diagrams, as in figure 17.13.

Figure 17.13: Selecting files with two filter criteria

Finally, extensive searchable help makes Free Backup a good choice for
safeguarding what can be priceless data.



Chapter 17: Safety and Security 571
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

General advice

• A surge protector is a nice thing to put between your computer and the
electrical outlet.

• Rebuild your [classic] desktop frequently, maybe once a month.
Desktop Reset, a utility that comes with SheepShaver packages, is the
easiest way to do this, Otherwise, hold down the command and option
keys when starting your Mac, until it asks you if you want to rebuild.
Refreshing your desktop pays off in speed and reliability of operation. It
also makes QuickFind, a utility we’ll look at in the next chapter, run
faster.

A simple restart will do the same for OSX systems.

• Clear your parameter RAM every so often. This can obviate some
system errors. Your Mac manual should tell you how to do this for your
model; for many legacy machines you hold down the command-option-
P-R keys while booting. For SheepShaver-WP systems, go in OSX to
Users > Shared > SheepShaver_folder > SheepShaver scripts, and run
Zap PRAM.

• On legacy and SheepShaver systems, don’t feel you have to install every
extension and control panel there is, even if it adds a functionality
you’ve been dying for. Some of the non-commercial products are badly
written, and will conflict with your Mac’s operation. With each one you
see, ask yourself, “Do I really need this?”

• Many extensions and control panels also slow your system down, while
reliably providing the functionality they advertise. Only you can judge
the value of the trade-off.
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• If a program is giving you problems, try moving its Preferences file into
another folder, where the program can’t find it. The program generally
then creates another Prefs file and, though you may have to re-specify
some settings – window positions and such – the source of your prob-
lems may be gone, since these Prefs files are often the first to become
corrupted by system errors.

• Rotate your backups. We use four, one per week, and start over next
month. If you get hit with a virus, or a corrupted system is damaging
files, last week’s versions are still there.

• There’s endless talk about how many files maximum you should put in a
folder, how many folders you should nest, and so on. Nobody really
seems to know. Experiment with the configuration you have, and you
might find some avenues to improvement.

• Upgrades are tempting but can be expensive. Version 5 of whatever
does have a lot more features than version 4, but the latter can often
work as well for what you want.

Summary

This chapter has discussed difficulties that personal computer users might
have, and steps to take to solutions. You can now:

• obtain and keep current virus protection software
• use disk diagnostic and protection applications
• use file recovery programs
• make automatic backups using different strategies
• follow general best practices taking care of data

and you now have available a safe as well as productive workspace.



Chapter 18

The Virtuoso Macintosh

In this chapter you’ll learn about many third-party enhancements to the
classic (OS 9) Macintosh environment, as chosen for inclusion in the
SheepShaver-WP package at WPMac. If you have a legacy Mac or run OSX
in Classic mode, you can download that SheepShaver package from
WPMac and copy them from there.

The other SheepShaver package at WPMac, titled WPMacApp, is written
by Edward Mendelson, a contributing editor at PC Magazine and creator of
the web site http://wpdos.org, a site primarily supporting users of WP for
DOS but with a large section on WP Mac. WPMacApp is a more advanced
design in many respects. It includes several of the enhancements discussed
below and also many others. You might like to download both packages and
see what they offer.

Many of these were originally released as freeware. Some were released as
shareware, which traditionally has been distributed free and, if an end-user
chose to keep it, required payment to the shareware author or his/her
agent, such as Kagi.

Although the shareware products discussed here have mostly either been
re-released as freeware or abandoned, if you wish to keep and use a
shareware product please attempt to contact the author or his/her agent
and pay the shareware fee. A tremendous amount of work goes into these
products and they greatly enhance our productivity and enjoyment of our
Macs.

This chapter has six sections: Apple Menu, Control Panels, Script Menu,
Extensions, Scripting Additions, and OSX Plugins.

http://wpdos.org
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Many control panels need to be in the Control Panels folder of the System
folder to work properly, and that location presents a single convenient
place for software that controls various aspects of our computers’ opera-
tions.

The Script Menu in SheepShaver-WP, provided by the OtherMenu exten-
sion, supports AppleScripts in script form, while the Apple Menu items
folder does not (both support AppleScript apps). Aside from that, software
enhancements have been placed in the Apple Menu if they operate inde-
pendently of major processes, i.e. programs in operation, such as do
calculators, Stickies and Super Ruler. Conversely, software has been
placed in the Script Menu if it operates in tandem with processes. Lupe is
useful only if there’s a program window underneath it to magnify; UltraClip
needs a WordPerfect document to copy from or paste to.

Extensions and Scripting Additions (osaxen, or Open Scripting Architec-
ture Extension, with plural of “en” determined after vigorous discussion in
the community), extend functionality to the OS and to AppleScript respec-
tively. They do not have user interfaces (except that an osax’s dictionary
will display if the osax is dropped on an AppleScript editor), so they are
presented here with short descriptions of their features. We’ll finish with
OSX extensions that support WP.

Apple Menu

Scientific Calculator

There are lots of calculator desk accessories available to replace the silly
little thing that shipped with legacy Macs. Here’s one of the two best (the
other is Convert, discussed below). Scientific Calculator looks like figure
18.1.
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Figure 18.1: Scientific Calculator

which follows the excellent Hewlett-Packard calculator design, using
Reverse Polish Notation (RPN) and a stack of four registers for calculation
results and numbers that will enter into a forthcoming calculation. It’s
better than the 2+2=4 model since it lets you chain together an unlimited
sequence of calculations without rekeying anything.

It offers nine additional memory registers, a large number of functions, and
lets you copy numbers and paste them elsewhere, into a WordPerfect table
for example. Or, you can paste numbers into the calculator.

SheepShaver-WP renames this “∞ Calculator” to put it at the top of the list,
since it’s often the most-used desk accessory.
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Clipboard

Figure 18.2: Clipboard contents

While the Clipboard itself is part of the OS, the idea to make an alias to the
Clipboard file in the System Folder and put that alias in the Apple Menu was
a great idea of someone, somewhere, lost in time. If you want to know
what’s on the system clipboard, the small window this enhancement posts,
as shown in figure 18.2, is very helpful.

Convert

Scientific Calculator is one of the two best we’ve seen for legacy Macs; this
is the other. It operates on the standard calculation model (2+2=4) rather
than RPN, and has a great set of conversions, as you see in figure 18.3.
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Figure 18.3: Convert

Especially since the United States has not yet adopted the metric system,
this is a handy tool to have.

Finances

Here’s a DA calculator especially configured for financial use, and much
faster than a general-purpose tool or a spreadsheet. It looks like figure
18.4.
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Figure 18.4: Finances

As a historical note, Diskworld was a magazine published every month that
landed in your mailbox with a floppy disk with utilities like these. Means of
distribution have certainly changed in the past 25 years, but some of the
software of that age is still as good as you can get.

The Dvorak Keyboard

We won’t include Key Caps here, since it’s an Apple desk accessory, but
we’ll take the opportunity to discuss a keymap well illustrated by the DA.

The standard typewriter keyboard, called “Qwerty” for the first six letters
on the top row, was designed when manual typewriters were in their
infancy. The very first typewriters had letters in alphabetical order across
the keyboard. Fast typists were able to move more quickly than the primi-
tive mechanisms could accommodate, and they constantly jammed. The
Qwerty keyboard design was a response to this, and placed letters specifi-
cally to slow typists down. Well and good until the electric typewriter
came along.
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By that time everyone knew Qwerty and a change seemed impossible,
especially since modifying a typewriter’s mechanism to reposition letters
involved major redesign (unlike remapping the Mac’s keyboard, which is
simple). Nonetheless, an educator and efficiency enthusiast named August
Dvorak designed an optimal keyboard that offered astonishing advantages.

On a Qwerty keyboard, the average person’s fingers move 16 miles in eight
hours. On the Dvorak keyboard, they move one mile. On Qwerty, you can
type only 100 English words from the center row of the keyboard, where
your fingers rest. On Dvorak, you can type 4000 words. Qwerty uses the
top row the most; Dvorak the center row. Qwerty uses the bottom row
more than the center row. Qwerty uses the left hand more than the right,
just because more people are right-handed. The Dvorak layout looks like
figure 18.5.

Figure 18.5: Dvorak keyboard

Since Dvorak puts all the vowels in the center row for the left hand, and the
most common consonants in the center row for the right, and no common
letter sequences are accessed with the same finger, typing becomes rhyth-
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mic and even. You’re much less tired afterwards, and threat of serious
injury such as Carpal-Tunnel Syndrome is said to be much lower.

You’d think it would take a long time to learn, but it only took us a couple
of days to get going, and then six weeks to regain the same speed (70 wpm)
we had with Qwerty, with fewer errors. You can switch back to Qwerty and
it’s much like riding a bicycle after a year’s absence: you’re only wobbly for
a few minutes. You sure appreciate the difference, though. Competent
typing tutors such as Mavis Beacon Teaches Typing offer the Dvorak
option.

The idea is starting to catch on; as one Macintosh magazine said, Dvorak
users are just the same as Qwerty users; they just make ten times as much
money.
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Marienbad

Figure 18.6: Marienbad

The only game included with SheepShaver-WP! Why? Well, there had to
be one and this computer implementation, shown in figure 18.6, of the
matchstick game of strategy made famous by the indie cult classic film Last
Year at Marienbad was an eminent choice. Seriously, many times all of us
work hard on something and, as the hours go on, find ourselves less fo-
cused. The two solutions are getting up and moving around, and playing
this for a few minutes.
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QuickFile

Figure 18.7: QuickFile

This is a piece of history: a note card program by one of the original Mac
developers and the inventor of HyperCard, itself a conceptual forerunner
of the world wide web. Did it all start here? In any case this original, whose
help screen is shown in figure 18.7, works well for addresses, notes, any
small pieces of information, and is convenient and fast.

Set Screen Colors

This is an AppleScript based on one written by Ed Mendelson, that resets
screen colors to thousands. This is useful since some versions of
SheepShaver, when performing some operations, leave screen colors
poorly adjusted. It can be edited (or replaced with Ed’s original) to set
colors to millions; thousands was the choice here just for speed.
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Super Ruler

Figure 18.8: Super Ruler

A nifty little thing written by Randy Ubillos, now a heavyweight at Apple,
that adds a visual ruler to WordPerfect’s draw module. While that module
has numerical position indicators, both absolute and delta, in the Status
Bar, a visual indicator such as you see in figure 18.8,  can be helpful.

Super Ruler can be dragged, stretched and flipped. Clicking anywhere
along the rule sets the zero mark, and scale in dpi (dots per inch) can be
changed as well. It’s a very friendly tool.

Control Panels

These are software components that modify system operation and which
have a user interface. Extensions, below, also change the OS but do not
have an interface.

ApplWindows

This makes the application menu at the right of the menu bar hierarchical,
with each application showing all open documents, as in figure 18.9.
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Figure 18.9: ApplWindows’ hierarchical menus

Navigation is then that much easier, including moving among windows of a
single program that doesn’t have a windows menu. The control panel will
let you move among applications and their windows with hot keys, and will
let you hide the apps you don’t want to include. Its control panel is shown
in figure 18.10.

As a final touch, ApplWindows lets you pop up the application menu
anywhere on your screen, with just a hot key and a click. Nice for large or
multiple monitors. There’s a lot in this one.
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Figure 18.10: ApplWindows’ control panel

Flash-It

Screen shots serve a lot of purposes, and this utility supports many op-
tions. A number of hot keys and capture tools and regions are some, as
shown in figure 18.11.
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Figure 18.11: Flash-It’s two dialogs

Keys!

The idea of better keyboard control of what you see onscreen was one of
the few good ideas to appear first in MS Windows, possibly because the
Mac, originally something of a revolt against the entirely text-based world
of DOS, had very few keyboard equivalents (and magazine reviewers
lambasted WordPerfect version 1, circa 1988, for having too many,
although nearly all Mac applications these days have more).

So control panels came along that gave Mac users more keyboard control.
The best one for dialog boxes was Keys!, shown in figure 18.12.
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Figure 18.12: Keys!

This added an underscore to the first letter of every button in a standard
Mac dialog, in system 7. At some point thereafter the underscore failed to
appear, but pressing the first letter of a button still clicks that button.
Stefan replaced the “C” of Cancel with an “A”.

MacLinkPlus Setup

This works in conjunction with the Mac Easy Open facility of the OS (which
can be disabled in Edit > Preferences > Files in WordPerfect, for the very
occasional difficult file that can’t be opened with Easy Open active). It’s
shown in figure 18.13.
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Figure 18.13: MacLink Plus

It doesn’t require much user interaction except for documents in languages
other than European. Like some other software here, its owner kindly made
it available free to WordPerfect Mac users.

Smart Scroll

Scroll arrows at both ends of both vertical and horizontal scroll bars is
simply good user interface but, in both legacy and in OSX Macs, it seems to
take an independent software enhancement to do it. Smart Scroll is an
excellent implementation of that, and also sets scroll speed (which can be
an issue with WordPerfect) and sets proportional scroll thumbs. It’s
interface is shown in figure 18.14.



Chapter 18: The Virtuoso Macintosh 589
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

Figure 18.14: Smart Scroll

Although shareware, its author Marc Moini kindly made it available as
freeware to WPMac members.

Adobe Type Manager (ATM)

Special considerations aside, any font you use on a legacy Mac should be
PostScript, TrueType or OpenType, formats that can print text at the
highest resolution your printer offers. Both your Mac and WordPerfect
came with TrueType fonts that are, out of the box, easy to install and that
look great on screen and in print, from any printer you can hook up to a
Mac.
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PostScript, developed by Adobe Systems Inc., is an older format and more
of a publishing standard. The fonts look just as good as TrueType but only
if you print to a laserwriter or imagesetter that has PostScript in it – as do,
for example, more expensive laser printers. PostScript fonts also don’t
look as good on screen.

This all changes, though, with Adobe Type Manager (ATM), a control panel
that makes PostScript fonts look their best on any printer, supports
OpenType fonts on legacy Macs and SheepShaver systems,  and gives fonts
a high resolution on screen. The control panel, with options for amount of
RAM (more memory equals faster drawing on screen when using multiple
fonts), and the tradeoff only on screen of moving line spacing to display all
of a letter’s descender, or preserving spacing, is shown in figure 18.15.

Figure 18.15: ATM control panel
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Found in SheepShaver-WP’s Control Panels folder as “~ATM™”, so it will
load late in the startup process.

SmoothType

This gem, originally shareware but kindly made available free to WP Mac
users by Greg Landweber of Kaleidoscope fame, does a better job of
smoothing type on screen than does Apple’s Appearance Manager or even
ATM, so turn smoothing off in those control panels and turn it on here. It’s
shown in figure 18.16.

Figure 18.16: SmoothType

Found in SheepShaver-WP’s Control Panels folder as “~SmoothType” so it
will load late in the startup process, specifically after ATM.
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Script Menu

This menu contains another set of elegant tools to enhance the legacy Mac
work environment. Its menu looks like the scroll also used for legacy
AppleScripts. As installed in SheepShaver-WP, it’s provided by the
OtherMenu extension, discussed in the extensions section below.

QuickFind

This application is at the top of the Script Menu for convenience in access-
ing an often-used tool. Its high inherent speed is enhanced by a large
number of filters and designated search areas, as shown in figure 18.17.
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Figure 18.17: QuickFind

If you can better specify what and where you’re looking for something, it’s
that much faster. As well, we may have forgotten what we named some-
thing, but remember we created it with WP and modified it no earlier than
last Tuesday. This makes it simple.

Recent…

This installation of the OtherMenu extension’s facility works better than
Apple Menu Options to list recently opened applications, documents and
folders, as shown in figure 18.18.
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Figure 18.18: Recent menus

The number of recent items to remember, and whether to remember
volumes as well, can be set in OtherMenu’s control panel at the bottom of
the menu.

Workspaces

This AppleScript-based utility works much likes Spaces of OS 10.5 and
later. As shipped, its menu is as shown in figure 18.19.

Figure 18.19: Workspaces
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Arrange your desktop as you like, with any combination of icons and open
windows sized and placed as you like, and command-click a workspace
(duplicate one and rename it, in OtherMenu’s folder in the System folder,
to make a new workspace). That workspace then remembers that desktop.
Choose it from this menu to restore windows and desktop icons as you had
them. Users call it brilliant. Saves a lot of time.

Dictionary and Thesaurus

Select any word or phrase in a WP document and choose one of these
AppleScripts. It activates either the OSX Dictionary or the free Nisus
Thesaurus (available separately) and looks up the word or phrase. Elegant
tools for the serious writer, complementing WordPerfect.

Citations

Scholars and academics have always had the extensive bibliographic and
citation tools of WordPerfect: footnotes, separate endnotes, and table of
authorities (designed primarily for legal use but which work very well for
in-text reference and bibliography). They did not, however,  have a fast,
clean interface to a database for references and quotes. Commercial
products like EndNote, ProCite and Reference Manager were configured
for semi-automatic operation with Microsoft Word but not other word
processing applications.

Citations changes all that. Its distribution includes a run-time FileMaker
Pro database (or you can use your own Filemaker or other database) for an
unlimited number of records, extensive number of fields, and all the most-
used citation formats, e.g. APA, MLA, Chicago and Turabian. The Settings
menu is shown in figure 18.20.
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Figure 18.20: Citations’ Settings

Simply place your cursor within a record you’d like to cite and call Cita-
tions from the Script Menu. Bibliographic data from the record is placed in
a WordPerfect footnote, endnote, table of authority or a combination, as
you’ve set. Accuracy is guaranteed and you save an enormous amount of
time. You can generate a bibliography from in-text citations anywhere you
want in your document.

The accompanying script, Cross-Reference, makes a reference in your
document linked to a previous Citation entry, as a footnote, endnote, or in-
text citation.

DocCompare

Gero Herrmann, a notable WordPerfect supporter with a doctorate in
Physics, used the numerical construct of Longest Common Subsequence
and the PERL language to write a document comparison / revision tracking
utility that greatly exceeds the capabilities of similar features in all other
word processors. It can find differences between two documents with an
accuracy and speed that is simply unequalled. It uses the MacPerl program
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that’s installed with SheepShaver-WP. Gero also wrote a version that will
compare two WP documents in the OSX environment, using the Perl
capabilities built in to that Unix-based OS. Per the release notes:

The algorithm since version 2.0 is that described in A fast algorithm
for computing longest common subsequences, CACM, vol.20, no.5,
pp. 350-353, May 1977, with a few improvements for higher speed.
Because WP DocCompare applies the same algorithm first for
sentences and then for words, large documents that have at least
some sentences in common are processed in a fraction of the time
needed for a full-scale calculation.

Filter

This utility can look through a 500-page document for a word or string
that’s found in four paragraphs, and create a new document that contains
only those four paragraphs, with search text highlighted. A boon for
working with large amounts of text.

Lupe

A magnifying glass for the screen, with resizable window and magnification
scales from 1:2 to 1:8.

MetaMacro

This AppleScript will run any installed WordPerfect macro on any number
of documents at once. Options include running on all files in a folder, or all
WP files, or all text files or files of any type. WordPerfect’s 50 script
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variables are supported, to pass substantial data to the macro, and all
variables are provided extensive document metadata. You can perform
actions such as Find / Change within a thousand files with one click.

Figure 18.21: MetaMacro runs any macro on all files in a folder

Mouse

Shows the mouse cursor’s horizontal and vertical coordinates on screen, in
the top window, and changes in coordinates since the mouse was clicked.
Also shows screen color of the point under the mouse, in RGB and hex, all
as shown in figure 18.22. Helpful for graphics and page design.
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Figure 18.22: Mouse

Open URL

Select a URL in WP document, whether text or a live link, e.g. “http://…”,
or any other text that could be construed as a URL, e.g. “nytimes.com” and
run Open URL, to go to that link in your default OSX browser.

Regex Search

Find/Change power beyond that offered by regular expression search (also
called GREP) in any other Mac word processor. Search for all instances in a
long document of a capital letter between A and H followed by a two-digit
number followed by any one of a list of 10 words followed by a word that
starts with a vowel. Literally find anything, as shown in figure 18.23.
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Figure 18.23: Regular Expression (Regex) Search

UltraClip

This text glossary copies selected text of any size, names it and puts it in a
menu. Thereafter call it from the menu to paste it into your current docu-
ment. Extensive codes support inclusion of date and time in many formats,
current at time of paste. Supports any number of entries.
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UltraSearch

Select any text in a WP document and call this utility for a menu of web
sites in which to search for that text, as shown in figure 18.24.

Figure 18.24: UltraSearch menu

Many web sites provided are specific to legal work; others can be added.

WP QuickHelp

As detailed in Chapter 6, WordPerfect has four separate help systems. This
one is provided in the QuickHelp format and, as installed in SheepShaver-
WP, is found on the Script Menu. Figure 18.25 shows a window.
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Figure 18.25: QuickHelp

Extensions

The SheepShaver-WP package tried to keep non-Apple extensions to a
minimum since, despite offering increased functionality, they may conflict
with the OS or with each other. Here are a few, though, that we couldn’t live
without.
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OtherMenu

We’ve mentioned use of this tool to create the Script Menu installed in
SheepShaver-WP. It comes with many other features. Originally
shareware; now free.

Folder Actions Plus

Before OSX, Apple’s folder actions, as nice an idea as they were, would
operate only when the window of a folder was open. This extension, which
supports printing and other SheepShaver > OSX communication, lets the
window be closed.

Disinfectant INIT

Monitors all disks inserted for legacy Mac malware. There was a lot of it, so
this extension, installed by the Disinfectant application (see Chapter 17), is
strongly recommended for all legacy Mac and OSX Classic installations.

Menu Events

Gives AppleScripts the ability to control a program’s menus. Depending on
that program’s scriptability, if any, Menu Events can dramatically increase
AppleScript’s power to script that program. Similar to Prefab Player,
below. Try both to see which you prefer.
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Prefab Player

Gives AppleScripts the ability to control a program’s menus. Depending on
that program’s scriptability, if any, Menu Events can dramatically increase
AppleScript’s power to script that program. Similar to Menu Events, above.
Try both to see which you prefer.

Scripting Additions

AppleScript was born as an implementation of Apple’s OSA – Open Script-
ing Architecture – and, as such, was just that, an architecture or shell, to be
filled primarily by applications. Well and good, but development in that
direction left a lot out, and third parties saw the chance to offer the com-
munity a lot of functionality by writing open scripting architecture exten-
sions, or osaxen. As with so much in the Mac community, the best were
free. Here’s what’s installed with SheepShaver-WP, and available separate-
ly at WPMac, either in Files > AppleScript Resources, or Links >
AppleScript Resources.

These osaxen have made possible many of the add-ons that make Word-
Perfect even better than the best Mac word processor it already was.
Citations and MetaMacro are only two of the utilities that would have been
impossible without one osax or another here, and for that we are most
sincerely grateful.

GTQ Library

One of the pioneers, this library of dozens of separate osaxen provided
commands and objects, some of which were only later added to vanilla
Applescript. One we use, for Set Screen Colors on the Apple Menu, is Set
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Depth to. Written by an individual everyone at the Berkeley Macintosh
Users’ Group liked to describe as “mysterious”, Gregory T. Quinn.

Jon’s Additions

Another pioneer, and the first to enable your script to tell if the user’s
pressing the Command Key or others, as well as get machine environment
and a good number of other valuable additions. In separate releases for
legacy systems and for PPC OSX. Jon Pugh was one of the earliest and
strongest supporters of AppleScript.

HipTools

Intended to support internet chat scripts, but with a good command set for
general use, and available for legacy systems and for PPC OSX. All of the
documentation and web info lists the author only as “damnhippie”.

Find Document

Blindingly fast file search by name, creator, type or date is used in the
QuickFind utility. By a professor in France, J.F. Pautex.

Regular Expressions

The engine that supports WordPerfect RegEx Search, a full Unix-level
command set, by the Canadian Mark Aldritt.
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Dialog Director

Extensive, exquisitely-detailed creator of complex dialogs for AppleScript,
by the British Christopher E. Hyde.

Akua Sweets

This is a stunning collection of over a hundred commands and objects that
allow control of almost any aspect of legacy Mac operation. We don’t know
where Gregory Lemperle-Kerr came from (or where he’s gone to), but his
website had the country identifier for Switzerland.

OSX Plugins

Here are two software enhancements for the OSX environment that
significantly add to WP’s usability. They were written by Gero Herrmann,
who also wrote DocCompare, discussed above.

Spotlight

Mac OS versions 10.4 and later have a wonderful search feature called
Spotlight. It can search for file names throughout the system, and can
search for text within files and for many characteristics of a file, but only if
an Importer file in installed that’s specific to the program that created the
file. According to Gero’s release notes:
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“Besides text content in main body, text boxes, comments, footnotes, and
endnotes, the following additional items are indexed by the Spotlight plug-
in:

• the version of the WordPerfect document format (WP Mac through
4.0),

• the security method (either “None” or “Password Encrypted”),
• the fonts used in the text (search for “Courier”),
• the languages used in the text (search “en” for English, “de” for German),
• the page height and width in points (search for width > 600 to find US

Letter but not A4), and
• the number of pages (estimated at 1800 characters per page)”.

With this Importer installed, you can search for a WP file and, if it’s in the
transfer folder, e.g. the user’s documents folder, and open it in
SheepShaver simply by choosing it from Spotlight’s list of finds.

Quick Look

Mac OS versions 10.5 and later have Quick Look, a feature where if you
click on a document icon in the Finder and press a keystroke, you are given
a view of that document. WP’s QuickLook Generator, per author Gero
Herrmann’s release notes, makes “thumbnails and previews (from Mac
OSX 10.5 Leopard) including graphics and tables for document and graph-
ics files created by WordPerfect on any platform, starting from version 1”.
Among other advantages, this lets you read any WP Mac document in OSX
10.5 and later, without even starting up SheepShaver.
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Symbolic Linker

SheepShaver is designed so that it can access an OSX folder, by default the
user’s Documents folder, and open any WordPerfect documents therein.
Symbolic links, the Unix equivalent of Mac OS alias files, can extend
SheepShaver’s “reach” to the rest of an OSX user’s machine.

Looking further . . .

We recommend joining the WPMac Yahoo group. See page 29 for the link.
Once you’ve joined, feel free to introduce yourself and your interests to
this friendly mailing list. Also, you might like to download John’s WordPer-
fect Tips & Macros from the Files section of WPMac, for about 140 pages
of such stuff to make your word processing efforts even easier.

Summary

This book has given you literally everything you need to use your Mac as
effectively and productively – and as enjoyably – as anyone. There are
specializations: computer-aided design (CAD), for example, or music, that
are personal computer worlds unto themselves. In terms of general profes-
sional-level use, though, you’ve achieved a high degree of competence.
Congratulations again.

The Mac world is growing so fast that it’s work just to keep abreast of what
all the new developments are, let alone know how to use them. The last
person to know all there was to know about the Mac hasn’t been able to
keep up for a while. Don’t feel that you have to.
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There will always be a great deal to learn and enjoy, and your present
advanced ability on the Macintosh means that learning more about these
tools will be as much fun as their use.

Thank you for letting us teach you this wonderful environment. As a final
note, may we recommend that you practice what you’ve learned until it’s
automatic, ensuring that the Macintosh will become an extension of, not an
object of, your thought.
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affect a menu in the Find and Change dialog directing
the Change command to govern text only, or
case, font, size or style

alias 1) an icon in the Finder pointing to a file; 2)
AppleScript's term used to indicate a specific file,
folder or disk

align character A user-defined character that governs tab align-
ment

align on character an equation editor command that positions two or
more equations relative to each other according to
a user-specified character

alignment in formatting, positioning lines so that their left
edges line up (left-aligned), or center, or right
edges, or justified, where both line up

allow setting fonts of
a different script

preference allowing user to switch scripts, e. g.
Kanji and Roman

allow underlining in tables of authorities, a command preserving in
a table the underlining in original citations

alphabet components of a script, Roman or non-Roman

alphanumeric sort order that treats numbers as letters

anchor to character preference treating a graphic as though it were
one character in a text string

anchor to page preference keeping a graphic at the same point
on a page as originally placed

anchor to para-
graph

preference positioning a graphic at a certain point
in a paragraph
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apple event a command sent by one program to another

Apple Menu the menu at the far left of the menu bar, contain-
ing one of WordPerfect's help commands, and
also desk accessories

Apple Menu item another term for desk accessory

AppleMail a protocol for electronic mail, part of AOCE,
available within WordPerfect

AppleScript a system-level macro and scripting language that
can control WordPerfect, and with which WordPer-
fect can control other programs

apply to selection in formatting, an option that will cause selection of
font, margin, etc., to apply to text already selected

arc types in the Graphic Editor, the choice between wedge
and chord as arc shapes

Arrange menu of commands in the Graphic Editor to work
with existing objects

arrow tool in the Graphic Editor, the tool represented by an
arrow icon, used to select and manipulate objects

ascender part of a letter's shape rising above the height of
the letter x: h, t and b have ascenders; n, o and p
do not

ASCII standard for text interchange format. Also called
Text Export or Plain Text. Stands for American
Standard Code for Information Interchange

assign in macros, causing a variable to have certain
contents. A variable can, for example, be as-
signed the value 3 or the contents of the clipboard
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assign keystrokes
command

WordPerfect's facility to allow any program
command to be assigned to and executed by any
keystroke

attributes parts of text formatting including font, size and
style, all available from the Font Bar

auto date/time WordPerfect's command to enter the date and/or
time as a code that will update whenever the
document containing it is opened or printed

auto-aided a hyphenation option that presents the user with a
dialog showing the hyphenation points of a word
at the end of a line, for the user to choose one or
to make the whole word wrap to the next line

automatic backup WordPerfect's feature that will keep either a timed
backup, an original file backup, or both, as the
user works. Promotes safety of data

average In tables, the arithmetic command allowing
calculation of the mean of selected cells

back tab the command moving the cursor one tab stop to
the left of the margin. Called Margin Release in
earlier versions of WordPerfect

background square in the Graphic Editor, the square icon that shows
the background color and pattern

badge in a QuickTime movie as it appears in a WordPer-
fect file, the small icon showing that it is a movie
and not another kind of graphic

Balloon Help one of WordPerfect's three kinds of on-line help,
in which small text explanations appear on screen
pointing to menu commands or other tools.
Requires system 7
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bar one of WordPerfect's screen areas with icons
representing commands. The Button Bar, any of
eight Control Bars, and the Status Bar are included

baseline the invisible line on which letters rest. Descenders,
such as the lowercase letters p and q have,
extend below the baseline

battery an optional indicator on the Status Bar showing
amount of battery charge in a Laptop

bitmap a way of drawing a font such that letters are
composed of pixels (screen elements)

block in page design, any component of a page – text or
graphics – seen as a single element, to be placed
relative to others for balance and composition

bookmark A specific place in a document that can be
marked, adding the bookmark name to a menu to
return to that place quickly

Bookmark (help) in on-line Help, the user can add references of her
choosing to a menu, to return to them quickly

boolean in WordPerfect macros and AppleScript, logical
components of a command that compare one
value to another with operators such as equals, to
return a value of true or false

border the optional design marking a frame for a graphic,
text, equation or other box in a document

box the part of a document containing a graphic or
special text, equation, movie or user-defined
element. A box can optionally have a visible frame
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box code the visible code in the Codes window showing the
original insertion point of a graphic or other box.
The code's location governs which page the box
appears on

bullet with indent formatting command on the Button Bar, which
puts a small black circle to the left of each select-
ed paragraph, and moves the start of that para-
graph to the right by one tab stop

Button Bar the main bar of icon commands in WordPerfect. It
can be relocated on screen and extensively
customized. The user can create additional Button
Bars as well

calculator icon on the Math Bar of the Table Bar. Clicking
causes recalculation of the current table

cancel to leave a dialog box by clicking Cancel or press-
ing the Escape key, without making changes

caps lock Key which stays pressed and allows user to type
in all caps. The Status Bar can indicate if this key
is on

caption The words accompanying a graphic or other box
in a WordPerfect document. Captions can be
listed and cross-referenced automatically

Carpal-Tunnel
Syndrome

a dangerous and debilitating physical condition
caused or aggravated by typing or working in
certain positions. The Dvorak keymap, wrist pads,
and proper monitor, desk, chair and keyboard
position are important aids to avoid this

cascade windows command to align all open windows offset so the
title bar of each is visible
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case sensitive option in Find and Change commands to look for
words with certain letters capitalized

Catalog Browser component of Apple's PowerTalk e-mail protocol

CD-ROM compact disk-read only memory: term for an
optical disk data storage system

cell number in a table, number assigned to intersection of a
given row and column

cells points of data entry and manipulation in a table

center alignment positioning lines of text so that their centers line
up; most often found in titles

centimeters unit of decimal measure available throughout
WordPerfect; 2.54 equal one inch

change all command in Find and Change to replace every
occurrence of specified text with other text

change direction in QuickTime movies, a command to change the
direction of play

change then find in Find and Change, a command to change the
next occurrence of specified text, and then find
the following occurrence

change to part of the Find and Change dialog where user
enters text to replace existing text

character any letter, single punctuation mark or number

check selection in the Speller, an option to check only selected
text

Check Syntax in AppleScript, a command to parse lines of script
commands for accurate terms and formatting

chooser an Apple Menu Item in which print or fax drivers
are selected
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chord a type of arc graphic

cicéro a European unit of measure available in WordPer-
fect as either single option or as default, with 5.63
to the inch

class In AppleScript, a type of object on which script
commands can work. Characters, paragraphs and
pages are classes

clipboard a part of Macintosh memory that holds text or
other data that is selected and then cut or copied.
The paste command inserts the contents of the
clipboard

close box the small white box at the top left of most Macin-
tosh windows. Clicking in it closes the window

code symbols in WordPerfect's Codes window, optional-
ly visible at the bottom of the screen, showing
precise formatting, location of graphic and other
boxes, and other components of a document

column formatting that places text side-by-side with other
text, in newspaper form where text at the bottom
of one column continues into the next, parallel,
where each paragraph is to one side of its rele-
vant neighbor, or extended – parallel across a
page break

column break point at which text moves from one column into
the adjacent one

command menu choice, Bar icon click or keystroke by the
user that results in an action by WordPerfect

command equiva-
lents

keystrokes that perform the same action as menu
commands
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command-period pressing the Command key and the period, which
will stop many commands in progress in WordPer-
fect

comment lines in WordPerfect or AppleScript macro scripts, lines
ignored by the Macintosh, meant for the user to
explain or comment on script commands

common library a set of macros, style sheets, key maps and other
WordPerfect resources available to all users on a
network, easily established and updated using
WordPerfect

composition in page design, placement of text and graphics on
a page or spread for aesthetic balance and impact

compress where the Macintosh writes data to take up less
room on disk than usual, and which is slower to
read from and write to than usual. WordPerfect
has a compressed option in its Save As command

concordance any words in a file, which WordPerfect will then
use as a list to index another file

contents, table of one of several lists WordPerfect can compile and
update of a document

continuous under-
line

underlining style that includes spaces or tabs

control bar the bar above the document window, with check
boxes or small buttons to access other Bars of
icon commands

control panel Macintosh program that starts automatically when
the computer is turned on, and has a panel of
controls accessible from the Apple Menu
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corrupted file file with damaged data. Can be caused by user
error but more often by a glitch in the Macintosh
system. WordPerfect attempts to repair these
automatically, notifying the user

create reference in making lists or cross-references, the command
that locates a point in the text that another point
will point to

create publisher the command to publish selected text or graphics,
so that other documents or programs can sub-
scribe to them in editions that will update automat-
ically when the published data is updated

cropping in graphics handling, moving a drawing within its
frame or changing the size or shape of the frame
so that some of the graphic is removed from view

cross index allowing two references in one index to point to
each other

cross referencing feature where See page 12, figure 2 will refer to a
given figure accurately, updating as data is added
or moved

crosshair one of the cursor shapes in the Graphic Editor

curve tool WordPerfect's graphic tool for drawing Bézier
curves, a highly precise and editable drawing
mode

data file in merge, the file containing pieces of information
to be inserted in a form file

date/time stamping WordPerfect's ability to put an automatically
updating date, time or both in a document

decimal align in a table, the feature that will align numbers in
contiguous cells in a column by their decimal point
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decimal tab a tab type that causes numbers to align at the
decimal point

Default Bar the standard Button Bar before user customization

define names in merge, giving names to fields of a data file. The
form file then references each field by name
rather than number

delimiters brackets in equations

descender part of a letter extending below the baseline

desktop the Macintosh environment on screen: windows,
menus and icons

diacritical mark indicating the pronunciation of a letter, such
as à, á and ç. Accessed using the Option key

dialog a box or window giving the user specific system
information and, optionally, asking the user for
data. When you first save a file, you work with the
Save dialog box

dictionary 1) a WordPerfect file used by the Speller and
Grammatik modules to check spelling; 2) a list in
WordPerfect accessed by AppleScript's Script
Editor, of commands WordPerfect makes avail-
able to AppleScript

didots a European unit of measure available in WordPer-
fect as either single option or as default, with 67.5
didots to an inch; 12 didots per cicéro

DigiSign a feature of Apple's PowerTalk allowing an
authentic signature to accompany an electronic
mail message

dingbat a symbol contained in a special font, used for
decoration on a page or to demarcate text
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disk a form of data storage media. Floppy disks are
3.5 wide, removable from the Macintosh; hard
disks are larger and internal either to the Mac or a
separate case; optical disks or compact disks are
removable

display figures preference to show graphics in a text document.
Not displaying figures speeds up text scroll.
Figures will print whether or not displayed

display overlay preference to display graphic figures in the
overlay level of a text document. The rest of the
document may be clearer on screen if an overlay
is not displayed. Does not affect printing

document number in the Status Bar, number indicating which of the
open files is active, or in front on screen

dormant return command to negate a hard return that would
otherwise cause a blank line to appear at the top
of a page

dot leaders series of dots or periods going from one word to
another along a line, created by this type of Tab

double underline Style attribute placing two lines under text

dpi dots per inch, a measure of resolution for the Mac
screen or a printer

drag and drop  in text editing, selecting some text and then
dragging it elsewhere in a document. An insertion
point follows your drag and, when you release the
mouse button, the text is moved (or, with the
option key, copied) to the new location

drop shadow a border style in WordPerfect giving the appear-
ance of a shadow behind the frame containing the
graphic, paragraph or other bordered element
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droplet in AppleScript, a script onto which other icons can
be dragged, to perform the script's actions on the
dragged file

duplicate in the Graphic Editor, command to make an offset
duplicate of selected objects

Dvorak designer of a keymap placing letters better on the
keyboard. The Macintosh can be easily reconfig-
ured to this, resulting in smoother and easier
typing

e-mail see electronic mail

edit codes codes representing document content and format-
ting, which appear in a separate window accessed
by the Show Codes command

edit full form (next) command in table of authorities generation
showing text of a citation's complete form, for the
next citation referenced in the file

edit full form (previ-
ous)

command in table of authorities generation
showing text of a citation's complete form, for the
previous citation referenced in the file

edition data, either text or graphics, that has been
published (in system 7 only), and available for
another document to subscribe to

electronic mail extensive range of software and protocols to send
and receive text or documents over networks or
telephone lines

element in page design, any item (graphic, headline or
column of body text) that is placed on a page

em width a printing measure equal to the width of the letter
m in a given font and size
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encapsulated
postscript

a file format in which a PostScript text description
of a page or graphic is accompanied by a pictorial
representation. WordPerfect can import these
graphics, which can produce especially high
quality

end of field in merge, a code indicating the end of the current
field of text

end of record in merge, a code indicating the end of the current
record of text

endnote a note linked to a point in the body of a document
and referenced by a number, letter or character.
Endnotes print in sequence at the end of the
document

EPS see encapsulated postscript. Also written EPSF

escape key used in WordPerfect to cancel a dialog or stop
a macro

export to save a file in a format readable by other pro-
grams. Plain Text or RTF are two common export
formats

extensions programs that stay running in memory and extend
the Mac's system functionality. Chapter 18 dis-
cusses several

extra menu com-
mand keys

preference to show a secondary set of command
keys on WordPerfect's main menus. All assigned
keys work, whether or not displayed

fence see delimiter

field in merge, a place in a form file to be filled with
information from a data file; in a data file, informa-
tion of a certain type and referenced either by a
name or number
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figure a graphic as it appears in a text document, which
can be listed and cross-referenced

fill gray or a color, in a degree usually expressed as
a percentage, as a background for text or graph-
ics. Zero percent is no fill; 100% is solid black

filter acceptance
criteria

data WordPerfect uses to extract items from a file
to meet this criteria. May be text or Boolean

find code command to search a file for the next or previous
occurrence of a formatting code and, optionally, to
remove it or all occurrences

fine font formatting command to set font size at a percent-
age of normal. Default is 50%

flip rotate a graphic 180 degrees either horizontally or
vertically

font mapping option to track fonts in a file relative to scripts, i. e.
Roman and other alphabets

font typeface or type style

footer part of a document created in a separate window,
which appears at the bottom of every page or
every even or odd page

footnotes a note linked to a point in the body of a document
and referenced by a number, letter or character.
Endnotes print in sequence below text on each
page, or at the bottom of each page

force page command to make a given page appear as either
odd- or even-numbered

foreground square in the Graphic Editor, the square icon that shows
the foreground color and pattern
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form file in merge, a file such as a letter with areas to be
filled in with address and other specific information
contained in a data file, to produce several
finished letters

format noun: the detailed appearance of a text docu-
ment, including fonts, line spacing, text alignment
and indenting. verb: to modify one or more of
these aspects

fractional character
widths

option in page setup to place letters of text next to
each other with greater accuracy than can be
displayed on the Macintosh screen. Recommend-
ed for laser printing but not for text entry and
editing, since it can be hard to read on screen

fragmentation condition on a computer disk where parts of files
are located in non-contiguous areas of the disk,
impeding performance

frame the structure enclosing a graphic or other box as
contained in a text document. A frame is optionally
visible

from keyboard in merge, a code that stops the progress of the
merge allowing the user to type data

get attributes in the Graphic Editor, a command to copy the
attributes of the selected object. Those attributes
then apply to objects subsequently drawn

get info a Finder command to display a window for select-
ed icons, showing size, type and date created and
modified, and allowing user to lock the file, make it
a stationery pad, or include comments

glyphs shapes of individual letters in a font
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gold user-definable WordPerfect key, default is 5 and 7
on keypad, that acts as an additional command
key

Grammatik WordPerfect grammar module

graphic any drawing in a WordPerfect file, either imported
or created with the Graphic Editor

graphic box code code showing original location of a graphic box in
a text document. Placement of the graphic can be
moved but some features, including caption
number and which page, depend on code location

graphic editor the WordPerfect module that creates or modifies
graphic images

graphic font menu preference to show the name of each font on the
menu in the actual font

Greek symbols symbols used by the Equation Editor and ac-
cessed by icons on its tool palette

grid cross-hatch of vertical and horizontal lines in the
Graphic Editor, visible or hidden, to which objects
may be aligned and to which, optionally, objects
will snap for precise alignment

grid options menu choices for grid display and snap

group command in the Graphic Editor to combine more
than one object, and to treat them as one

guides dotted vertical lines that extend from the text ruler
to the bottom of the screen, to help with alignment
of margins and tabs

hand appearance of the cursor when in print preview
mode, allowing a page to be dragged across the
screen
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handles black squares on the bottom and right sides, and
bottom right corner, of graphic or other boxes,
used to resize or crop boxes or their contents

header part of a document created in a separate window,
which appears at the top of every page or every
even or odd page

help any of WordPerfect's three features: the Help
window, balloon help and Status Bar help, to
describe commands and operations

hide grid command not to display the grid in the Graphic
Editor. Grid is still active

hide help command not to display Status Bar help messag-
es

history in the thesaurus, a list of all words previously
looked up in the current session

horizontal scroll bar scroll bar at the bottom of the active window

HTML Hyper Text Markup Language, used for web
pages

hyperlink Text in a document or web page that, when
clicked, goes to another web page or document or
runs a macro

hyphenation type controls WordPerfect's hyphenation: automatic
type hyphenates words crossing the user-set
hyphenation zone; auto-aided asks user for
hyphenation point, then hyphenates

hyphenation zone user-definable area near right margin. Words
beginning within zone and extending past its right
edge are wrapped; words beginning before zone
are hyphenated
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i-beam cursor in a text entry area

icon any small picture indicating a command or func-
tion, in a bar, or a file in the Finder

if…then…else syntax of conditional statements in WordPerfect
macros or AppleScript scripts

indent to move the beginning of a line to the right of the
left margin. The first word of a paragraph can be
indented, or the whole paragraph, as is common
in a long quotation

index list generated automatically of all words in a file so
marked, or of all occurrences of a word in one file
that are listed in another file called a concordance

initial caps attribute format command to start each word of
selected text with a capital letter

insert to place a file within another file, or a graphic or
other data in a file

interface means of communication between computer and
user. WordPerfect and the Macintosh have a
graphic, mouse-controlled interface

invert to change foreground and background colors.
Inverted text appears white against black

italics letter shapes curved and slanted relative to
normal, included with most fonts to indicate
emphasis

jump in a macro script, a command to pass over
several lines

justify to make all lines of text even at both left and right
margins
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justify all to justify all lines of text including the last (or only)
one, no matter how much text is in it. This can
spread letters widely across a page for a special
effect

keep together command to keep the selected text on one page,
moving the whole block to the next page if neces-
sary. Also called Block Protect

kern to adjust the space between two letters, most
useful in larger point sizes

keyboard equivalent keystroke that will activate a certain command.
These equivalents are user-definable and appear
on menus next to the command name

keypad numeric keys to the right of the alpha keyboard. In
WordPerfect, these can enter numbers if Number
Lock is on; otherwise they are used to navigate
within a document

kicker in page design, a few words above and to the left
of a headline or title that introduce it

label in macro scripts, line to which a conditional
statement can jump to

language code in WordPerfect identifying the language for
following text. Switches active dictionary and
thesaurus files

layers in Graphic Editor, placement of objects on top of
others. Layers can be shuffled to facilitate working
with objects

layout general term for commands relating to margins,
tabs, borders, headers and footers, footnotes,
numbering and hyphenation
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left-right indent format in which text is moved inwards from both
the left and right margins

level in outlines, the indent of a line and corresponding
label (I, II, A, B, etc.)

Librarian command moving and activating macros, key-
boards, styles and Button Bars

Library (USA) resource file containing macros, styles, keyboards
and Button Bars so they're available for use in
every document

line spacing formatting governing spacing between lines of text
according to line count (e. g. single or double),
leading (measurement between lines), or number
of lines per inch

list in WordPerfect, a dynamically updating set of
references to text, any box, note or user-defined
elements in a document

list bar control bar that marks text for index or table of
contents, generates these lists, and related
commands

lock table command to prevent inadvertent modification to
contents of a table

look up command to check dictionary or thesaurus for
word entered in the specific dialog, rather than in
the file being checked

macro set of commands that can be recorded as the
user works or that the user can type, that will then
run in automatic sequence. One of WordPerfect's
most powerful tools for productivity and accuracy

magnifying glass cursor shape in Print Preview when magnification
is less than 100%
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mailer dialog box controlling PowerTalk electronic mail
feature

main entry in an index, the entry beginning at the left margin,
from which subentries are indented

margins lines on all four sides of a page limiting text
placement

mark to designate a word for an index, table of contents
or other list

mark target to designate an element to which a reference will
be made elsewhere in the document

markers in merge, using small symbols rather than field
names or numbers in a form file to show location
of field codes

mark full form command to enter the entire citation of an entry in
a table of authorities

marquee in the Graphic Editor, a rectangle of a dotted line
drawn by dragging with the arrow tool. Inclusion of
any object within the marquee will select the
object

match character
representation

command in the Find dialog to specify alphabets
in text

match multiple
characters

wildcard option in the Find dialog, allowing user to
search for text where some letters or words are
unknown

match one charac-
ter

wildcard option in the Find dialog, allowing user to
search for text where one letter is unknown

match whole word option in the Find dialog to limit finds to the search
text seen as a complete word; searching for end
will not find send
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math bar part of the table Control Bar controlling formula
entry and number formatting

menu list of commands to be selected with the mouse
cursor, that can appear at the top of the screen, a
control bar, or in a dialog box

merge process of combining a form file, such as a letter
with blank spaces for specific information, with a
data file, containing those specific pieces

merge bar control bar with merge commands

move in the Graphic Editor, commands to shuffle
selected objects forward or backward in layers

movie an animated graphic specific to the Macintosh,
which can be inserted and controlled in WordPer-
fect documents

newspaper describes columns where text flows from the
bottom of one column to the top of the next

next window command to bring the back window of multiple
open windows to the front of the display, moving
all others back one layer

no columns command to turn multiple columns off, starting at
the insertion point

normal style user-editable style sheet that WordPerfect uses
for all new documents

note characters asterisk or other symbol, user-defined, available
to mark footnotes or endnotes

num lock control of numeric keypad: when on, keypad
enters numbers; otherwise, used for navigation in
a document. Shift-clear toggles Num Lock on and
off



Glossary 633

open latest command to keep track of and make available to
open, the last user-set number of files to have
been opened

optimize disk utility command to move file fragments on
disk to make them contiguous, improving perfor-
mance

orientation in page setup, placing data on a page in portrait
(tall) or landscape (wide) view

original file backup option in WordPerfect to maintain the next-to-
most-recent version of a file, useful for safety of
data

orphan a line that appears by itself at the top of a page.
Can be allowed or disallowed (at least two lines
will appear together) at user option

outline a structured document or part of one, with labels
(I, II, A, B, etc.) that WordPerfect updates auto-
matically as user adds or deletes data

outline text text style where letters are outlines, not filled in

overlay graphic mode where drawing appears over other
elements in a file.

page break division between text, either a soft break, inserted
automatically by WordPerfect, or hard break,
inserted by the user. Soft breaks move as text is
added or deleted; hard breaks do not

page numbers numbering that can be set to start at any number,
Arabic or Roman, and set at various points on a
page

page setup dialog setting paper and print size and orientation,
fractional widths, font substitution, image inversion
and similar printing options
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palette sets of icons for commands, used in the Graphic
and Equation modules

paragraph in word processing, any amount of text separated
from other text by hard returns

password set in the Save or Save As dialog boxes

paste command to enter the contents of the clipboard at
the insertion point

patterns in the Graphic Editor, available as foreground or
background texture for objects or lines

pause in macros, a command to pause the macro for
user input

pen Graphic Editor option to make outlines of lines and
shapes visible

physical page page of the present document; distinguished from
logical page, which reflects page numbering as
set by the user

pica unit of printing measure; six to one inch

PICT graphics file format. WordPerfect can save
graphics as independent files in this format, and
can import files in this format

pixel the smallest part of a computer screen that can be
lit or dark

place number at
current position

command to enter present page number at the
insertion point

plain text said of text that is not italic, bold or with other
special attribute

point unit of printing measure; 72 points are one inch
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polygon tool in the Graphic Editor, draws multi-sided shapes
or, with command key, draws freehand

pop up type of menu appearing as a shadowed box in a
dialog; when clicked, the rest of the menu appears

poster still graphic image showing a QuickTime movie

PostScript page description language used to describe high
resolution fonts and graphics

PowerTalk Apple's electronic mail protocol, allowing user to
send and receive entire WordPerfect documents,
not only text

preferences settings governing a wide range of program
operation, making WordPerfect highly
customizable

preview 1) command to show an entire page or two facing
pages at once on screen, allowing magnification
of any part; 2) smaller representation of the first
page of a document as shown in the Open dialog

primary key the word, field or zone used first in a sort. Any
identical items in the sort can then be sorted by a
secondary key

print preview command to show an entire page on screen just
as it will print

protect table command to prevent modifications to contents of
a table

pts abbreviation for point, a unit of measure

publish in Macintosh system 7, to make selected text or
graphics into an edition that other documents can
subscribe to. When the published material is
updated, subscribers update automatically
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publisher options command governing data to be published in
publish and subscribe

QuickCorrect Feature that recognizes common misspellings,
e.g. “the” and corrects them to e.g. “the”.

quickdraw Macintosh language for screen display

quickTime Macintosh technology for movies/videos and their
incorporation into WordPerfect documents

qwerty the standard typing keyboard, so named for the
first six letters on the top row. Clumsy and danger-
ous cause of repetitive injury syndromes, com-
pared to the Dvorak keymap

radio button control in a dialog box, appearing as a small circle
that, if active, has a darkened center

RAM random access memory, the part of the Macintosh
holding parts of currently active programs and
open documents. Contents of RAM are lost when
the Macintosh is turned off

RAM disk a pseudo-disk that is actually part of RAM but
functions as a disk would. Faster than a real disk,
but data is generally not as secure

random access
memory

see RAM

read-only variable in WordPerfect macros or AppleScript, a piece of
data identified by a name or number, where data
is assigned by the program, not the user

record (noun) in merge, one part of a data file containing one
instance each of all the types of data (fields) in
that file
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record (verb) to have WordPerfect watch as you perform
actions, and so make a macro that will perform
that same sequence again, automatically

rectangle tool in the Graphic Editor, tool that draws rectangles or
squares

redline formatting that puts a vertical line (red on color
monitors) just to the left of the margin. Used to
indicate editing changes in text

relative sizes settings changing the type size of very large to
fine, multiples or fractions of the current font point
size

remember window
locations

preference to open files with the same window
size and locations as they had when they were
closed

remove overlay command to remove an overlay graphic

remove watermark command to remove a watermark graphic from
the current page, or from the entire document

replicate in the Graphic Editor, to make a specified number
of copies, each offset by a given amount from the
original

restart on each
page

option for footnote numbering; otherwise, foot-
notes continue sequential numbering throughout
the document

resume after pausing a macro, this command resumes its
playback

right-aligned text formatting where the right end of all lines are
even

row in a table, a set of cells horizontally aligned with
each other
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RTF rich text format, an export format that preserves
information such as font and attribute (italic, bold,
etc.)

ruler icon structure optionally visible at the top of a
document window, showing margins and tabs
along a measured line

sans serif text letters without small caps at the end of major
strokes

save to put a copy of the active document on disk.
Should be done often for safety of data

save as to save a file to disk under a new name. Useful for
making successive versions of a document

scrapbook an Apple Menu Item used to store graphics or text
for frequent or ready use

screen saver a program that will darken the Mac screen after a
specified time of user inactivity, to prevent burn-in
of screen phosphor

script in WordPerfect macros or AppleScript, the lines of
commands of program instructions

Script Editor AppleScript utility used to write or edit scripts

scroll to move the screen display up or down, right or
left, to see other pages or parts of pages

SCSI small computer systems interface, a hardware
protocol used to connect hard disks and other
peripherals to the Macintosh

search mixed
alphabets

option of the Find command to look for text in
more than one alphabet, should more than one
exist in one document
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secondary key in a sort, the key used after the primary key has
sorted.

select all command that selects all data in a document

select in in the Equation Editor, moves the insertion point
into areas set off by brackets

select out in the Equation Editor, moves the insertion point
out of areas set off by brackets

selected cells in a table, those cells (intersections of columns
and rows) currently selected

serif text letters with small caps at the ends of major
strokes, or parts of the letter

settings program preferences or defaults

shadow text style with outlined letters and a shadow
behind each one

shareware software freely distributed with the provision that
the user pay for it if she decides to keep and use
it. Please support it

shift clicking to select multiple items by clicking on the first,
then holding the shift key and clicking on a second

shift-tab pressing shift and tab keys, to move to the left of
the margin by one tab. Also called back tab

shift-clear key sequence to turn number lock (Num Lock) on
and off

short form in tables of authorities, the shorter form of a
citation

show balloons command to display system 7's help balloons
whenever the cursor is over a menu, icon or other
item requiring an explanation



640 Teach Yourself WordPerfect Mac

show bars command to display the Button, Status or any of
the eight control bars

show codes command to display a separate window with
WordPerfect's editing codes

show grid in the Graphic Editor, command to display the grid

show help command on the Status Bar to display help
messages

show merge mark-
ers

command to display symbols in a form file at
locations of field codes

show ruler command to display the text ruler at the top of the
active window

show unknown
alphabets

command to display message that alphabet for
the current text has not been identified

show white space command to show pages on screen with space
where headers, footers and footnotes will appear
in Print Preview or on printed page

shut down to turn off the Macintosh properly, using the
Finder's Shut Down command

skip always spelling command to skip a flagged misspelling for
the entire document

skip once command to skip a flagged misspelling this time
only

small caps capital letters in a smaller point size than the
surrounding text: used for acronyms etc. in all
caps without overwhelming the surrounding text

smart quotes quotation marks that curl towards the quoted text.
Also called typographical quotes, curly quotes,
printer's quotes. Basic to quality text formatting,
set as a preference in WordPerfect



Glossary 641

snap to in the Graphic Editor, command to make drawn
elements move to the nearest grid line. Used for
accuracy in alignment

snap to grid in ruler On the text ruler, makes tabs and margins align at
the nearest ruler marking. Used for accuracy in
formatting

sort key primary, secondary or other (up to nine levels) key
governing sorts. In the phone book, names are
sorted by last name as the primary key, and first
name as the secondary key

speller WordPerfect module that checks spelling of all
words against the program's main dictionary and
against a user dictionary of words added to it by
the user

speller-thesaurus
utility

see ST Utility

spread in page design, a set of two facing pages

ST utility Speller-Thesaurus Utility, a small program that
comes with WordPerfect to modify the main
dictionary or to quickly check synonyms

stand-alone in AppleScript, a script saved as a small applica-
tion, so the user doesn't need the Script Editor to
run it

status bar bar along the bottom of the screen, displaying
user-defined status information about the current
document and the Macintosh, and help messages
according to cursor position

strikeout text formatting with a single line drawn through all
letters. Used to indicate text to be removed from a
document
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string any sequence of letters, numbers, punctuation
and spaces

style 1) attribute formatting: italics, bold, etc. 2) a style
sheet

style sheet a set of formatting decisions grouped under one
name. A subhead style or style sheet is the font,
size, alignment and all other options used for
subheads in a given document

styles bar Control Bar with icon commands and menus for
style sheets

subentry in an index, an entry indented to a main entry

subscribe to insert a text or graphic that has been published
by another document. When that publisher is
updated, the data in the subscriber updates
automatically

subscriber options dialog box governing subscribing to a published
edition

subscript text with a baseline below the normal baseline for
that point in the file. Often used in equations and
scientific symbols

subtitle in WordPerfect, a line of smaller text underneath a
main line, and linked to it. Often used for line-by-
line translations

superscript text with a baseline above the normal baseline for
that point in the document. Used for footnote and
endnote numbers, and in equations and scientific
symbols

switch font with
keyboard

command linking fonts and scripts used for
different alphabets and languages



Glossary 643

switch keyboard
with font

command linking fonts and scripts used for
different alphabets and languages

tab type any of several alignments or leader options for tab
indenting

tab-delimited a text file taken from a WordPerfect table or from
a database program, in which data from different
fields in one record is separated by tabs

table structured format in WordPerfect with columns
and rows, intersecting in cells. Formulas can be
constructed and math performed on numbers in
tables

table bar Control Bar with command icons and menus
specific to table construction and editing

table border lines around a table, and between columns, rows
and cells. They can all be different in WordPerfect,
and some or all can be invisible

table of authorities a list of citations linked to a document, where
references to bibliographical authorities is given in
long and short forms with page numbers that
update as text is edited. Up to 16 tables are
available in any document

table of contents a list of headings in a document, where the list is
linked to the headings so as to update as text is
edited. Can have up to five levels

table to text command to change data in a table to structured
text, such as tab- or paragraph delimited

target in cross referencing, the item in the document to
which reference will be made

target id user-defined name for the target of a reference
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target type any of five kinds of targets for lists. A figure is one
target type; table and equation are others

template a file used as a model for new files.

template folder WordPerfect's folder for template files, which then
appear on their own menu on the File menu

text box a component of a document containing text
separate from the normal body of text. This box
can be framed, captioned, listed and dragged
around on the page. Its formatting is separate
from that of the main text

text date/time the date and/or time entered in a document so it
will not update each time the file is opened. Auto
date/time is available too

text to table a command to put structured text, e. g. tab- or
paragraph delimited, into table form

text tool in the Graphic Editor, the tool to create a text box
and place an insertion point within it, and select
existing text

thesaurus WordPerfect's facility to look up synonyms and
antonyms

TIFF tagged image file format (also written TIF), a high-
resolution bitmap often produced by a scanner

tile windows command to size and place all open windows next
to each other on screen so they do not overlap

timed backup WordPerfect's capability of keeping a separate
copy of all open documents, updating at a user-
defined interval, that will be available to rescue
text should the active document be lost or corrupt-
ed
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truetype font format offering high resolution screen and
print fonts on any printer

typesetting on the Macintosh and WordPerfect, distinguished
from typing by the high quality the platform and
program can provide to printed text

undo command to revert to the condition immediately
before the last action

ungroup in the Graphic Editor, command to take a number
of objects that have been grouped and separates
them

unlock in the Graphic Editor, command to take a selected
object that has been locked, so it could not be
deleted, modified or moved, and unlock it

uppercase all capital letters

use inline allow WordPerfect to use a non-Roman script on
the same line as a Roman script

user defined type of list or box, like a figure or table box, that
can hold what the user wants

user dictionary dictionary of words, usually specialized spellings
or names, the user has added with that command
in the Speller

user message in a merge, a message appearing on screen for
the user, generally comments or instructions by
another user who has set up the merge

variables named or numbered bits of information, provided
by the program or the user in a WordPerfect
macro or AppleScript script, providing data for the
sequence being performed
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watermark WordPerfect graphic that appears behind text or
other graphics on a page. Visible on screen only
in Print Preview mode or in the Graphic Editor

wedge type of arc, contrasted with a chord

white space in page design, space without text or graphics,
used to effect of good balance and aesthetic
composition

wide insertion point preference to set the blinking vertical insertion
point three times as wide as standard. Good
feature especially for a large monitor

widow first line of text of a paragraph appearing by itself
at the bottom of a page. Can be disallowed, so
that at least two lines starting a paragraph appear
together

wildcard in a Find and Change procedure, a character
whose use represents one or more undefined
characters. If an asterisk were a wildcard, search-
ing for p*nt would find pant, pent, pint and punt

window visual device on a Macintosh screen enclosed by
a title bar and scroll bars, in which text or graphics
may be entered or edited

word any amount of contiguous text separated from
other characters by a space, punctuation, tab or
return

word count command to count words, lines, sentences,
paragraphs, and pages in a document, and return
average word and sentence length, and maximum
sentence length

worldscript Apple protocol to support different languages and
scripts on the Macintosh
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wrap to move to the next line; said of a word too long to
fit at the end of one line but not hyphenated

wrap around search search that begins at one point in the file, moves
to the end, then to the beginning of the file and
back to the starting point

wrap text around
box

option to arrange text in a file so it moves around
three sides of a graphic, text or other box

x-height height of lower case letters without ascenders,
such as x

xtnd file transfer protocol to import a number of differ-
ent formats of text into WordPerfect

zone in the sort function, any text separated from other
text by only one hard return





Command Reference

These are all the commands available for assignment to a keystroke or a
button on the Button Bar. Although many appear on menus, not all do. All
program commands are available in, and all keystrokes may be changed,
or others added, in Edit > Preferences > Keyboard.

Name Default key-
stroke

Function

About Shows the version and license
numbers of the active copy of
WordPerfect.

Align Center Command-Shift-
C

Centers each line of text between
the left and right margins.

Align Dialog In the Graphic Editor, lets you
choose vertical and horizontal
alignment options for selected
objects.

Align Justify Command-Shift-J Spaces words within each line so
that both left and right margins are
even.

Align Left Command-Shift-L Spaces words evenly, so that the
left margin is even and the right
margin ragged, according to the
natural length of each line.

Align Right Command-Shift-
R

Positions each line so that the right
margin is even and, owing to the
uneven length of most lines of text,
the left margin is ragged.
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Append to
Clipboard

Command-Shift-
A

Adds selected text to what’s already
on the Clipboard.

Arc Type
Dialog

Chooses chord or wedge, closed or
open graphic shapes.

Auto Sum In tables, sums numbers in selected
rows immediately above, or in
selected columns immediately to the
left.

Auto Sum
Right

In tables, sums numbers in selected
rows immediately above, or in
selected columns immediately to the
left.

Back Tab Shift-Tab Places insertion point one tab stop
to the left of the margin.

Beginning of
Line

Command-
Keypad-4

Moves the insertion point to the left
margin of the page or column.

Command-Shift-
Left

Command-Shift-
Keypad-4

Command-Left

Gold-Gold-Left

Gold-Gold-
Keypad-4

Bold Toggle Command-B Turns the bold font attribute on and
off.

Bookmark Bar
Show/Hide

Shows or hides the Bookmark/Hy-
perlink Bar
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Border Above Puts a border above the paragraph
containing the insertion point.

Border Be-
neath

Puts a border below the paragraph
containing the insertion point.

Build Index
And Lists

Option-F11 Generates all lists that have been
defined in a document.

Bullet With
Indent

Puts a bullet at the start of the
paragraph containing the insertion
point, and indents the paragraph.

Button Bar
Show/Hide

Command-
Option-B

Shows or hides the Button bar, at its
present location.

Calculate
Document

Recalculates all formulas in a
document.

Calculate
Table

Command-
Option-equals
sign

Recalculates all formulas in the
table containing the insertion point.

Cancel Clear Exits the active dialog box, making
no changes.Command-

Keypad-period

Escape

Command-period

Cascade
Windows

Places all open windows overlap-
ping each other, and sized as large
as possible for that configuration.

Cell Margin
Dialog

Sets margins in tables.
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Center Current
Page

Command-; Centers all contents of the current
page (including blank lines) be-
tween the top and bottom margins.

Center Current
Page Toggle

Toggles between centered and
standard configuration

Center Line Option-F5 Centers the text to the right of the
insertion point, on the line the
insertion point is in. To center the
whole line, put the insertion point at
the left of the line.

Command-Shift-
Q

Change All
Backwards

Replace all find text with change
text going backwards in document.

Change All
Forward

Replace all find text with change
text going forward in document.

Change Bar
Show/Hide

Command-
Option-C

Toggles visibility of Change Bar.

Change Found Replace current instance of find text
with change text.

Change Then
Find Back-
wards

Replace find text with change text
and then search backwards for next
instance of find text.

Change Then
Find Forward

Replace find text with change text
and then search forward for next
instance of find text.

Character
Border Dialog

F7 Sets patterns, types, fills, colors and
spacing, for a border for the select-
ed character(s).
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Character
Format Dialog

Command-H Opens a dialog with choices of font,
size (including relative sizes),
attributes and styles, and underlining.

F8

Clear In the Equation and Graphic Editors,
clears any selected object(s).

Clear All Tabs Removes all tabs from the ruler.

Click Simulates mouse click at insertion
point.

Clipboard
Show/Hide

Opens or closes a window showing
the contents of the Macintosh
Clipboard.

Close Graphic Closes the active graphic window.

Close Window Command-W Closes the active window.

Codes Show/
Hide

Command-Shift-
K

Shows or hides the special window
at the bottom of the screen contain-
ing formatting and special codes.

Option-F2

Color Palette
Dialog

Offers a selection of colors for
boxes, borders, text or graphic
objects.

Column Border
Dialog

Shift-F7 Offers choices of border patterns,
fills and spacing for columns.

Column Break Command-Shift-
Return

Moves the insertion point to the next
column.

Column
Format Dialog

Command-K Sets column type, margins and
spacing.

Column Width
Dialog

Sets column width.
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Columns Off Ends multiple column formatting.

Convert to
Lowercase

Option-F15 Converts selected text to lowercase.

Convert to
Titlecase

Converts selected text so first letter
of each word is capitalized; other
letters lowercase.

Convert to
Uppercase

Option-F14 Changes all selected text to capital
letters.

Copy Command-C Puts selected text, equation or
graphic object(s) on the clipboard,
leaving the original untouched.

F3

Copy Ruler Command-F3 Copies to the clipboard the ruler
formatting in effect at the insertion
point.

Create Chart
Dialog

Create Hyper-
link Dialog

Creates hyperlink to current or other
document, URL or macro

Cut Command-X Puts selected text, equation or
graphic object(s) on the clipboard,
deleting the original.

F2

Dash With
Indent

Puts a dash to the left of the current
paragraph, and indents it.

Date Function Inserts the date and/or time, so that
WordPerfect updates it automatical-
ly each time the document is
opened or printed.

Date Text Command-Shift-
D

Inserts the date and/or time as text,
so it will not update automatically.
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Date/Time
Option Dialog

Sets formatting for automatic entry
(either as updating function or plain
text) of the current date and/or time.

Decimal Align
Dialog

Sets offset from right cell margin.

Decrement
Font Size

Command-Shift-< Reduces font size of selected text,
or text subsequently typed, by one
point

Default Fold-
ers Dialog

Tells WordPerfect where to look for
documents, speller, thesaurus and
help files, and stationery and
conversion folders.

Default Font
and Size
Dialog

Sets these attributes for each new
document.

Delete DelLeft Removes the character to the left of
the insertion point if no text is
selected, or removes all selected
text or graphic objects.

Delete Col/
Row Dialog

Deletes a column or row from a
table

Delete to End
of Line

Command-End Deletes all text between the inser-
tion point and the end of the current
line.

Command-Shift-
Keypad-1

Command-
Keypad-1
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Delete to End
of Page

Command-
Keypad-3

Deletes all text between the inser-
tion point and the end of the current
page.Command-Shift-

Keypad-3

Command-
PgDown

Delete Right Keypad-period Deletes the character to the right of
the insertion point.Shift-Keypad-

period

Shift-DelRight

Shift-DelLeft

DelRight

Command-Shift-
DelRight

Command-Shift-
Keypad-period

Delete Word Command-
DelRight

Deletes the word the insertion point
is in.

Command-
DelLeft

Option-DelLeft

Command-Shift-
DelLeft

Deselect All Removes all selection flags from the
current document.

Disable
Bookmark

Removes a bookmark you choose
from a menu
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Discontinue
Header/Footer
Dialog

Turns a header or footer off,
beginning on the page the insertion
point is in.

Double Under-
line Toggle

Shift-F15 Places double underlining on
selected text, or begins this attribute
for text typed subsequently.

Down Keypad-2 Moves the insertion point down one
line.Down

Shift-Down

Shift-Keypad-2

Command-
apostrophe

Option-Keypad-2

Shift-Option-
Keypad-2

Draw Overlay Enters the Graphic Editor, keeping
the rest of the active document
visible. Any graphics created or
pasted in this mode appear over
other elements in the document, not
in their own space.

Duplicate Command-D Makes one duplicate of the selected
object(s) in graphic mode.

Edit Box Lets you edit a graphic, text or
equation box. You can also double-
click on the box itself.
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Edit Caption Lets you edit a graphic or text box
caption. You can also click once on
the box to which the caption be-
longs, to select it, then double-click
on the caption.

Edit Endnote
Dialog

Chooses, by number, an endnote to
edit. You can also double-click on
the endnote number in the docu-
ment.

Edit Equation
Dialog

Chooses an equation to edit. Choice
is made by number; you can also
double-click on the equation box.

Edit Footnote
Dialog

Chooses, by number, a footnote to
edit. You can also double-click on
the footnote number in the docu-
ment.

Edit Graphic
Dialog

Chooses a graphic to edit. Choice is
made by number. An alternative is
to double-click on the graphic itself.

Edit Header/
Footer Dialog

Chooses header or footer A or B
(active at the insertion point) to edit.

Edit HTML
Image

Edits image placed with HTML
protocol

Edit Hyperlink
Dialog

Edits document hyperlink (e.g. to
this or other document, web ad-
dress, or macro)

Edit
SpeedStyle
Dialog

Edit character-level style sheet
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Edit Style
Dialog

Option-F10 Chooses a style sheet to edit.

Edit Text Box
Dialog

Chooses a text box to edit. Choice
is made by number. You can also
double-click on the text box.

Edit Water-
mark Dialog

Opens the Graphic Editor, and
watermarks A or B active at the
insertion point.

End End Moves the insertion point to the end
of the document.Shift-End

Command-Shift-
End

Gold-Gold-
Keypad-2

Gold-Gold-Down

Command-
Option-Down

Command-Shift-
Option-Down
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End of Line Gold-Gold-
Keypad-6

Moves the insertion point to the
right end of the line.

Gold-Gold-Right

Command-
Keypad-6

Command-Shift-
Keypad-6

Command-Right

Command-Shift-
Right

Shift-Keypad-1

Endnote Bar
Show/Hide

Shows or hides Command Bar in
Endnote subdocument window

Endnote
Options Dialog

Chooses numbering style and
starting number for endnotes.

Enter Enter Same as Return unless a style
sheet is active that is linked to
another style sheet; Enter then
moves to the next style.

Keypad-Enter

Shift-Keypad-
Enter

Option-Keypad-
Enter

Command-
Keypad-Enter

Command-Shift-
Enter

Command-Shift-
Keypad-Enter
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Environment
Dialog

Sets many options for automatic
backups, screen colors, formatting,
graphic alignment, and languages.

Equation
Frame Dialog

Sets pattern, color and fill for
equation boxes, spacing and
caption location.

Equation
Options Dialog

Sets anchor, position and size
options for equation boxes.

Execute
Hyperlink

Performs link to current or other
document, web address or macro

Exit Box Places cursor outside of graphic or
other box that has been opened for
editing

Exit Table Places cursor outside of table

File Manager
Dialog

Presents Open Dialog, with menu of
other commands e.g. Search

File Preferenc-
es Dialog

Sets number of files that appear in
the Open Latest menu, and allows
removing files from that menu. Also
sets default open and save file
formats.

Find Bar
Show/Hide

Shows or Hides Command Bar with
Find and Change commands

Find/Change
Dialog

Command-F Lets you enter a text string to find,
and another to change it to. Also
specifies where to search, which
attributes to match, and whether to
look for or insert formatting codes.
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Find/Change
Reset

Restores find and change options
(default or as set in Preferences)

Find Code
Dialog

Searches forward or backward for
selected code, with option to
remove the next or all occurrences.

Find Next Command-G Looks for next occurrence of text
string and selected options in the
Find dialog.

Find Next from
Find Bar

Looks for next occurrence of text
string as specified in Find Bar

Find Previous Command-Shift-
G

Looks for previous occurrence of
text string and selected options in
the Find dialog.

Find Previous
from Find Bar

Looks for previous occurrence of
text string as specified in Find Bar

Flush Right Command-Shift-
Z

Moves text to the right of the
insertion point, on the current line
only, to right alignment.Shift-F5

Font Bar
Show/Hide

Shows or hides Command Bar with
font information and commands

Font Dialog Dialog to set default font and size

Font Size 9
Point

Sets this font size

Font Size 10
Point

Sets this font size

Font Size 12
Point

Sets this font size
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Font Size 14
Point

Sets this font size

Font Size 18
Point

Sets this font size

Font Size 24
Point

Sets this font size

Font Size 36
Point

Sets this font size

Font Size 48
Point

Sets this font size

Font Size 72
Point

Sets this font size

Footer Bar
Show/Hide

Shows or hides Command Bar in
Footer window

Footnote Bar
Show/Hide

Shows or hides Command Bar in
Footnote window

Footnote
Options Dialog

Sets numbering style, starting
number, spacing and position.

Get Attributes In graphic mode, takes pen and fill
settings for the selected object, and
applies them to objects you draw
subsequently.

Go To Begin-
ning of Column

In a table, moves the insertion point
to the first row in the present
column.

Go To Begin-
ning of Row

In a table, moves the insertion point
to the leftmost column in the current
row.
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Go To Begin-
ning of Table

Moves the insertion point to the
leftmost column, top row.

Go To Dialog Option-F13 Moves the insertion point to the
specified page, position and col-
umn.

Go To End of
Column

In a table, moves the insertion point
to the last row in the current col-
umn.

Go To End of
Row

In a table, moves the insertion point
to the rightmost column in the
current row.

Go To End of
Table

Moves the insertion point to the last
column and row.

Gold Key Keypad-5 An additional modifier key (like
command and option) used by
WordPerfect. Press this key once
(or twice) first, then any other you
define in Edit/Preferences/Key-
boards, to call any program com-
mand.

Keypad-7

Shift-Keypad-5

Shift-Keypad-7

Grammar
Dialog

Command-Y Opens Grammar Checker.

Graphic Box
Number Dialog

Sets box and chapter numbers for
the selected graphic box.

Graphic Frame
Dialog

Sets pattern, type, fill and spacing
for the selected graphic box.

Graphic
Options Dialog

Sets anchor, label, position, size,
contents and caption position for the
selected graphic box.
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Grid Options
Dialog

In graphic mode, sets size, appear-
ance and snap for the vertical and
horizontal lines covering the screen,
that help with alignment in drawing.

Group Takes selected graphic objects and
treats them as one, for positioning
and sizing. Offers special effects
with graphic text.

Hard Return Return Starts a new line in text, which will
remain whether text above it is
inserted or deleted.

Shift-Return

Hard Space Command-Space Inserts a space that will not be
broken by a soft return: two words
are thus treated as one.

Command-Shift-
Space

Gold-Space

Header Bar
Show/Hide

Shows or hides Command Bar in
Header window

Header Rows
Dialog

Sets how many rows of a table are
header rows

Help Command-? Calls up the world’s best on-line
computer help.Help

Command-Shift-?

Shift-Help

Command-Shift-
Help
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Home Gold-Gold-
Keypad-8

Moves the insertion point to the
start of the document.

Home

Shift-Home

Gold-Gold-Up

Command-
Option-Up

Command-Shift-
Option-Up

HTML Bar
Show/Hide

Shows or hides HTML Command
Bar

HTML Begin-
ning of Tag

Places start of tag in HTML format-
ting

HTML End of
Tag

Places end of tag in HTML format-
ting

HTML Escape Performs escape in HTML format-
ting

HTML Head
Dialog

Places heading in HTML formatting

HTML Prefer-
ences Dialog

Opens HTML preferences

HTML Rule
Dialog

Sets rule in HTML formatting

Hyphen-
Required

Enters a hyphen that will always
appear, but which will break at the
end of a line.

Hyphen-Soft Command-
hyphen

Will appear only if the word contain-
ing it falls at the end of a line.
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Hyphenation
Dialog

Sets the kind of hyphenation and
left and right hyphenation zones.

Hyphenation-
Suppress

Turns automatic hyphenation off for
the word containing the insertion
point.

Increment
Font Size

Command-Shift-> Increases font size of selected text,
or text subsequently typed, by one
point.

Indent Command-Shift-I Moves the left margin of the para-
graph containing the insertion point,
or paragraphs of selected text, one
tab stop to the right.

F5

Insert Col/Row
Dialog

Adds a column or row to a table

Insert Dialog Opens a file and places it within the
active document.

Insert Endnote
Number

Places number of the active end-
note at the insertion point.

Insert HTML
image

Adds image in HTML formatting

Insert Note
Number

Places number of the active foot-
note or endnote at the insertion
point.

Insert Page
Number

Places current page number at the
insertion point.

Insert Para-
graph Above

Adds a paragraph above a table.

Invoke Last
Dialog

Recalls the most recent dialog.
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Italics Toggle Command-I Turns italics on or off for selected
text, or text typed subsequently.

Keep Lines
Together
Dialog

Lets you keep selected text, or a
specified number of lines, from
crossing a page break.

Keep Lines
Together

Keeps specified number of lines
from crossing a page break.

Kerning Dialog Moves together or apart, by a
specified number of points, the
letters on either side of the insertion
point.

Keyboard
Dialog

Lets you assign or delete keyboard
equivalents and print listings,
change keyboards, and print.

Launch Web
Browser

Opens browser specified in Edit >
Preferences > HTML

Left Keypad-4 Moves the insertion point one
character to the left.Left

Shift-Keypad-4

Shift-Left

Left/Right
Indent

Command-F5 Indents the paragraph containing
the insertion point, or selected
paragraphs, inward by one tab stop
from the left and right margins (also
see Indent and Nest Paragraphs).

Librarian
Dialog

Move, rename, copy or delete
styles, macros, character maps and
Button bars.
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Line Number-
ing Dialog

Shift-F8 Sets appearance, position and
options for numbering lines.

Line Spacing
Dialog

Sets line spacing, leading (sum of
the point measure of text and space
to the next line), and line height.

List Bar
Show/Hide

Shows or hides the Command Bar
with List functions

List Dialog Command-J Define, edit, mark or generate a list,
or specify a concordance file for an
index.

Lock Command-L Locks graphic objects so they can’t
be moved or deleted (but can be
duplicated or copied).

Macro Contin-
ue

After pausing a macro, resumes
playback.

Macro Edit Shift-F9 Opens text of a macro for editing.

Macro Pause
Recording

Temporarily stops recording of a
macro.

Macro Read
Text

Turns a text listing into a macro.

Macro Save As Saves a macro under another
name.

Macro Save
Text

Saves macro listing as text, for
editing as a normal document.

Make It Fit
Dialog

Shows choices to fit a given amount
of text in a given space

Margins Dialog Command-M Sets page margins.
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Mark Book-
mark Dialog

Allows naming of new bookmark

Mark Index Shift-F11 Includes a word or phrase in an
index.

Mark ToC
Level 1

F11 Includes a word or phrase in the
primary (single level, or not indent-
ed or wrapped) level of a table of
contents.

Mark ToC
Level 2

Command-F11 Includes a word or phrase in the
secondary (indented or wrapped)
level of a table of contents.

Merge Bar
Show/Hide

Command-
Option-M

Shows or hides the Command Bar
with mail merge commands

Merge Data
File Dialog

Opens data merge file

Merge Form
File Dialog

Opens form merge file

Merge Mes-
sage Dialog

Add a message to a merge setup

Merge Trans-
fer

Stops a merge in progress, and
stores commands in the merged
document. The second instance of
this command resumes the merge.

Move Apart Shift-F2 Bypassing kerning dialog, puts
space (in one-point increments)
between letters on either side of the
insertion point.

Move Back-
ward

Command-Shift-} In graphic mode, moves the select-
ed object behind other objects, one
at a time.
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Move Forward Command-Shift-{ In graphic mode, moves the select-
ed object ahead of other objects,
one at a time.

Move Left a
Cell

Moves to previous cell in table

Move Right a
Cell

Moves to next cell in table

Move to Back In graphic mode, moves the select-
ed object behind all other objects.

Move to Front In graphic mode, moves the select-
ed object in front of all other objects.

Move to Next
Cell

In a table, goes to the next column
in same row or, from the last row, to
the first column in the next row.

Move to
Previous Cell

In a table, goes to the previous
column in same row or, from the
first row, to the last column in the
previous row.

Move Togeth-
er

Shift-F1 Bypassing kerning dialog, deletes
space (in one-point increments)
from letters on either side of the
insertion point.

Nest Para-
graphs

Left-indents current paragraph.

New Docu-
ment

Command-N Starts a new document, according
to the Normal style, or to settings in
New Document Stationery in the
Stationery folder.
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New Endnote Command-Shift-
E

Puts an endnote number at the
insertion point in the document, and
opens a new endnote window.

New Footnote Command-Shift-
F

Puts a footnote number at the
insertion point in the document, and
opens a new footnote window.

New Equation Opens Equation Editor and a new
window

New Graphic Command-F1 Opens the Graphic Editor and a
new window.

New Header/
Footer Dialog

Command-Shift-
H

Starts either of two headers or two
footers that may be active at one
time.

New Macro Opens dialog to name and place a
new macro, and start recording

New
SpeedStyle
Dialog

Opens dialog to name and place a
new character-level style sheet

New Style
Dialog

Command-F10 Sets name, description, place to
save and what parts of current text
to save to a new style.

New Table Box Specifies columns and rows for a
new table, put in a text box.

New Table
Dialog

Specifies columns and rows for a
new table.

New Text Box Command-F2 Starts a new text box, with an
insertion point ready to enter text.

New User Box Starts a new box for any contents.
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New Water-
mark Dialog

Opens editing of either of two
watermarks that may be active at
one time.

Next Window Command-Shift-
W

Brings the back window to the front,
moving each other open window
back one layer.

Non-Breaking
Hyphen

Command-Shift- Inserts a hyphen that will not break
at the end of a line: the hyphen and
the words on both sides will stay on
one line.

Num Lock Shift-Escape Makes the keypad enter numbers,
rather than move the insertion point
in the document. Command toggles
on and off with these keystrokes.

Shift-Clear

Number
Format Dialog

In tables, governs number display.

Open Dialog Command-O Opens an existing document.

Open Tem-
plate Dialog

Selects a template, or opens
Personal Info dialog for template
use

Other Font
Sizes Dialog

Selects a font size not listed on
menu or in command list

Outline Toggle Turns outline text attribute on and
off.

Outlining
Dialog

Command-Shift-
O

Turns outline document structure on
or off; governs formatting.

Page Border
Dialog

Option-F7 Sets patterns, types, fills, colors and
spacing for page borders.
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Page Break Command-
Return

Inserts a hard page break, that will
remain if text above is deleted.

Page Down Keypad-3 Moves insertion point down one
page.PgDown

Option-Down

Shift-PgDown

Command-Shift-
PgDown

Shift-Option-
Down

Shift-Keypad-3

Page Number-
ing Dialog

Option-F8 Sets starting number, type, position,
font and other options for page
numbers.

Page Setup
Dialog

Sets paper size, layout, reduction
percentage, orientation, fractional
widths and other options for the
entire document.

Page Up Keypad-9 Moves insertion point up one page.

PgUp

Option-Up

Shift-Keypad-9

Shift-PgUp

Command-Shift-
PgUp

Shift-Option-Up
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Paragraph
Border Dialog

Command-F7 Sets patterns, types, fills, colors and
spacing for paragraph borders.

Paragraph
Layout Dialog

Command-F8 Sets first line indent, and space
between paragraphs.

Paste Command-V Pastes text, graphics, attributes or
formatting into a document.F4

Paste Attrib-
utes

Shift-F4 Pastes attributes only.

Paste Special
Dialog

Command-Shift-
V

Pastes either text only, or attributes
only.

Paste Text Command-F4 Pastes text only.

Pattern Edit
Dialog

In graphic mode, edits pattern
bitmaps.

Pen Size
Dialog

Sets pen height and width, in points
or other units of measurement.

Plain Text Command-T Removes italic, bold and other
attribute formatting from selected
text, or from text typed subsequent-
ly.

PostScript
Dialog

Allows entry of commands in the
PostScript computer language, in
the watermark graphics layer.

Preview HTML See what web page will look like.

Previous
Bookmark

Go to previous bookmark in docu-
ment

Print Dialog Command-P Sets number of copies, page range,
paper source, destination (printer or
disk) and other options.
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Print Preview
Dialog

Command-Shift-
P

Displays document, page by page,
as it will appear in print. Headers,
footers, foot- and endnotes, and
page numbers, appear as they will
when printed.

QuickCorrect
Edit Dialog

Edit original and replacement text
for QuickCorrect function

QuickCorrect
Preferences
Dialog

Set preferences for QuickCorrect
function

Quit Command-Q Leaves WordPerfect, deleting
temporary files that would serve as
backups were your computer to
crash.

Redline/Strike-
out Dialog

Places a vertical line (red on a color
monitor) to the left of selected text,
or a line striking out selected text:
used to mark revisions.

Redline Toggle F14 Turns redlining on and off.

Relative Size
Dialog

Sets sizes of fine, small, large, very
large and extra large type relative to
normal.

Remove
Bookmark

Deletes bookmarks from document

Remove
Overlay Dialog

Removes overlays from the current
page or from the whole document.

Remove
Redline

Removes redlining from selected
text.
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Remove
Strikeout

Removes strikeout text – not only
the marking.

Remove Style Deletes style assignment

Repeat Next Command-Clear The action following this command
will be repeated the specified
number of times. Especially useful
for keystrokes and macros. Use Set
Repeat Count to change number.

Command-
Escape

Replicate
Dialog

In graphic mode, set number, offset
and rotation of replications.

Right Keypad-6 Moves the insertion point one
character to the right.Right

Shift-Keypad-6

Shift-Right

Rotate Dialog Sets anchor and degree of rotation
of the selected object(s).

Rounded
Corners Dialog

Sets how rounded the corners of a
rounded rectangle are drawn.

Row Height
Dialog

Sets row height in table.

Ruler Bar
Show/Hide

Command-
Option-R

Shows or hides the Ruler Bar.

Ruler Show/
Hide

Command-R Hides all Ruler Bars or shows last
set of Ruler Bars that were open.
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Run Macro Command-Shift-
X

Executes a macro chosen from a list
of all macros installed in the Library
or the active document. All macros
appear in this list, but you can leave
a macro off the macro submenu of
the tools menu.

F9

Save Command-S Save changes in a file to disk. If the
file has not yet been saved a first
time, this command calls the Save
As dialog.

Save As Dialog Command-Shift-
S

Presents options for saving a file to
disk with a new name, including
location, file format, and what is to
be retained, and choice to pass-
word-protect.

Save Defaults
Dialog

Save Draw
Defaults

In the Graphic Editor, lets you save
pen pattern and size, fill pattern,
color, arc type, rounded rectangle
radius, and grid options as defaults.

Save Graphic
Dialog

Saves graphic as its own file, in
either the PICT (generic draw
format) or in a WordPerfect graph-
ics format, for transfer to WordPer-
fect documents on other computer
platforms.
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Screen Down Keypad-+ Moves the insertion point down one
screen. This command is relative to
screen size – not the same as
moving one page.

Command-
Keypad-2

Gold-Keypad-2

Gold-Down

Command-Down

Command-Shift-
Down

Shift-Keypad-+

Command-Shift-
Keypad-2

Screen Left Gold-Keypad-4 Moves the insertion point to the left
end of the line.Gold-Left

Screen Right Gold-Keypad-6 Moves the insertion point to the
right end of the line.Gold-Right

Screen Up Keypad-minus Moves the insertion point up one
screen. This command is relative to
screen size – not the same as
moving one page.
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Gold-Keypad-8

Command-Up

Gold-Up

Command-Shift-
Up

Shift-Keypad-

Command-
Keypad-8

Command-Shift-
Keypad-8

Select All Command-A Selects everything in the active
document.

Select Column Shift-F6 Selects column containing the
insertion point.

Select Font Command-[ After this keystroke, type enough
letters of the name of the font you
want to distinguish it from others,
and press return.

Select Font
Size

Command-] After this keystroke, type the size
you want, and press return.

Select Page Option-F6 Selects the entire page containing
the insertion point.

Select Para-
graph

Command-Shift-
Y

Selects the entire paragraph
containing the insertion point.

Command-F6

Select Sen-
tence

Command-Shift-
U

Selects the sentence containing the
insertion point.

F6
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Select Table Option-Shift-T Selects the table containing the
insertion point.

Select Table
Cell

Selects a cell.

Select Table
Column

Selects the column containing the
insertion point.

Select Table
Formula

Command-equal Lets you type in a formula. Press
return to enter it.

Select Table
Row

Selects the row containing the
insertion point.

Select Window

Select Word Selects the word containing the
insertion point.

Set Language
Dialog

Specifies the point to change from
one language to another, for use
with spell checking and other
language tools.

Set Repeat
Count

Command-Shift-
Clear

Changes the number of repeats to
be used by the Repeat Next com-
mand.Command-Shift-

Escape

Shadow
Toggle

Turns the shadow lettering style on
and off.

Show Bars
Dialog

Sets which Command Bars to open
with a new document

Size Object
Dialog

In graphic mode, specifies anchor
point and percentage to resize the
selected object(s).
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Sleep Puts computer to sleep (with
compliant hardware).

Small Caps
Toggle

Shift-F14 Turns small caps on and off.

Smart Quotes
Toggle

Command-Shift-
Apostrophe

Turns smart (or printer’s, or curly)
quotes on and off.

Shift-F3

Sort Alphabeti-
cally

Sort by letter

Sort Ascending Sort A > Z or 1 > 9

Sort by First
Column Values

Sort by first column in table

Sort by Last
Column Values

Sort by last column in table

Sort by Sec-
ond Column
Values

Sort by second column in table

Sort Descend-
ing

Sort Z > A or 9 > 1

Sort Dialog Specifies levels, items and parame-
ters for a sort, and filter criteria.

Sort Lines by
First Word

Sort paragraphs by alphanumeric
value of first word

Sort Lines by
Last Word

Sort paragraphs by alphanumeric
value of last word

Sort Lines by
Second Word

Sort paragraphs by alphanumeric
value of second word
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Sort Numeri-
cally

Sort by number

Speech Bar
Show-Hide

Shows or hides the Command Bar
with Speech functions.

Speller Dialog Command-E Opens the spell checker.

Start Merge Command-\ Begin merging form and data files.

Shift-F12

Start Speech Begins speaking a document or
selection.

Status Bar
Show/Hide

Command-
Option-W

Shows or hides the Status Line (or
Bar).

Strikeout
Toggle

F15 Turns strikeout text marking on and
off.

Style Options
Dialog

F10 Bases one style on, or links it to,
another, and allows keystroke
assignment.

Styles Bar
Show/Hide

Shows or hides the Command Bar
with Styles functions

Subscript
Toggle

Command-
Option-comma

Turns subscript text on and off.

Command-F15

Subtitle Dialog Sets font and size options for
subtitles.

Superscript
Toggle

Command-F14 Turns superscript text on and off.
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Suppress
Format Dialog

Lets you turn off headers, footers,
watermarks, and page numbers for
the current page, or move the page
number for that page to bottom
center.

Symbol Dialog Option-F4 Shows the entire character set for
the active font. Clicking a character
inserts it in your text.

Tab Tab Moves the insertion point one tab
stop to the right, according to the
kind of tab stops set in the ruler and
tab dialog.

Tab Align Option-F12 Aligns tabs on either side of a
special character.

Table Bar
Show/Hide

Shows or hides Command Bar with
Table functions.

Table Border
Dialog

Present dialog to set borders for
current cell, selected cells or entire
table.

Table Calcu-
late Dialog

Allows you to recalculate one table,
or all in the document.

Table Position
Dialog

Sets position of current table.

Table Tab Option-Tab Tabs cursor within a table. (The
normal tab key moves the insertion
point from one cell to the next within
a table.)

Table To Text
Dialog

Changes a selected table to text:
tab- or comma-delimited, paragraph
or merge formats.
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Tabs Dialog Sets tabs evenly by number and
type.

Text Box
Frame Dialog

Sets pattern, type, fill, spacing and
caption position.

Text Box
Number Dialog

Specifies box and chapter number
and type.

Text Box
Options Dialog

Sets anchor, label, position, size
and contents.

Text To Table
Dialog

Specifies number of columns, and
conversion type: from paragraph,
tab- or comma-delimited, paragraph
or merge format.

Thesaurus
Dialog

Command-Shift-
T

Opens WordPerfect’s thesaurus and
looks up the word, if any, containing
the insertion point.

Tile Windows Sizes and places all open windows
so they are adjacent to each other
on screen.

Toggle In Line
Flag

Allows entry of two-byte characters,
such as Cyrillic or Japanese.

Toggle Script
Font Change
Flag

Allows WordPerfect to change
scripts automatically when you
change to a font requiring a differ-
ent script.

Typeover Command-Help In typeover mode, text entered in
the middle of a line does not push
succeeding text to the right, but
types over it.
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Underline
Toggle

Command-U Turns the underlining attribute on
and off. For double underlining, use
the Character Format dialog.

Undo Command-Z Undoes the most recent action that
changed the document. Scrolling,
etc., cannot be undone since it does
not change the document.

F1

Ungroup In graphic mode, returns a selected
object that is a grouping to
ungrouped individual elements.

Unlock In graphic mode, unlocks a selected
object that has been locked.

Unnest Para-
graphs

Removes left indent from nested
paragraphs

Up Keypad-8 Moves the insertion point one line
up.Up

Shift-Up

Option-Keypad-8

Shift-Keypad-8

Shift-Option-
Keypad-8

Update Style Shift-F10 Updates the active style with the
attributes and formatting of currently
selected text.

User Box
Frame Dialog

Sets pattern, type, fill, spacing and
caption position.

View at 100% F13 Displays document at actual size.

View at 200% Shift-F13 Displays document at double size.
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View Full Page Command-F13 Displays entire current page, at size
of screen.

Watermark
Options Dialog

Places either of two active water-
marks A or B on all, or even or odd
pages, or discontinues a watermark.

Word Count Option-F3 Displays number of characters,
words, lines, sentences paragraphs,
pages, average and maximum
words per sentence.

Word Left Option-Left Moves insertion point one word to
the left.Option-Keypad-4

Shift-Option-Left

Shift-Option-
Keypad-4

Word Right Option-Right Moves insertion point one word to
the right.Option-Keypad-6

Shift-Option-
Right

Shift-Option-
Keypad-6

Word Services
Dialog

Allows operation of separate
programs from within WordPerfect.
Limited to newer programs that
support Apple’s Word Services
protocol.

¶ Show/Hide Toggles display of space, tab,
return, and list markings.
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wp file recover  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 224
wp for pc  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 434
wp quickhelp  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 601
wpmac  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
wrap around  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
wrap around search . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 416
wrap text around box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 316
writing style  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
x-height  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 513
xtnd export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 435
yahoo group  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
zone, hyphenation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 321
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